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1 Preface

User's manual and reference manual

The documentation of your device consists of two parts: The user’s manual and the reference manual.

> The hardware of the LANCOM devices is documented in the respective user's manuals. Apart from a description
of the specific feature set of the different models, you find in the user’s manual information about interfaces and
display elements of the devices, as well as instructions for basic configuration by means of the wizards.

> You are now reading the reference manual. The reference manual describes all functions and settings of the cur-
rent version of LCOS, the operating system of all LANCOM routers and LANCOM Wireless Access Points. The refe-
rence manual refers to a certain software version, but not to a special hardware.

It completes the user's manual and describes topics in detail, which are valid for several models simultaneously.
These are for example:

Systems design of the LCOS operating system
Configuration

Management

Diagnosis

Security

Routing and WAN functions

Firewall

Quality of Service (QoS)

Virtual Private Networks (VPN)

Virtual Local Networks (VLAN)

Wireless Networks

LANCAPI

Further server services (DHCP, DNS, charge management)

v vV vVvvVvVvyvV VvV VvV VVV VYV

LCOS, the operating system of LANCOM devices

All LANCOM routers and LANCOM Wireless Access Points use the same operating system: LCOS. The operating sys-
tem developed by LANCOM Systems itself is not attackable from the outside, and thus offers high security. The con-
sistent use of LCOS ensures a comfortable and constant operation of all LANCOM products. The extensive feature set
is available throughout all LANCOM products (provided respective support by hardware), and continuously receives
further enhancements by free, regular software updates.

This reference manual applies to the following definitions of software, hardware and manufacturers:

> 'LCOS’ describes the device-independent operating system

> 'LANCOM’ stands as generic term for all LANCOM routers and LANCOM Wireless Access Points

> 'LANCOM Systems’ stands as shortened form for the manufacturer, LANCOM Systems GmbH, Germany

10
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Validity

The present reference manual applies to all LANCOM routers and LANCOM Wireless Access Points with firmware ver-
sion 3.52 or better.

The functions and settings described in this reference manual are not supported by all models and/or all firmware
versions. A table can be found in the appendix denoting the individual functions, from which firmware version they
are supported in the respective devices (‘Overview of functions for LANCOM models and LCOS* versions'
—page 312).

llustrations of devices, as well as screenshots always represent just examples, which need not necessarily corres-
pond to the actual firmware version.

Security settings

For a carefree use of your device, we recommend to carry out all security settings (e.g. Firewall, encryption, access
protection, charge lock), which are not already activated at the time of purchase of your device. The LANconfig
wizard 'Check Security Settings” will support you accomplishing this. Further information regarding this topic can be
found in chapter ‘Security’” —page 48.

We ask you additionally to inform you about technical developments and actual hints to your product on our Web
page www.lancom.de, and to download new software versions if necessary.

This documentation was compiled ...

...by several members of our staff from a variety of departments in order to ensure you the best possible support
when using your LANCOM product.

In case you encounter any errors, or just want to issue critics or enhancements, please do not hesitate to send an
email directly to:

info@lancom.de

. Our online services (www.lancom.de) are available to you around the clock should you have any queries
= regarding the topics discussed in this manual or require any further support. In addition, support from LAN-

11
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COM Systems is also available to you. Telephone numbers and contact information for LANCOM Systems
support can be found on a separate insert, or at the LANCOM Systems website.

Very important instructions. If not followed, damage may result.

@ Important instruction should be followed.

Additional instructions which can be helpful, but are not
required.

12
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2  System design

2.1 Introduction

The LANCOM operating system LCOS is a collection of different software modules, the LANCOM devices themselves
have different interfaces to the WAN and LAN. Depending on the particular application, data packets flow through

different modules on their way from one interface to another.

The following block diagram illustrates in abstract the general arrangement of LANCOM interfaces and LCOS modu-
les. In the course of this reference manual the descriptions of the individual functions will refer to this illustration to
show important connections of the particular applications and to deduce the resulting consequences.

[> Introduction
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The diagram can thus explain for which data streams the firewall comes into play, or, in case of address translations
(IP masquerading or N:N mapping), at which place which addresses are valid.
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= LANCOM RADIUS
‘'S | user manage- client/ server
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Notes regarding the respective modules and interfaces:

LAN interfaces

LAN / Switch
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B
(=]
L]

WLAN-1-1 :
D)

WLAN-1-8
WLAN-2-1

Encryption:
802.11i/WPA/WEP

» The IP router takes care of routing data on IP connections between the interfaces from LAN and WAN.
> With IP redirect requests in the LAN are redirected to a specific computer

» The firewall (with the services “Intrusion Detection”,

nou

Denial of Service” and “Quality of Service”) encloses the IP

router like a shield. All connections via the IP router automatically flow through the firewall as well.
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LANCOM devices provide either a separate LAN interface or an integrated switch with multiple LAN interfaces
as interfaces to the LAN.

LANCOM Wireless access points resp. LANCOM routers with wireless modules offer additionally one or, depen-
ding on the respective model, also two wireless interfaces for the connection of Wireless LANs. Depending on
the model every wireless interface can build up to eight different wireless networks (“multi SSID").

A DMZ interface enables for some models a ‘demilitarized zone' (DMZ), which is also physically separated within
the LAN bridge from other LAN interfaces.

The LAN bridge provides a protocol filter that enables blocking of dedicated protocols on the LAN. Additionally,
single LAN interfaces can be separated by the “isolated mode”. Due to VLAN functions, virtual LANs may be
installed in the LAN bridge, which permit the operating of several logical networks on a physical cabling.
Applications can communicate with different IP modules (NetBIOS, DNS, DHCP server, RADIUS, RIP, NTP, SNMP,
SYSLOG, SMTP) either via the IP router, or directly via the LAN bridge.

The functions “IP masquerading” and “N:N mapping” provide suitable IP address translations between private
and public IP ranges, or also between multiple private networks.

Provided according authorization, direct access to the configuration and management services of the devices
(WEBconfig, Telnet, TFTP) is provided from the LAN and also from the WAN side. These services are protected by
filters and login barring, but do not require any processing by the firewall. Nevertheless, a direct access from
WAN to LAN (or vice versa) using the internal services as a bypass for the firewall is not possible.

The IPX router and the LANCAPI access on the WAN side only the ISDN interface. Both modules are independent
from the firewall, which controls only data traffic through the IP router.

The VPN services (including PPTP) enable data encryption in the Internet and thereby enable virtual private net-
works over public data connections.

Depending on the specific model, either xDSL/Cable, ADSL or ISDN are available as different WAN interfaces.
The DSLol interface (DSL over LAN) is no physical WAN interface, but more a “virtual WAN interface”. With
appropriate LCOS settings, it is possible to use on some models a LAN interface as an additional xDSL/Cable
interface.
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[> Configuration tools and approaches

3 Configuration and management

This section will show you the methods and ways you can use to access the device and specify further settings. You
will find descriptions on the following topics:

» Configuration tools

> Monitoring and diagnosis functions of the device and software

> Backup and restoration of entire configurations

> Installation of new firmware in the device
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3.1 Configuration tools and approaches

LANCOM are flexible devices that support a variety of tools (i.e. software) and approaches (in the form of commu-
nication options) for their configuration. First, a look at the approaches.

You can connect to an LANCOM with three different access methods (according to the connections available).

» Through the connected network (LAN as well as WAN—inband)

> Through the configuration interface (config interface) on the rear of the router (also known as outband)

> Remote configuration via ISDN access

What is the difference between these three possibilities?

On one hand, the availability: Configuration via outband is always available. Inband configuration is not possible,
however, in the event of a network fault. Remote configuration is also dependent on an ISDN connection.

On the other hand, whether or not you will need additional hardware and software: The inband configuration
requires one of the computers already available in the LAN or WAN, as well as only one suitable software, such as
LANconfig or WEBconfig (see following section). In addition to the configuration software, the outband configura-
tion also requires a the computers with a serial port. The preconditions are most extensive for ISDN remote configu-
ration: In addition to an ISDN capable LANCOM, an ISDN card is needed in the configuration PC or alternatively,
access via LANCAPI to an additional LANCOM that is ISDN capable.

3.2 Configuration software

Situations in which the device is configured vary—as do the personal requirements and preferences of the person

doing the configuration. LANCOM routers thus feature a broad selection of configuration software:

> LANconfig — nearly all parameters of the LANCOM can be set quickly and with ease using this menu-based
application. Outband, inband and remote configuration are supported, even for multiple devices simultaneously.

> WEBCconfig — this software is permanently installed in the router. All that is required on the workstation used
for the configuration is a web browser. WEBconfig is thus independent of operating systems. Inband and remote
configuration are supported.

15
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[> Searching and configuring devices

> SNMP — device-independent programs for the management of IP networks are generally based on the SNMP
protocol. It is possible to access the LANCOM inband and via remote configuration using SNMP.

» Terminal program, Telnet —an LANCOM can be configured with a terminal program via the config interface
(e.g. HyperTerminal) or within an IP network (e.g. Telnet).

> TFTP - the file transfer protocol TFTP can also be used within IP networks (inband and remote configuration).

The following table shows, how you can use the configuration:
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LANconfig Yes Yes Yes
WEBconfig Yes No Yes
SNMP Yes No Yes
Terminal program No Yes No
Telnet Yes No No
TFTP Yes No Yes

Please note that all procedures access the same configuration data. For example, if you change the settings
in LANconfig, this will also have a direct effect on the values under WEBconfig and Telnet.

3.3 Searching and configuring devices

@ Always switch on your device first before starting the PC for configuration.

A Router or an Access Point can be configured in the following ways (provided that the model is equipped with the

according interface):

» Via the local network (LAN) @.

> Via the wireless network (WLAN) @), if the WLAN encryption (e.g. WEP) of a device with a wireless interface and
in the configuration PC has been adjusted correctly and/or has been deactivated.

> Via the serial configuration interface @.
> Via a ISDN connection @

16
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[> Configuration using different tools
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3.4 Configuration using different tools

3.4.1 LANconfig

Start LANconfig by, for example, using the Windows Start menu: Start » Programme » LANCOM » LANconfig.
LANconfig will now automatically search for devices on the local network. It will automatically launch the setup
wizard if a device which has not yet been configured is found on the local area network LANconfig.

% | ANconfig [ ot icanter LSS i e D = _ o x|
o Setup wiraed o LARCOM 1811 Wissles D51 4
File Edit Device Wew Jools Hep ey worgn 3

olals| mlelel olal sl wdol wlel o) s

LANcanfig Tame | Description I Address | Divice oo benbem s cavie duac o I
ESPLANCOM 1811 Wireless DAL 172,23.56,.254  OPENC Moy s s msomsicl
1 | mish b i S setirg el

If the firewall ist activated the LANconfig might not be able to find the new device in the LAN. In this occa-
@ sion deactivate the firewill whilst the configuration.

Your LANCOM device is equipped with an extensive firewall and protects your computer even if no further
firewall is active.

Find new devices

Click on the Find button or call up the command with Device P> Find to initiate a search for a new device manually.
LANconfig will then prompt for a location to search. You will only need to specify the local area network if using the
inband solution, and then you're off.

Once LANconfig has finished its search, it displays a list of all the devices it has found, together with their names
and, perhaps a description, the IP address and its status

17
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I
File Edit Device Wiew Tools Help
solail| ElwlE] Hlwl e Gl 22
a_ LaMconfig Marne I Drescription | Address | Device Status | Progress | ﬂ
l:l Clignt01 ESLC_PPP 10.1.1,31 Ok
Elc-wrls-e201 10,1.10.183 ok
Ealc-wrls-e316 10.1.10.184 Ok
Elc-wrls-e201-54m 10,1.10.186 Ok
Eplc-ez14-L54ag 10.1.10,157 ok
Eplc-e305-L54ag 10.1.10.185 ok
&lc-e310-L54ag 10.1.10.189 ok
I5;:,3,ILC1621.Inl:ernel: 10.1.80.125 Ok
@ Calvin 10.1.80.14%9 Ok
EHobbes 10,1.80.150 ok
EWLansry 10.1.80.245 Ok
& AMay_ISON 10.1,80,247 ok
Euskssl 10.1.82.100 Ok
w 10.1.140.159 Reading config ... 41472 bytes
IE;:,:,l1Ev21.\?\nne>< 10.1.140.160 Ok =
| Date | Time | Mame | Address | Message | ﬂ
@ 1fz9/2004 1044, 1621AnnexE 10.1.140,159 Configuration editing started
@ 1fz9fz004 1044, 1621AnnexE 10.1.140,159 Configuration reading started
@ 12902004 1045, 1621AnnexE 10,1.140,159 Configuration read successfully
Bt Bm Bem e rarrimeer - [ — R w i

The expanded range of functions for professionals
Two different display options can be selected for configuring the devices with LANconfig:

> The 'Simple configuration display' mode only shows the settings required under normal circumstances.

> The 'Complete configuration display' mode shows all available configuration options. Some of them should only
be modified by experienced users.

Select the display mode in the View P> Options menu.

Double-clicking the entry for the highlighted device and then clicking the Configure button or the Device »>Con-
figure option reads the device's current settings and displays the 'General' configuration selection.

The integrated Help function

The remainder of the program's operation is self-explanatory or you can use the online help. You can click on the
‘Help' button top right in any window or right-click on an unclear term at any time to call up context-sensitive help.

Management of multiple devices

LANconfig supports multi device remote management. Simply select the desired devices, and LANconfig performs
all actions for all selected devices then, one after the other. The only requirement: The devices must be of the same
type.

In order to support an easy management, the devices can be grouped together. Therefore, ensure to enable Folder
Tree’ in the View menu, and group the devices by ‘drag an drop” into the desired folders.
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[> Configuration using different tools

(‘ LANconfig shows only those parameters that are suitable for multi device configuration when more than one &
=7 device is selected, e.g. MAC Access Control Lists for all LANCOM Wireless Access Points. =2
<=
©
"."-rj LANconfig 10l =| E
Device Edit Wiew Tools Help <
©
ol 0yl sl sElele] wlEw 222 S
LaMconfig | address | Skatus g
RPN P 1601 nterr 10.1.80.125 ok ©
{17 Branch Offices 0.1.140.159 Ok =
D Engineering Configure l g
arm m
g S
£ WLAN &P et i’ Q
Check
«| Delete | _>|
Loads a new firmware into the selected ¢ properties v

3.4.2 WEBconfig

You can use any web browser, even text-based, for basic setup of the device. The WEBconfig configuration applica-
tion is integrated in the LANCOM. All you need is a web browser in order to access WEBconfig.

Functions with any web browser

WEBCconfig offers setup wizards similar to LANconfig and has all you need for easy configuration of the LANCOM—
contrary to LANconfig but under all operating systems for which a web browser exists.

A LAN or WAN connection via TCP/IP must be established to use WEBconfig. WEBconfig is accessed by any web
browser via the IP address of the LANCOM, via the name of the device (if previously assigned), or via any name if
the device has not been configured yet.

http://<IP address or device name>

Secure with HTTPS
WEBconfig offers an encrypted transmission of the configuration data for secure (remote) management via HTTPS.

https://<IP address or device name>

ﬁ~ For maximum security, please ensure to have installed the latest version of your Internet browser. For Win-
dows 2000, LANCOM Systems recommends to use the “High Encryption Pack” or at least Internet Explorer
5.5 with Service Pack 2 or above.
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Access to the device over WEBconfig

For the usage of WEBconfig the PC must connected to the LAN or WAN over TCP/IP. WEBconfig runs with the help
of a web browser and accesses the device either with the IP address io the LANCOM, with the name of the device (if
already assigned) or with a any desired name, in case the device has not been configured yet.

The reaction of Routers and Access Points, as well as their accessibility for configuration via web browser is depen-
dent on whether a DHCP server and a DNS server are already active in the LAN, and whether these two server pro-
cesses exchange the assignment of IP addresses to symbolic names within the LAN between each other.

After powered on, unconfigured LANCOM devices check first, whether a DHCP server is already active in the LAN.
Dependent on the situation, the device is able to switch on its own DHCP server or, alternatively, to activate its DHCP
client mode. In this second operating mode, the device itself can obtain an IP address from a DHCP server already
existing in the LAN.

Network without DHCP server

In a network without DHCP server, unconfigured LANCOM devices activate their own DHCP server service after star-
ting, and assign appropriate IP addresses and gateway information to the other workstations within the LAN, pro-
vided that the workstations are set to obtain their IP address automatically (auto-DHCP). In this constellation, the
device can be accessed with any web browser from each PC with activated auto-DHCP function through the name
LANCOM or by its IP address 172.23.56.254.

“J LANCOM 1811 Wireless DSL - Microsoft Internet Explorer: 10l =l
File Edit Wiew Favorites Tools Help |ﬁ
Crk -5 - @ o | Qisearch “J LANCOM 1811 Wireless DSL - Microsoft Internet Explorer: 10l =l

File Edit Wiew Favorites Tools Help |

GBack ~ = - (D at | Qhsearch [G|Favorites GlMedia &4 | - S

Address @] hep://172,23.56.254 x| @6 |Links >
B  ANCOM ° e ¥

If the configuration PC does not obtain its IP address from the LANCOM DHCP server, figure out the current IP
address of this PC (with Start »> Execute » cmd and command ipconfig at the prompt under Windows 2000 or
Windows XP, with Start P> Execute » cmd and the command winipcfg at the prompt under Windows Me and
Windows 9x, or with the command ifconfig on the console under Linux). In this case, the LANCOM is reachable

u,n

under the IP address x.x.x.254 ( “x" stands for the first three blocks in the IP address of the configuration PC).

Address [@] hep: /jLANCOM

Network with DHCP server

If a DHCP server is active in the LAN to assign IP addresses, an unconfigured LANCOM device will turn off its own
DHCP server. It will change into DHCP client mode and will obtain an IP address from the DHCP server of the LAN.
This IP address is not known at first. The accessibility of the device depends on the name resolution:

If there is a DNS server for name resolution in the LAN, which interchanges the assignment of IP addresses to names
with the DHCP server, then the device can be accessed by the name “LANCOM <MAC address>" (e.g. “LANCOM-
00a057xxxxxx")
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3 LANCOM 1811 Wireless DSL - Microsoft Internet Explorer 10l =l
File Edit View Favorites Tools Help |
GBack ~ = - (D at | Qhsearch [G|Favorites GlMedia &4 | - S

Address @http:HLANCOM-DDausmoogm R |Links 2

al

@ The MAC address can be found on a label at the bottom of the device.

> If there is no DNS server in the LAN, or it is not linked to the DHCP server, then the device can not be reached
by the name. The following options remain in this case:
> Figure out the DHCP-assigned IP address of the LANCOM by suitable tools and contact the device directly
with this IP address.

> Use LANconfig.
> Connect a PC with a terminal program via the serial configuration interface to the device.
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3.4.3 Telnet

Launching Telnet

Start configuration using Telnet, e.g. from the Windows command line with the command:
C:\>telnet 10.0.0.1

Telnet will then establish a connection with the device using the IP address.

After entering the password (if you have set one to protect the configuration), all configuration commands are avai-
lable.

1'.‘ Linux and Unix also provide Telnet over SSL encoded connections. Depending on your distribution you might
have to replace your version with one that provides SSL. The encoded Telnet connection is started with the
command

C:\>telnet -z ssl 10.0.0.1 telnets

21



d)
()}
©
=
©
S
=
=
©
=
S
~
€
=
>
oy
S
Q

P Chapter 3: Configuration and management LANCOM Reference Manual LCOS 3.52

> Configuration using different tools

22

Change the language of the display.

The terminal can be set to English and German modes. The display language of your LANCOM is set to English at
the factory. In the remaining documentation, all configuration commands will be provided in English. To change the
display language to German, use the following commands:

WEBconfig Expert configuration B> Setup P> Config-module » Language

Telnet set /Setup/Config module/Language German

Terminating Telnet
To terminate the configuration using Telnet, e.g. from the Windows command line with the command:

C:\>exit

The structure of the command line interface
The LANCOM command line interface is always structured as follows:
» Status

Contains all read-only statistics of the individual SW modules

»> Setup
Contains all configurable parameters of all SW modules of the device

> Firmware
Contains all firmware-management relevant actions and tables

> Other
Contains dialling, boot, reset and upload actions

Command line reference

Navigating the command line can be accomplished by DOS and UNIX style commands as follows:

cd <directory> Change the current directory. Certain abbreviations exists, e.g. “cd ../.." can be abbreviated to "cd ..." etc.
del <name> Delete the table entry with the index <name>

rm <name>

dir [<directory>] Display the contents of a directory

list[<directory>]
Is [<directory>]
Il [<directory>]

do <name> [<parameters>] Execute the action <name> in the current directory. Parameters can be specified

exit/quit/x Close the console session
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Unlock the feature with the specified feature code

passwd

change password

ping [IP address]

Issues an ICMP echo request to the specified IP address

readconfig

Displays the complete configuration of the device in “readconfig” syntax

readmib

display SNMP Management Information Base

repeat <VALUE> <command>

repeats command every VALUE seconds until terminated by new input

stop

stop ping

set <name> <value(s)>

Set a configuration item to the specified value. If the item is a table entry, multiple values must be given
(one for each table column). A "*" as a value indicates that the column in question should be left at its
previous value.

set [<name>] ?

Show which values are allowed for a configuration item. If <name> is empty, this is displayed for each
item in the current directory.

show <options>

Shows internal data. Run show ? for a list of available items, e.g. boot history, firewall filter rules, vpn rules
and memory usage

sysinfo Shows basic system information

trace [...] Configures the trace output system for several modules, see "How to start a trace” —page 43

writeconfig Accept a new configuration in “readconfig” syntax. All subsequent lines are interpreted as configuration
values until two blank lines in a row are encountered

writeflash load new firmware via TFTP

» All commands and directory/item names may be abbreviated as long as no ambiguity exists. For example, it is
valid to shorten the "sysinfo” command to “sys” ora "cd Management”to “c ma". Not allowed
would be "cd /s”, since that could mean either “cd /Setup” or "cd /Status”.

> Names with blanks in them must be enclosed in double quotes.

> Additionally, there is a command-specific help function available by calling functions with a question mark as
the argument, i.e. entering “ping 2" displays the options for the built-in PING command.

> A complete listing of available commands for a particular device is available by entering '?" from the command

line.

3.4.4 TFTP

Certain functions cannot be run at all, or not satisfactorily, with Telnet. These include all functions in which entire
files are transferred, for example the uploading of firmware or the saving and restoration of configuration data. In

this case TFTP is used.

TFTP is available by default under the Windows 2000 and Windows NT operating systems. It permits the simple
transfer of files with other devices across the network.

The syntax of the TFTP call is dependent on the operating system. With Windows 2000 and Windows NT the syntax is:

23
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tftp -i <IP address Host> [get|put] source [target]

@ With numerous TFTP clients the ASCII format is preset. Therefore, for the transfer of binary data (e.g. firm-
. ware) the binary transfer must usually be explicitly selected.This example for Windows 2000 and Windows
NT shows you how to achieve this by using the '-i' parameter.

3.4.5 SNMP
The Simple Network Management Protocol (SNMP V.1 as specified in RFC 1157) allows monitoring and configuration
of the devices on a network from a single central instance.

There are a number of configuration and management programs that run via SNMP. Commercial examples are Tivoli,
OpenView from Hewlett-Packard, SunNet Manager and CiscoWorks. In addition, numerous programs also exist as
freeware and shareware.

Your LANCOM can export a so-called device MIB file (Management Information Base) for use in SNMP programs.

WEBconfig Get Device SNMP MIB (in main menu)

TFTP ‘tftp 10.0.0.1 get readmib filel

3.4.6 ISDN Remote configuration via Dial-Up Network

(‘i‘ The complete section on remote configuration applies only to LANCOM with ISDN interface.

Configuring routers at remote sites is particularly easy using the remote configuration method via a Dial-Up Network
from Windows. The device is accessible by the administrator immediately without any settings being made after it is
switched on and connected to the ISDN interface. This means that you save a lot of time and costs when configuring
at separate locations because you do not have to travel to the other network or instruct the staff on-site on confi-
guring the router.

You can also reserve a special calling number for remote configuration. Then the support technician can always
access the router even if it is really no longer accessible due to incorrect settings.

This is what you need for ISDN remote configuration

> An LANCOM with an ISDN connection

> A computer with a PPP client, e.g. Windows Dial-Up Network

» A program for inband configuration, e.g. LANconfig or Telnet

> A configuration PC with an ISDN card or access via LANCAP/to an LANCOM with ISDN access.
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The first remote connection using Dial-Up Networking
For the remote connection of a LANCOM with LANconfig using Dail-Up Networking proceed as follows:

LANCOM with ISDN-inter- PC with Dail-Up Networ-
face for the configuration king, ISDN adapter (alter-

natively access to LANCAPI)
and LANconfig
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(D In the LANconfig program select Device P> New, enable 'Dial-Up connection' as the connection type and enter
the calling number of the ISDN interface to which the LANCOM is connected. If you wish, you can also enter the
time period after which an idle connection is to be disconnected automatically.

(2 LANconfig now automatically generates a new entry in the Dial-Up Network. Select a device that supports PPP
(e.g. the NDIS-WAN driver included with the LANCAPI) for the connection and press OK to confirm.

(@ Then the LANconfig program will display a new device with the name *Unknown' and the dial-up call number
as the address in the device list.

('3 When an entry in the device list is deleted, the related connection in the Windows Dial-Up Network is also
=7 deleted.

@ You can configure the device remotely just like all other devices. LANconfig establishes a dial-up connection
enabling you to select a configuration.

Always provide additional protection for the settings of the device by setting a password by switching to the
‘Security' tab in the ‘Management' configuration section.

The first remote connection using a PPP client and Telnet

Instead of a remote configuration with LANconfig it is also possible to acces over ISDN with Telnet. For a remote
configuration of a LANCOM with Telnet over any PPP client proceed as follows:

25
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@_"_

LANCOM with ISDN-inter- PC with Dail-Up Networ-

face for the configuration king, ISDN adapter (alter-
natively access to LANCAPI)
and LANconfig

(1) Establish a connection to the LANCOM with your PPP client using the following details:

> User name 'ADMIN'
> The password selected in LANCOM
> An IP address for the connection, only if required

(2 Open a Telnet session to the LANCOM. Use the following IP address for this purpose:

> '172.17.17.18', if you have not defined an IP address for the PPP client. The LANCOM automatically uses
this address if no other address has been defined. The PC making the call will respond to the IP
172171717,

I> Raise the IP address of the PC by one, if you have defined an address. Example: You have set the IP
'10.0.200.123" for the PPP client, the LANCOM then responds to '10.0.200.124'. Exception: If the digits
‘254" are at the end of the IP address, the router responds to ‘x.x.x.1".

(3 You can configure the LANCOM remotely just like all other devices.

\ Always provide additional protection for the settings of the device by setting a password. Alternatively, enter
the following command during a Telnet or terminal connection:

passwd

You will then be prompted to enter and confirm a new password.

The default layer for remote field installations

The PPP connection of any other remote site to the router, of course, will only succeed if the device answers every
call with the corresponding PPP settings. This is the case using the factory default settings because the default pro-
tocol (default layer) is set to PPP.

You may, however, want to change the default layer for LAN-to-LAN connections, for example, to a different protocol
after the first configuration run. Then the device will no longer take calls on the dial-up connection using the PPP
settings. The solution to this is to agree upon a special calling number for configuration access:
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The administrator access for ISDN remote management

If the device receives a call on this number, it will always use PPP, regardless of any other settings made on the router.
Only a specific user name which is automatically entered by the LANconfig program during call establishment will
be accepted during the PPP negotiations:

(1 Switch to the 'Security' tab in the 'Management' configuration section.

1621AnnexA Configuration ] 2=l
Configure: | M anagement x l

Generall Interfaces  Security | Costs I

i~ Configuration acce:
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Here you can specify the access rights for each network and
each supported configuration protocol separately. In addition
you can limit access ta the unit to certain stations,

Access Rights - | Access list .. |

Mumber [MSM): |123458
r— Configuration pazsword

Password: | “““““ 2|

™ Paszword required for SMMP read permizsion

r— Configuration lock

Lock configuration after: |5 login failures
Lock configuration far; |5 minutes

LANCOM ok, [I Cancel |
Systens

(2 Enter a number (MSN) at your location which is not being used for other purposes in the 'Configuration access'
area.

Alternatively, enter the following command:
set /setup/config-module/Farconfig 123456

(fi\ As long as no MSN is entered for the configuration acces, a non-configured LANCOM accepts the calls on
~ all MSNs. As soon as the first change is saved in the configuration, the device only takes calls on the confi-
gured MSN!
If no MSN configuration is entered the remote access is switched off and the device is protected against
access over ISDN.
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3.5 Working with configuration files

The current configuration of an LANCOM can be saved as a file and reloaded in the device (or in another device of
the same type) if necessary.

Additionally, configuration files can be generated and edited offline for any LANCOM device, firmware option and
software version:

New Configuration File 2x

S Select the device that you want ko create a new
configuration File Far.

Device bype: LAMCOM 1621 ADSL{1SDMN

Firmware wersion: | 3.00 =

Software options:  [_Leased line
WPM {1 connection)
[CJWPM (25 connections)

SkuUFFIE L

|

Backup copies of configuration
With this function you can create backup copies of the configuration of your LANCOM.

Convenient series configuration

However, even when you are faced with the task of configuring several LANCOM of the same type, you will come to
appreciate the function for saving and restoring configurations. In this case you can save a great deal of work by
first importing identical parameters as a basic configuration and then only making individual settings to the separate
devices.



LANCOM Reference Manual LCOS 3.52

» Chapter 3: Configuration and management

Running function

LANconfig

[> New firmware with LANCOM Systems FirmSafe

Device > Configuration Management P> Save to File
Device P> Configuration Management P Restore from File
Edit P> New Configuration File

Edit > Edit Configuration File

Device P> Configuration Management P> Print ...

WEBCconfig

Save Configuration P> Load Configuration (in main menu)

TFTP

3.6 New firmware with LANCOM Systems FirmSafe

tftp 10.0.0.1 get readconfig filel tftp
10.0.0.1 put filel writeconfig
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The software for devices from LANCOM Systems is constantly being further developed. We have fitted the devices
with a flash ROM which makes child's play of updating the operating software so that you can enjoy the benefits of
new features and functions. No need to change the EPROM, no need to open up the case: simply load the new
release and you're away.

3.6.1 This is how LANCOM Systems FirmSafe works

LANCOM Systems FirmSafe makes the installation of the new software safe: The used firmware is not simply over-
written but saved additionally in the device as a second firmware. Therewith your device is protected against the
results of a power blackout or a disconnection while installing the firmware.

Of the two firmware versions saved in the device only one can ever be active. When loading a new firmware version
the active firmware version is not overwritten. You can decide which firmware will be activated after the upload:

> ‘Immediate": The first option is to load the new firmware and activate it inmediately. The following situations

can result:

> The new firmware is loaded successfully and works as desired. Then all is well.

> The device no longer responds after loading the new firmware. If an error occurs during the upload, the

device automatically reactivates the previous firmware version and reboots the device.
> ‘Login": To avoid problems with faulty uploads there is the second option with which the firmware is uploaded

and also immediately booted.

> In contrast to the first option, the device will wait for the adjusted firmsafe timeout ( using WEBconfig in the
menu Expert Configuration > Firmware P> Timeout-firmsafe, using Telnet adjust with 'Firmware/Time-
out-firmsafe') until it is logged on over Telnet, a terminal program or WEBconfig. Only if this login attempt
is successful does the new firmware remain active permanently.

> If the device no longer responds or it is impossible to log in, it automatically loads the previous firmware
version and reboots the device with it.
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> 'Manual": With the third option you can define a time period during which you want to test the new firmware
yourself. The device will start with the new firmware and wait for the preset period until the loaded firmware is
manually activated and therefore becomes permanently effective. Activate the new firmware using LANconfig
with Device P> Firmware Management P> Activate Firmware running in Test Mode, using Telnet under
‘firmware/firmsafe table' with the command 'set # active' (#is the position of the firmware in the firmsafe table).
Using WEBconfig you can find the firmsafe table under Expert Configuration» Firmware.

The modus for the firmware upload can be adjusted using WEBconfig in the menu Expert Configuration » Firm-
ware P> Mode-firmsafe, using Telnet under ‘firmware/timeout firmsafe'. Using LANconfig select the modus when
selecting the new firmware file.

/‘ LIt is only possible to upload a second firmware, if the device has enough memory for two firmware versions.

Current firmware versions (in occasion with additional software options) may use up more than half of the
available memory. In this case the configuration software notifies a conflict and recommends the use of the
“converter”.

This converter can be downloaded free of charge from the LANCOM Systems website. With the converter the
memory in the LANCOM is devided into a larger area for the new firmware version and a smaller area for the
existing version.

While uploading the new firmware a minimal version of the previous firmware is loaded into the smaller memory
area. This version is used as a safety copy with the following restrictions:

> The minimal version of the firmware only partly provides the LCOS functions to restore the previous state or
to load another firmware. Internet access is possible with this version.

> A LANCOM with an active minimal firmware can only be addressed over the LAN, the WLAN or the outband
interface. The remote configuration is not possible, not even over ISDN.

> The minimal firmware can not be configurated. Changes in the configuration over LANconfig, WEBconfig or
Telnet are not saved in the device.

3.6.2 How to load new software

There are various ways of carrying out a firmware upload, all of which produce the same result:

> LANconfig

> WEBconfig

» Terminal program

» TFTP

All settings will remain unchanged by a firmware upload. All the same you should save the configuration first for
safety's sake (with Device »> Configuration Management »> Save to File if using LANconfig, for example).

Before uploading you should also save a version of the current firmware. If you do not have the firmware as a file,
you can download it from www.lancom.de.


http://www.lancom.de
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If the newly installed release contains parameters which are not present in the device's current firmware, the device
will add the missing values using the default settings.

LANconfig

When using LANconfig, highlight the desired device in the selection list and click on Device » Firmware Upload,
or click directly on the Firmware Upload button. Then select the directory in which the new version is located and
mark the corresponding file.

LANconfig then tells you the version number and the date of the firmware in the description and offers to upload
the file. The firmware you already have installed will be replaced by the selected release by clicking Open.

You also have to decide whether the firmware should be permanently activated immediately after loading or set a
testing period during which you will activate the firmware yourself. To activate the firmware during the set test
period, click on Edit » Firmware Management . After upload, start the new firmware in test mode.

WEBconfig

Start WEBconfig in your web browser. On the starting page, follow the Perform a Firmware Upload link. In the
next window you can browse the folder system to find the firmware file and click Start Upload to start the instal-
lation.

Terminal program (e.g. Telix or Hyperterminal in Windows)

If using a terminal program, you should first select the 'set mode-firmsafe' command on the 'Firmware' menu and

select the mode in which you want the new firmware to be loaded (immediately, login or manually). If desired, you

can also set the time period of the firmware test under 'set Timeout-firmsafe'.

Select the 'Firmware-upload' command to prepare the router to receive the upload. Now begin the upload procedure

from your terminal program:

> If you are using Telix, click on the Upload button, specify ‘XModem' for the transfer and select the desired file
for the upload.

> If you are using Hyperterminal, click on Transfer > Send File, select the file, specify 'XModem' as the protocol
and start the transfer with OK.

ﬁ The firmware upload over a terminal program is only possible over a serial configuration interface

\

TFTP

TFTP can be used to install new firmware on LANCOM. This can be done with the command (or target) writeflash.
For example, to install new firmware in a LANCOM with the IP address 10.0.0.1, enter the following command under
Windows 2000 or Windows NT:

tftp -1 10.0.0.1 put Lc_l6xxu.282 writeflash
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3.7 How to reset the device?

If you have to configure the device regardless of possible existing settings, or if a connection to the device configu-
ration failed, you can put back the device into the factory default state with a Reset. To do so, push the Reset but-
ton until the device LEDs will light up (approx. 5 seconds).

Reset switch (according to the model type
on the front or rear panel)

9/@/ LANCOM 8011 VPN )

Config(COM) Reset  Antenna Main || &

After applying the reset, the device will start fresh with factory defaults. All settings will be lost. Therefore,
you should save the current configuration if possible before the reset!

9

Please notice that also the WLAN encryption settings of the device will get lost in case of a reset and the
standard WEP key comes into effect again. The wireless configuration of a device with WLAN interface will
only succeed after a reset, if the standard WEP key is programmed into the WLAN adapter!

@
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4  Network management with the LANtools

The LANtools (consisting of LANconfig and LANmonitor) are ideally suited to configuring and monitoring LANCOM
devices in complex application scenarios. Multiple routers and/or wireless access points in a network can be
administered from a central location, as can devices in remote networks—for example, when a service company
maintains a device located with the customer.

Network management with the LANtools primarily involves the following functions:
Device configuration

Management of configurations, i.e. save and restore the settings

Carries out updates to the latest firmware versions

Activates additional software options

Monitors device status

Connection monitoring (including VPN)

Monitoring of firewall actions
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4.1 Project management with LANconfig

LANconfig facilitates the configuration of various devices within a project with a range of functions that can be run
on several devices at once. If the list in LANconfig contains multiple devices, just click on the device of your choice
with the right mouse key to open a context menu offering the following actions:

=S
File Edit Device Wiew Tools Help
w|alw| mElwlE| =l ol @lalw 2w
W Marne I Drescription | Address | Device Status | Progress | :I
{7 Cliento1 ESLC_PPP 10.1.1.31 Ok
Client0z 20 10.1.10.183 Ok
{7 ©Fficent 10.1.10.184 Ok
-(0 officenz ; 100 1,10,186 Ok,
----- 3 nternal 4154 Li0187 ok
c Check Chrl+FS 1.10.188 ok
Elcedl0l5 Fimware Upload  Chrl+U 1.10.189 Ok
L1621, It 1.80.125 Ok
&pCalvin Open Telnet Session Chrl+T 1.80.149 ok
pHobbes Monitor Device Chrl+M 1.80.150 ok
EpWLansry Set DateTime ... 1.80.245 ok
E9AMay_ISON  Delete Del 1.80,247 ok
Epusksel Cancel dctions 1.82.100 ok
e . 4 e,

» Configure: Opens up the LANconfig configuration dialog for the selected device
> Check: Checks if the selected device can be contacted
> Firmware upload: Uploads firmware simultaneously to all selected devices
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%% LANconfig - Branch_offices 1ol x|
File Edit Device Wiew Tools Help
lalx| ElalE o6 =il sl alale *2
I:_l LaMconfig Marmne I Address I Device Status | Progress |
43 Branch_offices RESDEN 10.1.202.192 Uploading Firmware . 53% (AEI63 Byhes/s)
10,1.202,193 Uploading Firmware | 58% (69240 Bytes/s)
101,202,194 Uploading firmware | 58% (55022 Bytes/s)
L] Internal T
10.1.202.198 Uploading Firmware , 57% (43670 Bytes/s)
10.1.202.199 Uploading Firmware . 53% (68675 Bytes/s)
10.1.202.210 Uploading firmware . 59%. (70285 Bytes/s)
10,1.202.211 Uploading firmware . 53% (52147 Bytes/s)
10.1.202.213 Uploading firmware . 58% (53007 Bytes/s)
10,1.202.217 Uploading firmware , 56% (52525 Bytes/s)
10,1.202.218 Uploading firmware , 32% (21644 Bytes/s)
10.1.202,219 Uploading firmware | 46% (53706 Bytes/s)
10.1.202.220 Uploading firmware | 53% (50486 Bytes/s)
10.1.205,137 Uploading firmware | 42% (66901 Bytes/s)
! 10.1.206.211 Uploading Firmware . [WENNENE 54% (62541 Bytes/s)
| Date | Tirne | Mame | Address | Message |
() 27.01.2004 10:383:00  LEIPZIG 10.1.202.218 Firmware upload started
(i) 27.01.2004 10:38:00  TEMPELHOF 10,1.202,219 Firmware upload started
(i) 27.01.2004 10:38:00  MERSEBURG 10.1.202,220 Firmware upload started
(i) 27.01.2004  10:38:00  WITTENBERG 10,1.205,137 Firmware upload started
@ 27.01.2004  10:35:00  ANGERMUEMDE 10.1.206,211 Firmware upload started
() 27.01.2004  10:38:00  CHEMMITZ 10.1.206,212 Firmware upload started
(i) 27.01.2004 10:38:00  ADLERSHOF 10.1.206.213 Firmware upload started
| y

> Open Telnet session: Opens up multiple DOS windows and sets up a Telnet connection to each device
» Monitor device: Starts LANmonitor for the surveillance of the selected devices
» Set date/time: Sets the same time on all selected devices.

ﬁ When setting the time, please observe the functions of the LANCOM as NTP client and NTP server ('Time
~ server for the local net" —page 292).

> Delete: Deletes the selected devices from the LANconfig list.

4.1.1 Directory structure
LANconfig uses a directory structure for a clear overview when managing multiple devices. Folders dedicated to
projects or customers can be set up to organize the relevant devices:

» Create a new folder by clicking on the parent directory with the right mouse key and selecting "New Folder" from
the context menu.
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> Just use the mouse to drag and drop the devices into the appropriate folder. Devices can also be moved from
one folder to another in this way.

(‘: The arrangement of devices in folders effects only the display of the devices within LANconfig. The
organization of the folders has no influence on the configuration of the devices.

s
=
<=
O]
IS
P?'.;»'jL.l\I“«:onfig il ;|g|5| % E
File Edit Device Wiew Tools Help (':B 5:
S| mllE] skl =iseley] sl = g 3
a_ LaMconfig Marne I Drescription | Address | Device Status | Progress | :I X g
{11 Cliento1 ESLC_PPP 10.1.1,31 Ok E =
=] Clientnz Elc-wrls-e201 10.1.10.183 Ok =
Ehlc-wrls-e316 10.1.10.184 ok "5
Elc-wrls-e201-54m 10,1.10.186 Ok 2
Eplc-ez14-L54ag 10.1.10,187 ok
Eplc-e305-L54ag 10.1.10.188 ok
Eplc-e310-L54ag 10.1.10.189 ok
EaLC1621 Inkernet 10.1.80.125 ok
@ Calvin 10.1.80.14%9 Ok
EHobbes 10,1.80.150 ok
EWLansry 10.1.80.245 Ok
o AMay_ 150N 10.1.80.247 ok
Euskssl 10.1.82.100 Ok
w 10.1.140.159 Reading config .. 41472 bytes
G 1621 Annex
File Edit Device WYiew Tools Help

14

| Date | Time | Marme - - |
@ 1/29/2004¢  1L:0%4..  16214nnexB o]} =5 g_l_ﬂ“s _Icﬁ _I@ B
@ 1fz0/z004 1:04:4... 1621AnnexB Marne
@ 1/20/2004 1:04:5... 1621AnnexB Ealc-wrls-s201 ‘
(@ 1fz9fz004  1:0S:5..  1621AnnexE wrls-e316
@ 1fz9fz004  L0&1..  1621AnnexE Jete Del wrls-2201-54m
@ 1/29(2004 1:06:1...  16214nnexB e214-L54ag

Rename Fz

'2308-L54a0
Eplc-e310-L54ag
EraLC1621. Internet

C‘Tr_l. e

|

. The directory structure in the left margin of the LANconfig window can be switched on and off with the F6
=~ function key or by using the menu View P> Folder Tree.

4.1.2 Multithreading

The management of larger projects can be aided by simultaneously opening up configuration windows for multiple
devices to compare similarities and differences. LANconfig allows multiple configuration dialogs to be opened at the
same time ("multithreading"). After opening the configuration for a device, simply open up further configurations
from the device list in LANconfig. All of the configurations can be processed in parallel.
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il
Fle Edt Device View Tooks Help
Slalm| sl HlE Rl SlEle] 2
LANconfig Description | Address [ Device Status [ Progress | -]
{2 Clientay o 1621AnNExA 101,140,160 Open Config Dialog
= £+ Clientoz 10.1,140,159 Open Config Dislog 40960 bytes
= (03 officent =% AMay_ISDN 10.1,80.247 ok
§ (O officenz S Calin 10.1.80,149 ok
+— 0 meernal &pHobbes 10.1.80,150 ok
% v SaLCI621, Intermet 10.1.80.125 ok
- =aLC_PPP 10.1.1.31 Ok
E (=) SaLC_RAS 101,112 ok
C E SBLC_YPH_M_LCSTEST 10.1.1.10 Ok,
© 2 1621AnnexB Configuration i 21x| HONE :221‘ 1;':224‘200 gt
S << 180,
T — Configure:  [Management - 10:1 2100 oK
E @ Edag 10,110,187 Ok
<= General | Intafaces | Secury | Costs | Edag 10,110 1 ok
Edag 10.1.10,189 o
< = K
D ull i in e a3 j
S Devics name: [ > —
iqurati 7| %
= 3 S
L Admiristrator 107 Configue:  [Management [ B
= o banagement
Q 1. Genersl | jnfDale & Time |
10, Log & Trace j
10: A 1621Anneeh %
~ Information & |
i S E210 £
Device type: LANCOM 1621 ADSLASDN
Hardwars release; & (GRsichel
Fiimware version: 330,0031 / 25.01.2004
Serial number: 859530980220
Device type: LANCOM 1621 ADSLASDN
Hardware relsase: A
Firmuars version: 330,0031 / 26,01 2004
Taneon Serial number; 089540209081
ML Cancel

ER—C Coree

@‘: "Cut and paste" can be used to transfer content between the configuration windows via the Windows
= clipboard.

Multithreading allows changes to both the internal configurations of the available devices and to the configuration
files. Each configuration is written separately to the file and to the device when the dialog is closed.

4.2 Display functions in LANmonitor

LANmonitor supports the administration of the LANCOM applications by offering a range of functions that simplify
the surveillance of devices at widely dispersed locations. The overview of devices monitored by LANmonitor already
shows the most important information about the status of the devices:
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51 LANmonitor ~1ol =]
Fle Device Yiew Tools Help
& L1621 Internet =]

= DSL Line 1: Not ready

@ Error (ISDN): Connection establishment failed (D-channel layer 2) [0x0082]
3 ISDH Line 1: Ready

3 ISDH Line 2: Ready

opped.
05 protection - UDP packet from 127.0,0,1:68 to 255.255,255,255:67 - Packet dropped
@) 4.12.2003 9:59:28: intruder detection - Packet of protocal 0 from 10,1,140, 1540 to 10,1,580,125:0 - Packet rejected
@) 3.12.2003 14:25:44: intruder detection - Packet of protocol 0 from 10.1,80,180:0 to 10,1,50,125:0 - Packet rejected
() PN connections
= ¥ System information
E-&jp Device: LANCOM 1621 ADSL{ISDN
€ Firmware version: 3.20,0029
@ serial number: 858050000017
€ MAC address: 00a0570b13FF
€ Location: E.212
€ Administrator: GReichel
@ Date and time: 1/29/2004 12:24:26 PM
€ System up time: 62 days and 0 hours
B WaN interfaces: ADSL, ISDN, DSLol
£~ ADSL modem: Handshaking
¥ Line type: ADSL over ISDN (Annex B)
¥ Line code: U74.4.3
% Line mode: Multimode
W Upstream rate: 0 kBit/s
W Downstream rate: 0 keit/s
W signakto-Noise ratio: 0.0 dB
£ 15DN: DSS1 (Euro-ISDN)
W 50 bus active: Yes
W TEI assigned: Yes
W Layer 2 active: No
(=7 DL over LAN
W Link state: Up
58 Total charge: 0 units
& Router (ISDN): 0 units
£ LANCAPT: 0 units
& Time sync.: O uits
- Total online time
Router (ADSL): 0 minutes
Router (ISDR) {out

Dwibar (IS0 fine

ES
=
+—
S »
SIS
S S
G)N
22
s 3
g o
xS
S
=
D
=

The information that can be taken from the overview includes, among others, details about active WAN connections,
the five most recent firewall messages, the current VPN connections and system information about charges and
online times.

Right-clicking with the mouse on a device in LANmonitor opens up a context menu with further information:
> VPN connections

The list of VPN connections is a log of the 100 most recent VPN connections. The detailed recorded information
includes
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& LC_¥PN_M_LCSTES PN Connec| =1ol x|
Connections  tiew
Mlamme [ state [ Last Errar [ short Hold [ conmection [ Gateway [ Encryption Algorithm | Hmac Algorithm [ Hash Algarithrn |
<@WPM_CBLERSCH  Connected 0 seconds INTERNET 80.142.179.234 BLOWFLSH (125 bit) tnone) {0 bty HMAC_SH# (150 bit)
KGYPM_CSCHALLE  Connectsd 0 saconds INTERNET 80.145.104.30 AES (126 bit) trone) (@ bit) HMAC_MDS (125 bit)
SQVPM_C_BUHMAN  Motcomnected  1SDWerDSLem.. 0 seconds WPN_C_EBUHMAN  10.98.100.87 3DES (192 bit) {none! {0 bit) HMAC_MDS (128 bit)
<EWPM_DEICH Connected 0 saconds INTERNET 80.142.147.155 BLOWFISH (125 bit) trone) (@ bit) HMAC_SHA (150 bit)
SQPN_DKRAL Mot connected  Dynamic PN - ... O scconds INTERNET 0.0.0.0 tnane) {0 bit) {none! {0 bit) tnane) {0 bit)
<y WPM_ETRABER Connected 0 saconds INTERNET 212.202.73.28 BLOWFISH (125 bit) SHA (160 biE) HMAC_SHA (150 bit)
<@WPM_FIANSSEN  Connected 0 seconds INTERNET 213.29.254.17 BLOWFISH (125 bit) SHA (160 bit) HMAC_SH# (150 bit)
%) <GVPM_FTHEINEN  Connectsd 0 saconds INTERNET 80.145.80.9 BLOWFISH (125 bit) tnone) (@ bit) HMAC_SHA (150 bit)
S S WPN_HEATTL Connected 0 seconds INTERNET 80.145.95.224 BLOWFISH (125 bit) {none! {0 bit) HMAC_SH# (150 bit)
Q <Gy WPN_MBAGSTK Connected 0 saconds INTERNET 82.52.224.144 AES (126 bit) trone) (@ bit) HMAC_MDS (125 bit)
S < WPN_MERIX Connected 0 seconds INTERNET 213.54.108.209 AES (126 bit) {none! {0 bit) HMAC_MDS (128 bit)
= <EyWPM_MPLUM Connected 0 saconds INTERNET 80.145.86.178 BLOWFISH (125 bit) trone) (@ bit) HMAC_SHA (150 bit)
< CHWPM_OSCHILPE  Connected 0 seconds INTERNET 82.72.51.240 AES (126 bit) {none! {0 bit) HMAC_MDS (128 bit)
—~ <EyWPN_PCPRO Connected 0 saconds INTERNET 62.226.217.118 AES (126 bit) trone) (@ bit) HMAC_MDS (125 bit)
[<b < PN_Qs_TEST Connected 0 seconds INTERNET 50.145.67.133 AES (126 bit) {none! {0 bit) HMAC_MDS (128 bit)
E A i - I - . ———— i i i i o v——— a0y . Ve Cmem i dasmtan
> Name of the remote device

> Current status

> Last error message

> 1P address of the gateway

> Encryption information
> Accounting information

The accounting information is a protocol of the connections from each station in the LAN to remote sites in the
WAN. The detailed information recorded includes

BT —— i
Accounting  Wisw

User | Remote site [ Type | connections | Received | Transmitted | Total Orling Time | =
€53 00:00:00:00:00,00 VPN_QS_TEST YR connection ] 0K OKB 1732 days and 21 hours

= 10.1.11 VPH_WTIW VPN connection 0 833 KE 740KE 18 days and 8 hours
0111 VPH_CSCHALLE  YPN connection 0 12,699KB  10,S52KB 18 days and 6 hours

= chuersch-gs VPN_CBUERSCH PN connection 0 1,007,186 KB 0KB 17 days and 22 haurs

B chuersch-as VPN_CBUERSCH  YPN connection ] 4K 1,128 M 17 days and 22 hours

= ke_vpn_m_ethout VPH_WOHH WPH connection 0 3,904KB 113,59 KB 17 days and 21 haurs

B ic_vpn_m_ethout VPH_WTIW VP connection ] 53BKE  56,035KB 17 days and 14 hours

= dey-prodtest VPN_HEATTI VPN connection 0 OKE 434,498k 16 days and 18 haurs
10,180,173 VPH_HEATTI WP connection 0 467,340KB 0K 16 days and 18 hours

= 10,180,172 VPH_FTHEINEN  YPH connection 0 OKE  11,695KE 15 days and 5 hours

= 10,1.80,172 VPH_FTHETNEN  YPN connection ] 3,938 KB 0KE 15 days and 5 hours

= kes-voip VPN_ETRABER PN connection 0 IR761KE  12,425KE 14 days and 8 hours
e _vpr_m_ethout VPH_TNIO! VPH connection ] 189 KB 366 KB 13 days and 14 hours

= les-data WPH_MPLUM WPH connection 0 3,758KE 40,226 KB 11 days and 22 haurs

B kes-veip VPH_MPLUM VP connection 0 40,205KB  34,121KB 11 days and 10 hours

= 10,180,172 VPH_TNIO! VPN connection 0 112KB 0KB 11 days and 10 haurs

B ic_vpr_m_ethout VPN_MBAGSIK YR connection ] 5659KB 240,474 KB 11 days and 3 hours
R PH_HBATTL INTERNKET Dial-up (DSL) 0 6B,S08KE  67,882KB 10 days and 20 haurs

B ies-mail VPH_TNIO! VP connection 0 B2,152KB 266,546 KB 10 days and 18 hours

= wlanprint VPN_ETRABER P connection 0 443,863KB 1,658 MB 10 days and 17 haurs

= duakpa VPH_MPLUM VPH connection 0 369,063KB  536,872KB 9 days and 11 hours x|

> Name or IP address of the station

> Remote station used to establish the connection
> Type of connection, e.g. DSL or VPN

> Number of connections

> Data volume sent and received

> Online time

> Activity log

38



LANCOM Reference Manual LCOS 3.52

p Chapter 4: Network management with the LANtools

[> Display functions in LANmonitor

The activity log is a detailed list of the connections via WAN, WLAN, VPN, LANCAPI and a/b port, and a list of
firewall activities. The detailed information recorded includes

E1LC_VPN_M_LCSTEST - Activity Log oy [ o3}

File Wew Tools

Date and time: [ source [ Message [«] §
[ Mo connection ko YPN_C_BUHMAR - Last Error: ISDN o DSL error on inkerfat...
PN Connected ko YPN_DEICH (via INTERNET) +—
PN Mo connection ka YPN_DKRAL - Last Error: Dynamic ¥PN - no ISDN call numbs, .. (=
PN Connected ko YPN_ETRABER (via INTERNET) QO U»n
PN Connected ko YPN_FIANSSEN (via INTERKET) E =
PN Connected ko YPN_FTHEINEN (via INTERNET) )
PN Connected ko VPN_HBATTI (via INTERKET) <5) E
WA DSL Line - INTERNET , Connect (=)
PN Connected to YPN_MBAGSIK (via INTERNET) © 2
WPN Connected to WPN_MBRIX (via INTERMET) < Q:
PN Connected ko YPN_MPLUM (via INTERKET) © —J
PN Connected ko YPN_OSCHILPE (via INTERNET) E
PN Connected ko YPN_PCPRO (via INTERKET) b}
PN Connected ko YPN_QS_TEST {via INTERNET) < E
PN Connected ko YPN_WOHN (via INTERNET) =
PN Connected ko YPN_WTIW {via INTERNET) =

> Date and time

> Source
> Message

> Firewall actions log
The firewall actions log lists the last 100 actions taken by the firewall. The detailed information recorded includes

&5 LC_¥PN_M_LCSTEST - Firewall Event Log =101x|
Eventlog View

Tebe, | System time Source address | Dest, address Frot Source ... | Dest, p... | Fikerrule | Limit [ Action -
1z 1ziz4l 100111 224.0.0.9 17 (... intruder de...  Immediately  Packet dropped; SYSLOG sent

2 Z/4E00412:11:40 1001111 255,255,255,255 17 {UL... intruder de... Immedistely  Packet dropped; SYSLOG sent

3 Z42004 120645 1001111 224.0.0.9 17{0... intruder de...  Immediately  Packet dropped; SYSLOG sent

4 2/4200412:05:44 101111 255,255,255,255 17 {UL... intruder de... Immedistely  Packet dropped; SYSLOG sent

S5 zzod1z0z3z 100111 224.0.0.9 17{0... S20(r0.. inbruderde... Immediately  Packet dropped; SYSLOG sent

6 Z/4E00412:01:31 100111 255,255,255,255 17 {UL... 68(bo.. intruderde... Immedistely  Packst dropped; SVSLOG sent  —
7 42004120004 100111 224.0.0.9 17{0... S20(r0.. inbruderde... Immediately  Packet dropped; SYSLOG sent

S8 242004115903 100111 101,255,255 17 (... intruder de... Immedistely  Packet dropped; SYSLOG sent

9 42004105508 100111 224.0.0.9 17{0... intruder de...  Immediately  Packet dropped; SYSLOG sent

10 Z/4200411:54:07 101111 255,255,255,255 17 {UL... 68(bo... intruderde... Immedistely  Packet dropped; SYSLOG sent

11 Z/4/2004 1148:05 101111 224.0.0.9 17{0... S20(r0.. inbruderde... Immediately  Packet dropped; SYSLOG sent

1z Z/42004 114704 101111 255,255,255,255 17 {UL... 68(bo... intruderde... Immedistely  Packet dropped; SYSLOG sent

13 242004114500 1001111 224.0.0.9 17{0... S20(r0.. inbruderde... Immediately  Packet dropped; SYSLOG sent

14 2/4200411:43:59 101111 101,255,255 17 (... intruder de... Immedistely  Packet dropped; SYSLOG sent

15 ZM2004 104213 100111 224.0.0.9 17(0... intruder de...  Immediately  Packet dropped: SYSLOG sent

Time

Source and destination address

Protocol with source and destination port
Activated filter rule and exceeded limit
Action carried out

v vV VvV VvV V
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5 Diagnosis

5.1 LANmonitor—know what's going on

The LANmonitor includes a monitoring tool with which you can view the most important information on the status
of your routers on your monitor at any time under Windows operating systems—of all of the LANCOM routers in the
network.

Many of the internal messages generated by the devices are converted to plain text, thereby helping you to trouble-
shoot.

(.‘: Explanations about the LANmonitor messages and helpful tips can be found in the appendix under 'Error
messages in LANmonitor’ —page 299.

You can also use LANmonitor to monitor the traffic on the router's various interfaces to collect important information
on the settings you can use to optimize data traffic.
In addition to the device statistics that can also be read out during a Telnet or terminal session or using WEBconfig,

a variety of other useful functions are also available in LANmonitor, such as the enabling of an additional charge
[imit.

. With LANmonitor you can only monitor those devices that you can access via IP (local or remote). With this
=~ program you cannot access a router via the serial interface.

5.1.1 Extended display options

Under View » Show Details you can activate and deactivate the following display options:
» Error messages

> Diagnostic messages

> System information

@ Many important details on the status of the LANCOM are not displayed until the display of the system infor-
“ mation is activated. These include, for example, the ports and the charge management. Therefore, we rec-
ommend that interested users activate the display of the system information.

5.1.2 Monitor Internet connection

To demonstrate the functions of LANmonitor we will first show you the types of information LANmonitor provides
about connections being established to your Internet provider.
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(1 To start LANmonitor, go to Start » Programme » LANCOM » LANmonitor. Use File » Add Device to set
up a new device and in the following window, enter the IP address of the router that you would like to monitor.
If the configuration of the device is protected by password, enter the password too.

Alternatively, you can select the device via the LANconfig and monitor it using Device » Monitor Device.

(2 LANmonitor automatically creates a new entry in the device list and initially displays the status of the transfer
channels. Start your Web browser and enter any web page you like. LANmonitor now shows a connection being
established on one channel and the name of the remote site being called. As soon as the connection is estab-
lished, a plus sign against the communication channel entry indicates that further information on this channel
is available. Click on the plus sign or double-click the appropriate entry to open a tree structure in which you can
view various information

@
(%5
(=)
S

R

S

8! LAMmonitor 10l =|

Device  Yiew | Tools Help
eam LC_YPN_M_ YPN Connections
Q} LC_YPM_M_  Accounting Information

- DL Line S ]

ISDN LI Wiew Saved Accounting Information ...

: ISDN LimezrFeaT

E@ Firewall: 2/6/2003 23:45:49 intruder detection - Packet dropped

L 9 intruder detection - Packet of protocol 50 from 10,98,100,11:0 ko 10,1,1,10:0 - Packet dropped
é WPMN connections

o System information

oo LC1621 Internet

feam 1621AnnexE

o LC_RAS

In this example, you can determine from the PPP protocol information the IP address assigned to your router by
the provider for the duration of the connection and the addresses transmitted for the DNS and NBNS server.

Under the general information you can watch the transmission rates at which data is currently being exchanged
with the Internet.

(3 To break the connection manually, click on the active channel with the right mouse button. You may be required
to enter a configuration password.

@ If you would like a log of the LANmonitor output in file form, select Device » Device Activities Logging and
go to the 'Logging' tab. Open the dialog for the settings for the activity protocol, click on Tools » Options.
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options 2|
Fecord | Logging |

— Filter

IV Log'WiN connections
A
icd

Log 'WLAN connections

¥ Log¥PN connections
¥ Log LANCAF! connections
IV Log a/b-poits connections
IV Log actions of Firewall

— Buffer:

™ Load Activity Log file at the start of record

.2
w
=]
S,

S

Q

Buffer size: 100 Lines

™ Stop record, if buffersize is reached

oK Cancel |
Lt

On the 'Protocol’ tab you can define whether the following activities should be protocolled:

WAN connections

WLAN connections

VPN connections

LANCAPI connections

a/b port connections

Firewall actions

You can also specify whether LANmonitor should create a log file daily, monthly, or on an ongoing basis.

>
>
>
>
>
>

5.2 Trace information—for advanced users

Trace outputs may be used to monitor the internal processes in the router during or after configuration. One such
trace can be used to display the individual steps involved in negotiating the PPP. Experienced users may interpret
these outputs to trace any errors occurring in the establishment of a connection. A particular advantage of this is:
The errors being tracked may stem from the configuration of your own router or that of the remote site.

(‘ The trace outputs are slightly delayed after the actual event, but are always in the correct sequence. This will
~ not usually hamper interpretation of the displays but should be taken into consideration if making precise
analyses.
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5.2.1 How to start a trace

Trace output can be started in a Telnet session. Set up a Telnet connection to your device. The command to call up
a trace follows this syntax:

trace [code] [parameters]

The trace command, the code, the parameters and the combination commands are all separated from each other by

spaces.
5.2.2 Overview of the keys 2
s}
=
Thiscode.._|..incombination with the trace causes the following: g
S
Q
? displays a help text
+ switches on a trace output

switches off a trace output

# switches between different trace outputs (toggle)

no code displays the current status of the trace

5.2.3 Overview of the parameters

The available traces depend individually on the particular model and can be listed by entering trace with
no arguments on the command line.

Status status messages for the connection
Error error messages for the connection
LANCOM LANCOM protocol negotiation
IPX-router IPX routing

PPP PPP protocol negotiation

SAP IPX Service Advertising Protocol
IPX-watchdog IPX watchdog spoofing
SPX-watchdog SPX watchdog spoofing

LCR Least-Cost Router

Script script processing

RIP IPX Routing Information Protocol
IP-router IP routing
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IP-RIP IP Routing Information Protocol
ARP Address Resolution Protocol
ICMP Internet Control Message Protocol

IP masquerading

processes in the masquerading module

DHCP

Dynamic Host Configuration Protocol

NetBIOS NetBIOS management
DNS Domain Name Service Protocol
Packet dump display of the first 64 bytes of a package in hexadecimal form

D-channel-dump

trace on the D channel of the connected ISDN bus

ATM

spoofing at the ATM packet level

ADSL ADSL connections status

VPN-Status IPSec and IKE negotiation

VPN-Packet IPSec and IKE packets

SMTP-Client E-mail processing of the integrated mail client
SNTP Simple Network Time Protocol information

5.2.4 Combination commands

Al all trace outputs

Display status and error outputs

Protocol LANCOM and PPP outputs

TCP-1P IP-Rt., IP-RIP, ICMP and ARP outputs

IPX-SPX IPX-Rt., RIP, SAP, IPX-Wd., SPX-Wd., and NetBIOS outputs

Time displays the system time in front of the actual trace output
Source includes a display of the protocol that has initiated the output in

front of the trace

Any appended parameters are processed from left to right. This means that it is possible to call a parameter and then

restrict it.
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5.2.5 Trace filters

Some traces, such as the IP router trace or the VPN trace, produce a large number of outputs. The amount of output
can become unmanageable. The trace filters allow you to sift out the information that is important to you.

A trace filter is activated by adding the parameter “@" that induces the following filter description. In filter descrip-
tion uses of the following perators:

(space) OR:
The filter applies if one of the operator occurs in the trace output

+ AND:
The filter applies if the operator occurs in the trace output

&
(%2)
S
=
S

.

Q

Not:
The filter applies if the operator does not occur in the trace output

the output must match the search string exactly

An operator can be entered as any string of characters, such as the name of a remote station, protocols or ports. The
trace filter then processes the output according to the operator rules, much like an Internet search engine. Examples
of the application of filters can be seen under "Examples of traces’ —page 46.
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5.2.6 Examples of traces

trace displays all protocols that can generate outputs during the configuration, and the status of each
output (ON or OFF)

trace + all switches on all trace outputs

trace - all switches off all trace outputs

trace + protocol display

switches on the output for all connection protocols together with the status and error messages

trace + all - icmp

switches on all trace outputs with the exception of the ICMP protocol

trace ppp

displays the status of the PPP

trace # ipx-rt display

toggles between the trace outputs for the IPX router and the display outputs

trace + ip-router @ GEGENSTELLE-A
GEGENSTELLE-B

switches on all trace outputs for IP routers related to remote site A or B

trace + ip-router @+GEGENSTELLE-A -

ICMP

switches on all trace outputs for IP routers related to remote site A or B that do not use ICMP

trace + ip-router @ GEGENSTELLE-A
GEGENSTELLE-B +ICMP

switches on all trace outputs for IP routers related to remote site A or B that use ICMP

trace + ip-router @+TCP +"port: 80"

5.2.7 Recording traces

switches on all trace outputs from the IP router wiht TCP/IP and port 80. “port: 80" is in quotes
so that the space is recognised as a part of the string.

Traces can be conveniently recorded under Windows (e.g. as an aid to Support), and we recommend you do this as

follows:

Start the program HyperTerminal under Start » Programs » Accessories » Communications » Hyper Termi-
nal. Enter a name of your choice when prompted to do so.

Connect To

S LANCOM Systems

Enter details for the host that you want to call

Host address: | 192.169.2.100)

Fort nurnber: | 23

Connect using: | TCPAP Mwinsack)

9

L Ok ” Cancel ]
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In the window 'Connect to' use the pulldown menu 'Connect using' and select the entry ‘TCP/IP'. As 'Host address'
enter the local/official IPaddress or the FQDN of the device. After confirmation, HyperTerminal dipslays a request to
log in. Enter the configuration password .

You record the traces by clicking on Transmit » Capture text. Enter the path of the directory where the text file is
to be saved. Now change back to the dialog window and enter the required trace command.

To stop the trace, click on the HyperTerminal menus Transmit » Stop text capture.

o)
(%5
(=)
S,
<
Q

47



=
=
=
3
v

p Chapter 6: Security LANCOM Reference Manual LCOS 3.52

[> Protection for the configuration

48

6 Security

You certainly would not like any outsider to have easy access to or to be able to modify the data on your computer.
Therefore this chapter covers an important topic: safety. The description of the security settings is divided into the
following sections:
> Protection for the configuration

1> Password protection

> Login barring

> Access verification
> Securing ISDN access

At the end of the chapter you will find the most important security settings as a checklist. It ensures that your
LANCOM is excellently protected.

(‘i Some further LCOS features to enhance the data security are described in separate chapters:

> 'Firewall" —page 95
> 'IP masquerading” —page 67
> ‘Virtual LANs (VLANs)" —page 211

6.1 Protection for the configuration

A number of important parameters for the exchange of data are established in the configuration of the device. These
include the security of your network, monitoring of costs and the authorizations for the individual network users.

Needless to say, the parameters that you have set should not be modified by unauthorized persons. The LANCOM
thus offers a variety of options to protect the configuration.

6.1.1 Password protection

The simplest option for the protection of the configuration is the establishment of a password.

%‘ As long as a password hasn't been set, anyone can change the configuration of the device. For example,
~ your Internet account information could be stolen, or the device could be reconfigured in a way that the pro-
tection-mechanisms could by bypassed.

@ Note: If a password has not been set, the Power LED flashes, until the devices have been configured correctly.
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Tips for proper use of passwords

We would like to give you a few tips here for using passwords:

>

Keep a password as secret as possible.

Never write down a password. For example, the following are popular but completely unsuitable: Notebooks,
wallets and text files in computers. It sounds trivial, but it can't be repeated often enough: don't tell anyone your
password. The most secure systems surrender to talkativeness.

Only transmit passwords in a secure manner.

A selected password must be reported to the other side. To do this, select the most secure method possible.
Avoid: Non-secure e-mail, letter, or fax. Informing people one-on-one is preferable. The maximum security is
achieved when you personally enter the password at both ends.

Select a secure password.
Use random strings of letters and numbers. Passwords from common language usage are not secure. Special
characters such as '&"?#-*+_:;,1°" make it difficult for potential attackers to guess your password and increase
the security of the password.

@ Capital and small letters are distinguished in the configuration password.

>

Never use a password twice.

If you use the same password for several purposes, you reduce its security effect. If the other end is not secure,
you also endanger all other connections for which you use this password at once.

Change the password regularly.

Passwords should be changed as frequently as possible. This requires effort, however considerably increases the
security of the password.

Change the password immediately if you suspect someone else knows it.

If an employee with access to a password leaves the company, it is high time to change this password. A pass-
word should also always be changed when there is the slightest suspicion of a leak.

If you comply with these simple rules, you will achieve the highest possible degree of security.

Entering the password

You will find the box to enter the password in LANconfig in the configuration area ‘Management' on the ‘Security'
tab. Under WEBconfig you run the wizard Security Settings. In a terminal or Telnet session you set or change the
password with the command passwd.

LANconfig Management P> Security P> Configuration password
WEBconfig Security settings
Terminal/Telnet passwd
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Protecting the SNMP access

At the same time you should also protect the SNMP read access with a password. For SNMP the general configura-
tion password is used.

LANconfig Management P> Security P> Password required for SNMP read
permission
WEBconfig Expert Configuration > Setup P> SNMP-module P> Password-

required-for-SNMP-read-access

Terminal/Telnet setup/SNMP module/password-required

6.1.2 Login barring

The configuration in the LANCOM is protected against “brute force attacks” by barring logins. A brute-force attack
is the attempt by an unauthorized person to crack a password to gain access to a network, a computer or another
device. To achieve this, a computer can, for example, go through all the possible combinations of letters and numbers
until the right password is found.

As a measure of protection against such attacks, the maximum allowed number of unsuccessful attempts to login
can be set. If this limit is reached, access will be barred for a certain length of time.

If barring is activated on one port all other ports are automatically barred too.

The following entries are available in the configuration tools to configure login barring:
> Lock configuration after (Login-errors)

> Lock configuration for (Lock-minutes)

LANconfig Management P> Security
WEBconfig Expert Configuration > Setup P> Config-module
Terminal/Telnet Setup/Config module

6.1.3 Restriction of the access rights on the configuration

Access to the internal functions of the devices can be restricted separately for each access method as follows:
» ISDN administrative account

> LAN

> Wireless LAN (WLAN)

» WAN z. B. ISDN, DSL oder ADSL)
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For network-based configuration access further restrictions can be made, e.g. that solely specified IP addresses or
dedicated LANCAPI clients are allowed to do so. Additionally, all following internal functions are separately selec-
table.

> LANconfig (TFTP)

» WEBconfig (HTTP, HTTPS)
» SNMP

» Terminal/Telnet

(‘ The use of the internal functions with a WAN interface of devices with VPN can be restricted merely for the
VPN connection.

=
=
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Restrictions on the ISDN administrative account

As long as no MSN-configuration is entered a non-configured LANCOM accepts the calls on all MSNs. As soon as
the first change in the configuration ist saved the device only accepts calls on the configuration MSN.

ﬁ If no configuration MSN ist entered when configuring the first time, the remote configuration ist switched
off and the device ist protected from the acces over the ISDN line.

(1) Change to the register card 'Security in the ‘Management' configuration area:
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LC1621.Internet Configuration 2=l

Configure: I M anagement = l

Generall Interfaces  Security | Costs I

r— Configuration acce:

Here you can specify the access rights for each network. and
each supported configuration protocol separately.

Access Rights - |

Mumber [SH]: |12345

— Configuration password

Password: I ***** 4
=
S V' Pagsword required for SNMP read permiszsion
éj_) Configuration lack

r— Configuration locl

%)

Lock configuration after: |5 login failures

Lock configuration far: |5 minutes

:;I:Nﬁ oK I Cancel

(2 Enter as call number within ‘configuration access' a call number of your connection, which is not used for other
purposes.

Enter alternatively the following instruction:
set /setup/config-module/farconfig- (EAZ-MSN) 123456

The ISDN administrative account is excluded as only configuration method from in the following described
restrictions of network access methods. I.e. all on the Admin MSN incoming connections are not limited by
the access restrictions of remote networks

@ If you want to completely switch off the ISDN remote management, leave the field with Admin MSN empty.

4

Limit the network configuration access

The access to the internal functions can be controlled separately for accesses from the local or from remote networks
- for all configuration services separately. The configuration access can generally be permitted or forbidden, a pure
read access or - if your model is equipped with VPN - also can be permitted only over VPN.
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1621AnnexA Configuration 1 2=l
Configure: | M anagement x l

Generall Interfaces  Security | Costs I

i~ Configuration acce:

Here you can specify the access rights for each network and
each supported configuration protocol separately. In addition
you can limit access ta the unit to certain stations,

Access Rights - | Access list .. |

Murnber (MSHM]: |1 FEYE] Access Rights - From remote networks 2=l
— Configuration passward Telnet: Ionly via VPN j Ok I

S, I_ xxxxx 7 TFTR: Ionly wia PN vl el | -_E\

=
™ Password required for SNMP n SR Ionly via ¥PN j a
T 7 HTTF: I Iy wia WP 'l (5]
— Configuration lock only via A
" . HTTRS:
Lock configuration after: |5

Lock configuration far; |5 minutes ‘

LANCOM ok, [I Cancel |
Systens

@ If you want to remove the network access to the router over the WAN completely, set the configuration
access from distant nets for all methods to 'denied".

You can reach the configuration of the access-list of WEBconfig or Telnet with the following runs:

WEBconfig Expert Configuration P Setup P>Config-module P> Access-list

Terminal/Telnet /Setup/Config-Modul/access-list

Restriction of the network configuration access to certain IP addresses

With a special filter list the access to the internal functions of the devices can be limited to certain IP addresses.
The configuration dialog with the access rights from local or distant networks can be opened with the Button Access

Rights.
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1621AnnexA Configuration 2=l
Configure: | M anagement x l

Generall Interfaces  Security | Costs I

i~ Configuration acce:

Here you can specify the access rights for each network and
each supported configuration protocol separately. In addition
you can limit access ta the unit to certain stations,

Access Rights - | Access list .. |
oty (T 1
- Configuration password — [ 1p address | Metmask | o
192,1658.2.100 255.255,255.255
Password:

Cancel

™ Paszword required for

r— Configuration lock

SIE] UV_

Lock configuration after:

Lock configuration far; Add ... Edit: 0 | Femoye |

LANCOM ok, [I Cancel |
Systens

By default, this table does not contain entries. Thus the device can be accessed over TCP/IP from computers with
arbitrary IP addresses. With the first entry of a IP address (as well as the associated net mask) the filter is activated,
and solely the IP addresses contained in this entry are entitled to use the internal functions then. With further entries,
the number of the entitled ones can be extended. The filter entries can designate both individual computers and
whole networks.

With WEBconfig for Telnet you reach the configuration of the access list with the following runs:

WEBconfig Expert Configuration P> Setup P>/ TCP-1P-module
Access-list
Terminal/Telnet ‘ /setup/TCP-IP-module/access-1list

6.2 Protecting the ISDN connection

For a device with an ISDN connection basically any ISDN subscriber can dial into your LANCOM. To prevent undesired
intruders, you must therefore pay particular attention to the protection of the ISDN connection.

The protection functions of the ISDN connection can be divided into two groups:
» Identification control
1> Access protection using name and password
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> Access protection via caller ID
» Callback to defined call numbers

6.2.1 ldentification control

For identification monitoring either the name of the remote site or the so-called caller ID can be used. The caller ID
is the telephone number of the caller that is normally transmitted to the remote site with the call with ISDN.

Which “Identifier” is to be used to identify the caller is set in the following list:

LANconfig Communication P> Call accepting *E‘
WEBconfig Expert Configuration » Setup » WAN-module P> Protect §
Terminal/Telnet setup/WAN-module/protect ©

You have a choice of the following:

» all: Calls are accepted from any remote station.

> by number: Only calls from those remote stations whose Calling Line Identification number (CLIP) is entered in
the number list are accepted.

» by approved number: Only calls from those remote stations whose Calling Line Identification number (CLIP) is
entered in the name list and whose number is approved by the Central Office.

It is an obvious requirement for identification that the corresponding information is sent by the caller.

Verification of name and password

In the case of PPP, a user name (and in conjunction with PAP, CHAP or MS-CHAP, a password) is sent to the remote
station during connection establishment. When a computer dials into the LANCOM, the communications software,
for example Windows Dial-Up Network, prompts the user for the user name and password to be transferred.

If the router establishes the connection itself, for instance, to an ISP, it is using the user name and password from
the PPP list. If no user name is listed there, the device name is used in its place.

The PPP list can be found as follows:

LANconfig Communication P> Protocols > PPP list
WEBconfig Expert Configuration > Setup B WAN-module B> PPP-list
Terminal/Telnet /setup/WAN-module/PPP-1list

In addition, the PPP protocol also permits the caller to require an authentication from the remote station. The caller
then requests a user or device name and password from the remote station.
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% Of course you will not need to use the PAP, CHAP or MS CHAP security procedures if you are using the
LANCOM to dial up an Internet service provider yourself, for exampleYou will probably not be able to per-
suade the ISP to respond to a request for a password...

Checking the number

When a call is placed over an ISDN line, the caller's number is normally sent over the D channel before a connection
is even made (CLI — Calling Line Identifier).

Access to your own network is granted if the call number appears in the number list, or the caller is called back if
the callback option is activated. If the LANCOM is set to provide security using the telephone number, any calls from
remote stations with unknown numbers are denied access.

You can use call numbers as a security measure with any B-channel protocol (layers).

6.2.2 Callback

The callback function offers a special form of access privilege: This requires the 'Callback’ option to be activated in
the name list for the desired caller and the call number to be specified, if required.

LANconfig Communications P> Remote site B> Name list (ISDN)

WEBconfig Expert configuration P> Setup » WAN module b
ISDN-name-list

Terminal/Telnet /Setup/WAN-module/Name list

Using the settings in the name and number list and the selection of the protocol (LANCOM or PPP), you can control
the callback behaviour of your router :

> The router can refuse to call back.

> It can call back using a preset call number.

> First the name can be checked and then a preset telephone number can be called back.

> The caller can opt to specify the call number to be used for callback.

And all the while you can use the settings to dictate how the cost of the connection is to be apportioned. The router
accepts all unit charges, except for the unit required to send the name, if call back 'With name' is set in the name
list. The caller also accepts a unit if the caller is not identified via CLIP (Calling Line Identifier Protocol). On the other
hand, the caller incurs no costs if identification of the caller's number is possible and is accepted (callback via the D
channel).

An especially effective callback method is the fast-callback procedure (patent pending). This speeds up the callback
procedure considerably. The procedure only works if it is supported by both stations. All current LANCOM routers are
capable of fast callback.
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(‘i\ Additional information on callback can be found in section ‘Callback functions” —page 90.

6.3 The security checklist

In the following checklist you will find an overview of the most important security functions. That way you can be
quite sure not to have overlooked anything important during the security configuration of your LANCOM.

>

Have you assigned a password for the configuration?

The simplest option for the protection of the configuration is the establishment of a password. As long as a pass-
word hasn't been set, anyone can change the configuration of the device. The box for entering the password is
located in LANconfig in the "Management' configuration area on the 'Security' tab. It is particularly advisable to
assign a password to the configuration if you want to allow remote configuration.

Have you permitted remote configuration?

If you do not require remote configuration, then deactivate it. If you require remote configuration, then be sure
to assign a password protection for the configuration (see previous section). The field for deactivating the remote
configuration is also contained in LANconfig in the '"Management' configuration area on the 'Security' tab. Under
‘Access Rights' 'From remote networks' select for all configuration types 'denied".

Have you permitted the configuration of wireless networks?

If you do not require the configuration from wireless networks switch it off. The field for switching off the con-
figuration from wireless networks you can also find in LANconfig in the ‘Management' configuration area on the
‘Security' tab. Under 'Access Rights' 'From the wireless LAN' select for all configuration types ‘denied".

Have you assigned a password to the SNMP configuration?

Also protect the SNMP configuration with a password. The field for protection of the SNMP configuration with
a password is also contained in LANconfig in the ‘Management' configuration area on the 'Security' tab.

Have you allowed remote access?

If you do not require remote access, deactivate call acceptance by deactivating a call acceptance 'by number'
and leaving the number list blank in LANconfig in the ‘Communication’ configuration area on the 'Call accepting'
tab.

Have you activated the callback options for remote access and is CLI activated?

When a call is placed over an ISDN line, the caller's number is normally sent over the D channel before a con-
nection is even made (CLI — Calling Line Identifier). Access to your own network is granted if the call number
appears in the number list, or the caller is called back if the callback option is activated (this callback via the D
channel is not supported by the Windows Dial-Up Network). If the LANCOM is set to provide security using the
telephone number, any calls from remote stations with unknown numbers are denied access.

Have you activated the Firewall?

The Stateful Inspection Firewall of the LANCOM ensures that your local network cannot be attacked from the
outside . The Firewall can be enabled in LANconfig under ‘Firewall/QoS’ on the register card 'General".
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> Do you make use of a ‘Deny All' Firewall strategy?
For maximum security and control you prevent at first any data transfer through the Firewall. Only those con-
nections, which are explicitly desired have to allowed by the a dedicated Firewall rule then. Thus ‘Trojans’ and
certain Email viruses loose their communication way back. The Firewall rules are summarized in LANconfig under
‘Firewall/Qos’ on the register card 'Rules’. A guidance can be found under ‘Set-up of an explicit "Deny All" stra-
tegy’ —page 124.

» Have you activated the IP masquerading?

IP masquerading is the hiding place for all local computers for connection to the Internet. Only the router module
of the unit and its IP address are visible on the Internet. The IP address can be fixed or assigned dynamically by
the provider. The computers in the LAN then use the router as a gateway so that they themselves cannot be
detected. The router separates Internet and intranet, as if by a wall. The use of IP masquerading is set individually
for each route in the routing table. The routing table can be found in the LANconfig in the 'IP router' configura-
tion section on the 'Routing' tab.
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> Have you excluded certain stations from access to the router?

Access to the internal functions of the devices can be restricted using a special filter list. Internal functions in this
case are configuration sessions via LANconfig, WEBconfig, Telnet or TFTP. This table is empty by default and so
access to the router can therefore be obtained by TCP/IP using Telnet or TFTP from computers with any IP address.
The filter is activated when the first IP address with its associated network mask is entered and from that point
on only those IP addresses contained in this initial entry will be permitted to use the internal functions. The circle
of authorized users can be expanded by inputting further entries. The filter entries can describe both individual
computers and whole networks. The access list can be found in LANconfig in the ‘'TCP/IP' configuration section
on the 'General' tab.

> Is your saved LANCOM configuration stored in a safe place?
Protect the saved configurations against unauthorized access in a safe place. A saved configuration could other-
wise be loaded in another device by an unauthorized person, enabling, for example, the use of your Internet
connections at your expense.

» Have you encoded the radio network and secured it with an ACL?
With 802.11i, WPA or WEP you can encode your data in the radio network with different kinds of encoding
methods as for AES, TKIP or WEP. LANCOM Systems recommends the most secure encoding with 802.11i and
AES. If the used WLAN client adapter does not provide these, use the TKIP or at least WEP. Make sure that your
device when using the encoding function has at least one passphrase or WEP key entered. To check the WEP
settings select in the LANconfig in the configuration area ‘Management' on the tab 'Interfaces’ under 'Wireless
LAN' the wireless LAN interface you would like to configure.

With the Access Control List (ACL) you allow or prohibit the access of single radio LAN clients to your radio LAN.
The access is regulated over the static MAC address of the wireless client adapter. To check the Access Control
List select in LANconfig in the configuration area "WLAN Security' the tab 'Stations'.

> Have you configured 802.1x or IPsec over WLAN for especially sensitive data transfer?
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For more security when transmitting sensitive data over your wireless LAN you can use the [EEE 802.1x techno-
logy. To check or activate the IEEE 802.1x settings select in the LANconfig the configuration area "WLAN Security'
the tab 'IEEE 802.1x'".

If your base station provides VPN you can alternatively to IEEE 802.1x select IPsec over WLAN to protect your
data between radio networks and local networks in a VPN tunnel.
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7  Routing and WAN connections

This chapter describes the most important protocols and configuration entries used for WAN connections. It also
shows ways to optimize WAN connections.

7.1 General information on WAN connections

WAN connections are used for the following applications.
» Internet access

> LAN to LAN coupling

» Remote access

7.1.1 Bridges for standard protocols

WAN connections differ from direct connections (for example, via the LANCAPI) in that the data in the WAN are
transmitted via standardized network protocols also used in the LAN. Direct connections, on the other hand, operate
with proprietary processes that have been specially developed for point-to-point connections.

Via WAN connections a LAN is extended, and with direct connections only one individual PC establishes a connection
to another PC. WAN connections form a kind of bridge for the communication between networks (or for connecting
individual computers to the LAN).

Which protocols are used for WAN connections?

WAN connections over highspeed ports (e.g. DSL connections) use the IP standard for transmitting packets. Devices
with an ISDN interface provide beside IP additionaly IPX.

Close cooperation with router modules

Characteristic of WAN connections is the close cooperation with the router modules in the LANCOM. The router
modules (IP and IPX) take care of connecting LAN and WAN. They make use of the WAN modules to fulfil requests
from PCs within the LAN for external resources.

7.1.2 What happens in the case of a request from the LAN?

Initially the router modules only determine the remote station to which a data packet is to be sent. The various para-
meters for all required connections must be arranged so that a given connection can be selected and established as
required. These parameters are stored in a variety of lists, the interaction of which permits the correct connections.

A simplified example will clarify this process. Here we assume that the IP address of the computer being searched
for is known in the Internet.
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Data packet with Internet user's PC
IP target address

=

G = =(Pm = D = =

LANCOM

Provider

IP routing tab. | IP address =» remote station name

ters (ISDN: telephone number), communications
layer

Terminal =» user name and password

(1 Selecting the correct route
A data packet from a computer initially finds the path to the Internet through the IP address of the receiver. The
computer sends the packet with this address over the LAN to the router. The router determines the remote station
in its IP routing table via which the target IP address can be reached, e.g. 'Provider_A'".

Name-list Remote station = interface, connection parame-)

connections
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(2) Connection data for the remote station
Using these names, the router checks the names list and finds the necessary connection data for provider A.
Included in these connection data are, for instance, the WAN interface (DSL, ISDN) through which the provider
is connected to, protocol information, or the necessary number for an ISDN call connection. The router also
obtains the user name and password required for login from the PPP list.

(3 Establishing the WAN connection
The router can then establish a connection to provider via a WAN interface. It authenticates itself with a user
name and password.

(4) Transmission of data packets
As soon as the connection is established, the router can send the data packet to the Internet.
7.2 IP routing

An IP router works between networks which use TCP/IP as the network protocol. This only allows data transmissions
to destination addresses entered in the routing table. This section explains the structure of the IP routing table of an
LANCOM Systems router, as well as the additional functions available to support IP routing.
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7.2.1 The IP routing table

The IP routing table is used to tell the router which remote station (which other router or computer) it should send
the data for particular IP addresses or IP address ranges to. This type of entry is also known as a “route” since it is
used to describe the path of the data packet. This procedure is also called “static routing” since you make these ent-
ries yourself and they remain unchanged until you either change or delete them yourself. Naturally, “dynamic rou-
ting” also exists. The routers use the routes in this way to exchange data between themselves and continually update
it automatically. The static routing table can hold up to 256 entries, the dynamic table can hold 128. The IP router
looks at both tables when the IP RIP is activated.

You also use the IP routing table to tell the router the length of this route's path so that it can select the most suitable
route in conjunction with IP RIP where there are several routes to the same destination. The default setting for the
distance to another router is 2, i.e. the router can be reached directly. All devices which can be reached locally, such
as other routers in the same LAN or workstation computers connected via proxy ARP are entered with the distance
0. The "quality level” of this route will be reduced if the entry addressed has a higher distance (up to 14). “Unfavou-
rable” routes like this will only be used if no other route to the remote station in question can be found.

Configuration of the routing table

LANconfig IP router P> Routing P> Routing table

WEBconfig Expert Configuration > Setup P> IP-router-module b
IP-routing-table

Terminal/Telnet cd /setup/IP-router/IP-routing-table

An IP routing table can, for example, look like this:

192.168.120.0 | 255.255.255.0 | MAIN 2 off
192.168.125.0 | 255.255.255.0 | NODE1 3 off
192.168.130.0 |255.255.255.0 | 191.168.140.123 |0 off

What do the various entries on the list mean?
» |P addresses and netmasks

This is the address of the destination network to which data packets may be sent and its associated network
mask. The router uses the network mask and the destination IP address of the incoming data packets to check
whether the packet belongs to the destination network in question.

The route with the IP address '255.255.255.255" and the network mask '0.0.0.0" is the default route. All data
packets that cannot be routed by other routing entries are sent over this route.
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» Router
The router transmits the appropriate data packets to the IP address and network mask to this remote station.
> If the remote station is a router in another network or an individual workstation computer the name of the
remote station.

> If the router on the network cannot address the remote station itself, then the IP address of another router
which knows the path to the destination network is entered.

The router name indicates what should happen with the data packets that match the IP address and network
mask.

> Routes with the entry '0.0.0.0" identify exclusion routes. Data packets for this “zero route” are rejected and
are not routed any further. That way routes which are forbidden on the Internet (private address spaces, e.qg.
'10.0.0.0"), for example, are excluded from transmission.

> Ifan IP address is input as router name, this is a locally available router, which is responsible for transfer of
the relevant data packets.
> Distance
Number of routers between your own and the destination router. This value is often equated with the cost of the
transmission and used to distinguish between inexpensive and expensive call paths for wide-area connections.
The distance values entered are propagated as follows:
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> All networks which can be reached while a connection exists to a destination network are propagated with
a distance of 1.

> All non-connected networks are propagated with the distance entered in the routing table (but with a mini-
mum distance of 2) as long as a free transmitting channel is still available.

> The remaining networks are propagated with a distance of 16 (= unreachable) if there are no longer any
channels available.

I> Remote stations connected using proxy ARP are an exception to this. These “proxy hosts” are not propagated
atall.

» Masquerading

Use the 'Masquerade' option in the routing table to inform the router which IP addresses to use when transfer-
ring packets from local networks.

For further information see the section 'IP-Masquerading’ —page 69.

7.2.2 Local routing

You know the following behaviour of a workstation within a local network: The computer searches for a router to
assist with transmitting a data packet to an IP address which is not on its own LAN. This router is normally introduced
to the operating system with an entry as standard router or standard gateway. It is often only possible to enter one
default router which is supposed to be able to reach all the IP addresses which are unknown to the workstation com-
puter if there are several routers in a network. Occasionally, however, this default router cannot reach the destination
network itself but does know another router which can find this destination.
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How can you assist the workstation computer now?

By default, the router sends the computer a response with the address of the router which knows the route to the
destination network (this response is known as an ICMP redirect). The workstation computer then accepts this
address and sends the data packet straight to the other router.

Certain computers, however, do not know how to handle ICMP redirects. To ensure that the data packets reach their

destination anyway, use local routing. In this way you instruct the router itself in your device to send the data packet
to other routers. In addition, in this case no more ICMP redirects will be sent. The setting is made under:

LANconfig IP router P> General P> Forward packets within the local network

WEBconfig Expert Configuration P> Setup P> IP-router-module »
Loc.-routing

Terminal/Telnet set /setup/IP-router-module/Loc. routing on

Local routing can be very helpful in isolated cases, however, it should also only be used in isolated cases. For local
routing leads to a doubling of all data packets to the desired target network. The data is first sent to the default
router and is then sent on from here to the router which is actually responsible in the local network.

7.2.3 Dynamic routing with IP RIP

In addition to the static routing table, LANCOM Systems routers also have a dynamic routing table containing up to
128 entries. Unlike the static table, you do not fill this out yourself, but leave it to be dealt with by the router itself.
It uses the Routing Information Protocol (RIP) for this purpose. All devices that support RIP use this protocol to
exchange information on the available routes.

What information is propagated by IP RIP?

A router uses the IP RIP information to inform the other routers in the network of the routes it finds in its own static
table. The following entries are ignored in this process:

> Rejected routes with the '0.0.0.0" router setting.

> Routes referring to other routers in the local network.

> Routes linking individual computers to the LAN by proxy ARP.

Although the entries in the static routing table are set manually, this information changes according to the connec-
tion status of the router and so do the RIP packets transmitted.

> If the router has established a connection to a remote station, it propagates all the networks which can be rea-
ched via this route in the RIPs with the distance '1'. Other routers in the LAN are thus informed by these means
that a connection to the remote station has been established on this router which they can use. The establish-
ment of additional connections by routers with dial-up connections can be prevented, thus reducing connection
costs.
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> If this router cannot establish a further connection to another remote station, all other routes are propagated
with the distance '16" in the RIPs. The '16' stands for “This route is not available at the moment”. A router may
be prevented from establishing a connection in addition to the present one may be due to one of the following
causes:

> Another connection has already been established on all the other channels (also via the LANCAPI).
I> Y connections for the Sy port have been explicitly excluded in the interface table.

I> The existing connection is using all B channels (channel bundling).
>

The existing connection is a leased-line connection. Only a few ISDN providers enable a dial-up connection
to be established on the second B channel in addition to a permanent connection on the first B channel.

Which information does the router take from received IP RIP packets?
When the router receives such IP RIP packets, it incorporates them in its dynamic routing table, which looks some-

T =
thing like this: %l: -
S
R
[Paddress IPnetmask  Tme  Distnce Router S8
> S
192.168.120.0 |255.2552550 |1 2 192.168.110.1 £ 5
S

192.168.130.0 |255.255.255.0 |5 3 192.168.110.2 §

192.168.140.0 | 255.255.255.0

—_
wu

192.168.110.3

What do the entries mean?

IP address and network mask identify the destination network, the distance shows the number of routers between
the transmitter and receiver, the last column shows which router has revealed this route. This leaves the 'Time'. The
dynamic table thus shows how old the relevant route is. The value in this column acts as a multiplier for the intervals
at which the RIP packets arrive. A '1", therefore, stands for 30 seconds, a '5' for about 2.5 minutes and so on. New
information arriving about a route is, of course, designated as directly reachable and is given the time setting '1".
The value in this column is automatically incremented when the corresponding amount of time has elapsed. The dis-
tance is set to '16' after 3.5 minutes (route not reachable) and the route is deleted after 5.5 minutes.

Now if the router receives an IP RIP packet, it must decide whether or not to incorporate the route contained into its
dynamic table. This is done as follows:

> The route is incorporated if it is not yet listed in the table (as long as there is enough space in the table).

» The route exists in the table with a time of '5' or '6'. The new route is then used if it indicates the same or a
better distance.

> The route exists in the table with a time of '7" to 10" and thus has the distance '16'. The new route will always
be used.

» The route exists in the table. The new route comes from the same router which notified this route, but has a
worse distance than the previous entry. If a device notifies the degradation of its own static routing table in this
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way (e.g. releasing a connection increases the distance from 1 to 2, see below), the router will believe this and
include the poorer entry in its dynamic table.

RIP packets from the WAN will be ignored and will be rejected immediately. RIP packets from the LAN will
be evaluated and will not be propagated in the LAN.

The interaction of static and dynamic tables

The router uses the static and dynamic tables to calculate the actual IP routing table it uses to determine the path
for data packets. In doing so, it includes the routes from the dynamic table which it does not know itself or which
indicate a shorter distance than its own (static) route with the routes from its own static table.

Scaling with IP RIP

If you use several routers in a local network with IP RIP, you can represent the routers outwardly as one large router.
This procedure is also known as “scaling”. As a result of the constant exchange of information between the routers,
such a router theoretically has no limits to the transmission options available to it.

connections

Configuration of IP-RIP function

LANconfig IP router P> General P> RIP options
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WEBconfig Expert Configuration > Setup P> IP-router-module b
RIP-config

Terminal/Telnet setup/IP-router-module/RIP-config

> In the field 'RIP support' (or 'RIP type') the following selection is possible:
> ‘off': IP-RIP is not used (default).
> 'RIP-1": RIP-1 and RIP-2 packets are received but only RIP-1 packets are sent.
> 'RIP-1 compatible: RIP-1 and RIP-2 packets are received. RIP-2 packets are sent as an IP broadcast.
>

‘RIP-2": Similar to 'RIP-1 compatible’, except that all RIP packets are sent to the IP multicast address
224.0.0.9.

» The entry under 'RIP-1 mask' (or 'R1 mask’) can be set to the following values:

> ‘class' (default): The network mask used in the RIP packet is derived directly from the IP address class, i.e.
the following network masks are used for the network classes:

Class A 255.0.0.0
Class B 255.255.0.0
Class C 255.255.255.0
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> ‘address’: The network mask is derived from the first bit that is set in the IP address entered. This and all
high-order bits within the network mask are set. Thus, for example, the address 127.128.128.64 yields the
IP network mask 255.255.255.192.

> ‘class + address': The network mask is formed from the IP address class and a part attached after the address

procedure. Thus, the above-mentioned address and the network mask 255.255.0.0 yield the IP network
mask 255.128.0.0.

(1'5 Routers with RIP capabilities dispatch the RIP packets approximately every 30 seconds.The router is only set
up to send and receive RIPs if it has a unique IP address.The IP RIP module is deselected in the default setting
using the IP address xxx.xxx.xxx.254.

7.2.4 SYN/ACK speedup

The SYN/ACK speedup method is used to accelerate IP data traffic. With SYN/ACK speedup IP check characters (SYN
for synchronization and ACK for acknowledge) a given preference within the transmission buffer over simple data
packets. This prevents the situation that check characters remain in the transmission queue for a longer time and the
remote station stop sending data as a result.
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The greatest effect occurs with SYN/ACK speedup with fast connections (e. g. ADSL) when data quantities are simul-
taneously transferred in both directions at high speed.

The SYN/ACK speedup is activated at the factory.
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Switching off in case of problems

Due to the preferred handling of individual packets, the original packet order is changed. Although TCP/IP does not
ensure a certain packet order, problems may result in a few isolated applications. This only concerns applications
that assume a certain order that differs from the protocol standard. In this case the SYN/ACK speedup can be deac-

tivated:
LANconfig IP router P> General P> Pass on TCP SYN and ACK packets preferentially
WEBconfig Expert Configuration P> Setup P> IP-router-module »
Routing-method > SYN/ACK-speedup
Terminal/Telnet cd /setup/IP-router-module/routing-
method set SYN/ACK-speedup OFF

7.3 IP masquerading

One of today's most common tasks for routers is connecting the numerous workstation computers in a LAN to the
network of all networks, the Internet. Everyone should have the potential to access, for example, the WWW from his
workstation and be able to fetch bang up-to-date information for his work.
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So that not every single computer with it's IP address in known on the entire internet “IP masquerading” is used to
hide all computers located in an intranet. IP masquerading demands two ponits from a router: On the one hand a
valid IP address in the local network, on the other hand a valid and public IP address in the internet (static or assi-
gned by the provider).

Because these two addresses are not allowed to exist in one logical net, the router must have two IP addresses:

> the intranet IP address to communicate with computers in the LAN

> the public IP address to communicate with remote stations in the Internet

The computers in the LAN use the router as a gateway but are recognizable themselves. The router devides the intra-
net from the internet.

7.3.1 Simple masquerading

How does IP masquerading work?

Masquerading makes use of a characteristic of TCP/IP data transmission, which is to use port numbers for destination
and source as well as the source and destination addresses. When the router receives a data packet for transfer it
now notes the IP address and the sender's port in an internal table. It then gives the packet its unique IP address
and a new port number, which could be any number. It also enters this new port on the table and forwards the packet
with the new information.

connections
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Source: 10.0.0.100
Target: 80.123.123.123

Source: 80.146.74.146, Port 3456
Target: 80.123.123.123

IP: 10.0.0.100

internal IP: 10.0.0.1
public IP: 80.146.74.146

10.0.0.100 3456

The response to this new packet is now sent to the IP address of the router with the new sender port number. The
entry in the internal table allows the router to assign this response to the original sender again.
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Source: 80.123.123.123
Target: 10.0.0.100

Source: 80.123.123.123
Target: 80.146.74.146, Port 3456

IP: 10.0.0.100

internal IP: 10.0.0.1
public IP: 80.146.74.146

10.0.0.100 3456

Which protocols can be transmitted using IP masquerading?
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IP masquerading for all IP protocols that are based on TCP, UDP, or ICMP and communicate exclusively through ports.
One example of this type of uncomplicated protocol is the one the World Wide Web is based on: HTTP.

Individual IP protocols do use TCP or UDP, but do not, however communicate exclusively through ports. This type of
protocol calls for a corresponding special procedure for IP masquerading. Among the group of protocols supported
by IP masquerading in the LANCOM are:

> FTP (using the standard ports)
> H.323 (to the same extent as used by Microsoft Netmeeting)
» PPTP

> [PSec

> IRC

Configuration of IP masquerading
The use of IP masquerading is set individually for each route in the routing table. The routing table can be reached

as follows:
LANconfig IP router P> Routing P> Routing table
WEBconfig Expert Configuration > Setup P> IP-router-module
IP-routing-table
Terminal/Telnet /setup/IP-router-module/IP-routing-table
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7.3.2 Inverse masquerading

(simple masquerading has the effect, that all IP addresses in the local network are masked behind the IP address of
the router. But when using simple masquerading if a certain computer on the LAN ist supposed zu be available for
stations on the internet (e.q. FTP server) the IP address of the FTP server is not visible either. A connection to this FTP
server from the internet in not possible.

To enable the access to such a server (‘exposed host’) in the LAN, the IP address of the FTP server must be entered
with all services that are also supposed to be available from outside the LAN. If a computer sends a packet from the
Internet to, for example, an FTP server on the LAN , from the point of view of this computer the router appears to be
the FTP server. The router reads the IP address of the FTP server in the LAN from the entry in the service table. The
packet is forwarded to this computer. All packets that come from the FTP server in the LAN (answers from the server)
are hidden behind the IP address of the router.

Source: 80.123.123.123

Target: 80.146.74.146, Port 21 p@
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20to 21 10.0.0.10

The only small difference is that:

> Access to a service (port) in the intranet from outside must be defined in advance by specifying a port number.
The destination port is specified with the intranet address of, for example, the FTP server, in a service table to
achieve this.

> When accessing the Internet from the LAN, on the other hand, the router itself makes the entry in the port and
IP address information table.

(fs The table concerned can hold up to 2048 entries, that is it allows 2048 simultaneous transmissions bet-
\ ween the masked and the unmasked network.

After a specified period of time, the router, however, assumes that the entry is no longer required and deletes it
automatically from the table.
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Configuration of the inverse masquerading

The service table for setting inverse masquerading can be reached in LANconfig in the configuration area 'IP Router'
on the tab 'Masq.".

1621AnnexB Configuration 2=l
Configure: |IP Flouter 'l

Generall Routing  Masq. |N:N Mappingl
|

et cpirs Y S 2l
TCF aging: Im
First portl Lask portl Address | OF |
1IDP aging: |20 &0 20 10.0.0.99
20 21 10.0.0.100 Cancel |
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Service list - New Entry 2=l =
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First port: |0 oK § =
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Under WEBconfig or Telnet the parameters for setting inverse masquerading can be found as follows.

WEBconfig Expert Configuration > Setup > IP-router-module P Masquerading P> Service-table

Terminal/Telnet /setup/IP-router-module/masquerading/
service-table

@ Stateful Inspection and inverse masquerading: If in the Masquerading module a port is exposed (i.e. all

~ packets received on this port should be forwarded to a server in the local area network), then this requires
with a Deny All Firewall strategy an additional entry in the Stateful Inspection Firewall, which enables the
access of all stations to the respective server.

7.3.3 De-Militarized Zone (DM2)

Locally the router can manage two different IP address sections: the intranet (LAN) and the ‘De-Militarized Zone'
(DMZ). The DMZ has it's own area, which is used for reachable servers in the internet.
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Intranet
(LAN)

public IP:
80.146.74.146

192.168.2.1

DMz

The option Masg. in the Service list informs the router, if the local intranet or DMZ addresses should be hidden

behind the IP address of the router:

> IP Masquerading switched off: No masquerading is performed. This variation is for internet accesses with
several static IP addresses (enter under DMZ IP address and DMZ netmask) to link only servers to the internet or
e.g. to link two intranet subnets via VPN.

» masking Intranet and DMZ (default): This setting has the effect, that all local addresses are masked. Additi-
onally to the Intranet (LAN) a second local net with private addresses can be linked to the Internet.

> masking Intranet only: This setting is especially for the internet access with several static IP addresses. The
difference to the case 'IP Masquerading switched off' is that besides the DMZ the intranet address section with
masked private IP addresses is available in the LAN.

The DMZ and the intranet addresses of the LANCOM are set as follows:

connections
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LANconfig TCP/IP »>General
WEBconfig Expert Configuration P Setup » TCP-IP-module
Terminal/Telnet /setup/TCP-IP-module

7.3.4 Unmasked Internet access for server in the DMZ
While the inverse masquerading described in the proceeding paragraph allows to expose at least one service of each
type (e.g. one Web, Mail and FTP server), this method is bound to some restrictions.

» The masquerading module must support and ‘understand’ the particular server service of the ‘exposed host'. For
instance, several VolP servers use proprietary, non-standard ports for extended signalling. Thus such server could
be used on unmasked connections solely.
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> From a security point of view, it must be considered that the ‘exposed host’ resides within the LAN. When the
host is under control of an attacker, it could be misused as a starting point for further attacks against machines
in the local network.

(Q‘ In order to prevent attacks from a cracked server to the local network, some LANCOM provide a dedicated
DMZ interface (LANCOM 7011 VPN) or are able to separate their LAN ports on Ethernet level by hardware
(LANCOM 821 ADSL/ISDN, LANCOM 1511 DSL, LANCOM 1521 ADSL, LANCOM 1621 ADSL/ISDN, LANCOM

1711 VPN, LANCOM 1811 DSL und LANCOM 1821 ADSL).

Two local networks - operating servers in a DMZ

This feature requires an Internet access with multiple static IP addresses. Please contact you ISP for an appropriate
offer.

Example: You are assigned the IP network address 123.45.67.0 with the netmask 255.255.255.248 by your provider.
Then you can assign the IP addresses as follows:

123.45.67.0 network address

connections
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123.45.67.1 LANCOM as a gateway for the Intranet

123.45.67.2 Device in the LAN which is to receive unmasked access to the Internet, e.g. web server connected at the DMZ port

123.45.67.3 broadcast address

All computers and devices in the Intranet have no public IP address, and therefore appear with the IP address of the
LANCOM (123.45.67.1) on the Internet.

Separation of Intranet and DMZ

% Although Intranet and DMZ may be already separated on a Ethernet level by distinct interfaces, an approp-
riate Firewall rules must be set up in any case so that the DMZ is being separated from the LAN on the IP
level as well.

Thereby, the server service shall be available from the Internet and from the Intranet, but any IP traffic from
the DMZ towards the Intranet must be prohibited. For the above example, this reads as follows:

> With a 'Allow All’ strategy (default): Deny access from 123.45.67.2 to "All stations in local network"

> With a 'Deny All" strategy (see ‘Set-up of an explicit "Deny All" strategy’ —page 124): Allow access from "All
stations in local network" to 123.45.67.2
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7.4 N:N mapping

Network Address Translation (NAT) can be used for several different matters:

> for better utilizing the IP4 addresses ever becoming scarcer
» for coupling of networks with same (private) address ranges
» for producing unique addresses for network management

In the first application the so-called N:1 NAT, also known as IP masquerading ('IP-Masquerading’ —page 69) is
used. All addresses (“N") of the local network are mapped to only one (“1") public address. This clear assignment of
data streams to the respective internal PCs is generally made available by the ports of the TCP and UDP protocols.
That's why this is also called NAT/PAT (Network Address Translation/Port Address Translation).

Due to the dynamic assignment of ports, N:1 masquerading enables only those connections, which have been initi-
ated by the internal network. Exception: an internal IP address is staticly exposed on a certain port, e.g. to make a
LAN server accessible from the outside. This process is called “inverse masquerading” (‘Inverse masquerading’
—page 70).

AN:N mapping is used for network couplings with identical address ranges. This transforms unambiguously multiple

addresses (“N") of the local network to multiple (“N”) addresses of another network. Thereby, an address conflict
can be resolved.

Rules for this address translation are defined in a static table in the LANCOM. Thereby new addresses are assigned
to single stations, parts of the network, or the entire LAN, by which the stations can contact other networks then.

Some protocols (FTP, H.323) exchange parameters during their protocol negotiation, which can have influence on
the address translation for the N:N mapping. For a correct functioning of the address translation, the connection
information of these protocols are tracked appropriately by functions of the firewall in a dynamic table, and are addi-
tionally considered to the entries of the static table.

ﬁ\‘ The address translation is made “outbound”, i.e. the source address is translated for outgoing data packets

\ and the destination address for incoming data packets, as long as the addresses are located within the defi-
ned translation range. An “inbound” address mapping, whereby the source address is translated (instead of
the destination address), needs to be realized by an appropriate “outbound” address translation on the
remote side.

7.4.1 Application examples

The following typical applications are described in this section:
» Coupling of private networks utilizing the same address range
» Central remote monitoring by service providers
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Network coupling

An often appearing scenario is the coupling of two company networks which internally use the same address range
(e. g. 10.0.0.x). This is often the case, when one company should get access to one (or more) server(s) of the other

one:
Network of firm A:
10.0.0.X < N:N mapping to 192.168.2.x

N:N mapping to 192.168.1.x

Network of firm B:
10.0.0.x

Target: 192.168.2.1

I— Server_A1:10.0.0.1 Server_B1: 10.0.0.1 —I
Server_A2:10.0.0.2 Server_B2: 10.0.0.2

connections

<
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In this example network servers of company A and B should have access over a VPN tunnel to the respective other
network. All stations of the LAN should have access to the server of the remote network. For the time being, there
is no access possible to the other network, because both networks use the same address range. If one station of the
network of company A wants to access server 1 of company B, the addressee (with an address from the 10.0.0.x
network) will be searched within the own local network, and the inquiry even does not reach the gateway.

With the help of N:N mapping, all addresses of the LAN can be translated to a new address range for the coupling
with the other network. The network of company A e. g. will be translated to 192.168.1.x, the network of company
B to 192.168.2.x. Under these new addresses the two LANs are now reachable for the respective other network. The
station from the network of company A is now addressing server 1 of company B under the address 192.168.2.1.
The addressee does not reside any more within the own network, the inquiry is now passed on to the gateway, and
the routing to the other network is working as desired.

Remote monitoring and remote control of networks

Remote maintenance and control of networks become more and more importance because of the possibilities given
by VPN. With the use of the nearly ubiquitous broadband Internet connections, the administrator of such manage-
ment scenarios is no longer dependent of the different data communication technologies or expensive leased lines.
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Gateway, e.g. Customer A, office 1: Customer B, office 1:
10.1.2.1 10.1.2.x, 255.255.255.0 10.1.2.x, 255.255.255.0

Customer B, headquarters;

Customer A, headquarters:
10.1.x.x, 255.255.0.0

LI —
Customer B, office 27

10.1.3.x, 255.255.255.0

Customer D:
172.16.10.x,
255.255.255.0

Gateway

Customer A, office 2:
10.1.3.x, 255.255.25

Hot Spot, e.g.
172.16.10.11

Customer C:
172.16.10.x, 255.255.255.0

Gateway, e.g.
80.123.123.123 (public)
and 172.16.10.11 (intern)

connections
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Service provider:
172.16.10.x,
255.255.255.0

In this example, a service provider monitors the networks of different clients out of a central control. For this purpose,
the SNMP-capable devices should send the respective traps of important events automatically to the SNMP trap
addressee (e. g. LANmonitor) of the network of the service provider. So the LAN administrator of the service provider
has an up-to-date view of the state of the devices at any time.

The individual networks can be structured very differently: Clients A and B integrate their branches with own net-
works via VPN connections to their LAN, client C operates a network with several public WLAN base stations as hot
spots, and client D has got an additional router for ISDN dial-up accesses in his LAN.

ﬁ The networks of client A and B use different address ranges in the respective head office and the connected
branches. A standard network coupling via VPN is therefore possible between these networks.

In order to avoid the effort to building up its own VPN tunnel to each individual subnetwork of the clients A and B,
the service provider makes only one VPN connection to the head office, and uses the existing VPN lines between
head office and branches for communication with the branches.
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Loopback:
decentralized
1:1 mapping

Alternative:
central
N:N mapping

> N:N mapping

Traps from the networks report to the service provider whether e. g. a VPN tunnel has been build up or cut, if an user
has been tried to log in three times with a wrong password, if an user has been applied for a hot spot, or if some-
where a LAN cable has been pulled out of a switch.

, A complete list of all SNMP traps supported by LANCOM can be found in the appendix of this reference
manual (‘'SNMP Traps" —page 303).

Routing of these different networks reaches very fast its limiting factors, if two or more clients use same address
ranges. Additionally, if some clients use the same address range as the service provider as well, further address con-
flicts are added. In this example, one of the hot spots of client C has got the same address as the gateway of the
service provider.

There are two different variants to resolve these address conflicts:

> In the decentralized variant, alternative IP addresses for communicating with the SNMP addressee are assigned
to each of the monitored devices by means of an 1:1 mapping. This address is in technical language also known
as “loopback address”, the method accordingly as “loopback method”.

(.“ The loopback addresses are valid only for communication with certain remote stations on the connections
belonging to them. Thus a LANCOM is not generally accessible via this IP address.

» Even more appealing is the solution of a central mapping: instead of configuring each single gateway in the
branch networks, the administrator configures solely one central address translation in the gateway of the head
office. On this occasion, also all subnetworks located “behind” the head office are supplied with the needed
new IP addresses.

In this example, the administrator of the service provider selects 10.2.x.x as central address translation for the net-
work of client B, so that both networks with actual same address range looks like two different networks for the
gateway of the service provider.

The administrator selects the address ranges 192.168.2.x and 192.168.3.x for client C and D, so that the addresses
of these networks do differ from the own network of the service provider.

In order to enable the gateway of the provider to monitor the networks of clients C and D, the administrator sets up
an address translation to 192.168.1.x also for the own network.

7.4.2 Configuration

Setting up address translation

Configuration of N:N mapping succeeds with only few information. Since a LAN can be coupled with several other
networks via N:N, different destinations can have also different address translations for a source IP range. The NAT
table can contain 64 entries at maximum, including the following information:

> Index: Unambiguous index of the entry.
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>
>
>
>

Source address: IP address of the workstation or network that should get an alternative IP address.
Source mask: Netmask of source range.

Remote station: Name of the remote station over that the remote network is reachable.

New network address: IP address or address range that should be used for the translation.

For the new network address, the same netmask will be used as the source address already uses. For assignment of
source and mapping addresses the following hints apply:

>

>

Source and mapping can be assigned arbitrarily for the translation of single addresses. Thus, for example, it is
possible to assign the mapping address 192.168.1.88 to a LAN server with the IP address 10.1.1.99.

For translation of entire address ranges, the station-related part of the IP address will be taken directly, only
appended to the network-related part of the mapping address. Therefore, in an assignment of 10.0.0.0/
255.255.255.0 to 192.168.1.0, a server of the LAN with IP address 10.1.1.99 will get assigned the mapping
address 192.168.1.99.

@“ The address range for translation must be at minimum as large as the source address range.

%“ Please notice that the N:N mapping functions are only effective when the firewall has been activated. (‘Fire-

" wall/QoS enabled’ —spage 109)!

Additional configuration hints

By setting up address translation in the NAT table, the networks and workstations become only visible under another
address at first in the higher network compound. But for a seamless routing of data between the networks some
further settings are still necessary:

>
>

>

>

Entries in the routing tables for packets with new addresses to find the way to their destination.

DNS forwarding entries, in order that inquiries about certain devices in the respective other networks can be
resolved into mapped IP addresses ('DNS forwarding” —page 279).

The firewall rules of the gateways must be adjusted such that (if necessary) authorized stations resp. networks
from the outside are permitted to set up connections.

VPN rules for loopback addresses in order to transmit the newly assigned IP addresses through an according VPN
tunnel.

ﬁ‘ The IP address translation takes place in the LANCOM between firewall and IP router on one hand, and the

VPN module on the other hand. All rules related to the own network use therefore the “unmapped” original
addresses. The entries of the remote network use the “mapped” addresses of the remote side, valid on the
VPN connection.
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LANconfig

> N:N mapping

CE—

connection via LAN/Switch
|

IP-Redirect

LAN interfaces

VPN services

IPX over PPTP/VPN

Configuration with different tools
With LANconfig you adjust the address translation for the configuration range ‘IP router’ on register card 'N:N-Map-
ping":
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1621AnnexB Configuration i 2 x|
Configure: |IP Flouter ‘l

Generall Houtingl Mazg  M:M Mapping |

M:M Address Mapping

The MN:M table contains rules to map the source addresses of
zingle stations or complete networks to the specified |P
addreszes. You have to specify those mapping rules for every
remote site separately. For the remote site the stations ar
networks will be reachable with their mapped addresses.

| M:M table ... %J

NNtable R .1
Remate site | Source IP | Tetmask, | Mapped IP | OF |

2 ZEMTRALE 10.0.0.0  255.255.255.0 192.168.1.0
<§( = Cancel |
g 2]
k-
S Destination remote site: | ZENTRALE [ o
gj E Criginal source address: IID.D.D.D cancel |
g =2 Metmask: [ 255,255, 255.0
C% LANMEOM ——— Mappedsource address; |192.168.1.0|
Systens
WEBCconfig, Under WEBconfig and Telnet you find the NAT table for configuration of N:N mapping at the following positions of
Telnet the menu tree:

WEBconfig Expert configuration / Setup / IP router / NAT table

Terminal/Telnet Setup / IP router module / NAT table

When starting a new entry under WEBconfig, the NAT table shows up as follows:

Expert Confiquration
&3 Setup
4 IP-router-module

NAT-table

Iehc [

Sre-Address W
Sre-Mask W
Dst-Gtation [Comparve
Mapped-MNetwork IW
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7.5 Configuration of remote stations

Remote stations are configured in two tables:
» In the name list(s) all information is set that applies individually to only one remote station.
> Parameters for the lower protocol levels (below IP or IPX) are defined in the communication layer table.

ﬁ The configuration of the authentication (protocol, user name, password) is not covered in this section.Infor-
~" mation on authentication is contained in the section 'Establishing connection with PPP" —page 84.

7.5.1 Name list

The available remote stations are created in the name list with a suitable name and additional parameters. For every

WAN interface exists a separate name list. The name list reached as follows: 3(
S
b =~
Comfguationtool  Menwtable
T &
LANconfig Communication P> Remote sites B> Name list g g
SIS
WEBconfig Expert configuration B> Setup » WAN module B Name-list § o
Terminal/Telnet cd /Setup/WAN module =

set DSL name list[...]
set ISDN name list
set ADSL name list

For the remote stations following parameters are required:

DSL Name With this name the remote stations are identified in the router modules. As soon as the router
module has detected the remote station (using the IP address of the destination), the connec-
tion parameters are located in the name list.

Short hold This time indicates how long the connection is kept if no data is being transmitted anymore.
If zero is entered, the connection does not terminat automatically. If 9999 seconds are entered
a broken off connection is rebuild automatically. (see ‘Extended connection for flat rates—
Keep-alive” —page 89)

Access concentrator The Access concentrator (AC) is a server, which can be accessed by the remote station. If several
ADSL providers are listed, select the provider that is responsible for the remote station (using
the name of the AC).

The value for the AC is advised to you by your provider. If no value is entered for the AC, every
AC s accepted that provides the demanded service.

Service Enter the service you would like to use from your provider. The service can be e.g. internet sur-
fing or even video downstream.

The value for the service is advised to you by your provider. If no value is entered, every Service
is accepted that is provided by the AC.

Layer name Select the layer name for the connection. The configuration of this layer is descibed in the follo-
wing section.
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ADSL Name See DSL Name list
Short hold See DSL Name list
VPI Virtual Path Identifier.
vl Virtual Channel Identifier. The value for VCl and VPI are advised to you by your provider. Stan-
dard values for the combination of VPI and VCl are:
0/35, 0/38, 1/32, 8/35, 8/48.
Access concentrator See DSL Name list
Service See DSL Name list
Layer name See DSL Name list
ISDN Name See DSL Name list
Phonenumber A Phonenumber is only then required, if the remote station must be called. This field can
remain empty if only incoming calls should be accepted. Several phonenumbers for the same
remote station can be entered in the RoundRobin list.
Short hold See DSL Name list
Short hold 2 The second B channel is cut down, if it is not used for the set duration.
Layer name See DSL Name list
Callback The automatic callback provides a secure connection and decreases the costs for the caller.
Further information can be found in the next section 'Callback functions” —page 90.

@ Please note following points when editing the name list:

> If two identical name lists (e.g. DSL name list and ISND name list) are entered, the LANCOM when connecting
to the remote station uses the “faster” interface. The other interface is then used as a backup.
> If nor the access concentrator neither the service is specified the router connects to the first AC that answers
the query.
In the occasion of a DSLoL interface the same entries as for the DSL interface are valid. Depending on the model the
entries are made in a mixed ADLS/DSLoL name list or a separate namelist.
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7.5.2 Llayer list

With a layer, a collection of protocol settings are defined, which should be used when connecting to specific remote
stations. The list of the communication layers can be found under:

LANconfig

Communication P General »> Communication layers

WEBconfig

Expert Configuration P> Setup P WAN-module P> Layer-list

Terminal/Telnet

cd /setup/WAN
module/ set layer-list [...]

In the communication layer list the common protocol combinations are already predefined. Changes or additions
should only be made when remote stations are incompatible to the existing layers. The possible options are contai-
ned in the following list.

Please note that the parameters located in LANCOM depend upon the functionality of the unit. It is possible
that your unit does not offer all of the options described here.

Layer name

The layer is selected in the name list under this name.

Encapsulation

Additional encapsulations can be set for data packets.

‘Transparent’ | No additional encapsulations.

‘Ethernet' Encapsulation in the form of ethernet frames.

'LLC-MUX' Multiplexing via ATM with LLC/SNAP encapsulation according to RFC 2684. Several protocols can be trans-
mitted over the same VC (Virtual Channel).

'VC-MUX' Multiplexing with ATM by establishing additional VCs according to RFC 2684.

Layer-3

The following options are available for the switching layer or network layer:

‘Transparent’ | No additional header is inserted.

'PPP' The connection is established according to the PPP protocol (in the synchronous mode, i.e. bit-oriented).
The configuration data are taken from the PPP table.

'AsyncPPP' Like 'PPP*, only the asynchronous mode is used. This means that PPP functions character-oriented.

"... with All options can be run with their own script if desired. The script is specified in the script list.

script’

‘DHCP! Assignment of the network parameters via DHCP.
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Layer-2 In this field the upper section of the security layer (Data Link Layer) is configured. The following options are available:

‘Transparent' | No additional header is inserted.

‘PPPoOE' Encapsulation of the PPP protocol information in ethernet frames.

‘PPPoOE' The PPP negotiation runs via Ethernet. The PPP packets are encapsulated in Ethernet frames for this pur-
pose. This process is frequently used for DSL connections.

Options Here you can activate the compression of the data to be transmitted and the bundling of channels. The selected option only
becomes active when it is supported by both the ports used and the selected Layer-2 and Layer-3 protocols. For further
information see section ‘Channel bundling with MLPPP* —page 93.

Layer-1 In this field the lower section of the security layer (Data Link Layer) is configured. The following options are available:
'AAL-5' ATM adaptation layer
‘ETH-10' Transparent Ethernet as per IEEE 802.3.
'HDLC' Securing and synchronization of the data transfer as per HDLC (in the 7 or 8-bit mode).
'V.110" Transmission as per V.110 with a maximum of 38,400 bps.
Modem Modem transmission (requires Fax Modem option)

7.6 Establishing connection with PPP

LANCOM Systems routers also support the point-to-point protocol (PPP). PPP is a generic term for a whole series of
WAN protocols which enable the interaction of routers made by different manufacturers since this protocol is sup-
ported by practically all manufacturers.

Due to the increasing importance of this protocol family and the fact that PPP is not associated with any specific
operating mode of the routers, we will be introducing the functions of the devices associated with the PPP here in a
separate section.

7.6.1 The protocol

What is PPP?

The point-to-point protocol was developed specifically for network connections via serial channels and has asserted
itself as the standard for connections between routers. It implements the following functions:

> Password protection according to PAP, CHAP or MS CHAP

> Callback functions

> Negotiation of the network protocol to be used over the connection established (IP or IPX, for example). Included
in this are any parameters necessary for these protocols, for example IP addresses. This process is carried out
using IPCP (IP Control Protocol).

> Verification of the connection through the LCP (Link Control Protocol)
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» Combining several ISDN channels (MultiLink PPP)

PPP is the standard used by router connections for communication between devices or the WAN connection software
of different manufacturers. Connection parameters are negotiated and a common denominator is agreed using stan-
dardized control protocols (e.g. LCP, IPCP, CCP) which are contained in PPP, in order to ensure successful data transfer
where possible.

What is PPP used for?

It is best to use the point-to-point protocol in the following applications:

» for reasons of compatibility when communicating with external routers, for example
> remote access from remote workstations with ISDN cards

> Internet access (when sending addresses)

The PPP which is implemented by LANCOM can be used synchronously or asynchronously not only via a transparent
HDLC connection, but also via an X.75 connection.

The phases of PPP negotiation

connections

Establishment of a connection using PPP always begins with a negotiation of the parameters to be used for the con-
nection. This negotiation is carried out in four phases which should be understood for the sake of configuration and
troubleshooting.

> Establish phase
Once a connection has been made at the data communication level, negotiation of the connection parameters
begins through the LCP.
This ascertains whether the remote site is also ready to use PPP, and the packet sizes and authentication protocol
(PAP, CHAP, MS-CHAP or none) are determined. The LCP then switches to the opened state.

> Authenticate phase

Passwords will then be exchanged, if necessary. The password will only be sent once if PAP is being used for the
authentication process. An encrypted password will be sent periodically at adjustable intervals if CHAP or MS
CHAP is being used.

Perhaps a callback is also negotiated in this phase via CBCP (Callback Control Protocol).
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» Network phase
LANCOM, supports the protocols IPCP and IPXCP.

After the password has been successfully transmitted, the IPCP and/or IPXCP network layer can be established.

IP and/or IPS packets can be transferred from the router modules to the opened line if the negotiation of para-
meters is successful for at least one of the network layers.

» Terminate phase
In the final phase the line is cleared, when the logical connections for all protocols are cleared.
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PPP negotiation in the LANCOM

The progress of a PPP negotiation is logged in the devices' PPP statistics and the protocol packets listed in detail
there can be used for checking purposes in the event of an error.

The PPP trace outputs offer a further method of analysis. You can use the command
trace + ppp

to begin output of the PPP protocol frames exchanged during a terminal session. You can perform a detailed analysis
once the connection has been broken if this terminal session has been logged in a log file.

7.6.2 Everything o0.k.? Checking the line with LCP

The devices involved in the establishment of a connection through PPP negotiate a common behaviour during data
transfer. For example, they first decide whether a connection can be made at all using the security procedure, names
and passwords specified.

The reliability of the line can be constantly monitored using the LCP once the connection has been established. This
is achieved within the protocol by the LCP echo request and the associated LCP echo reply. The LCP echo request is
a query in the form of a data packet which is transferred to the remote station along with the data. The connection
is reliable and stable if a valid response to this request for information is returned (LCP echo reply). This request is
repeated at defined intervals so that the connection can be continually monitored.

What happens when there is no reply? First a few retries will be initiated to exclude the possibility of any short-term
line interference. The line will be dropped and an alternative route sought if all the retries remain unanswered. If, for
example, the high-speed connection refuses to work, an existing ISDN port can open the way to the Internet as a
backup.

‘/ﬁ \ During remote access of individual workstations with Windows operating systems, we recommend switching
\ off the regular LCP requests since these operating systems do not reply to LCP echo requests.

C.‘ The LCP request behaviour is configured in the PPP list for each individual connection. The intervals at which
LCP requests should be made are set by the entries in the 'Time' and 'Retr." fields, along with the number of
retries that should be initiated without a response before the line can be considered faulty. LCP requests can
be switched off entirely by setting the time at '0" and the retries at '0'.

7.6.3 Assignment of IP addresses via PPP

In order to connect computers using TCP/IP as the network protocol, all participating computers require a valid and
unique IP address. If a remote station does not have its own IP address (such as the individual workstation of a
telecomputer), the LANCOM assigns it an IP address for the duration of the connection, enabling communications
to take place.
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This type of address assignment is carried out during PPP negotiation and implemented only for connections via
WAN. In contrast, the assignment of addresses via DHCP is (normally) used within a local network.

t“ Assignment of an IP address will only be possible if the LANCOM can identify the remote station by its call

number or name when the call arrives, i.e. the authentication process has been successful.

Examples

>

Remote access

Address assignment is made possible by a special entry in the IP routing table. 255.255.255.255 is specified as
the network mask as the IP address to be assigned to the remote site in the ‘Router-name’ field. In this case, the
router name is the name, with which the remote site must identify itself to the LANCOM.

In addition to the IP address, the addresses of the DNS and NBNS servers (Domain Name Server and NetBIOS
Name Server) including the backup server from the entries in the TCP/IP module are transmitted to the remote
station during this configuration.

So that everything functions properly, the remote site must also be adjusted in such a way that it can obtain the
IP address and the name server from the LANCOM. This can be accomplished with Windows dial-up networking
through the settings in the 'TCP settings' under 'IP address' and 'DNS configuration'. This is where the options
'IP address assigned by server' and 'Specify name server addresses' are activated.

Internet access

If Internet access for a local network is realized via the LANCOM, the assignment of IP addresses can occur in a
reverse manner. Configurations are possible in which the LANCOM does not have a valid IP address in the Inter-

net and is assigned one by the Internet provider for the duration of the connection. In addition to the IP address,
the LANCOM also receives information via the DNS server of the provider during the PPP negotiation.

In the local network, the LANCOM is only known by its internal valid intranet address. All workstations in the
local network can then access the same Internet account and also reach e.g. the DNS server.

Windows users are able to view the assigned addresses via LANmonitor. In addition to the name of the remote sta-
tion, the current IP address as well as the addresses of DNS and NBNS servers can be found there. Options such as
channel bundling or the duration of the connection are also displayed.
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7.6.4 Settings in the PPP list

You can specify a custom definition of the PPP negotiation for each of the remote sites that contact your net.

LANconfig Communication P> Protocols > PPP list
WEBconfig Expert Configuration P> Setup » WAN-module b
PPP-list
Terminal/Telnet cd /setup/WAN module
set PPP-list [...]

The PPP list may have up to 64 entries and contain the following values:

=
§ S _

S
25
© g Remote site Name the remote site uses to identify itself to your router.
E’ S (device name)
= O
g < User name The name with which your router logs onto the remote site. The device name of your router is used if nothing is
s specified here.

Password Password transferred by your router to the remote site
(if demanded).

An asterisk (*) in the list indicates that an entry is present.

Auth. Security method used on the PPP connection ('PAP*, ‘CHAP' or ‘none’). Your own router demands that the remote
site observes this procedure. Not the other way round.

This means that 'PAP*, ‘CHAP" security is not useful when connecting to Internet service providers, who may not
wish to provide a password. Select ‘none' as the security attribute for connections such as these.

Time Time between two checks of the connection with LCP (see the following section). This is specified in multiples of 10
seconds

(i.e. 2 for 20 seconds, for instance).

The value is simultaneously the time between two verifications of the connection to CHAP. Enter this time in minu-
tes.

The time must be set to '0' for remote sites using a Windows operating system.

Retr. Number of retries for the check attempt. You can eliminate the effect of short-term line interference by selecting
multiple retries. The connection will only be dropped if all attempts are unsuccessful. The time interval between
two retries is 1/10 of the time interval between two checks.

Simultaneously the number of the “Configure requests” that the router maximum sends before it assumes a line
error and clears the connection itself.

Conf, Fail, Term These parameters are used to affect the way in which PPP is implemented. The parameters are defined in RFC 1661
and are not described in greater detail here. You will find troubleshooting instructions in this RFC in connection
with the router's PPP statistics if you are unable to establish any PPP connections.

The default settings should generally suffice.

These parameters can only be modified via LANconfig, SNMP or TFTP!
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7.7 DSL Connection with PPTP

Some DSL providers enable dail-in over PPTP (Point-to-Point Tunneling Protocol) instead of PPPoE. PPTP is an exten-
sion of PPP, partly developed by Microsoft.

With PPTP it is possible to build up a “tunnel” over IP nets to a remote station. A tunnel is a logical shield connection,
that protects the tranferred data from unauthorized access. For this purpose the encoding algorithm RC4 is used.

Configuration of PPTP

As soon as the internet access over PPTP is selected the LANCOM enquires all needed PPTP parameters with the
Internet Access Wizard. Additionally to the entries for PPPoE access the IP address of the gateway must be specified.
A PPTP gateway is often a DSL modem. Detailled information is available from your DSL provider.

The PPTP list for editing the configuration can be reached as follows:

PPTP-name-list

=
S e
fofiguationstool Liste s
S
LANconfig Communication P> Protocols P> PPTP list S g
o> S
WEBconfig Expert Configuration P> Setup P WAN-module » S g
5 G

S

oc

Terminal/Telnet cd /Setup/WAN-Modul
set PPTP-List [...]

The PPTP configuration consists of three parameters:

> 'Remote site'—the entry from the DSL name list.

> 'IP address'—IP address of the PPTP gateway, often the address of the DSL modem.

» 'Port'—IP port the PPTP protocol runs on. For conformity with the protocol standard enter the port '1.723".

7.8 Extended connection for flat rates—Keep-alive

The term flat rate is used to refer to all-inclusive connection rates that are not billed according to connection times,
but instead as a flat fee for fixed periods. With flat rates, there is no longer any reason to disconnect. On the contrary:
New e-mails should be reported directly to the PC, the home workplace is to be continuously connected to the com-
pany network and users want to be able to reach friends and colleagues via Internet messenger services (ICQ etc.)
without interruption. This means it is desirable to continuously maintain connections.

With the LANCOM the Keep-alive function ensures that connections are always established when the remote station
has disconnected them.

Configuration of Keep-alive function
The keep alive procedure is configured in the name list.
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If the holding time is set to 0 seconds, a connection is not actively disconnected by the LANCOM. The automatic
disconnection of connections over which no data has been transmitted for a longer time is deactivated with a hol-
ding time of 0 seconds then. However, connections interrupted by the remote site are not automatically re-establis-
hed with this setting.

With a holding time of 9,999 seconds the connection is always re-established after any disconnection. Additionally,
the connection is re-established after a reboot of the device ('auto reconnect’).

7.9 Callback functions

The LANCOM supports automatic callback via its ISDN port.

In addition to callback via the D channel, the CBCP (Callback Control Protocol) specified by Microsoft and callback
via PPP as per RFC 1570 (PPP LCP extensions) are also offered. There is also the option of a particularly fast callback
using a process developed by LANCOM. PCs with Windows operating system can be called back only via the CBCP.

7.9.1 Callback for Microsoft CBCP

With Microsoft CBCP, the callback number can be determined in various ways.
> The party called does not call back.

> The party called allows the caller to specify the callback number itself.

» The party called knows the callback numbers and only calls these back.

Via CBCP, it is possible to establish connection to the LANCOM from a PC with Windows operating system and also
to be called back by this PC. Three possible settings are selected in the name list via the callback entry as well as the
calling number entry.

Name list {ISDN) - New Entry 21 x|

Hame: | Mam oK A |

Phonenumber: I— el |
Short hold time: IZU— seconds

Short: hold time (bundle); IZD— seconds

Layer name: | PPPHOLC vI

Aukomatic callback:

& Mo callback

7 Call back the remote site

" Call back the remote site {Fast procedure)

connections

<
=
=
=
©
g
=
3
s

7 Call back the remote site after name verification
7 wait for callback from remate sie

No callback
For this setting, the callback entry must be set to 'off' when configuring via WEBconfig or in the console.
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Callback number specified by caller

For this setting the callback entry must be set to 'Call back the remote site after name verification' (or must have the
value 'Name' in WEBconfig or in the console). In the name list no telephone number may be specified.

After the Authentication an input window appears on the caller's screen in Windows that requests the ISDN tele-
phone number of the PC.

The calling number is determined in the LANCOM

For this setting the callback entry must be set to 'Call back the remote site after name verification' (or must be set
to the value 'Name' in WEBconfig or in the console). In the name list one telephone number must be specified.

Some Windows versions (especially Windows 98) prompt the user to confirm the callback to the telephone number
stored in the LANCOM (‘Administrator Specified’) with an input window. Other Windows versions only inform the
user that the PC is waiting for the callback from the LANCOM.

Callback Security x|
*r'ou may supply a callback location oK
to connect to PPP_LARNCOR. _

Specify the phone number of pour
current location. Cancel |

connections
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Callback to: (39

The callback to a Windows workstation occurs approx. 15 seconds after the first connection has been dropped. This
time setting cannot be decreased since it is a Windows default setting.

7.9.2 Fast callback using the LANCOM Systems process

This fast, LANCOM Systems-specific process is ideal if two LANCOM are to communicate with one another via call-

back.

> The caller who may wish to be called back can activate the function 'Wait for callback from remote site" in the
name list (or 'Looser' when configuring via WEBconfig, terminal program or Telnet).

> The callback party selects 'Call back the remote site (fast procedure)" in the name list and enters the calling num-
ber (‘'LANCOM" when configuring via WEBconfig, terminal program or Telnet).

f For fast callback using the LANCOM Systems method, the number list for answering calls must be kept up
. to date at both ends.
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7.9.3 Callback with RFC 1570 (PPP LCP extensions)

The callback as per 1570 is the standard method for calling back routers of other manufacturers. This protocol exten-
sion describes five possibilities for requesting a callback. All versions are recognized by LANCOM. All versions will be
processed in the same way, however:

The LANCOM drops the connection after authenticating the remote station and then calls back the station a few
seconds later.

Configuration

For callback as per PPP you select the option 'Call back the remote site' in LANconfig or ‘Auto’ with configuration
via WEBconfig, terminal program or Telnet.

(fi\ For callback as per PPP the number list for answering calls in the LANCOM must be up to date.

7.9.4 Overview of configuration of callback function

The following options are available in the name list under WEBconfig and terminal program/telnet for the callback
function:

‘Off* No callback occurs.
'Auto’ (not for The remote station will be called back if so specified in the name list. At first, the call is denied and as soon as the
Windows opera- channel is clear again, it is called back (duration is approx. 8 seconds). If the remote station is not found in the nume-

ting systems, see rical list, it is first accepted as the DEFAULT remote station, and the callback is negotiated during the protocol negoti-
below) ation. A charge of one unit is incurred for this.

‘Name' Before a callback occurs, a protocol negotiation is always carried out even when the remote station was found in the
numerical list (e.g. for computers with Windows having direct dialing on the device). Here only minor charges result.

‘LANCOM' When the remote station is found in the numerical list, a quick callback is carried out, i.e., the LANCOM sends a spe-
cial signal to the remote station and calls back immediately when the channel is clear again. After approx. 2 seconds,
the connection is established. If the remote station does not take back the call immediately after the signal, then after
two seconds the situation reverts back to normal callback procedures (duration is once again approx. 8 seconds). This
process is only available for DSS1 connections.

'Looser Use the 'Looser' option when a callback is expected from the remote station. This setting carries out two functions
simultaneously. On the one hand, it ensures that a custom connection setup is taken back when there is an incoming
call from the called remote station, and on the other hand, the function is activated with this setting to be able to
react to the rapid callback procedure. In other words, in order to be able to use rapid callback, the caller must be in
the 'Looser' mode while the party being called must discontinue callback with ‘LANCOM'.

The setting ‘Name' offers the greatest security when an entry is made into the number list as well as the PPP
list. The setting 'LANCOM" offers the fastest callback method between two LANCOM Systems routers.
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(Q»‘ With Windows remote stations, the ‘Name' setting must be selected.

7.10 Channel bundling with MLPPP

When establishing an ISDN connection to a remote station with PPP capability, you can transmit data more quickly.
Data can be compressed and/or several B channels can be used for data transmission (channel bundling).

Connecting with cable bundling is distinguished from “normal” connections in that not only one, but rather several
B channels are used parallel for data transmission.
MLPPP (Multilink PPP) is used for channel bundling. This procedure is of course only available when PPP is used as

the B-channel protocol. MLPPP is used e.g. for Internet access via Internet provider, which also operate remote sta-
tions with MLPPP capability from your direct dialing nodes.

Two methods of channel bundling

> Static channel bundling

If a connection is established with static channel bundling, the LANCOM tries to establish the second B channel
immediately after setting up the first B channel. If this does not work because, for example, this channel is
already taken by another device or a different connection within the LANCOM, the connection attempt is auto-
matically and regularly repeated until the second channel is available for it.

connections
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» Dynamic channel bundling
In the case of a connection with dynamic channel bundling, the LANCOM first only establishes one B channel
and begins transmitting data. If, during this connection, it determines that the throughput rate lies above a cer-
tain threshold value, it tries to add the second channel.

If the second channel is established and the data throughput rate drops below the threshold value, the LANCOM
waits for the set B2 timeout period and then automatically closes the channel again. In this way, the per minute
charges are fully utilized so long as rate information is communicated during the connection. Therefore, the
LANCOM only uses the second B channel if and as long as it really needs it.

Here's how to configure your system to combine channels
The configuration of channel bundling for a connection is made up of three settings.

(1) Select a communication layer for the remote station from the layer list that has bundling activated in the Layer-
2 options. Select from the following Layer-2 options:

> compr. according to the LZS data compression procedure (Stac) reduces the amount of data if the data
hasn't already been compressed. This procedure is also supported by routers of other manufacturers and by
ISDN adapters under Windows operating systems.

> bundle uses two B channels per connection.

> bnd+empr uses both (compression and channel bundling) and provides the maximum possible data trans-
mission performance.
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(2 Now create a new entry in the name list. When doing so, watch the holding times for the connection. Please
observe the following rules:

> Depending on the type of application, the B1 hold time should be increased to such a level so that the con-
nection is not dropped prematurely because of packets not being transmitted for a short time. Experience
has shown that values between 60 and 180 seconds are a good basis which can be adapted as required
during operation.

> The B2 holding time determines whether static or dynamic channel bundling will be used (see above). A B2
holding time of ‘0" or '9999" ensures that the bundling will be static; values in between permit dynamic
channel bundling. The B2 holding time defines how long the data throughput may lie below the threshold
for dynamic channel bundling without the second B channel automatically being disconnected.

(3 Use the entry for the Y connection in the Router interface list to determine what should happen if a second con-
nection to a different remote station is requested during an existing connection using channel bundling.

WEBconfig Expert Configuration > Setup» WAN-module »

Router-interface-list

Terminal/Telnet cd /setup/WAN-module

set router-interface-list [...]

I> Y connection On: The router interrupts the bundled connection to establish a connection to the other remote
station. When the second channel is free again, the originally bundled connection automatically takes the
channel back (always in the case of static bundling, only as required when using dynamic bundling).

> Y connection Off: The router maintains the existing bundled connection; the establishment of the new con-
nection must wait.

ﬁ Please note that if channel bundling is used, the cost of two connections is charged.Here no additional con-
nections via the LANCAPI are possible! So you should only use channel bundling if the double transmission
capacity can really be used in full.
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8 Firewall

For most companies and many private users a work without the Internet is no longer conceivable. E-mail and web
are indispensable for communication and information search. But each connection of the workstations from the
own, local network to the Internet represents however a potential danger: Unauthorized users can try to see your
data via this Internet connection, to modify it or to manipulate your PCs.

Therefore this chapter covers an important topic: the firewall as defensive measure against unauthorized access.
Besides a brief introduction to the topic of Internet security, we show you which protection a LANCOM is able to
offer you by right configuration and how to make the needed specific settings.

8.1 Threat analysis

To plan and to realize suitable measures to guarantee security, it is advisable to know first all possible sources of
danger:

» Which imminent dangers exist for the own LAN resp. the own data?
» Which are the ways intruders take for the access to your network?
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@ We denote the intrusion into protected networks in the following as “attack” according to the general usage,
and the intruder thus as “attacker”.

8.1.1 The dangers

The dangers in the Internet arise in principle from completely different motives. On the one hand the perpetrators
try to enrich themselves personally or to damage the victims systematically. By the ever increasing know-how of the
perpetrators, the “hacking” became already a kind of sports, in which young people often measure who takes at first
the hurdles of Internet security.

Regardless of the individual motivation, the intention of the perpetrators mostly leads to the following aims:

> Inspect confidential information such as trade secrets, access information, passwords for bank accounts etc.

> Use of LAN workstations for purposes of the attackers, e. g. for the distribution of own contents, attacks to third
workstations etc.

» Modify data of LAN workstations, e. g. to obtain even further ways for access.
> Destroy data on the workstations of the LAN.
> Paralyse workstations of the LAN or the connection to the Internet.

C‘\\ We restrict ourselves in this section to the attacks of local networks (LAN) resp. to workstations and servers
*in such LANs.
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8.1.2 The ways of the perpetrators

In order to undertake their objectives, the perpetrators need at first a way to access your PCs and data. In principle,
the following ways are open as long as they are neither blocked nor protected:

> Via the central Internet connection, e. g. via routers.

» Via decentral connections to the Internet, e. g. modems of single PCs or mobile phones on notebooks.

> Via wireless networks operating as a supplement to wired networks.

((i In this chapter we only deal with the ways via the central Internet connection, via the router.

ak For hints on the protection of wireless networks, please refer to the respective chapters of this reference
F manual resp. of the appropriate device documentation.

8.1.3 The methods

Normally strangers have of course no access to your local area network or to the workstations belonging to it. Wit-
hout the appropriate access data or passwords nobody can thus access the protected area. If spying out of these
access data is not possible, the attackers will try another way to achieve their goals.

A fundamental starting point is to smuggle data on one of the allowed ways for data exchange into the network,
which opens from the inside the access for the attacker. Small programs can be transferred on a computer by appen-
dices in e-mails or active contents on web pages, e.g., in order to lead afterwards to a crash. The program uses the
crash to install a new administrator on the computer, which can then be used from distance for further actions in
the LAN.

If the access via e-mail or www is not possible, the attacker can also look out for certain services of servers in the
LAN, which are useful for his purposes. Because services of the servers are identified over certain ports of the TCP/
IP protocol, the search for open ports is also called “port scanning”. On the occasion, the attacker starts an inquiry
for particular services with a certain program, either generally from the Internet, or, only on certain networks and
unprotected workstations, which in turn will give the according answer.

A third possibility is to access an existing data connection and use it as a free-rider. The attacker observes here the
Internet connection of the victim and analyses the connections. Then he uses e. g. an active FTP connection to
smuggle his own data packets into the protected LAN.

A variant of this method is the “man-in-the-middle” attack. The attacker observes here first the communication of
two workstations, and gets then in between.

8.1.4 The victims

The question about the degree of exposure for an attack influences to a considerable degree the expenditure one
wants to or must meet for defending. In order to assess whether your network would be particularly interesting for
an attacker as a potential victim, you can consult the following criteria:
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> Particulary endangered are networks of common known enterprises or institutions, where valuable information
is suspected. Such information would be e.g. the results of research departments, which are gladly seen by
industrial spies. Or, on the other hand, bank servers, on which big money is distributed.

> Secondly, also networks of smaller organisations are endangered, which perhaps are only interesting to special
groups. On the workstations of tax consultants, lawyers or doctors do slumber certainly some information quite
interesting for third persons.

> Last but not least also workstations and networks are victims of attackers, which obviously offers no use for the
attackers. Just the “script kiddies” testing out their possibilities by youthful ambition are sometimes just sear-
ching for defenceless victims in order to practise for higher tasks.
The attack against an unprotected, apparently not interesting workstation of a private person can also serve the
purpose to prepare a basis for further attacks against the real destination in a second step. The workstation of
“no interest” becomes source of attacks in a second step, and he attacker can disguise his identity.

All things considered, we can resume that the statistical probability for an attack to the network of a global player
of the industry may be higher than to a midget network of the home office. But probably it is only a matter of time
that a defenceless workstation installed in the Internet will - perhaps even accidentally - become the victim of
attacks.
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8.2 What is a Firewall?

The term “Firewall” is interpreted very differently. We want to define at this point the meaning of “Firewall” within
the boundaries of this reference manual:

A Firewall is a compilation of components, which monitors at a central place the data exchange between two net-
works. Mostly the Firewall monitors the data exchange between an internal, local network (LAN), and an external
network like the Internet.

The Firewall can consist of hard and/or software components:
» In pure hardware systems the Firewall software often runs on a proprietary operating system.

» The Firewall software can also run on a conventional workstation, which is dedicated to this task under Linux,
Unix or Windows.

> As a third and frequently used alternative, the Firewall software runs directly within the router, which connects
the LAN to the Internet.

In the following sections we only look at the Firewall in a router.

@‘ The functions “Intrusion Detection” and “DoS protection” are part of the content of a Firewall in some appli-
cations. The LANCOM contains these functions also, but they are realised as separate modules beside the
Firewall.
Further information can be found in the section ‘Protection against break-in attempts: Intrusion Detection’
—page 144 and 'Protection against “Denial of Service” attacks” —page 145.
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8.2.1 Tasks of a Firewall

Checking data packets

How does the Firewall supervises the data traffic? The Firewall works in principle like a door keeper for data packets:
Each packet will be checked, whether it may pass the door of the network (Firewall) in the desired direction or not.
For such a checking different criteria are used, in common language of Firewalls called “rules” or “guidelines”.
Depending on the kind of information, which are used for creation of the rules and which are checked during the
operation of the Firewall, one distinguishes different types of Firewalls.

Above all, the aspect of the “central” positioning is very Important: Only when the entire data traffic between
“inside” and “outside” goes through the Firewall, it can fulfil its task reliably under any circumstances. Each alter-
native way can reduce or even turn off the security of the Firewall. This central position of the Firewall simplifies by
the way also the maintenance: One Firewall as common passage between two networks is certainly easier to
maintain than a “Personal Firewall” on each of the workstations belonging to the LAN.

@ In principle, Firewalls operate at the interconnection between two or more networks. For the following

explanation, we only look as example at the passage between a local network of a company and the Inter-

net. These explanations can be transferred however in a general manner also to other network constellati-

ons, e.g. for the protection of a subnetwork of the personnel department of a company against the remaining
network users.

Logging and alerting

An important function of the Firewall is beside the checking of data packets and the right reaction to the results of
this checking also the logging of all actions triggered by the Firewall. By analyzing these protocols, the administrator
can draw conclusions from the occurred attacks and on the basis of this information he can, if necessary, go on to
improve the configuration of the Firewall.

But sometimes, logging alone comes too late. Often, an immediate intervention of the administrator can prevent a
major danger. That is why Firewalls have mostly an alerting function, by which the Firewall notifies the administrator
e.g. by e-mail.

8.2.2 Different types of Firewalls

During the last years, the operating principles of Firewalls have more and more evolved. Under the generic term
“Firewall”, a whole range of different technical concepts is offered to protect the LAN. Here we introduce the most
important ones.

Packet filters

One speaks about a packet filter-based Firewall, if the router only checks the details in the header of the data packets
and decides on the basis of this information, whether the packet may pass or not. The following details belong to
the analyzed information:
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» IP address of source and destination

» Transfer protocol (TCP, UDP or ICMP)

» Port numbers of source and destination
> MAC address

The rules defined in a packet filter-orientated Firewall determine e.g., whether the packets may pass on by a special
IP address range into the local network, or whether packets should be filtered for special services (i.e. with special
port numbers). By these measures, the communication with certain workstations, entire networks or via special ser-
vices can be reduced or even prevented. Besides, the rules are combinable, so that e.g. only workstations with special
IP addresses get access to the Internet via the TCP port 80, while this services remains blocked for all other work-
stations.

The configuration of packet filtering Firewalls is quite simple, and the list with the permitted or forbidden packets
can be extended very easily. Because also the performance requirements of a packet filter can be address with quite
little means, the packet filters are often directly implemented in routers, which operate as interface between the net-
works anyway.

An unfavourable effect on the packet filters is, that the list of rules becomes uncomfortable after a while. Besides,
for some services the connection ports are negotiated dynamically. To enable communication then, the administrator
has to leave open all possibly used ports, which is contrary to the basic orientation of most security concepts.

One example for a process, which is quite problematical for simple packet filters, is the establishing of a FTP con-
nection from a workstation of the own LAN to a FTP server in the Internet. By the generally used active FTP, the client
(of the protected LAN) sends an inquiry from a port of the upper range (>1023) to port 21 of the server. The client
informs the server, over which port it is expecting the connection. The server will establish as a result from its port
20 a connection to the desired port of the client.
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Source port 4321

Destination port 4322 Source port 20
Client Server

To enable this process, the administrator of the packet filter must open all ports for incoming connections, because
he does not know in advance for which port the client will inquire the FTP connection. An alternative is to use passive
FTP. Thereby, the client establishes the connection itself to the server over a particular port, which was told to the
server before. This process is, however, not supported by all clients/servers.

If we furthermore compare the Firewall with a porter, this door keeper only checks, whether he knows or not the
courier with the packet at the door. If the courier is known and came ever into the building before, he has the per-
mission to go in without hindrance and without being checked also for all following orders up to the workplace of
the addressee.
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Stateful Packet Inspection

Stateful Packet Inspection (SPI), or briefly Stateful Inspection, enhances the packet filter approach by checking
further connection state information. Beside the more static table with the permitted ports and address ranges, a
dynamic table will be kept up in this variant, in which information about the connection state of the individual con-
nections is held. This dynamic table enables to first block all endangered ports, and to selectively open only if
required a port for a permitted connection (adjusted by source and destination address). The opening of ports is
always made from the protected network to the unprotected one, that means mostly from LAN to WAN (Internet).
Data packets that do not belong to one of the tracked session of the connection state table will be automatically
discarded.

Stateful Inspection: direction-dependent checking

The filter sets of a Stateful Inspection Firewall are - contrary to classical port filter Firewalls - dependent on their
direction. Connections can only be established from source to their destination point. The other direction would
require an explicit filter entry as well. Once a connection has been established, only the data packets belonging
to this connection will be transmitted - in both directions, of course. So you can block in a reliable way all traffic
not belonging to a known session, not coming from the local network.

Additionally, the Stateful Inspection is able to track from the connection set up, whether additional channels are
negotiated for data exchange or not. Some protocols like e.g. FTP (for data transfer), T.120, H.225, H.245 and H.323
(for netmeeting or IP telephony), PPTP (for VPN tunnels) or IRC (for chatting) signalize when establishing the con-
nection from the LAN to the Internet by a particular used source port whether they are negotiating further ports with
the remote station. The Stateful Inspection dynamically adds also these additional ports into the connection state
list, of course limited to the particular source and destination addresses only.

Let's have once again a look at the FTP download example. When starting the FTP session, the client establishes a
connection from source port '4321" to the destination port '21' of the server. The Stateful Inspection allows this first
set up, as long as FTP is allowed from local workstations to the outside. In the dynamic connection state table, the
Firewall enters source and destination and the respective port. Simultaneously, the Stateful Inspection can inspect
the control information, sent to port 21 of the server. These control signals indicate that the client requires a con-
nection of the server from its port 20 to port 4322 of the client. The Firewall also enters these values into the dynamic
table, because the connection to the LAN has been initiated from the client. Afterwards, the server can send so the
desired data to the client.
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Dest. port 4322

Source port 2

IP: 80.146.204.15 O

But if another workstation from the Internet tries to use the just opened port 4322 of the LAN to file itself data from
its port 20 on the protected client, the Firewall will stop this try, because the IP address of the attacker does not fit
to the permitted connection!
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After the successful data transfer, the entries disappear automatically from the dynamic table and the ports
@ will be closed again.

Moreover, a Firewall with Stateful Inspection is mostly able to re-assemble the received data packets, that means to
buffer the individual parts and to assemble them again to an complete packet. Therefore, complete IP packets can
be checked by the Firewall, rather than individual parts only.

This porter is making a definite better job. When somebody in this company orders a courier, he must also inform
the porter that he is expecting a courier, when he will be arriving and what information should be found on the deli-
very note. Only when this information matches the logbook entries of the porter, the courier may pass. If the courier
brings not only one packet, but rather two, only the one with the correct delivery note will pass. Likewise, a second
courier demanding access to the employee will be rejected, too.

Application Gateway

By checking of contents on application level, Application Gateways increase the address checking of the packet fil-
ters and the connection monitoring of the Stateful Packet Inspection. The Application Gateway runs mostly on a
separate workstation, because of the high demands to the hardware performance. This workstation is between the
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local network and the Internet. Seen from both directions, this workstation is the only possibility to exchange data
with the respective other network. There doesn’t exist any direct connection between these two networks, but just
to the Application Gateway.

Internet Application gateway Local nétwork

The Application Gateway is thus a kind of proxy for each of the two networks. Another term for this constellation is
the “dualhomed gateway”, because this workstation is so to speak at home in two networks.

For each application to be allowed through this gateway, an own service will be set up, e.g. SMTP for mail, HTTP for
surfing the Internet or FTP for data downloads.
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This service accepts data received by either one of the two sides and depicts it to the respective other side. What
seems to be at first sight a needless mirroring of existing data, is on closer examination the far-reaching concept of
Application Gateways: It never exists a direct connection e.g. between a client of the local network and a server of
the Internet. The LAN workstations only see the proxy, the workstations of the Internet likewise. This physical sepa-
ration of LAN and WAN, makes it quite difficult for attackers to intrude into the protected network.

Applied to the porter example, the packet will be left at the gate, the courier is not allowed to enter the company
premises. The porter takes the packet, will open it after checking address and delivery note and will control also the
content. When the packet has taken these hurdles successfully, then the company internal courier will bring it himself

Local network
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to the addressee of the company. He became proxy of the courier on company premises. The other way around, all
employees, wanting to send a packet, have to inform the porter, which has to collect the packet at the workstation
place and which will hand over the packet to the ordered courier at the gate.

Functions of Application Gateways are not supported by the LANCOM, mainly because of the high hardware
demands.

8.3 The LANCOM Firewall

After general explanations concerning the dangers of the Internet and the tasks and types of Firewalls, this chapter
describes special functions of the LANCOM Firewall and concrete configurations.
8.3.1 How the LANCOM Firewall inspects data packets

The Firewall filters only those data packets out of the entire data stream running through the IP router of the
LANCOM, for which a special treatment has been defined.
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The Firewall only checks routed data packets!

IP-Redirect

LAN interfaces

‘connection via LAN/Switch :

=
<
=
2
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IPX over PPTP/VPN

The Firewall only checks data packets routed by the IP router of the LANCOM. In general, these are the data
packets, which are exchanged between one of the WAN interfaces and the internal networks (LAN, WLAN,
DMZ).

For example, the communication between LAN and WLAN is normally not carried out by the router, as long as
the LAN bridge allows a direct exchange. Thus the Firewall rules do not apply here. The same applies to the so-
called “internal services” of the LANCOM like Telnet, TFTP, SNMP and the web server for the configuration with
WEBconfig. The data packets of these services do not run through the router, and therefore aren't influenced by
the Firewall.

Due to the positioning behind the masquerading module (seen from the WAN), the Firewall operates
with the “"real” internal IP addresses of the LAN stations, and not with the outside known Internet
address of the LANCOM.
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The LANCOM Firewall uses several lists for checking data packets, which are automatically generated from Firewall
rules, resulting Firewall actions or by active data connections:

» Host block list

> Port block list

» Connection list

> Filter list

When a data packet should be routed via the IP router, the Firewall uses the lists as follows:

(1) The first check is, whether the packet was coming from a workstation belonging to the host block list. If the
sender is blocked, the packet will be discarded.

(2 Ifthe sender is not blocked in this list, the port block list will be checked, if the used port/protocol combination
on the destination PC is closed. In this case the packet will be discarded.

(@ If sender and destination are not blocked in the first two lists, then it will be checked whether a connection entry
exists for this packet in the connection list. If such an entry exists, then the packet will be handled as noted in
this list.

@) If no entry has been found for the packet, then the filter list will be searched, whether a suitable entry exists
and the action indicated in this list will be carried out. If the action intends to accept the packet, then an entry
is made in the connection list, as well as for any further actions.
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——> Host blocked?
——=3 Port blocked?
=3 ACtive connection?
3 Filter list?

LAN interfaces

VPN services A ———t

(

IP router

| H 7
: f
‘connection via LANISwi% I
IP-Redirect

IPX over PPTP/VPN

If no explicit Firewall rule exists for a data packet, the packet will be accepted ('Allow-All'). That grants a
backward-compatibility for existing installations. For maximum protection by the Stateful Inspection, please
note the section ‘Set-up of an explicit "Deny All" strategy’ —page 124.

The four lists obtain their information as follows:

> In the host block list are all those stations listed, which are blocked for a certain time because of a Firewall
action. The list is dynamic, new entries can be added continuously with appropriate actions of the Firewall. Ent-
ries automatically disappear after exceeding the timeout.

> In the port block list those protocols and services are filed, which are blocked for a certain time because of a
Firewall action. This list is likewise a dynamic one, new entries can be added continuously with the appropriate
Firewall actions. Entries automatically disappear after exceeding the timeout.

> For each established connection an entry is made in the connection list, if the checked packet has been accep-
ted by the filter list. In the connection list is noted from which source to which destination, over which protocol
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and which port a connection is actually allowed. The list contains in addition, how long an entry will stay in the
list and which Firewall rule is responsible for the entry. This list is very dynamic and permanently “moving”.

> The filter list is made of the Firewall rules. The containing filters are static and only changed when Firewall
rules are added, edited or deleted.

Thus all lists, which are consulted by the Firewall to check data packets, finally base on the Firewall rules ('Parameters

of Firewall rules’ —page 112).

8.3.2 Special protocols

One important point during the connection tracking is the treatment of protocols that dynamically negotiate ports
and/or addresses, over which further communication is done. Examples of these kinds of protocols are FTP, H.323 or
also many UDP-based protocols. Thereby it is necessary that further connections must be opened, additionally to the
first connection. See also 'Different types of Firewalls” —page 98.

UDP connections

UDP is actually a stateless protocol, nevertheless one can speak regarding UDP-based protocols also of a (only short
term) connection, since UDP mostly carries Request/Response based protocols, with which a client directs its
requests to a well known port of a server (e.g. 53 for DNS), which in turn sends its responds to the source port selec-
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12345 Request 53
—

12345 Response 53
-

However, if the server wants to send larger sets of data (e.g. TFTP) and would not like or can not differentiate on the
well known port between requests and acknowledges, then it sends the response packets to the source port of the
sender of the original request, but uses as its own source port a free port, on which it reacts now only to those
packets, which belong to the data communication:

12345 Request 69
—
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12345 Response 54321
-

12345 Ack/Data 54321
—>

12345 Data/Ack 54321
-—

While the data communication takes place now over the ports 12345 and 54321, the server on the well-known port
(69) can accept further requests. If the LANCOM pursues a "Deny All" strategy, the answer packets of an entry of the
port filter Firewall, which permits only a connection to port 69 of the server, would simply be discarded. In order to
prevent this, when creating the entry in the connection state database, the destination port of the connection is kept
free at first, and set only with the arrival of the first answer packet, whereby both possible cases of an UDP connec-
tion are covered.

TCP connections

TCP connections cannot be tracked only by examination of the ports. With some protocols (e.g. FTP, PPTP or H.323)
examinations of the utilizable data are necessary to open all later negotiated connections, and to accept only those
packets belonging really to the connections. This corresponds to a simplified version of IP masquerading, but without
addresses or ports to be re-mapped here. It is sufficient to pursue the negotiation to open appropriate ports, and
link them with the main connection, so that these ports are closed likewise with the closing of the main connection,
and traffic on the secondary connection keeping open also the main connection.

ICMP connections

For ICMP two cases must be differentiated: The ICMP request/reply connections, like to be used with "ping", and the
ICMP error messages, which can be received as an answer to any IP packet.

ICMP request/reply connections can be clearly assigned to the identifier used by the initiator, i.e. in the status data-
base an entry will be provided with the sending of an ICMP request, which lets through only ICMP replies with the
correct identifier. All other ICMP replies will get discarded silently.

In ICMP error messages, the IP header and the first 8 bytes of the IP packet (on behalf UDP or TCP headers) can be
found within the ICMP packet. With the help of this information, the receipt of an ICMP error message triggers auto-
matically the search for the accessory entry in the status database. The packet passes only if such an entry exists,
otherwise it is discarded silently. Additionally, potentially dangerous ICMP error messages (redirect route) are filtered
out.
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Connections of other protocols

For all other protocols no related connections can be followed up, i.e. with them only a connection between involved
hosts can occur in the status database. These can be initiated also only from one side, unless, in the port filter Fire-
wall exists a dedicated entry for the "opposite direction”.

8.3.3 General settings of the Firewall
Apart from individual Firewall rules, which ensure the entries in the filter, connection and block lists, some settings
apply generally to the Firewall:

Firewall/QoS enabled

Default VPN rules (—Seite 109)
Administrator email (—Seite 110)
Fragments (—Seite 110)

Re-establishing of the session (—Seite 110)
Ping blocking (—Seite 110)

Stealth mode(—Seite 111)

Mask authentication port (—Seite 111)

vVVvVvVvVvvVvYVyYVYyYy
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Firewall/QoS enabled
This option switches on or off the entire Firewall, including Quality of Service functions.

a\ Please notice that the N:N mapping functions ('N:N mapping’ —page 74) are only active when the Firewall
~ has been switched on!

Default VPN rules

A VPN rule consists, apart from some VPN specific information and among other things, of the definition of source

and destination networks. The information about source and destination can get in principle from the IP routing

table, the TCP/IP settings (Intranet addresses and DMZ addresses), or from the Firewall rules.

Similar to Quality of Service functions, VPN connections also use existing Firewall functions in order to classify e. g.

the packets according to their subnetworks. Therefore, the Firewall is a central source for the VPN rules. It can be

defined in the Firewall whether further sources should be used for the VPN rules or not. The according option can

take on the following values:

> Create automatically: With this setting, all available sources for generating VPN rules will be consulted, i.e. IP
routing table, TCP/IP settings and Firewall rules.

» Specify manually: With this setting only the manually specified Firewall rules are used as base for creating VPN
rules.
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(1% For detailed information about VPN rules, please see the appropriate VPN documentation.

Administrator email

One of the actions a Firewall can trigger is alerting of an network administrator via email. The “administrator email”
is the email account, to which the alerting mails are sent to.

Fragments

Some attacks from the Internet try to outsmart the Firewall by fragmented packets (packets split into several small
units). One of the main features of a Stateful Inspection like in the LANCOM is the ability to re-assemble fragmented
packets in order to check afterwards the entire IP packet.

You can centrally adjust the desired behaviour of the Firewall. The following options are available:

> Filter: Fragmented packets are directly discarded by the Firewall.

> Route: Fragmented packets are passed on without any further checking by the Firewall, as long as permitted by
valid filter settings.

> Re-assemble: Fragmented packets are buffered and re-assembled to complete IP packets. The re-assembled
packets will then be checked and treated according to the valid filter settings.

Session recovery

The Firewall enters all actual permitted connections into the connection list. Entries disappear automatically from

the connection list after a certain time (timeout), when no data has been transmitted over this connection any more

re-triggering the timeout.

Sometimes connections are ended according to the general TCP aging settings, before data packets requested by an

inquiry have been received by the remote station. In this case perhaps an entry for a permitted connection still exists

in the connection list, but the connection itself is no more existing.

The parameter “Session recovery” determines the behaviour of the Firewall for packets that indicate a former con-

nection:

> Always denied: The Firewall re-establishes the session under no circumstances and discards the packet.

» Denied for default route: The Firewall re-establishes the session only if the packet wasn't received via the
default route (e.g. Internet).

> Denied for WAN: The Firewall re-establishes the session only if the packet wasn't received over one of the WAN
interfaces.

> Always allowed: The Firewall re-establishes the connection in principle if the packet belongs to a former con-
nection of the connection list.

Ping blocking

One - not undisputed - method to increase security is hiding the router. Based loosely on the method: “Who doesn’t
see me neither tries to attack me...". Many attacks begin with the searching for workstations and/or open ports by
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actual harmless inquiries, e. g. with the help of the “ping” command or with a portscan. Each answer to these inqui-
ries, even the answer “I'm not here” indicates to the attacker that he has found a potential destination. Because
anybody who answers must be existing, too. In order to prevent this conclusion, the LANCOM is able to suppress the
answers to these inquiries.

In order to achieve this, the LANCOM can be instructed not to answer ICMP echo requests any more. At the same
time TTL-exceeded messages of a "trace route" are also suppressed, so that the LANCOM cannot be found, neither
by “ping" nor by "trace route".

Possible settings are:

> Off: ICMP answers are not blocked.

> Always: ICMP answers are always blocked.

» WAN only: ICMP answers are blocked on all WAN connections.

> Default route only: ICMP answers are blocked on default route (usually Internet).

TCP Stealth mode

Apart from ICMP messages, also the behaviour in case of TCP and UDP connections gives information on the exis-
tence or non-existence of the addressed workstation. Depending on the surrounding network it can be useful to sim-
ply reject TCP and UDP packets instead of answering with a TCP RESET resp. an ICMP message (port unreachable),
if no listener for the respective port exists. The desired behaviour can be adjusted in the LANCOM.
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((i“ If ports without listener are hidden, this generates a problem on masked connections, since the "authenti-
~ cate" - resp. "ident" service does no longer function properly (resp. do no longer correctly reject). The appro-
priate port can so be treated separately ("Mask authentication port’ —page 111).

Possible settings are:

> Off: All ports are closed and TCP packets are answered with a TCP reset.

> Always: All ports are hidden and TCP packets are silently discarded.

» WAN only: On the WAN side all ports are hidden and on the LAN side closed.

> Default route only: Ports are hidden on the default route (usually Internet) and closed on all other routes.

Mask authentication port

When TCP or UDP ports are hidden, inquiries of mail servers to authenticate users can no more be answered correctly.
Inquiries of the servers run into a timeout, and delivery of mails will be considerably delayed.

Also when the TCP Stealth mode is activated, the Firewall detects the intention of a station in the LAN to establish
a connection to a mail server. As a result, the needed port will be opened for a short time (20 seconds) solely for the
authentication inquiry.

This behaviour of the Firewall in TCP Stealth mode can be suppressed specifically with the parameter “Always mask
authentication port, too”.

m
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(‘ The activation of the option “Mask authentication port” can lead to considerable delays for the dispatch and
* receipt of e. g. e-mails or news!

A mail or a news server, which requests any additional information from the user with the help of this service, runs
first into a disturbing timeout, before it begins to deliver the mails. This service needs thus its own switch to hide
and/or to hold it “conformingly”.

The problem thereby is however that a setting, which hides all ports, but rejects the ident port is unreasonable -
alone by the fact that rejecting the ident port would make the LANCOM visible.

The LANCOM offers now the possibility to reject ident inquiries only by mail and news servers, and to discard those
of all other PCs. For this, the ident inquiries of the respective servers are rejected for a short time (20 seconds) when
a mail (SMTP, POP3 IMAP2) or a news server (NNTP) is calling up.

When the timeout is exceeded, the port will be hidden again.

8.3.4 Parameters of Firewall rules

In this section we describe the components of Firewall rules and the available options to set up the different para-
meters.

Q Information regarding definition of Firewall rules with the different kinds of configuration tools (LANconfig,
' WEBconfig or Telnet) can be found in chapter ‘Configuration of Firewall rules’ —page 127.

Components of a Firewall rule

A Firewall rule is at first defined by its name and some further options:
» On/Off switch: Is the rule active for the Firewall?

» Priority: Which is the priority of the rule? (—Seite 112)

> Observe further rules: Should further Firewall rules be observed when this rule applies to a data packet?
(—Seite 113)

» Create VPN rule: Is this Firewall rule also used to create a VPN rule? (—Seite 113)

Priority

When setting up the filter list of the Firewall rules, the LANCOM will automatically sort the entries. Thereby the
“grade of detail” will be considered: All specified rules are observed at first, after that the general ones (e. g. Deny
All).

If after the automatic sorting the desired behaviour of the Firewall does not turn out, it is possible to change the
priority manually. The higher the priority of the Firewall rule, the earlier it will be placed in the according filter list.

@ For complex rule types please check the filter list as described in section ‘Firewall diagnosis’ —page 136.
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Observe further rules

There are requirements to a Firewall, which cannot be covered by a single rule. If the Firewall is used to limit the
Internet traffic of different departments (in own IP subnetworks), individual rules cannot e.g. illustrate the common
upper limit at the same time. If to everyone of e.g. three departments should be granted a bandwidth of maximal
512 kbps, but the entire data rate of the three departments should not exceed a limit of 1024 kbps, then a multi-
level checking of the data packets must be installed:

> In afirst step it will be checked, if the actual data rate of the individual department does not exceed the limit of
512 kbps.

> In asecond step it will be checked, if the data rate of all departments together does not exceed the overall limit
of 1024 kbps.

Normally the list of the Firewall rules is applied sequentially to a received data packet. If a rule applies, the appro-
priate action will be carried out. The checking by the Firewall is terminated then, and no further rules will be applied
to the packet.

In order to reach a two-stage or multi-level checking of a data packet, the “Observe further rules option” will be
activated for the rules. If a Firewall rule with activated observation of further rules applies to a data packet, the
appropriate action will be carried out at first, but then the checking in the Firewall will continue. If one of the further
rules applies also to this data packet, the action being defined in this rule will also be carried out. If also for this
following rule the observe further rules option is activated, the checking will be continued until

> either a rule applies to the packet, for which observe further rules is not activated.

> orthelist of the Firewall rules has been completely worked through without applying a further rule to the packet.
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To realize this aforementioned scenario it is necessary to install for each subnetwork a Firewall rule that rejects from
a data rate of 512 kbps up additional packets of the protocols FTP and HTTP. For these rules the observe further rules
option will be activated. Defined in an additional rule for all stations of the LAN, all packets will be rejected which
exceed the 1024 kbps limit.

VPN rules
As described in section ‘Default VPN rules" —page 109, a VPN rule can receive its information about source and
destination network from Firewall rules.

By activating the option “This rule is used to create VPN rules” for a Firewall rule, you determine that a VPN rule will
be derived from this Firewall rule.

Apart from this basic information, a Firewall rule answers the question when and/or on what it should apply to and
which actions should be executed:

> Stations / Service: To which stations/networks and services/protocols does the rule refer to? (—Seite 115)

» Conditions: Is the effectiveness of the rule reduced by other conditions? (—Seite 116)

> Trigger: On exceeding of which threshold shall the rule being triggered? (—Seite 116)
4

Action: What should happen to the data packets when the condition applies and the limit is reached?
(—Seite 117)
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> Further measures: Should further measures be initiated apart from the packet action? (—Seite 117)

> Quality of Service (QoS): Are data packets of certain applications or with the corresponding markings trans-
ferred preferentially by assurance of special Quality of Services? (—Seite 117)

@ Condition, limit, packet action and other measures form together a so-called “action set”. Each Firewall rule
” can contain a number of action sets. If the same trigger is used for several action sets, the sequence of action
sets can be adjusted.

In section "How the LANCOM Firewall inspects data packets’ —page 103 we have already described that in the end
the lists for checking data packets are created from Firewall rules. Thus the extension of the block diagram looks like
as follows:
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Structure of the Firewall rules

> Host?
= Port?
> Connection?
—> Filter?

VPN services

\WAN interfaces

‘connection via LAN/Swit@

== == IP router

=
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=

IP-Redirect

IPX over PPTP/VPN

Connection

M The connection of a Firewall rule defines to which data packets the rule should refer to. A connection is defined by
its source, its destination and the used services. The following details can be used to specify the source or destina-
tion:
> All stations

The entire local network (LAN)

Certain remote stations (described by the name of the name list)

Certain stations of the LAN described by the host name)

Certain MAC' addresses

vvyyvyy
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> Ranges of IP addresses

» Complete IP networks

You can only operate with host names, when your LANCOM is able to transform the names into IP addresses. For
that purpose the LANCOM must have learned the names via DHCP or NetBIOS, or the assignment must be entered
staticly in the DNS or IP routing table. An entry in the IP routing table can therefore assign a name to a whole net-
work.

@ If the source or the destination for a Firewall rule has not been determined at greater detail, the rule applies
generally to data packets “from all stations” resp. “to all stations”.

The service is determined by the combination of an IP protocol with respective source and/or destination port. For
frequently used services (www, mail, etc.) the appropriate combinations are already predefined in the LANCOM,
others can be compiled additionally as required.

Condition

The effectiveness of a Firewall rule is also reduced with additional conditions. The following conditions are available:
> Only packets with certain ToS and/or DiffServ markings.

» Only, if the connection does not yet exist.

» Only for default route (Internet).

> Only for VPN routes.

Limit / Trigger

The limit or trigger describes a quantified threshold value that must be exceeded on the defined connection before
the filter action gets executed for a data packet. A limit is composed by the following parameters:

» Unit (kbit, kbyte or packets)

» Amount, that means data rate or number.

> Reference value (per second, per minute, per hour or absolute)

Additionally, you can adjust for the limit whether it refers to a logical connection or to all connections together, which
exist between the defined destination and source stations via the corresponding services. Thus it is controlled whe-
ther the filter takes effect, if e.g. all HTTP connections of the users in the LAN exceed the limit in sum, or whether it
is sufficient that only one of the parallel established HTTP connections exceeds the threshold value.

For absolute values it is additionally possible to specify whether the counter belonging to it will be reset to zero when
the limit has been reached.

1. MAC s the abbreviation for Media Access Control and it is the crucial factor for communication inside of a LAN. Every network device has
its own MAC address. MAC addresses are worldwide unique, similar to serial numbers. MAC addresses allow distinguishing between the PCs
in order to give or withdraw them dedicated rights on an IP level. MAC addresses can be found on most networking devices in a hexadecimal
form (e.g. 00:A0:57:01:02:03).
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ﬁ In any case, data will be transferred if a limit has not been reached yet! With a trigger value of zero a rule
becomes immediately active, as soon as data packets arrive for transmission on the specified connection.

Packet action

The Firewall has three possibilities to treat a filtered packet:

> Transmit: The packet will be transferred normally.

> Drop: The packet will be discarded silently.

> Reject: The packet will be rejected, the addressee receives an appropriate message via ICMP.

Further measures

The Firewall does not only serve to discard or accept the filtered data packets, but it can also take additional measu-
res when a data packet has been registered by the filter. The measures here are devided into the fields “protocolling/
notification” and “prevent further attacks”:

> Send a Syslog message: Sends a message via the SYSLOG module to a SYSLOG client, as defined in configu-
ration field “Log & Trace”.

» Send an email message: Sends an email message to the administrator, using the account specified in the con-
figuration field “Log & Trace".

» SNMP/LANmonitor: Sends a SNMP trap, that will be analyzed e. g. by LANmonitor.

3
=
g
[y

<\ Each of these three message measures leads automatically to an entry in the Firewall event table.

> Disconnect: Cuts the connection, over which the filtered packet has been received.

On the occasion, the physical connection will be cut off (e. g. the Internet connection), not only the logical
@ connection between the two involved PCs!

> Lock source address: Blocks the IP address from that the filtered packet has been received for a given time.
> Lock target port: Blocks the destination port to that the filtered packet has been sent for a given time.

Quality of Service (QoS)

Apart from the restrictions for the transfer of data packets, the Firewall can also concede a “special treatment” to
certain applications. QoS settings use features of the Firewall to specifically identify data packets of certain connec-
tions or services.

ﬂ For further information about QoS and the appropriate configuration please see chapter ‘Quality of Service’
—page 151.
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8.3.5 Alerting functions of the Firewall

This paragraph describes the Firewall alerts in detail that are sent on security-relevant events. The following message
types are available:

> Email notification

> SYSLOG report

» SNMP trap

Alerts are triggered either separately by the intrusion detection system, by the denial of service protection or by arbi-
trary trigger conditions specified in the Firewall. The specific parameters for the different alerting types such as the
relevant email account can be set at the following places:

LANconfig Log & Trace P> SMTP Account P> SNMP B> SYSLOG

WEBconfig Expert Configuration P> Setup P> SMTP B> SNMP Module SYSLOG Module
Terminal/Telnet /Setup/SMTP resp. SNMP Module or SYSLOG Module

An example:

Let us assume a filter named 'BLOCKHTTP*, which blocks all access to a HTTP server 192.168.200.10. In case some
station would try to access the server nevertheless, the filter would block any traffic from and to this station, and
inform the administrator via SYSLOG also.

SYSLOG notifications

If the Firewall drops an appropriate packet, a SYSLOG notification is created (see ‘Setting up the SYSLOG module’
—page 290) as follows:
PACKET_ALERT: Dst: 192.168.200.10:80 {}, Src: 10.0.0.37:4353 {} (TCP): port filter

Ports are printed only for port-based protocols. Station names are printed, if the LANCOM can resolve them directly
(without external DNS request).

If the SYSLOG flag is set for a filter entry (s action), then this notification becomes more detailed. Then the filter
name, the exceeded limit and the filter action carried out are printed also. For the example above this should read as:

PACKET_ALERT: Dst: 192.168.200.10:80 {}, Src: 10.0.0.37:4353 {} (TCP): port filter
PACKET_INFO:

matched filter: BLOCKHTTP
exceeded limit: more than 0 packets transmitted or received on a connection
actions: drop; block source address for 1 minutes; send syslog message;
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Notification by email

If the email system of the LANCOM is activated, then you can use the comfortable notification by email. The device
sends an email to the administrator as soon as the firewall executes the appropiate action:

FROM: LANCOM_Firewall@MyCompany.com

TO: Administrator@MyCompany.com

SUBJECT: packet filtered

Date: 9/24/2002 15:06:46

The packet below

Src: 10.0.0.37:4353 {cs2} Dst: 192.168.200.10:80 {ntserver} (TCP)

45 00 00 2c ed 50 40 00 80 06 7a a3 0a 00 00 25 | E..,.PQ. ..z....%

cO0 a8 c8 0a 11 01 00 50 00 77 5e d4 00 00 00 00 | ....... P .wh.....

60 02 20 00 74 b2 00 00 02 04 05 b4 | LoLt...

matched this filter rule: BLOCKHTTP

and exceeded this limit: more than 0 packets transmitted or received on a connection
because of this the actions below were performed:

drop

block source address for 1 minutes

send syslog message

send SNMP trap
send email to administrator

IS
=
2
=

Sending the email from the LANCOM to the administrator only works if the right email address is entered. Under
LANconfig you can enter the email address in the configuration area 'Firewall/QoS' under the tab 'General' .

<% New Configuration for LANCOM 1811 Wireless DsL [ [

Configure: IFl'rewaIIfQoS - ;

General | Rules | DoS | DS |

v Firewall/QoS enabled
— General settings

Tothe email address ofthe administrator the rule defined
messages will be sent.

Administrator email iadmln@company.de

Under WEBconfig or Telnet you can find the administrator email address as follows:

WEBconfig Expert Configuration P> Setup P> IP Router P> Firewall

Terminal/Telnet /Setup/IP-Router/Firewall
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To send an email an the required settings must be entered under LANconfig in the configuration area 'Log & Trace'
under the tab 'SMTP Account’.

<8 New Configuration for LANCOM 1811 Wireless DsL 2|

Configure: Log & Trace hd

SNMP | SYSLOG SMTP Account gsMTP Options |

With the Simple Mail Transfer Protocol (SMTP) your device can inform
you about specific events (e g. Denial of Service attacks).

— General settings

This is the server to which the device will post email messages:

SMTP Server: Ismpl.prowder.com
SMTP Port o5
Sender Email address: Iadmm@company com
=
E Here you can specify the necessary SMTP account data:
[
User name: |123456?8
User Password: |

Under WEBconfig or Telnet the SMTP settings can be reached as follows:

WEBconfig Expert Configuration P> Setup P> SMTP

Terminal/Telnet /Setup/SMTP

Notification by SNMP trap

If as notification method dispatching SNMP traps was activated (see also 'SNMP" —page 24), then the first line of
the logging table is sent away as enterprise specific trap 26. This trap contains additionally the system descriptor
and the system name from the MIB-2.

For the example the following trap is thus produced:

SNMP: SNMPvl; community = public; SNMPvl Trap; Length = 443 (0x1BB)
SNMP: Message type = SNMPvl

SNMP: Version = 1 (0x0)

SNMP: Community = public

SNMP: PDU type = SNMPvl Trap
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System
descriptor

Device string

Time stamp

Source address

Destination

address

Protocol (6 =
TCP)

Source port

Destination
port (80 =
HTTP)

Name of the
filter rule
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SNMP: Enterprise = 1.3.6.1.4.1.2356.400.1.6021

SNMP: Agent IP address = 10.0.0.43

SNMP: Generic trap = enterpriseSpecific (6)

SNMP: Specific trap = 26 (0x1A)

SNMP: Time stamp = 1442 (0x5A2)

SNMP: OID = 1.3.6.1.2.1.1.1.0 1.

SNMP: String Value = LANCOM Business 6021 2.80.0001 / 23.09.2002 8699.000.036
SNMP: OID = 1.3.6.1.2.1.1.5.0 2. System-Name

SNMP: String Value = LANCOM Business 6021

SNMP: OID = 1.3.6.1.4.1.2356.400.1.6021.1.10.26.1.2.1 3.
SNMP: String Value = 9/23/2002 17:56:57

SNMP: OID = 1.3.6.1.4.1.2356.400.1.6021.1.10.26.1.3.1 3.
SNMP: IP Address = 10.0.0.37

SNMP: OID = 1.3.6.1.4.1.2356.400.1.6021.1.10.26.1.4.1 4.
SNMP: IP Address = 192.168.200.10

SNMP: OID = 1.3.6.1.4.1.2356.400.1.6021.1.10.26.1.5.1 5.
SNMP: Integer Value = 6 (0x6) TCP

SNMP: OID = 1.3.6.1.4.1.2356.400.1.6021.1.10.26.1.6.1 6.
SNMP: Integer Value = 4353 (0x1101)

SNMP: OID = 1.3.6.1.4.1.2356.400.1.6021.1.10.26.1.7.1 7.
SNMP: Integer Value = 80 (0x50)

SNMP: OID = 1.3.6.1.4.1.2356.400.1.6021.1.10.26.1.8.1 8.
SNMP: String Value = BLOCKHTTP

ﬁ‘ This trap and all different in the LANCOM generated traps are sent to all manually configured trap receivers,
C just like to each registered LANmonitor, which can evaluate this and possibly all other traps.

8.3.6 Strategies for Firewall settings

Firewalls are the interface between networks, and they restrict to a smaller or larger extent an unhindered data
exchange. Thus Firewalls have opposite objectives than networks, although they are a part of them: networks should
connect workstations, Firewalls should prevent the connection.

This contradiction shows the dilemma of the responsible administrators who have developed subsequently different
strategies to solve this problem.

121

3
=
g
[y



IS

=
2
[

P Chapter 8: Firewall LANCOM Reference Manual LCOS 3.52

[> The LANCOM Firewall

122

Allow All

The Allow All strategy favours unhindered communication of the employees compared over security. Any communi-
cation is allowed at first, the LAN is still open for attackers. The LAN becomes gradually more secured by configura-
tion of the administrator, by settings of more and more new rules, which restrict or prevent parts of communication.

Deny All

The Deny All strategy proceeds at first according to the method “Block all!”. The Firewall blocks completely the com-
munication between the protected network and the rest of the world. In a second step, the administrator opens
address ranges or ports, which are necessary e.g. for daily communication with the Internet.

This approach ensures superior security for the LAN security compared to the Allow All strategy, but may lead espe-
cially in its initial stages to difficulties for the users. After activation of the Deny All strategy, some things just may
behave differently than before, some stations may not reached any more etc.

Firewall with DMZ

The demilitarized zone (DMZ) is a special range of the local network, which is shielded by a Firewall both against the
Internet and against the normal LAN. All stations or servers that should be accessible from the unsecured network
(Internet) should be placed into this network. These include for example own FTP and web servers.

The Firewall protects at first the DMZ against attacks from the Internet. Additionally, the Firewall protects also the
LAN against the DMZ. To do so, the Firewall is configured in this way that only the following accesses are possible:

» Stations from the Internet can access to the servers in the DMZ, but no access from the Internet to the LAN is
possible.

» The stations of the LAN can access the Internet, as well as servers in the DMZ.

> Servers of the DMZ have no access to the stations of the LAN. That guarantees that no “cracked” server of the
DMZ becomes a security risk for the LAN.
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Local netwo

FTP server

Web server

Internet

Some LANCOM models support this structure by a separate LAN interface only used for the DMZ. Looking at the path
of data through the LANCOM, then the function of the Firewall for shielding the LAN against the DMZ becomes
visible.

=
©
=
2
LT

LAN interfaces

VPN services

éconnection via LAN/Switch

Z
[

IP-Redirect

IPX over PPTP/VPN
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A direct data exchange between LAN and DMZ via LAN bridge is not possible if a dedicated DMZ port is used. The
path from LAN to DMZ and vice versa is therefore only possible through the router, and thus also only through the
Firewall! This shields the LAN against inquiries from the DMZ, similar to the LAN against inquiries from the Internet.

(@‘\ The shielding of the DMZ against the Internet on one side and the LAN on the other is solved in many net-
~ work structures with two separate Firewalls. When using a LANCOM with DMZ port, only one device for this
setup is needed, which e.g. results in a clearly simplified configuration.

8.3.7 Hints for setting the Firewall

The LANCOM Firewall is an extremely flexible and powerful tool. In order to help you to creating individual Firewall
rules, you'll find in the following some hints for your specific application.

The default settings of the Firewall

On delivery there is exactly one entry in the Firewall rule table: “WINS". This rule prevents unwanted connection set-
ups on the default route (gen. to the Internet) by the NetBIOS protocol. Windows networks send inquiries in regular
intervals into the network to find out if known stations are still available. This leads in case of a time-based account
of a network coupling to unwanted connection set-ups.

(. The LANCOM can prevent this by the integrated NetBIOS proxy also for network couplings, by pretending
~an answer for the concerned resource, until a real access takes place.

Security by NAT and Stateful Inspection

If no further Firewall rule will be entered, the local area network is protected by the interaction of Network Address
Translation and Stateful Inspection: Only connections from the local area network produce an entry in the NAT table,
whereupon the LANCOM opens a communication port. The Stateful Inspection supervises communication via this
port: Only packets, which belong exactly to this connection may communicate via this port. For accesses from the
outside to the local network results thus an implicit "Deny All" strategy.

ﬁ If you operate a web server in your LAN, that has been permitted access to this service from the outside (see

\ ‘IP masquerading’ —page 67), stations from the Internet can establish from the outside connections to this
server. The inverse masquerading has priority over the Firewall in this case, as long as no explicit "Deny All"
rule has been set.

Set-up of an explicit "Deny All" strategy

For maximum protection and optimum control of the data traffic it is recommended to prevent first any data transfer
by the Firewall. Then only the necessary functions and communication paths are allowed selectively. This offers e.g.
protection against so-called "Trojans" and/or e-mail viruses, which set up actively an outgoing connection on certain
ports.
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Deny All: The most important Firewall rule!

The Deny All rule is by far the most important rule to protect local networks. By this rule the Firewall operates
according to the principle: “All actions, which are not explicitly allowed, remain forbidden!” Only by this strategy
the administrator can be sure not to have “forgotten” an access method, because only those accesses exist,
which have been opened explicitly by himself.

We recommend to set up the Deny All rule before connecting the LAN via a LANCOM to the Internet. Then you
can analyse in the logging table (to start e. g. via LANmonitor), which connection attempts have been blocked
by the Firewall. With the help of this information the Firewall and the “Allow rules” can be gradually extended.

Some typical applications are shown in the following.

ﬂ All filters described here can be installed very comfortably with the Firewall wizard, and if necessary be
7 further refined with e.g. LANconfig.

> Example configuration “Basic Internet”

ALLOW_HTTP Local network All stations transmit HTTP, HTTPS
ALLOW_FTP Local network All stations transmit FTP
ALLOW_EMAIL | Local network All stations transmit MAIL, NEWS
ALLOW_DNS_F | IP address of transmit transmit DNS
ORWARDING LANOM (or: Local

network)
DENY_ALL All stations reject reject ANY

> Ifyou want to permit a VPN dial-in to a LANCOM acting as VPN gateway, then you need a Firewall rule allowing
incoming communication from the client to the local network:

ALLOW_VPN_DIAL_IN | remote site name | Local network | transmit | ANY
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> Incase a VPN is not terminated by the LANCOM itself (e.g. a VPN Client in the local area network, or LANCOM
as Firewall in front of an additional VPN gateway), you'd have to allow IPSec and/or PPTP (for the "IPSec over
PPTP" of the LANCOM VPN Client) ports additionally:

ALLOW_VPN VPN Client VPN Server transmit IPSEC, PPTP

» For ISDN or V.110 dial-in (e.g. by HSCSD mobile phone) you have to allow the particular remote site (see also
'Configuration of remote stations” —page 81):

ALLOW_DIAL_IN remote site name Local network transmit | ANY

> For a network coupling you permit additionally the communication between the involved networks:

=
<
=
=
[y

ALLOW_LAN1_TO_LAN2 LAN1 LAN2 transmit | ANY
ALLOW_LAN2_TO_LAN1 ‘ LAN2 ‘ LAN1 ‘ transmit ‘ ANY

> If you operate e.g. an own web server, you selectively allow access to the server:

ALLOW_WEBSERVER ANY Webserver transmit HTTP, HTTPS

> For diagnostic purposes it is helpful to allow ICMP protocols (e.g. ping):

ALLOW_PING Local network ANY transmit ICMP

These rules can now be refined as needed - e.g. by the indication of minimum and maximum bandwidths for the
server access, or by a finer restriction on certain services, stations or remote sites.

‘-. The LANCOM automatically sorts Firewall rules when creating the filter list. Thereby, the rules are sorted into
7 thefilter list on the basis of their level of detail. First all specific rules are considered, afterwards the general
ones (e.g. Deny All). Examine the filter list in case of complex rule sets, as described in the following section.

126



LANCOM Reference Manual LCOS 3.52 p Chapter 8: Firewall

[> The LANCOM Firewall

8.3.8 Configuration of Firewall rules

Firewall wizard
The fastest method to configure the Firewall is provided by the Firewall wizard in LANconfig:

7% Setup Wizard for LANCOM 1811 Wireless DSL |

Setup Wizard for LANCOM 1811
Wireless DSL

Thiz wizard lets you configure your device for specific
applications quickly and easily.

‘what do you want to do?

:g{ Check security settings

&
Setup Interme e
%Provide m—— %1 Setup Wizard for 1621AnnexB |
&
34 Connecttwo  Add Firewall Rule
Wwhich data packet does the new firewall rule apply to?

< Configure fire

:g{ Configure Dyt

Should thiz rule apply to all services/pratocols or only to certain services/protocols?

" This iule appliss to all services/protocols

' This rule applies to the following services/protocols:

=
=
2
[

(+ Special services:
¥ world Wwide \Web [HTTP, HTTPS) ™ Teminal access [TELNET]
™ Mail and News [SMTP, POP3, NNTP] T Layer2 Tunnel [PFTP)
™ File transfers [FTP)

" Name resolution [DMNS)

" wfindows network (NetBIOS via IP)

 Vitual Privat Network [VPH/APSec)

" Custom protocols: Edit custam protozols, |

< Zuriick I Weiter; I Abbrechen
<

LANconfig

The filters can be installed very comfortably with LANconfig. Starting from the general register card "Firewall / QoS
I Rules", you reach after "Add" or "Edit" the dialogue to define the Firewall rules:
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Configure: |Firewalla"QoS 'l
General Rules |Dos |15 |

-~ Firewall Rules [Filter/QaS)

“r'ou can filter or prefer packets according to a variety of criteria
to pratect your system against unauthorized acocess or to assure
a minimal bandwidth to specific services [Quality of Service], for
example.

Rules:

Firewall| F'ri0| Mame |

1 ALLOW_FTP
On 1 ALLOW_PING
On 1 ALLOW_DNS_FORWARDING
On 1 ALLOW_HTTP
On 0 ALLOW VPN
Off 0 WiINS
On 0 DEWY_ALL

ilil sdd. | Edt. | Deete |

Within the dialogue for the definition of filter rules, the following options can be found on different index cards:

> General: Here the name of the Firewall rule is specified, as well as if further rules should be considered after this
rule matched, and whether a VPN rule should be derived from this rule.

Filter rule ALLOW_FTP cd [

General |Acti0ns| Qo5 I Stationsl Servicel

IS

=
2
[

—Rule

Filter rules can be uzed to trgnsfer or drop data packets
=

according to specified criteria.

Mame of this rule:
IALLDW_FTF'l

¥ This rule is active for the firswal
[~ Observe further rules, after this ule matches.

™ This rule is used to create VPN rules

> The option 'Observe further rules ..." can be used to create complex functions ensuring e.g. certain band-
widths with QoS ('Connection” —page 115)

> The option 'This rule is used to create VPN rules' enables to utilize the information about source and desti-
nation networks of this rule also to define VPN networks ('Default VPN rules” —page 109).

> Actions: Here the Firewall actions are defined, consisting of condition, trigger, packet action and further measu-
res.

128



LANCOM Reference Manual LCOS 3.52 p Chapter 8: Firewall

[> The LANCOM Firewall

General  Actions | QoS I Stationsl Servicel

— &ctioh Trigger/ Actions Sek - 21l
0 The actions table describes an arbitrary amaor B
L‘E‘, actions that will be executed, if special rule n
amaunts of data or packages wil be exceed | ™ action orly if not connected

i T [~ Action only for default route [i.e. intemet)
rigger clions
[~Yirmediately Re [~ Action only for DiffSere-CP: [BE =

= 32kbis Drop [~ #ction only for send packets
@ 256 kb/s Tranzfer

[~ Action only for received packets
& Physical ransmission diection

€ Logical transmizsion direction

o] x| T =
Ikbit j |321 per zecond j

[ Resetcourter & Perconnection © Global

— Packet Action
=
" Transmit " Drop * Rgject g
— Further Meast &3
(T

oK
_% ™ Send Spslog message ™ Send email message

¥ SNMP [ie. L&Nmonitor) [ Disconnect
™ Lock source address ™ Lock target port

—_— T —

> QoS: Here you can assign minimum bandwidths for data packets specified by according Firewall rules (see also
'Defining minimum and maximum bandwidths —page 165).

Quality of Service B 2l

Condition:

[~ Action only for default route [i.e. intemet)
[~ Action only for DiffSery-CF:  [BE +
™ Action only for send packets

[ Action anly for received packets

a o

> Stations: Here the stations — as sender or addressee of the packets — are specified, for which the filter rule
shall match.
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Filter rule ALLOW_FTP fcd [

Generall Actionsl Qo5 Stations | Servicel

— Connection source
)= This rule applies to packets an
OO connections from al stations
' connections from the following stations:

All stations in local netwark.

Add... Exdif.... Dielete

— Connection destination
= B This rule applies to packets an
% © connections to all stations
' connections to the following stations:

Remate site REMOTE

add. || Edt. || Deee |

T
=
=
[

> Services: Here the IP protocols, source and destination ports are specified for which the filter rule shall apply.
For example, it can be specified here that only access to web pages and emails shall be permissible.

Filter rule ALLOW_FTP cd [

Generall Actionsl Qo5 I Stations Servicel

—Scope of rule [services/pratocals)
bt : 4 :
W% Thiz rule applies to all services/protocals

' This rule appliss to the following services/protocols:
' Special services:
I~ Wworld Wide Web (HTTP, HTTPS]
[~ Mail and News [SMTP, POP3, NNTP]
V' File transfers [FTP)
™ Teminal access [TELNET]
™ Laper2 tunnel [PRTR)
" Name resolution [DNS)
" WWindows network (NetBIOS via IP)
 Wirtual Privat Metwork [VPN/IPSec)

€ Custom protocols:

Edit custom protocals:.

Ok, Cancel
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WEBconfig, Telnet
Under WEBconfig or Telnet the Firewall rules are configured in the following menus and lists:

WEBconfig Expert Configuration / Setup / IP Router Module/ Firewall: Rule
Table, Object Table, Actions Table

Terminal/Telnet Setup / IP Router Module/ Firewall / Rule Table, Object Table,
Actions Table

There is a special syntax in LCOS for the description of the Firewall rules. This syntax allows to describe also complex
relations for checking and treatment of data packets within the Firewall just with a few characters.

Rules are defined in the rule table. Pre-defined objects can be saved in two additional tables in order to prevent
entering frequently used objects each time again in LCOS syntax:

> The action table contains Firewall actions
> The object table contains stations and services

q:. Objects from these tables can be used for rule definition, but this is not a must. They simply facilitate the use
7 of frequently used objects.

The rule table combines different information to a Firewall rule. The rule contains the protocol to be filtered, the
source, the destination as well as the Firewall action to be executed. For each Firewall rule there is an additional on/
off-switch, a priority, the option for a linkage with other rules and an activation of the rule for VPN connections.
General information concerning these parameters can be found in section 'Parameters of Firewall rules’ —page 112.

The definition of the Firewall rules can be composed of entries of the object table for protocols, services, stations
(—Seite 132), and of entries of the action table for Firewall actions(—Seite 133). It can also contain direct descrip-
tions in the appropriate LCOS syntax (e. g. %P6 for TCP).

131

IS

=
2
=




P Chapter 8: Firewall LANCOM Reference Manual LCOS 3.52

[> The LANCOM Firewall

Expert Confiquration
{3 Setup
=4 IP-router-maodule
3 Firewall

Rule-table

Name |ALLOW_HTTP
Prat. TCR

Source [LOCALNET

Destination IANYHOST%880,443,591,808,8080

Action |%LcdsD Ay
Linked Mo =
Prio ID

Active IYes 'l
YPN-rule IND 'l

A

=
<
=
=
[y

For direct entering of rule parameters in LCOS syntax, the same guidelines apply as described in the following
sections for protocols, source and destination, as well as for Firewall actions.

Object table The object table defines elements and objects that apply to the rule table of the Firewall. Objects can be:
> Single PCs (MAC or IP address, host name)
> Entire networks
> Protocols
> Services (ports or port ranges, e. g. HTTP, Mail&News, FTP, ...)

Any combination of these elements is possible. Furthermore, objects can be defined hierarchically. So one can first
define objects for TCP and UDP protocols, then objects for e.g. FTP (= TCP + ports 20 and 21), HTTP (= TCP + port
80) and DNS (=TCP, UDP + port 53). All these single objects can be assembled subsequently into a new object, which
contains all previously defined single objects then.

Stations and services can be described according to the following rules in the object table:

Local network %L

Remote stations %H Name must be in DSL /ISDN /PPTP or VPN
name list

Host name %D Note advice for host names (—Seite 116)

MAC address %E 00:A0:57:01:02:03
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IP address %A %A10.0.0.1, 10.0.0.2;
%A0 (all addresses)
Netmask %M %M255.255.255.0
Protocol (TCP/UDP/ICMP etc.) | %P %P6 (for TCP)
Service (port) %S %S20-25 (for ports 20 to 25)

Equal identifier can generate comma-separated lists as for example host lists/address lists (%A10.0.0.1, 10.0.0.2),
or hyphen-separated ranges like port ranges (%S20-25). The occurrence of a "0" or an empty string represents the
‘any’ object.

Expert Confiquration
5 Setup

& IP-router-maodule
=9 Firewall

Object-table

Narne |l—_|'P

=
<
=
2
(T

Description |%P8 %521

Reset |

@ When configuring via console (Telnet or terminal program), the combined parameters (port, destination,
source) must be embraced with inverted commas (character ").

As described above, a Firewall action consists of condition, limit, packet action and further measures. In the action
table Firewall actions are composed as any combination of the following elements:

» Conditions
Connect filter | The filter is active when no physical connection to the @c

packet destination exists.

DiffServ filter | The filter is active when the packet contains the indicated | @d (plus DSCP)
Differentiated Services Code Point (DSCP) (‘Evaluating
ToS and DiffServ fields' —page 163.

Internet filter | The filter is active when the packet is received or will be | @i
transmitted via default route.

VPN filter The filter is active when the packet is received or will be | @v
transmitted via VPN connection.

133



IS
=
=
[y

P Chapter 8: Firewall

LANCOM Reference Manual LCOS 3.52

[> The LANCOM Firewall

134

If no further actions are specified in a “connect” or “Internet” filter, then implicitly a combination of these filters
with the “reject” action is assumed.

> Limits/Trigger
Each Firewall action can be tied together with a limit, whose excess leads to the triggering of the action. Also,

several limits for a filter thereby can build action chains.

Limit objects are generally introduced by %L, followed by:

I> Reference: per connection (c) or globally (g)

> Kind: Data rate (d), number of packets (p) or packet rate (b)
> Value of the limit

> Further parameters (e. g. period and quantity)

The following limitations are available:

Data (abs) Absolute number of kilobytes on the connection after which the action is executed. %lcd
Data (rel) Number of kilobytes/second, minute, hour on the connection after which the action is executed. %lcds
%lcdm
%lcdh
Packet (abs) Absolute number of packets on the connection after which the action is executed. %lcp
Packet (rel) Number of packets/second, minute, hour on the connection after which the action is executed. %lcps
%lcpm
%lcph
Global data Global data (abs): Absolute number of kilobytes received from the destination station or sent to it, after %Ilgd
(abs) which the action is executed.
Global data (rel) | Number of kilobytes/second, minute or hour received from the destination station or sent to it, after which | %lgds
the action is executed. %lgdm
%Ilgdh
Global packet Absolute number of packets received from the destination station or sent to it, after which the action is %lgp
(abs) executed.
Global packet Number of packets/second, minute or hour received from the destination station or sent to it, after which | %Igps
(rel) the action is executed. %Igpm
%Igph
Receive option | Limit restriction to the direction of reception (this affects in the context with above limitations). In the ID | %lgdsr
object column, examples are indicated. %lcdsr
Transmit option | Limit restriction to the sending direction (this affects in the context with above limitations). In the ID %lgdst
object column, examples are indicated. %lcdst

@ If an action is given without any associated limit, then implicitly a packet limit is assumed that is immediately
" exceeded with the first packet.
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» Packet action

Accept The packet will be accepted. Y%a

Reject The packet will be rejected with the corresponding error %r
message.

Drop The packet will be discarded silently. %d

These packet actions can be combined arbitrarily. If you choose absurd or ambiguous actions (e. g.: Accept +
Drop), then the more secured action will be taken (here: “Drop”).

» Further measures

Syslog Gives a detailed notification via SYSLOG. %s
Mail Sends an email to the administrator. %m
SNMP Sends a SNMP trap. %n
Close port Closes the destination port for a given time. %p
Deny host Locks out the sender address for a given time. %h

Disconnect Disconnects the connection to the remote site from which | %t
the packet was received or sent.

Zero limit Resets the limit counter to 0 again upon exceeding of the | %z
trigger threshold.

Fragmenta- Forces a fragmentation of all packets not matching to the | %f

tion rule.

If the “close port" action is executed, an entry in a block list is made, by which all packets, which are sent at the
respective computer and port, get rejected. For the "close port" object a timeout can be given in seconds, minu-
tes or hours, which is inserted directly behind the object ID. This time value is composed of the designator of the
time unit (h, m, s for hour, minute and second), and the actual time. Thus e.g. %pm10 closes a port for 10 minu-
tes. If no time unit is provided, then implicitly "minutes" apply (and thus %p10 is equivalent to %pm10).

If the "Deny host" action is executed, then the sender of the packet is registered in a block list. Starting from this
moment, all packets received from the blocked server will be rejected. Also the "Deny host" object can be pro-
vided with a time-out, which is formed similarly to the "CLOSE port" option.

If you want to limit e.g. the permissible data rate for a connection to 8 kbps and to lock out the aggressor committing
a flooding attempt, and furthermore send at the same time an email to the administrator, then the description of the
object for the action reads as follows:
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Expert Confiquration
=3 Setup

&4 IP-router-maodule
= Firewrall

Object-table

Name ICLOSE_ON_FLOODING

Description |%a%chsB%d%Igbs1DD%h1D%m|

Feset |

> This description permits traffic ($a) at the beginning. A simple %a at the beginning of the description is equiva-
lent to a %Ip0%a (= accept, if the limit was exceeded on zero packets, i.e. with the first packet).

> If over the current connection now 8 kbit (¥1cds8) is transferred in one second, then all further packets - up to
the expiration of the second - will be silently discarded (%d), thus automatically creating a Traffic Shaping.

> If 100 packets for the server (destination address of the connection) arrive (¥1gbs100) in one second, then the
remote host (source address) is locked for 10 minutes (3h10), and an email is sent to the administrator (3m) .

Similar to the address and service objects of the object table, action objects can be provided with a name, and can
arbitrarily be combined recursively, whereby the maximum recursion depth is limited to 16. In addition, they can be
entered directly into the action field of the rule table.

When building the actual filter table, action objects get minimized similarly to the address and service objects to the
smallest necessary number, i.e. multiple definitions of an action get eliminated, and contradictory actions are turned
into the "safest". Thus e.g. $a (accept) and %4 (drop) becomes only $d, and %r (reject) and $d becomes %r.
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8.3.9 Firewall diagnosis

All events, conditions and connections of the Firewall can be logged and monitored in detail.

The most comfortable inspection is accomplished by displaying the logging table (see below) with LANmonitor.
LANmonitor displays under 'Firewall’ the last five events, that were triggered either by a Firewall rule, the DoS, or
the IDS system with activated 'SNMP/LANmonitor’ option.
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-loix]

File Device View Tools Help

e NHAMEL_HOME
Ell::> D5L Line: Connected to 10MD1
B Pratocal: PPR

-3 Metwark protocal; TCPIIP
----- o Connection ktime: 13 minutes and 32 seconds
----- € Sending 5149 byte/s, receiving 7879 byte/s
----- = ISDN Line 1: Mok ready

----- & 1/29/2004 %: 1:54; intrud
----- & 1/25/2004 14:49:19: D05 Refresh
----- = 1/28/2004 14:33:13: DoS proteckion - TP 7.0.0,1:80 ko 80,146,66,127:1744 - Packet dropped
----- = 1/26/2004 19:17:48: DoS protection - TCP packet from 127.0.0,1:80 ko 80,146,80,98: 1653 - Packet dropped
----- = 1/26/2004 18:21:24: DoS protection - TCP packet from 127,0.0,1:80 to 80,146,80,98:13584 - Packet dropped
[ System information

k 169,254,164, 169: 1048 to 255,255,255, 255:69 - Packet dropped
£7.0.0.1:80 to 80,146.66.127:1926 - Packet dropped

A new window with the complete logging table opens by clicking the right mouse button in the Firewall Event Log
context menu. (—Seite 137).

All lists and tables described in this section can be found under the following menu options:

3
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WEBconfig Expert Configuration Status IP-Router-Statistics

Terminal/Telnet /Status/IP-Router-Statistics

The Firewall table

If an event occurred that had to be logged in either way, i.e. a log action was specified with the receipt of a packet,
or a report by e-mail, Syslog or SNMP was generated, then this event is held in the logging table.

If you call up the logging table via LANmonitor, it looks like the following depiction:

& LC_¥PN_M_LCSTEST - Firewall Event Log

Event Log  Wiew

Tdx, | Syskem time | Source address I Dest, address | Fraok | SOUFCE ... | Dest, p... | Filter rule | Lirnit: | Action

|1 2j4f2004 12:12:41 10.1.1.11 224,009 17{U... 520{ro... 520{ro... intruderde... Immediately Packet dropped; SYSLOG sen
e zj4f2004 12:11:40 10.1.1.11 255,255,255,255  17{U... &7ibo... 6&8ibo... intruderde... Immediately Packet dropped; SYSLOG sen
a3 2j4f2004 12:06:45 10.1.1.11 224,009 17{U... 520{ro... 520{ro... intruderde... Immediately Packet dropped; SYSLOG sen
a4 2j4f2004 12:05:44 10.1.1.11 255,255,255,255  17{U... &7ibo... 6&8ibo... intruderde... Immediately Packet dropped; SYSLOG sen
s zj4f2004 12:02:32 10.1.1.11 224,009 17{U... 520{ro... 520{ro... intruderde... Immediately Packet dropped; SYSLOG sen
e 2j4/2004 12:01:31 10.1.1.11 255,255,255,255  17{U... &7ibo... 6&8ibo... intruderde... Immediately Packet dropped; SYSLOG sen
7 2j4f2004 12:00:04 10.1.1.11 224,009 17{U... 520{ro... 520{ro... intruderde... Immediately Packet dropped; SYSLOG sen
e 2j4f2004 11:59:03 10.1.1.11 10,1,255,255 17{U... 137i{n... 137{n... intruderde... Immediately Packet dropped; SYSLOG sen
™o 2j4f2004 11:55:08 10.1.1.11 224,009 17{U... 520{ro... 520{ro... intruderde... Immediately Packet dropped; SYSLOG sen
10 2j4f2004 11:54:07 10.1.1.11 255,255,255,255  17{U... &7ibo... 6&8ibo... intruderde... Immediately Packet dropped; SYSLOG sen
11 2j4f2004 11:48:05 10.1.1.11 224,009 17{U... 520{ro... 520{ro... intruderde... Immediately Packet dropped; SYSLOG sen
|1z zj4f2004 11:47:04 10.1.1.11 255,255,255,255  17{U... &7ibo... 6&8ibo... intruderde... Immediately Packet dropped; SYSLOG sen
13 2j4/2004 11:45:00 10.1.1.11 224,009 17{U... 520{ro... 520{ro... intruderde... Immediately Packet dropped; SYSLOG sen

If you call up the logging table via WEBconfig, it looks like the following depiction:
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Expert Confiquration
5 Status

& |P-router-statistics

Log-table

Idx. System-time Src-address Dst-address Prot. Src-port Dst-port Filter-rule Limit Threshold Action
0001 14292004 16:10:63 169.254 164,168 224.00.2 2 i} i} intruder detection 00000001 O aboooson
0002 142972004 16:09:43 169,254 164,169 234149 2 1} i} intruder detection 00000001 O ad0oo0son
0003 17292004 9:11:58 169254 164,169 255255255255 17 1048 ate] intruder detection 00000001 O ab0oo0son
0004 1/28/2004 14:49:23 127.001 8014666127 B a0 1926 Do protection 00000001 O adoooson
0005 1/28/2004 14:33:17 127.0.01 8014666127 B a0 1744 DoS protection 00000001 O a0booo0son
0006 1/26/200419:17:62 127.0.01 80.146.80.98 B a0 1683 DoS protection 00000001 O ad0oo0son
0007 1626/2004 18:21:28 127.001 80.146.80.98 B a0 1384 Do protection 00000001 O aboooson

The table contains the following values:

Idx. Current index (so that the table can be polled also via SNMP)

System time | System time in UTC codification (will be transformed on displaying of the
table into clear text)

=
<
=
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Src address Source address of the filtered packet

Dst address | Destination address of the filtered packet

Prot. Protocol (TCP, UDP etc.) of the filtered packet

Sre-p Source port of the filtered packet (only with port-related protocols)
Dst-p Destination port of the filtered packet (only with port-related protocols)
Filter-Rule Name of the rule, which has raised the entry.
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Limit Bit field, which describes the crossed limit, which has filtered the packet.
The following values are defined at present:

0x01 Absolute number

0x02 Number per second

0x04 Number per minute

0x08 Number per hour

0x10 Global limit

0x20 Byte limit (if not set, it concerns a packet-related limit)

0x40 Limit applies only in receiving direction

0x80 limit applies only in transmission direction

Threshold Exceeded limit value of the trigger limit

Action Bit field, which specifies all implemented actions. At present the following
values are defined:

0x00000001 Accept

0x00000100 Reject

0x00000200 Connect filter

0x00000400 Internet- (Default route-) filter
0x00000800 Drop

0x00001000 Disconnect

0x00004000 Block source address

0x00020000 Block destination address and port
0x20000000 Send SYSLOG notification
0x40000000 Send SNMP trap

0x80000000 Send email

IS
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ﬂ All Firewall actions are likewise displayed within the IP router trace ("How to start a trace’ —page 43). Fur-
” thermore, some LANCOM models have a Firewall LED, which signals each filtered packet.

The filter list
The filter list allows to examine filters generated by rules defined in the action, object and rule table.

‘-‘ Please note that manually entered filter rules do not generate a fault indication and also no error message.
(\ If you configure filters manually, you should in each case examine on the basis of the filter list whether the
desired filters were generated or not.

On Telnet level, the content of the filter list can be displayed with the command show filter:
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Password:

LC1621 . Internet:/
> show filter

Filter 8881 from Rule WINS:
Protocol: 17
AA:AA:AR:AA:AR:AA A.A.A.0 A.A.A.A 137-139
HH:00:A0:A0:A0: A8 B.A.B.8 B.A.8.8 B-8
UPN-Flag=s: none
Limit per conn.: after transmitting or receiving of B packets
actions after exceeding the limit:

reject if on default route

Filter 8882 from Rule WINS:
Protocol: 6
Src: BH:PP:PAA:PAA:AA:A0 B.A.B.8 B.A.A.8 137-139
Ds HH:00:A0:A0:A0: A8 B.A.B.8 B.A.8.8 B-8
UPN-Flag=s: none
Limit per conn.: after transmitting or receiving of B packets
actions after exceeding the limit:
reject if on default route

LC1621 . Internet:/
>

Under WEBconfig the filter list has the following structure:

('QU Expert Confiquration

= 3 Status

g 4 |P-router-statistics

L
Filter-list
Idx. Prot. Src-MAC Src-address Src-netmask S-st. S-end Dst-MAC Dst-address Dst-netmask D-st. D-end Action
oot 6 000000000000 192168.2.0 25525525500 i} 0oooooooo0o0 0.0.0.0 0.0.0.0 9895 995  limit acce
ooz 6 000000000000 192168.2.0 25525525500 0 0o0oooooo0oon 0.0.0.0 0.0.0.0 143 143 limit acce
ooz 6 000000000000 192.168.2.0 25525525500 i} Qoooooooo0oo 0.0.0.0 0.0.0.0 119 119 limit: acce
noo4 6 000000000000 192168.2.0 25525525500 1} no0oooooo0o0 0.0.0.0 0.0.0.0 110 110 limit: acce
noos & 000000000000 192.168.2.0 25525525500 1} Q0o0oooo0o0o0 0.0.0.0 0.0.0.0 25 23 limit: acce
0006 & 000000000000 192168.2.0 255.255.255.0 0 1} 0oooooooo0oon 0.0.0.0 0.0.0.0 b B limit: acce
ooy 1 000000000000 192168.2.0 25525525500 0 Q0o0oooo0o0o0 0.0.0.0 0.0.0.0 1} 1} limit: acce

The individual fields in the filter list have the following meaning:

Idx. Current index
Prot Protocol to be filtered, e.g. 6 for TCP or 17 for UDP.
Src MAC Ethernet source address of the packet to be filtered or 000000000000, if the filter should apply to all packets.

Src address Source IP address or 0.0.0.0, if the filter should apply to all packets.

Source mask | Source network mask, which determinates the source network together with the source IP address, or 0.0.0.0, if the filter
should apply to packets from all networks.

Q start Start source port of the packets to be filtered.

Qend End source port of the packets to be filtered. Makes up the port range together with the start source port, in which the filter
takes effect. If start and end port are 0, then the filter is valid for all source ports.
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Dst MAC Ethernet destination address of the packet to be filtered or 000000000000, if the filter should apply to all packets.

Dst address Destination address or 0.0.0.0, if the filter should apply to all packets.

Dst mask Destination network mask, which determinates the destination network together with the destination IP address, or 0.0.0.0,
if the filter should apply to packets to all networks.

Z start Start destination port of the packets to be filtered.

Zend Destination port of the packets to be filtered. Makes up the port range together with the start destination port, in which the

filter takes effect. If start and end port are 0, so the filter is valid for all destination ports.

Action Into this column, the "main action" is unveiled as a text, which will be executed when the first limit has been exceeded. The
first limit can be also an implicit limit, e.g. if only one limit for the restriction of the throughput was configured. Then an
implicit limit - linked with an "accept” action - is inserted. In this case, "accept” is unveiled as main action.

You can see the complete actions under the command show filter.

Linked Indicates whether it concerns a "first Match" rule (linked = no). Only with linked rules in the case of applying of this rule,
also further rules are evaluated.

Prio Priority of the rule having generated the entry.

The connection list

The connection table files source address, destination address, protocol, source port, destination port, etc. of a con-
nection, as well as possible actions. This table is sorted according to source address, destination address, protocol,
source port and destination port of the packet, which caused the entry in the table.

Under WEBconfig the filter list has the following structure:

Expert Confiquration
& Status

£ IP-router-statistics

Connection-list

Src-address Dst-address  Prot. Src-port Dst-port Timeout Flags Filter-rule Src-route Dest-route
192.168.2.60 80.190.24017 & 3617 80 295 00020008 ALLOWY_HTTP 1UNDA |
192.168.2.60 80.190.24017 & 3618 80 296 00020008 ALLOWY_HTTP 1UNDA
192.168.2.60 212227151816 3610 110 1 00020038 ALLOW_EMAIL 1UNDA
192.168.2.60 212227151816 3612 110 2 00020038 ALLOW_EMAIL 1UNDA
|7|1m1m7ﬁn MTIITARIA R R4 11N 2 AANIOA38 4l | ovd Fhdall AL INIMA

The table contains the following elements:

Src addr. Source address of the connection
Dst addr. Destination address of the connection
Protocol Used protocol (TCP/UDP etc.). The protocol is decimally indicated.
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Src port Source port of the connection. The port is only indicated with port-related protocols (TCP/UDP) or protocols, which own a
comparable field (ICMP/GRE).

Dst port Destination port of the connection (with UDP connections, this one is occupied only with the first answer).
Timeout Each entry ages out with the time of this table, thus the table does not overflow with "died" connections.
Flags In the flags the condition of the connection and further (internal) information are stored in a bit field.(—Seite 142)

As conditions the following values are possible: new, establish, open, closing, closed, rejected (corresponding to the
TCP flags: SYN, SYN ACK, ACK, FIN, FIN ACK and RST).

UDP connections know the conditions new, open and closing (the last one only, if the UDP connection is linked with a con-
dition-afflicted control path. This is e.g. the case with protocol H.323.).

Src route Name of the remote station, over which the first packet has been received.

Dst route Name of the remote station, where the first packet will be sent to.

Filter rule Name of the rule, which has generated the entry (determines also the actions to be executed), when a suitable packet is
received.

Meaning of the flags of the connection list

=
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— 00000001 TCP: SYN sent
00000002 TCP: SYN/ACK received
00000004 TCP: waiting for ACK of the server
00000008 all: open connection
00000010 TCP: FIN received
00000020 TCP: FIN sent
00000040 TCP: RST sent or received
00000080 TCP: session will be re-established
00000100 FTP: passive FTP connection will be established
00000400 H.323: belonging to T.120 connection
00000800 connection via loopback interface
00001000 checking concatenated rules
00002000 rule is catenated
00010000 destination is on "local route"
00020000 destination is on default route
00040000 destination is on VPN route
00080000 physical connection is not established
00100000 source is on default route
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00200000 source is on VPN route

00800000 no route for destination

01000000 contains global actions with condition
Port block list

Address, protocol and port of a destination station are filed in the port block list, if blocking of the destination port
on the destination station was selected as a filter's packet action. This table is likewise a sorted semi-dynamic table.
Sorting is done according to address, protocol and port. The table contains the following elements:

Address Address of the station, to which the blocking should apply.
Protocol Used protocol (TCP/UDP etc.) The protocol is decimally indicated.
Port Port to close at the station. If the respective protocol is not port related, then the entire protocol for this station becomes =
closed. =
. . N =
Timeout Duration of the blocking in minutes. Q
. ) . ) ) . [y
Filter rule Name of the rule, which has produced the entry (determines also the actions to be executed), when a suitable packet is
received.
Host block list

The address of a station is filed in the host block list, if blocking of the sender was selected in a filter's packet action.
This table is a sender address sorted semi-dynamic table and contains the following elements:

Address Address of the station, to which the blocking should apply.

Timeout Duration of the blocking in minutes.

Filter rule Name of the rule, which has generated the entry (determines also the actions to be executed), when a suitable packet is
received.

8.3.10 Firewall limitations

Apart from understanding the functioning of Firewalls, it is also very important to discern their limitations and to
extend them if necessary. The Firewall does not protect against malicious contents coming through the permitted
ways into your local network. It is true that certain effects of some viruses and worms are stopped, because com-
munication is blocked via the required ports, but no Firewall alone is a comprehensive protection against viruses.

Also monitoring of sensitive data in the Internet is not be prevented by a Firewall. If data once reaches the unsecured
net beyond the Firewall, then it is exposed to well-known dangers. Despite using a Firewall, any confidential infor-
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LANconfig
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mation such as contracts, passwords, development information etc. should be transmitted only over protected con-
nections, i.e. by using suitable data encryption and VPN connections.

8.4 Protection against break-in attempts: Intrusion Detection

A Firewall has the task to examine data traffic across borders between networks, and to reject those packets, which
do not have a permission for transmission. Beside attempts to access directly a computer in the protected network,
there are also attacks against the Firewall itself, or attempts to outwit a Firewall with falsified data packets.

Such break-in attempts are recognized, repelled and logged by the Intrusion Detection system (IDS). Thereby it can
be selected between logging within the device, email notification, SNMP traps or SYSLOG alarms. IDS checks the
data traffic for certain properties and detects in this way also new attacks proceeding with conspicuous patterns.

8.4.1 Examples for break-in attempts

Typical break-in attempts are falsified sender addresses ("IP Spoofing") and port scans, as well as the abuse of spe-
cial protocols such as e.g. FTP in order to open a port on the attacked computer and the Firewall in front of it.

IP Spoofing

With IP Spoofing the sender of a packet poses itself as another computer. This happens either in order to trick the
Firewall, which trusts packets from the own network more than packets from untrusted networks, or in order to hide
the author of an attack (e.g. Smurf).

The LANCOM Firewall protects itself against spoofing by route examination, i.e. it examines, whether a packet was
allowed to be received over a certain interface at all, from which it was received.

Portscan Detection

The Intrusion Detection system tries to recognize Portscans, to report and to react suitably on the attack. This hap-
pens similarly to the recognition of a 'SYN Flooding” attack (see ‘SYN Flooding” —page 146): The "half-open" con-
nections are counted also here, whereby a TCP RESET, which is sent by the scanned computer, leaves a "half-open”
connection open again.
If a certain number of half-open connections between the scanned and the scanning computer exist, then this is
reported as a port scan.

Likewise, the receipt of empty UDP packets is interpreted as an attempted port scan.

8.4.2 Configuration of the IDS

Parameters of the Intrusion Detection System are set in LANconfig in the configuration tool 'Firewall/QoS' on index
card 'IDS":
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NHAMEL_HOME Configuration 2=l
Configure: |Firewalla"QoS 'l

Generall Rules I Do5  IDS |

i~ Intrusion Detection System
If the amaount of port inquires grows above the here given

walue, an intrusion attack will be detected and the IDS actions
defined below will be executed.

Maximum port inquinies:

DS - Packet action

 Transmit & Diop " Reject

DS - Further meast

IV Send Spslog message v Send emai
™ SMMF [i.e. La&Nmanitor) ™ Disconnect
™ Lock source address I Lock target port

Duration: | Duratian: I
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:;r:lﬂﬂ 0K I Cancel |

Apart from the maximum number of port inquiries, fragment action and the possible registration mechanisms, also
these reactions are possible:

> The connection will be cut off.
» The sender address will be blocked for an adjustable period of time.
> The destination port of the scan will be blocked for an adjustable period of time.

WEBconfig, The behaviour of the Intrusion Detection Systems can be configured here under WEBconfig or Telnet:
Telnet

WEBconfig Expert Configuration: Setup/IP Router Module/Firewall

Terminal/Telnet ‘ Setup/IP Router Module/Firewall

8.5 Protection against “Denial of Service” attacks

Attacks from the Internet can be break-in attempts, as well as attacks aiming to block the accessibility and functio-
nality of individual services. Therefore a LANCOM is equipped with appropriate protective mechanisms, which recog-
nize well-known hacker attacks and which guarantee functionality.
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8.5.1 Examples of Denial of Service attacks

Denial of service attacks do profit from fundamental weaknesses of TCP/IP protocols, as well as from incorrect imp-
lementations of TCP/IP protocol stacks. Attacks, which profit from fundamental weaknesses are e.g. SYN Flood and
Smurf. Attacks aiming at incorrect implementations are all attacks, which operate with incorrectly fragmented
packets (e.g. Teardrop), or which work with falsified sender addresses (e. g. Land). In the following some of these
attacks are described, their effects and possible countermeasures.

SYN Flooding

SYN Flooding means that the aggressor sends in short distances TCP packets with set SYN flag and with constantly
changing source ports on open ports of its victim. The attacked computer establishes as a result a TCP connection,
replies to the aggressor a packet with set SYN and ACK flags and waits now in vain for the confirmation of the con-
nection establishment. Hundreds of "half-open” TCP connections are staying thereby, and just consume resources
(e.g. memory) of the attacked computer. This procedure can go that far that the victim can accept no more TCP con-
nection or crashes due to the lack of memory.

An appropriate countermeasure of a Firewall is to supervise the number of "half-open" TCP connections, which exists
between two stations and to limit it. That means, if further TCP connections between these workstations were esta-
blished, these connections would be blocked by the Firewall.

Smurf

The Smurf attack works in two stages and paralyzes two networks at once. In the first step a Ping (ICMP echo
Request) packet with a falsified sender address is sent to the broadcast address of the first network, whereupon all
workstations in this network answer with an ICMP echo Reply to the falsified sender address, which is located in the
second network. If the rate of incoming echo requests is high enough, as well as the number of answering worksta-
tions, then the entire incoming traffic of the second network is blocked during the attack and, moreover, the owner
of the falsified address cannot receive normal data any more during the attack. If the falsified sender address is the
broadcast address of the second network, also all workstations are blocked in this network, too.

In this case the DoS recognition of the LANCOM blocks passing packets, which are addressed to the local broadcast
address.

LAND

The land attack is a TCP packet that is sent with set SYN flag and falsified sender address to the victim workstation.
The bottom line is that the falsified sender address is equal to the address of the victim. With an unfortunate imp-
lementation of TCP, the victim interprets the sent SYN-ACK again as SYN, and a new SYN-ACK is sent. This leads to
a continuous loop, which lets the workstation freeze.

In a more up to date variant, the loopback address “127.0.0.1" is taken as sender address, but not the address of
the attacked workstation. Sense of this deception is to outwit personal firewalls, which react in fact to the classical
variant (sender address = destination address), but which pass through the new form without hindrance. This variant
is also recognized and blocked by a LANCOM.
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Ping of Death

The Ping of Death belongs to those attacks, which use errors when fragmented packets are reassembled. This func-
tions as follows:

In the IP header there is a field "fragment offset" that indicates in which place the received fragment is to be assem-
bled into the resulting IP packet. This field is 13 bits long and gives the offset in 8 byte steps, and can form an offset
from 0 to 65528. With a MTU on the Ethernet of 1500 bytes, an IP packet can be made up to 65528 + 1500 - 20 =
67008 bytes. This can lead to an overrun of internal counters or to buffer overruns, and thus it can provoke the pos-
sibility to the aggressor of implementing own code on the victim workstation.

In this case, the Firewall offers two possibilities:

Either, the Firewall reassembles the entire incoming packet and examines its integrity, or solely the fragment which
goes beyond the maximum packet size is rejected. In the first case, the Firewall itself can become the victim when
its implementation was incorrect. In the second case "half" reassembled packets accumulate at the victim, which are
only rejected after a certain time, whereby a new Denial of Service attack can result thereby if the memory of the
victim is exhausted.

Teardrop

The Teardrop attack works with overlapping fragments. After the first fragment another one is sent, which overlaps
completely within the first one, i.e. the end of the second fragment is located before the end of the first. If - due to
the indolence of the IP stack programmer - it is simply counted “new end" - "old end" when determining the number
of bytes to copy for the reassembly, then a negative value results, resp. a very large positive value, by which during
the copy operation parts of the memory of the victim are overwritten and thereupon the workstation crashes.
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The Firewall has again two possibilities:

Either the Firewall reassembles and rejects if necessary the entire packet, or it holds only minimum offset and maxi-
mum end of the packet and rejects all fragments, whose offset or end fall into this range. In the first case the imp-
lementation within the Firewall must be correct, so that the Firewall does not become the victim itself. In the other
case "half" reassembled packets accumulate again at the victim.

Bonk/Fragrouter

Bonk is a variant of the Teardrop attack, which targets not at crashing the attacked computer, but to trick simple port
filter Firewalls, which accept also fragmented packets and thus to penetrate into the network being protected.
During this attack, the UDP or TCP Header of the first fragment is overwritten by skillful choice of the fragment offset.
Thereby, simple port filter Firewalls accept the first packet and the appropriate fragments while overwriting the first
packet's header by the second fragment. Thus suddenly a permissible packet is created, which rather actually should
be blocked by the Firewall.

Concerning this occurrence, the Firewall can itself either reassemble or filter only the wrong fragment (and all follo-
wing), leading to the problems already indicated by either one of the other solutions above.
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ﬁ By default installation all items are configured as "secure”, i.e. maximal 100 permissible half-open connec-
tions by different workstations (see SYN Flooding), at most 50 half-open connections of a single computer
(see Portscan) of fragmented packets to be reassembled.

8.5.2 Configuration of DoS blocking

Parameters against DoS attacks are set in the LANconfig in the configuration tool 'Firewall/QoS' on the register card
'DoS":
NHAMEL _HOME Configuration 2=l

Configure: | Firewall/Qo%S 3 l

GeneraIIHuIes Do |IDS I

— Denial-0f-Service - Detection

Halfopen connections are such that are still in negatiation,

If their amount to & specific host grows above the here given
value, a Denial of Service attack will be detected and the DioS
actions defined below will be executed.

Mawimum halfopen connections: 100

DS - Packet action

 Transmit & Diop " Reject

DS - Further meast

IV Send Spslog message v Send emai
™ SMMF [i.e. La&Nmanitor) ™ Disconnect
™ Lock source address I Lock target port

Duration: | Duratian: |

LANCOM ok, ﬁ I Cancel
Systens

@ In order to drastically reduce the susceptibility of the network for DoS attacks in advance, packets from dis-
tant networks may be only accepted, if either a connection has been initiated from the internal network, or
the incoming packets have been accepted by an explicit filter entry (source: distant network, destination:

local area network). This measure already blocks a multitude of attacks.

For all permitted accesses explicitly connection state, source addresses and correctness of fragments are tracked in
a LANCOM. This happens for incoming and for outgoing packets, since an attack could be started also from within
the local area network.
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This part is configured centrally in order not to open a gate for DoS attacks by incorrect configuration of the Firewall.
Apart from specifying the maximum number of half-open connections, fragment action and possible notification
mechanisms, also these more extensive possibilities of reaction exist:

» The connection will be cut off.

> The sender address will be blocked for an adjustable period of time.

> The destination port of the scan will be blocked for an adjustable period of time.

WEBconfig, The behaviour of the DoS detection and blocking can be configured here under WEBconfig or Telnet:
Telnet

WEBconfig Expert Configuration: Setup/IP Router Module/Firewall

Terminal/Telnet ‘ Setup/IP Router Module/Firewall

However, always active are the following protection mechanisms:
> Address examination (against IP Spoofing)

> Blocking of broadcasts into local area network (against Smurf and Co). czc
(B}
8.5.3 Configuration of ping blocking and Stealth mode N
LANconfig Parameters for ping blocking and Stealth mode can be set with LANconfig under 'Firewall/QoS" on register card
'General":
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New Configuration for LANCOM 7011 ¥PN i 2 x|
Configure: |Firewalla"QoS ‘l

General | Rules | Dos | 105 |

¥ Firewall/Q05 enabled
— General setting

Default YPM rules: |Ereate automatically 'l

Ta the email address of the administrator the e defined
messages will be zent.

Administrator email; |

— Precaution

Fragments: I Fie-azzemble ¥ l
Session recovery: | Denied for default route = l

Fing Blocking: Qff i
Stealth mode: off i
= lways mask. authenticm
— WwWAN only
— Drefault route only
©
=
L
Lt wﬂ oK I Cancel |
WEBCconfig, With WEBconfig or Telnet the suppression of responses can be configured here:
Telnet

WEBconfig Expert Configuration: Setup/IP Router Module/Firewall

Terminal/Telnet Setup/IP Router Module/Firewall
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9 Quality of Service

This chapter dedicates itself to quality: Under the generic term Quality of Service (short: QoS) those LCOS functions
are summarized, which are concerned with the guarantee of certain service availabilities.

9.1 Why QoS?

The main objective of Quality of Service is to transfer certain data packets either particularly safe or as immediately
as possible:

> It may happen during a data transfer that data packets are not delivered to the addressee. But for some appli-
cations it is very important that all sent packets really do arrive. An e-mail, for example, divided into several small
data packets, can only be assembled together again, when all parts have arrived completely. Whether one or an
other packet arrives with little time delay does not make any difference. These applications often count on the
connection-orientated Transmission Control Protocol (TCP). This protocol ensures that data will be transferred
correctly and chronologically via the net. It automatically adjusts the sending rate downwards if the confirmation
of sent data packets is outstanding for longer times, and also takes care of repeated transmission in case of
packet losses.

> In other applications, e.g. telephony via the Internet (Voice-over-IP, VolP), it is - differently to the case above -
very important that the data packets arrive at the addressee with only little time delay. But it really doesn’t mat-
ter if once a data packet gets lost in this case. The participant at the other end of the connection will understand
the caller, even if small parts of the speech got lost. This application aims at the fastest sending of data packets
as possible. The connectionless User Datagram Protocol (UDP) is often used for this kind of application. Also this
protocol has very little administrative overhead. But chronological delivery of packets is not guaranteed, data
packets are simply sent out. Because no confirmation receipt exists, lost packets never get delivered again.
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9.2 Which data packets to prefer?

The necessity of a QoS concept results only from the fact that the available bandwidth is not always sufficient for
transferring all pending data packets reliably and on time. Load peaks result easily from running simultaneously large
FTP downloads, while exchanging e-mails and using IP telephones over the data line. In order to meet also in these
situations the demands of the desired data transfer, certain data packets must be treated preferentially. It is neces-
sary for this, that at first a LANCOM recognizes which data packets should be preferred at all.

There are two possibilities to signal the need for a preferential treatment of data packets in the LANCOM:

> The application, as e.g. the software of certain IP telephones, is itself able to mark the data packets appropria-
tely. This marking, the “tag”, is set within the header of the IP packets. The two different variants of this marking
“ToS" and "DiffServ” can simply described assume the following states:

> ToS “Low Delay”
> ToS “High Reliability”
> DiffServ “Expedited Forwarding”
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> DiffServ “Assured Forwarding”

The IP header bits of the ToS resp. DiffServ field are copied in case of a VPN route also into the enclosing IP
header of the IPSec VPN packet. Thus QoS is available also for VPN routes over the Internet, as long as your
provider treats according packets preferentially also in the WAN.

» When the application itself has no possibility to mark the data packets appropriately, the LANCOM can ensure
the correct treatment. For this, it uses the existing functions of the firewall, which can classify e.g. data packets
according to subnets or services (applications). Due to these functions it is e. g. possible to treat individually data
packets of a FTP connection or those of a certain department (in a separate subnet).

For treatment of data packets classified by the firewall the following two possibilities can be chosen:

> Guaranteed minimum bandwidth
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> Limited maximum bandwidth
What is DiffServ?

DiffServ stands for “Differentiated Services” and is a quite recent model to signal the priority of data packets.
DiffServ is based on the known Type-of-Service(ToS) field and uses the same byte within the IP header.

ToS is using the first three bits to describe the priorities (precedence) 0 to 7, as well as four further bits (the ToS
bits) to optimize the data stream (e.g. “Low Delay” and “High Reliability”). This model is rather inflexible, and this
is why it has been used quite rarely in the past.

The DiffServ model uses the first 6 bits to make distinctions of different classes. Up to 64 gradings are thus pos-
sible (Differentiated Services Code Point, DSCP) which enable a finer priorisation of the data stream:

» To ensure downward compatibility with ToS implementations, the previous precedence levels can be depicted
with the “Class Selectors” (CSO to CS7). Thereby, the level “CS0” denotes so-called “Best Effort” (BE) and
stands for usual transfer of data packets without special treatment.

» The “Assured Forwarding” classes are used for a secured transfer of data packets. The first digit of the AF

class describes each the priority of the transfer (1 to 4), the second digit the “drop probability” (1 to 3).
Packets with AFxx marking are transferred in a secured way, and thus not dropped.

<b)
» Finally, the class “Expedited Forwarding” marks those packets, that shall be transferred preferentially, before 2
P
. (S5)
all other packets A
S—
(=]
_ _ _ :'é\
=
S
S
CS0 (BE) | 000000 |0 AF11 001010 |10 AF33 011110 |30
Cs1 001000 |8 AF12 001100 |12 AF41 100010 |34
52 010000 |16 AF13 001110 |14 AF42 100100 |36
s3 011000 |24 AF21 010010 |18 AF43 100110 |38
Cs4 100000 |32 AF22 010100 |20 EF 101110 |46
Cs5 101000 | 40 AF23 010110 |22
Cs6 110000 |48 AF31 011010 |26
cs7 111000 | 56 AF32 011100 |28

9.2.1 Guaranteed minimum bandwidths

Hereby you give priority to enterprise-critical applications, e.g. Voice-over-IP (VoIP) PBX systems or certain user
groups.
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Full dynamic bandwidth management for sending

Concerning the sending direction, the bandwidth management takes place dynamically. This means that e.g. a qua-
ranteed minimum bandwidth is only available, as long as the corresponding data transfer really exists.

An example:

For the transmission of VoIP data of an appropriate VoIP gateway, a bandwidth of 256 Kbps is to be guaranteed
always. Thereby, each individual VoIP connection consumes 32 Kbps.

As long as nobody telephones, the entire bandwidth is at the disposal to other services. Per adjacent VolP connection
32 Kbps less is available to other applications, until 8 VoIP connections are active. As soon as a VolP connection is
terminated, the corresponding bandwidth is available again to all other applications.

<‘ For correct functioning of this mechanism, the sum of the configured minimum bandwidth must not exceed
the effectively available transmission bandwidth.

Dynamic bandwidth management also for reception

For receiving bandwidth control, packets can be buffered and only belatedly confirmed. Thus TCP/IP connections
regulate themselves automatically on a smaller bandwidth.

Each WAN interface is assigned a maximum reception bandwidth. This bandwidth will be accordingly degraded by
every QoS rule that guarantees a minimum bandwidth of reception on this interface.

> Ifthe QoS rule has been defined connection-related, the reserved bandwidth will be unblocked immediately after
releasing the connection and the maximum available bandwidth will increase accordingly on the WAN interface.

> If the QoS rule has been defined globally, then the reserved bandwidth will be unblocked only after the ending
of the last connection.

9.2.2 Limited maximum bandwidths

Hereby you limit e.g. the entire or connection-related maximum bandwidth for server accesses.
An example:
You operate both a Web server and a local network on a shared Internet access.

To prevent that your productive network (LAN) is paralyzed by many Internet accesses to your Web server, all server
accesses are limited to half of the available bandwidth. Furthermore, in order to guarantee that your server services
are available equally to many users at the same time, a certain maximum bandwidth per each server connection is
set.

Combination possible

Minimum and maximum bandwidths can be used together in combination. Thus the available bandwidth can be
distributed accordingly depending on your requirements, e.g. on certain user groups or applications.
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9.3 The queue concept

9.3.1 Queues in transmission direction

Quality of Service requirements are realized in LCOS by using different queues for the data packets. For the transmis-
sion side, the following queues are utilized:
» Urgent queue |

This queue is always processed at first before all others. The following data packets are handled here:

> Packets with ToS “Low Delay”

> Packets with DiffServ “Expedited Forwarding”

> All packets that have been assigned a certain minimum bandwidth, as long as the guaranteed minimum
bandwidth is not exceeded.

> TCP control packets can be likewise dispatched by this queue preferentially (see 'SYN/ACK speedup’
—page 67).

» Urgent queue Il
This is for all packets that have been assigned a guaranteed minimum bandwidth, but whose connection has
exceeded this minimum bandwidth.

As long as the interval for the minimum bandwidth is not exceeded (i.e. up to the end of the current second), all
packets in this queue are treated without further special priority. All packets of this queue, of the "secured
queue” and the "standard queue" share now the existing bandwidth. The packets are taken in order from the
queues when sending in exactly the same sequence, in which they have been placed into these queues. If the
interval runs off, all blocks, which are at this time still in the "Urgent queue 11" up to the exceeding of the in each
case assigned minimum bandwidth, are placed again into the "Urgent queue I". The rest remains in the "Urgent
queue 1",
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With this procedure it is guaranteed that prioritized connections do not crush the remaining data traffic.

> Secured queue
This queue does not have a separate priority. However, packets in this queue are never dropped (transmission
guaranteed).
> Packets with ToS “High Reliability"
1> Packets with DiffServ “Assured Forwarding”

> Standard queue
The standard queue contains all not classified data traffic. Packets in this queue are dropped at first when
packets cannot be delivered fast enough.

The queue concept can, however, only work out when a “traffic congestion” of data packets has been accumulated
at the interface from LAN to the WAN. Such a congestion is created when the interface within the LANCOM can
submit fewer data to the WAN than data are delivered in peak periods from the LAN. This is e.g. the case, if the
interface to the WAN is an integrated ADSL interface with comparatively low transmission speed (“upstream”). The
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integrated ADSL modem automatically reports back to the LANCOM how many data packets it is still able to receive,
and thus brakes the data stream already within the router. As a result, the queues will automatically fill up.

h Queues

Different is the case, if an Ethernet interface represents the connection to the WAN. From the LANCOM'’s point of
view, the connection to the Internet via an external broadband modem looks like an Ethernet segment. On the dis-
tance from the LANCOM to the DSL modem, data will be transferred with full LAN speed of 10 or 100 Mbps. Because
of an equal input and output speed, no natural congestion will be produced then. Furthermore, the Ethernet between
the LANCOM and the broadband modem does not report anything about the capacity of the connection. The con-
sequence: a congestion will only be happen within the broadband modem. But because no queues are deployed
therein, surplus data will be lost. Thus a prioritisation of “preferred” data is not possible!

l dropped data

To solve this problem, the transfer rate of the LANCOM's WAN interface will be reduced artificially. This interface will
thereby be adjusted to the transfer rate that is available for the actual data transport towards the WAN. For a stan-
dard DSL connection, the DSL interface is thus adjusted in the LANCOM to the appropriate upstream rate (e.g. 128
kbps).

Data rates indicated by providers are mostly likely net rates. The gross data rate, which is available for the interface
is a little bit higher than the net data rate guaranteed by the provider. If you know the gross data rate of your
provider, you can enter this value for the interface and slightly increase in this way the data throughput. However,
with entering the net data rate you play safe in any case!
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9.3.2 Queues for receiving direction

Apart from the data transfer rate in transmission direction, the same consideration applies also to the receiving direc-
tion. Due to its 10 or 100 Mbps Ethernet interface, the LANCOM's WAN interface is fed by clearly fewer data from
the broadband modem than would actually be receiveable. All data packets received on the WAN interface are trans-
ferred to the LAN with equal rights.

In order to be able to prioritise incoming data as well, thus an artificial “brake” must be added also in this direction.
Like already incorporated for the upstream direction, the data transfer rate of the interface is therefore adapted to
the provider's offer in the downstream direction. For a standard DSL connection thus e.g. a downstream rate of 768
kbps applies. Again, the gross data rate can be entered here, if known.

Reducing the receiving bandwidth makes possible to treat received data packets suitably. Preferred data packets will
be directly passed on to the LAN up to the guaranteed minimum bandwidth, all remaining data packets are running
into congestion. This congestion produces generally a delayed confirmation of the packets. For a TCP connection,
the sending server will react to this delay by reducing its sending frequency and adapting itself to the available band-
width.

The following queues operate on the receiving side:
> Deferred Acknowledge Queue

Each WAN interface contains additionally a QoS reception queue, which takes up those packets that should be
.Slowed down”. The storage period of each individual packet depends on its length and on the actual permitted
reception bandwidth on the receiving side. Packets with a minimum reception bandwidth assigned by a QoS rule
are passing through without any further delay, as long as the minimum bandwidth is not exceeded.
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> Standard reception queue

All packets that do not need special treatment because of an active QoS rule on the receiving side end up here.
Packets of this queue are directly passed on resp. confirmed without consideration of maximum bandwidths.

9.4 Reducing the packet length

The preferential treatment of data packets belonging to important applications can be endangered - depending on
the situation - by very long data packets of other applications. This is the case e.g. when IP telephony and a FTP data
transfer are simultaneously active on the WAN connection.

1

The FTP transfer uses quite large data packets of 1500 byte, whereas, the Voice over IP connection sends packets of
e.g. 24 byte net in relatively short intervals. If FTP packets are in the sending queue of the LANCOM just at the
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moment when a VolP packet is to be transferred, then the VoIP packet can only be sent after the line is free again.
Depending on the transfer rate of the connection, this may cause a noticeable delay of the speech transmission.

="
%
EDDDDDEDE@

This annoying behaviour can be compensated if all data packets, which are not belonging to the connection prefer-
red by QoS, do not exceed a certain packet length. While doing so, the data packets of the FTP connection will be
divided into such small sections that the time-critical VoIP connection is able to deliver the packets without notice-
able delay within the required time slots. A resulting delay has no disadvantageous effect to the TCP-secured FTP

transfer.
%

EEDEEDDDD@

Two different procedures exist to influence the packet length:

L@

L@

> The LANCOM can inform the peers of a data connection that they should only send data packets up to a certain
length. Thereby, an appropriate PMTU (Path Maximum Transmission Unit) is enforced on the sending side. This
procedure is called PMTU reduction”.
The PMTU reduction can be used for sending as well as for receiving direction. For the sending direction, the
data source of the own LAN is adjusted with the PMTU reduction to a smaller packet size, for the receiving direc-
tion the data source of the WAN, e.g. web or FTP servers in the Internet.

Provided that the data connection already exists when the VolP connection is started, the senders regulate
packet lengths very quickly to the permitted value. When setting up new data connections while a VolP connec-
tion is already established, the maximum permitted packet length is negotiated directly during the connection
phase.
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@ The reduced packet length on the data connection still remains also after terminating the VoIP connection,
as long as the sender checks the PMTU value again.

> The LANCOM is able to split packets to be sent above an adjustable maximum size (e.g. 256 byte) into smaller
units itself. But such a procedure called “fragmentation” is not supported by all servers of the Internet, because
dealing with fragmented packets is considered as a security risk, and therefore is turned off by many servers.
That's why disturbances can occur e.g. while downloading or while transmitting web pages.
Thus, this procedure is recommended only for connections without involving unknown servers, e.g. for a direct
connection of branches to their head office via VPN connection, over which the Internet traffic is not running
simultaneously.

9.5 QoS parameters for Voice over IP applications

An important task when configuring VoIP systems is to guarantee a sufficient voice quality. Two factors considerably
influence the voice quality of a VoIP connection: The voice delay on its way from sender to addressee, as well as the
loss of data packets, which do not arrive or do not arrive in time at the addressee. The “International Telecommuni-
cations Union” (ITU) has examined in extensive tests, what human beings perceive as sufficient voice quality, and
has published as the result in the ITU G.114 recommendation.

A Packet loss litter
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20 %

10 %

5%

>

100 ms 150 ms 300 ms Delay

In case of a delay of not more than 100 ms, and a packet loss of less than 5%, the quality is felt like a “normal”
telephone connection. In case of more than 150 ms delay and less than 10% packet loss, the telephone user per-
ceives still a very good quality. Up to 300 ms and 20%, some listeners feel this quality like still suitable, beyond that

the connection is considered as no more suitable for voice transmission.
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Apart from the average delay time, also a variation in this delay is perceived by the human ear. Delay differences of
the voice information from sender to addressee (jitter) are still tolerated up to 10 ms, and values beyond considered
as irritating.

Accordingly, a VoIP connection should be configured such that the criteria for good speech quality are met: Packet
loss up to 10%, delay up to 150 ms and jitter up to 10ms.

> litter can be removed in the receiving station by an appropriate buffer. In this buffer (jitter buffer) the packets
are stored intermediately, and passed on at a constant rate to the addressee. By this intermediate buffering, the
delay variations due to individual transmission times of the individual packets can be removed.

» The delay is influenced by several components:

> Time of processing (packeting, coding and compression by the sender and the addressee), duration of han-
ding over the packet from application to the interface (serialization), and the time for transmitting via the
WAN distance (propagation) contribute to the fixed part of delay.

> The variable part is determined by the jitter resp. by the setting of the jitter buffer.
These two parts together compose a delay, which should ideally not exceed 150 ms.

Delay < 150 ms! (@
_____________________ > 4
F‘ Processing

Processing
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Propagation

> Apart from the general loss by network transmission, the packet loss is significantly influenced by the jitter buffer.
If packets arrive with a larger delay than it can be balanced by the jitter buffer, the packets will be discarded and
will increase the packet loss. The larger the jitter buffer, the smaller is the loss. Conversely, the entire delay will
increase with the jitter buffer size. That means for configuration, that the jitter buffer should be selected as small
as the quality can be considered still as sufficient.

In detail, delay is determined especially by the codec used, the resulting packet size and the available bandwidth:

In comparison: satellite quality

Processing  Serialization Propagation Jitter buffer

>
150ms

> The time for processing is determined by the used codec. For a sampling time of 20 ms, exactly each 20 ms a
new packet is generated. Times for compression can mostly be neglected.
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» The time for handing over the packet to the interface is defined by the quotient of packet size and available

bandwidth:

56 Kbps 0,14 9 18 36 73 146 215
64 Kbps 0,13 8 16 32 64 128 187
128 Kbps 0,06 4 8 16 32 64 93
256 Kbps 0,03 2 4 8 16 32 47
512 Kbps 0,016 1 2 4 8 16 23
768 Kbps 0,010 | 06 13 2,6 5 11 16
1536 Kbps | 0,005 | 0,3 0,6 13 3 5 8

A 512 byte packet of an FTP connection occupies the line at 128 Kbps upstream for at least 32 ms.

Besides, the packets of the VoIP connection are often much larger than the pure net payload. The additional hea-
ders of the IP and Ethernet packets, as well eventual IPsec headers have to be added as well. The net load results
from the product of net data rate and sampling time of the used codec. For all codecs, each 40 bytes UDP header
and at least 20 bytes for the IPSec header must be added (RTP and IPSec headers can be larger, depending on
the configuration).
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G.723.1 | 6,3 Kbitis 30 ms 333 24 byte 64 byte 84 byte 22,3 Kbps

G711 64 Kbit/s 20 ms ‘ 50 ‘ 160 byte ‘ 200 byte ‘ 276 byte ‘ 110.4 Kbps

Since packets encrypted with DES, 3DES, or AES, are only able to grow in block sizes of 64 bytes, the IPSec packet
for G.711 consists of 160 bytes payload + 96 bytes up to the next block limit + 20 bytes IPsec header = 276 bytes.

Assimilar “quote of loss” can also occur for the G.723 codec, if e.g. the RTP header is longer than 12 bytes. Then,
the IP packet will grow up to the next block limit of 128 bytes; plus 20 bytes for the IPsec header creates packets
of an overall length of 128 bytes, which means more than the sixfold net load!

The required bandwidth for transmission results finally from the quotient of packet size and sampling time.

> The time for transmission via Internet depends on the distance (about 1 ms per 200 km), and on the thereby
passed routers (about 1 ms per hop). This time can be approximated by the half average ping time to the remote
station.

> The jitter buffer can be adjusted directly at many IP telephones, e.g. as fixed number of packets, which should
be used for buffering. The telephones load then up to 50% of the adjusted packets and begin afterwards to
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replay. The jitter buffer correspond therefore to half of the entered packets multiplied with the sampling time of
the codec.

» Conclusion: The total delay is composed as follows for the according bandwidth, a ping time of 100 ms to the
remote station and a jitter buffer of 4 packets for both codecs in this example:

G.723.1 30 ms 32 ms 50 ms 60 ms 172 ms

G711 20 ms ‘32 ms ‘50 ms ‘40 ms ‘ 142 ms

The transfer time of the packets to the interface (serialization) assumes a PMTU of 512 bytes on a 128 Kbps con-
nection. Therefore, for slower interfaces or other codecs it is eventually necessary to adjust jitter buffers and/or
PMTU values.

@ Please notice that the bandwidths are required in the sending and receiving direction, as well as just for one
single connection.

9.6 QoS in sending or receiving direction

For controlling data transfer by means of QoS one can select whether the according rule applies to the sending or
to the receiving direction. But which direction refers to sending and receiving for a given a data transfer depends on
the particular point of view. The following two variants apply:

> The direction corresponds to the logical connection setup
» The direction corresponds to the physical data transfer over the appropriate interface

The differences are unveiled by looking at a FTP transfer. A client of the LAN is connected to the Internet through a
LANCOM.

» During an active FTP session, the client sends by the PORT command the information to the server, on which port
the DATA connection is expected. As the result, the server establishes the connection to the client and sends the
data in the same direction. In this case, the logical connection as well as the real data stream over the interface
go from the server to the client, and the LANCOM takes both as the receiving direction.

> Different is the case of a passive FTP session. Here the client itself establishes the connection to the server. The
logical connection setup thus is from client to server, but the data transmission over the physical interface flows
in the reverse direction from server to client.

With standard settings, a LANCOM assumes the sending or receiving direction depending on the logical connection

setup. Because such a point of view may not be easy to follow in certain application scenarios, the point of view can
alternatively be changed to the flow of the physical data stream.



LANCOM Reference Manual LCOS 3.52 » Chapter 9: Quality of Service

LANconfig

WEBCconfig,
Telnet

> QoS configuration

The differentiation between sending and receiving direction applies only to the installation of maximum
ﬁ bandwidths. For a guaranteed minimum bandwidth, as well as for fragmentation and PMTU reduction
always the physical data transfer via the respective interface applies as the direction!

9.7 QoS configuration

9.7.1 Evaluating ToS and DiffServ fields

ToS or DiffServ?

For configuration with LANconfig, select the configuration field 'IP router'. Adjust on index card 'General' whether
the Type of service field' or alternatively the 'DiffServ field" is to be observed for prioritisation of data packets. When
both options are turned off, the ToS/DiffServ field will be ignored.

1621AnnexB Configuration 2=l
Configure: |IP Flouter 'l

General | Houtingl Mazq. I M:M Mappingl

¥ IP router enabled
Fouting option

V¥ Use Proxy ARP to tie remate stations into the LAN
™ Forward packets within the local network

[ Transfer ICMP packets secured

¥ Pass on TCP SN and ACK packets preferentially
™ Maote the Type-Of-Service field in IP packets

¥ Intarnrat the DS ar fisld in 1P nacketz

For configuration with WEBconfig or Telnet, your decision for the evaluation of the ToS or DiffServ fields are entered
at the following places:

WEBCconfig Setup/IP router module/Routing method

Telnet ‘ Setup/IP router module/Routing method
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Feature settings for routing method values are the following:
> Standard: The ToS/DiffServ field is ignored.

> TOS: The ToS/DiffServ field is considered as ToS field, the bits “Low delay” and “High reliability” will be evalua-
ted.
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> DiffServ: The ToS/DiffServ field is interpreted as DiffServ field and evaluated as follows:

CSx (including CSO = BE) normal transmission

AFxx secured transmission

EF preferred transmission

DiffServ in Firewall rules

The code points from the DiffServ field can be evaluated by Firewall rules for further control of QoS parameters such
as minimum bandwidth or PMTU reduction.

LANconfig The parameters for evaluating the DiffServ fields are adjusted when defining the QoS rule in LANconfig:

Fiter ile 21|
General I Actions (oS | Stations I Service I
'
-~ Qualiy of Service 21|
?% The Quality-0f-Service table describes anar  — Canditian
=)

amount of minimal bandwidths, fragmentatior
reduction of PMTU actions, which assure, th [~ Action only for default route [i.e. intemet)

tchi ket ted prefered.
et e [ Action ony for DifiServCP: [aF =]z ][« =]
[ Action only for send packets

¥ #ction only for received packets

Actions

D
.S
N
)
51
S—
Q
=
=
©
S
(@]

—Action

% Grank minimum bandwidth

. = kbit j |U |per zecond j
il il R | Bl | = & Per cornection ¢ Global

" Fragmentation of other packets

Maw Packetsize: I Bytes

 Feduction of PMTL

BT I Bytes

According to your selection of the DSCP type (BE, CS, AF, EF) the valid values can be adjusted in additional drop down
lists. Alternatively, the DSCP decimal value can be entered directly. A table listing valid values can be found under
‘What is DiffServ?’ —page 153.

WEBconfig, For configuration with WEBconfig or Telnet, the parameters are entered at the following places into a new Firewall
Telnet .
rule:

WEBconfig Setup/IP router module/Firewall/Rule list

Telnet Setup/IP router module/Firewall/Rule list
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The Firewall rule is extended by condition “@d” and the DSCP (Differentiated Services Code Point). The code point
can either be indicated with its name (CSO - CS7, AF11 to AF 43, EF or BE) or its decimal resp. hexadecimal depiction.

“Expedited Forwarding” can therefore be indicated as “@dEF”, “@d46" or “@d0x2e". Furthermore, collective names
(CSx resp. AFxx) are possible.

Examples:

> %Lcds0 @dAFxx %A: Accept (secured transmission) on DiffServ “AF”, limit “0”

> %Qcds32 @dEF: Minimum bandwidth for DiffServ “EF” of 32 kbps

> %Fprw256 @dEF: PMTU reduction for reception for DiffServ “EF” to 256 bytes

These examples reserve a desired bandwidth for Voice over IP phone calls. The first element “%Lcds0 @dAFxx %A
accepts DSCP “"AFxx" marked packets of signalling calls. Voice data marked with “EF" is transferred preferentially by
the entry “%Qcds32 @dEF", and a bandwidth of 32 Kbps is guaranteed thereby as well. In parallel, the PMTU is

reduced to 256 byte by “%Fprw256 @dEF”, which enables ensuring the required bandwidth in receiving direction
atall.

@ Further information about defining Firewall rules can be found in chapter ‘Firewall” —page 95.

9.7.2 Defining minimum and maximum bandwidths

A minimum bandwidth for certain applications is defined in LANconfig by a Firewall rule according to the following
conditions:

> The rule does not need an action, because QoS rules always implicitly assume “transfer” as action.

> The guaranteed bandwidth is defined on index card ‘QoS".

2|
Generall Actions QoS |Stati0ns| Service |
— Quality of Service
0 The Quality-0F-Service table desor | Conditiors
L, amount of minimal bandwidths, frac i S
fsi) (Salietian SEEM T e rich [~ Action only for default route [i.e. intemet)
matching packets are routed prefe I~ Action only for DiffSere-CP:  [BE +
Ations ™ Action only for send packets
[ Action anly for received packets
—Action
% Grank minimum bandwidth
Ikbit j |258 per second j
3 f T - | absolut
i | A | Add... Edit... {* Per connection p it
" Fragmentation of other packets e minute
Maw Packetsize: | e
 Feduction of PMTL
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> The option 'Action only for default route' limits the rule to those packets, which are sent or received via
default route.

> The option 'Action only for VPN route' limits the rule to those packets, which are sent or received via VPN
tunnel.

I> The option 'Per connection' resp. 'Globally' specifies, whether the minimum bandwidth set here is valid for
each single connection corresponding to this this rule (‘per connection’), or, if this should be the upper limit
for the sum of all connections together (‘globally’).

> Like for other Firewall rules, index cards 'Stations' and 'Services' determine for which stations in the LAN / WAN
and for which protocols this rule applies.

For configuration with WEBconfig or Telnet, the minimum resp. maximum bandwidths are entered into a new Fire-
wall rule at the following places:

WEBconfig Setup/IP router module/Firewall/Rule list

Telnet ‘ Setup/IP router module/Firewall/Rule list

A required minimum bandwidth is introduced by “%Q". Here it is implicitly assumed that the respective rule is an
“Accept” action, and that the packets will thus be transmitted.

A maximum bandwidth is simply defined by a limit rule, which discards by a “Drop” action all packets, which exceed
the defined bandwidth.

Examples:
> %Qcds32: Minimum bandwidth of 32 kbps for each connection
> %Lgds256 %d: Maximum bandwidth of 256 kbps for all connections (globally)

@ Further information about defining Firewall rules can be found in chapter ‘Firewall” —page 95.

9.7.3 Adjusting transfer rates for interfaces

ﬁ Devices with built-in ADSL/SDSL modem resp. with an ISDN adapter make these settings independently for
' the respective interface. For a LANCOM model with Ethernet and ISDN interface, these settings have to be
made solely for the Ethernet interface.

Data rate restrictions for Ethernet, DSL and DSLoL interfaces are entered in LANconfig under configuration field
‘Management' on index card 'Interfaces’ within the settings for the different WAN interfaces:
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¥ DSLol interface enabled
Downstrean rake: I FE8 byte k
Cancel |

Upstream rate: 128 kBit}s

External overhead: I 36| byte

> An Ethernet WAN (DSL/cable) and DSLoL interface can be switched off completely in this dialogue.

> Asupstream and downstream rate the gross data rates are entered, which are usually a little bit higher than the
net data rates indicated by the provider as the guaranteed data rate (see also ‘'The queue concept’ —page 155).

> The “external overhead” considers information added to the packets during the data transfer. Concerning appli-
cations with small data packets (e.g. Voice over IP), this extra overhead is quite noticeable. Examples for the
external overhead:

PPPoE0A 36 bytes additional headers, loss by not completely used ATM cells
PPTP 24 bytes additional headers, loss by not completely used ATM cells
IPoA (LLC) 22 bytes additional headers, loss by not completely used ATM cells

IPoA (VC-MUX) | 18 bytes additional headers, loss by not completely used ATM cells

Cable modem 0 direct transfer of Ethernet packets

Under WEBconfig or Telnet the restrictions of data transfer rates for Ethernet, DSL and DSLol interfaces are entered
at the following places:

WEBconfig Setup/Interfaces/DSL Interfaces

Telnet Setup/Interfaces/DSL Interfaces

@ Only upstream and downstream rates are indicated by Kbps, external overhead in bytes/packet.

9.7.4 Sending and receiving direction

The interpretation of the data transfer direction can be adjusted in LANconfig when defining the QoS rule:
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Fiter ile 21|
Generall Actions (oS |Stati0ns| Servicel
Quality of Service 3 2l

— Quality of Service

0 The Quality-Of-Service table describes ¢ [~ Condition
L‘E‘, amount of minimal bandwidths, fragment
reduction of PMTL actions, which assur

matching packets are routed preferred. I~ Action arly for DiffSere-CP: [RE =
Actions

[~ Action only for default route [i.e. intemet)

v ction only for send |:|ac:kets‘g

[ Action anly for received pacl

—Action

% Grank minimum bandwidth
Ikbit j |U |per zecond j
oir | A | Add---i\l Edit.. | & Per cornection { Global

" Fragmentation of other packets

Maw Packetsize: I Bytes
" Radurtinn nf PMTL

@ WEBconfig, For configuration with WEBconfig or Telnet, the interpretation of the data transfer direction is specified at the follo-
2 Telnet wing places in a new Firewall rule by parameters “R” for receive, “T" for transmit (send) and “W" for reference to
3 the WAN interface:
54
S—
S
=
§ WEBconfig Setup/IP router module/Firewall/Rule list

Telnet Setup/IP router module/Firewall/Rule list

A restriction of data transfer to 16 Kbps in sending direction applying to the physical WAN interface is e.g. made by
the following Firewall rule:

» %Lcdstw16%d

9.7.5 Reducing the packet length

The length reduction of the data packets is defined by a Firewall rule according to the following conditions:
> The reduction refers to all packets, which will be sent to the interface and which do not correspond to the rule.
> Not packets of certain protocols are reduced, rather than all packets globally on that interface.

LANconfig The length reduction of the data packets is set in LANconfig when defining the QoS rule:

168



LANCOM Reference Manual LCOS 3.52 » Chapter 9: Quality of Service

> QoS configuration

Fiterrule 21|
Generall Actions (oS |Stati0ns| Servicel
lity of Servi y 20 x
e 21|

? The Quality-Of-Service table describes an. [ Condition
amount of minimal bandwidths, fragmentati
reduction of PMTL actions, which assure,

matching packets are routed preferred. [~ Action only for DiffS erv-CP: IBE vl
Actions

[~ Action only for default route [i.e. intemet)

¥ Action only for send packets

[ Action anly for received packets

—Action

7 Grank minimum bandwidth
lebit LI IU Iper zecond j
il il Add... [\ | Edit.. | i {% | Fer conection € Global
' Fragmentation of other packets
Max.Packetsiée:W Butes
 Feduction of PMTL

BT I Bytes

©
)
WEBconfig, For configuration with WEBconfig or Telnet, the reduction is entered at the following places in a new Firewall rule &
Telnet by parameter “P" for PMTU reduction (Path MTU, MTU = Maximum Transmission Unit) and “F" for the fragment size: 52
S
=
IS
S
WEBconfig Setup/IP router module/Firewall/Rule list S
Telnet Setup/IP router module/Firewall/Rule list

PMTU reduction and fragmentation refer always to the physical connection. Indicating parameter “W" for
WAN sending direction is not required here and hence will be ignored if existing.

The following example shows a setting for Voice over IP telephony:

VolIP IP addresses of IP IP addresses of IP | %Qcds32 %Prt256 ubP
telephones in the | telephones in the
LAN, all ports LAN, all ports

This rule defines the minimum bandwidth for sending and receiving to 32 Kbps, forces and reduces the PMTU while
sending and receiving to packets of 256 byte size. For the TCP connection, the maximum segment size of the local
workstation is determined to 216, so that the server will send packets of maximum 256 byte (reduction of the PMTU
in sending and receiving direction).
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10 Virtual Private Networks—VPN

10.1 What does VPN offer?

A VPN (Virtual Private Network can be used to set up cost-effective, public IP networks, for example via the Internet.

While this may sound unspectacular at first, in practice it has profound effects. To illustrate this, let's first look at a
typical corporate network without VPN technology. In the second step, we will see how this network can be optimi-
zed by the deployment of VPN,

Conventional network infrastructure

First, let's have a look at a typical network structure that can be found in this form or similar forms in many compa-
nies:
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Computers
using remote

Q access, e.g.

home working

Branch office

The corporate network is based on the internal network (LAN) in the headquarters. This LAN is connected to the out-
side world in three ways:

@ A subsidiary is connected to the LAN, typically using a leased line.
@ PCs dial into the central network via modem or ISDN connections (Remote Access Service — RAS).

@ The central LAN has a connection to the Internet so that its users can access the Web, and send and receive e-
mail.

All connections to the outside world are based on dedicated lines, i.e. switched or leased lines. Dedicated lines are
very reliable and secure. On the other hand, they involve high costs. In general, the costs for dedicated lines are
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dependent on the distance. Especially in the case of long-distance connections, keeping an eye out of cost-effective
alternatives can be worthwhile.

The appropriate hardware must be available in the headquarters for every type of required connection (analog dial-
up, ISDN, leased lines). In addition to the original investment costs, ongoing costs are also incurred for the adminis-
tration and maintenance of this equipment.

Networking via the Internet
The following structure results when using the Internet instead of direct connections:

s

(L
rEﬂE
Wi

Headquarters

Branch office Computers using remote access

All participants have fixed or dial-up connections to the Internet. Expensive dedicated lines are no longer needed.

@ Allthatis required is the Internet connection of the LAN in the headquarters. Special switching devices or routers
for dedicated lines to individual participants are superfluous.

@ The subsidiary also has its own connection to the Internet.

© The RAS PCs connect to the headquarters LAN via the Internet.

The Internet is available virtually everywhere and typically has low access costs. Significant savings can thus be

achieved in relation to switched or dedicated connections, especially over long distances.

The physical connection no longer exists directly between two participants; instead, the participants rely on their
connection to the Internet. The access technology used is not relevant in this case: ideal is the use of broadband
technologies such as DSL (Digital Subscriber Line) in combination with flatrate contracts. But also a conventional
ISDN line can be used.
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The technologies of the individual participants do not have to be compatible to one another, as would be the case
for conventional direct connections. A single Internet access can be used to establish multiple simultaneous logical
connections to a variety of remote stations.

The resulting savings and high flexibility makes the Internet (or any other IP network) an outstanding backbone for
a corporate network.

Two technical properties of the IP standard speak against using the Internet as a part of a corporate network, howe-
ver:

> The necessity of public IP addresses for all participants

> The lack of data security of unprotected data transfers

10.1.1 Private IP addresses on the Internet?

The IP standard defines two types of IP addresses: public and private. A public IP address is valid worldwide, while
a private IP address only applies within a closed LAN.

Public IP addresses must be unique on a worldwide basis. Private IP addresses can occur any number of times world-
wide; they must only be unique within their own closed network.

Normally, PCs in a LAN only have private IP addresses, while the router to the Internet also has a public address. All
PCs behind this router have access to the Internet via its public IP address (IP masquerading). In such a case, only
the router itself is responsive via the Internet. PCs behind the router are not responsive to the Internet without inter-
vention by the router.

=
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Routing at the IP level with VPN

IP connections must be established between routers with public IP addresses in order to link networks via the Inter-
net. These routers provide the connections between multiple subnetworks. When a computer sends a packet to a
private IP address in a remote network segment, the local router forwards the packet to the router of the remote
network segment via the Internet.
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The VPN gateway handles the conversion between private and public IP addresses. Without VPN, computers without
public IP addresses would not be able to communicate with one another via the Internet.

10.1.2 Secure communications via the Internet?

The idea of using the Internet for corporate communications has been met with skepticism. The reason for this is
that the Internet lies beyond a company's field of influence. Unlike dedicated connections, data on the Internet tra-
vels through the network structures of third parties that are frequently unknown to the company.

In addition, the Internet is based on a simple form of data transfer using unencrypted data packets. Third parties can
monitor and perhaps even manipulate the contents of these packets. Anyone can access the Internet. As a result,
third parties may gain unauthorized access to the transferred data.
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VPN — Security through encryption

VPN was developed as a solution to this security problem. If necessary, it can encrypt the complete data communi-
cations between two participants. The packets are then unreadable for third parties.

The latest and most secure encryption technologies can be used for VPN. A very high level of security can thus be
reached. VPN-protected data traffic via the Internet offers a degree of security that at least corresponds to that of
dedicated lines.

Codes usually referred to as "keys" are agreed upon between the participants and used for data encryption. Only the
participants in the VPN know these keys. Without a valid key, it is not possible to decrypt the data. They thus remain
"private”, inaccessible to unauthorized parties.

Send your data through the tunnel — for security’s sake

This also explains the nature of a virtual private network: A fixed, physical connection between the devices of the
type required for a direct connection does not exist at any time. Rather, the data flows via suitable routes through
the Internet. With the proper technology, third parties can monitor and even record data traffic. As the packets are
encrypted by VPN, the actual content of the packets is inaccessible. Experts compare this state to a tunnel: it's open
at either end, but perfectly shielded in between. Secure connections within public IP networks are thus also referred
to as "tunnels".

The goal of modern network structures has thus been achieved: secure connections via the largest and most low-
cost public IP network: the Internet.

10.2 LANCOM VPN: an overview

10.2.1 VPN example application

VPN connections are used in many different fields of application. In most cases, a variety of communications tech-
nologies is used for transferring both data and audio, and VPN unites these systems into an integrated network. The
following example illustrates a typical application that is often used in practice.
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Voice-over-1P
telecommuni-
Access via public WLAN
“--thotspot)

&

Mobile user

The principal components and features of these applications:

>

>
>
>
>

The coupling of networks, for example between headquarters and a branch office
Connecting external locations without fixed IP addresses via VPN router
Connecting home offices without fixed IPs via ISDN or analog modems
Connecting to Voice-over-1P telephone exchanges

Connecting mobile users, for example when using public WLAN access

10.2.2 Advantages of LANCOM VPN

LANCOM VPN solutions have numerous clear advantages over other VPN applications:

>

When connecting remote stations with dynamic IP addresses (e.g. branch-office networks), LANCOM VPN can
work with the “Main Mode” instead of the inferior "Aggressive Mode". This mode offers a highly secure solution
that is also easy to implement.

When VPN clients are dialing in with the appropriate client software, extended functions in the IKE handshake
of LANCOM VPN allow the use of different Preshared Keys (PSKs). Other conventional VPN client connections
can use a single common PSK, a situation that is a compromise in terms of security.

The use of LANCOM Dynamic VPN means that the headquarters with a static IP address can be connected to
external locations that have neither fixed IP addresses nor flatrate Internet access. As these remote stations
generally do not use dynamic DNS services, they cannot be reached via an IP address or via a name that can be
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resolved by DNS. The extensions provided by LANCOM Dynamic VPN make it possible to use ISDN signalling to
establish connections.

Further information about these features can be found in the description of the applications.

10.2.3 LANCOM VPN functions

This section lists all of the functions and properties of LANCOM VPN. This overview will provide a great deal of infor-
mation for VPN experts. It is very compact, but contains a lot of complex, specialized terminology. Knowledge of the
technical basics of VPN are required to understand this section. Don't worry: it's no problem if you skip this section.
The information contained here is not required to set up and use LANCOM VPN.

>

>
>
>

vy

VPN in accordance with IPSec standard
VPN tunnel via leased lines, switched connections and IP networks
IPSec main and aggressive mode

LANCOM Dynamic VPN: Public IP addresses can be static or dynamic (initiation of a connection towards remote
sites with dynamic IP addresses requires ISDN)

IPSec protocols AH and ESP in transport and tunnel mode
Hash algorithms:

> HMAC-MD5-96, Hash length 128 bit
> HMAC-SHA-1-96, Hash length 160 bit
Symmetrical encryption methods

> AES, key length 128 bit

> Triple-DES, key length 168 bit

> Blowfish, key length 128 - 448 bit

> CAST, key length 128 bit

> DES, key length 56 bit

IKE key exchange with Preshared Keys

Key exchange via Oakley, Diffie-Hellman algorithm with key lengths 768 bit, 1024 bit or 1536 bit, well-known
groups 1, 2and 5

Key management in accordance with ISAKMP

Apart from conventional IPSec implementations, LANCOM devices offer extended functionality, such as the
LANCOM Dynamic VPN that allows the use of the high-security IKE Main Mode even with dynamic IP addresses.
In combination with the LANCOM Advanced VPN Client, a separate pre-shared key can be used for each con-
nection even when using IKE Aggressive Mode connections.

10.3 VPN connections in detail

Two types of VPN connections are available:
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> VPN connections linking two local networks. This type of connection is also known as a "LAN-LAN coupling".

» The connection of an individual computer with a network, generally via a dial-in connection (Remote Access Ser-
vice — RAS).

10.3.1 LAN-LAN coupling
The coupling of two remote networks is known as a LAN-LAN coupling. With such a connection, the devices in one
LAN can access those of the remote LAN (assuming they have the necessary access rights).

In practice, LAN-LAN couplings are frequently used between company headquarters and subsidiaries, or for connec-
tions to partner companies.
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A VPN-enabled router (VPN gateway) is located at either end of the tunnel. The configuration of both VPN gateways
must be matched to one another.
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The connections are transparent for the remaining devices in the local networks, i.e., they appear to have a direct
connection. Only the two gateways must be configured for the VPN connection.
Internet access in parallel

The Internet access for VPN can be used simultaneously for other Internet applications, such as web-browsing or e-
mail. For security reasons, the parallel Internet access may be unwanted in some cases. For instance, if a branch
office should be enforced to access the Internet only via a central firewall. For such applications the parallel Internet
access can be disabled as well.

10.3.2 Dial-in connections (Remote Access Service)

Individual remote computers (hosts) can access the resources of the LAN via dial-up connections. Practical examples
of this are employees working from home or field staff that dial into the company network.
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If the dial-up connection of an individual computer to a LAN is to be realized via VPN, that computer first connects
to the Internet. A special VPN client software then sets up a tunnel to the VPN gateway of the LAN using this Internet
connection.

Remote computer
with VPN client

The VPN gateway of the LAN must support the establishment of VPN tunnels with the VPN client software of the
remote PC.

10.4 What is LANCOM Dynamic VPN?

LANCOM Dynamic VPN is a patent-pending LANCOM Systems technology which permits VPN tunnels to be connec-
ted to remote stations that do not have a static, but only a dynamic IP address.

Who needs LANCOM Dynamic VPN and how does it work? We will answer this question in two steps: First, a look
at the basics of IP addressing will show the problem of static IP addresses. The second step shows the solution the-
reof with LANCOM Dynamic VPN.

10.4.1 A look at IP addressing

Every participant on the Internet needs an IP address. Participants even need a special kind of IP address - a public
one. The administration of public IP addresses is handled from central locations in the Internet. Each public IP
address may only occur once on the entire Internet.

Local IP-based networks do not use public, but private IP addresses. For this reason, a number of address ranges
within the entire IP address range have been reserved for private IP addresses.

A computer connected to both a local network and directly to the Internet therefore has two IP addresses: a public
one for communication with the rest of the Internet and a private one by which the computer can be reached within
the local network.
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Static and dynamic IP addresses

Public IP addresses must be applied for and managed, which involves costs. There is also only a limited number of
public IP addresses. For this reason, not every Internet user has his or her own fixed (static) IP address.

The alternative to static IP addresses are the so-called dynamic IP addresses. A dynamic IP address is assigned to an
Internet user by the Internet Service Provider (ISP) upon dialling-in, and remains valid for the duration of the con-
nection. The ISP takes an unused address selected at random from their pool of IP addresses. This IP address is only
temporarily assigned to the user for the duration of a given connection. When the connection is ended, the IP
address is once again free and the ISP can assign it to another user.

Many flatrate connections, too, are realised with via dynamic IP addresses. Every 24 hours or so, the connection
is forcibly interrupted. The new connection is generally assigned with a new and different IP address.

Advantages and disadvantages of dynamic IP addresses

This process has a very important advantage for ISPs: they only need relatively small pools of IP addresses. Dynamic
IP addresses are also favorable for users: it's not necessary for them to apply for static IP addresses in advance - they
can connect to the Internet immediately. It's also not necessary for them to manage IP addresses. This saves trouble
and costs. The other side of the coin: A user without a static IP address cannot be addressed directly from the Inter-
net.

This is a major problem when setting up VPNs. If, for example, Computer A would like to communicate with Com-
puter B using a VPN tunnel on the Internet, Computer A needs the remote computer's IP address. If B only has a
dynamic address, A cannot know that address and therefore cannot contact B.

The LANCOM Dynamic VPN offers the answer here.

=
SN

10.4.2 This is how LANCOM Dynamic VPN works

Let's use two examples to explain how LANCOM Dynamic VPN works (designations refer to the IP addressing type
of the two VPN gateways):

> dynamic — static

> static — dynamic

» dynamic — dynamic
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Dynamic — static

If a user on computer B in LAN 2 wishes to connect to computer Ain LAN 1, then gateway 2 receives a request and
tries to establish a VPN tunnel to gateway 1. Gateway 1 has a static IP address and can be directly contacted over
the Internet.

A problem arises in that the IP address from gateway 2 is assigned dynamically, and gateway 2 must communicate
its current IP address to gateway 1 when attempting to connect. In this case, LANCOM Dynamic VPN takes care of
transmitting the IP address during connection establishment.
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Headquarters Branch_office

T
: n
- Gateway 2 with
¢ —

dynamic IP
address

Gateway 1 with
static IP address

@
4

Computer A Computer B

(1) Gateway 2 connects to the Internet and is assigned a dynamic IP address.

(2) Gateway 2 contacts Gateway 1 via its known public IP address. LANCOM Dynamic VPN enables the identification
and transmission of the actual IP address of Gateway 2. Gateway 1 initiates the VPN tunnel then.

The great advantage of LANCOM devices with this application: Instead of the “Aggressive Mode” that is normally
used when connecting VPN clients to the headquarters, the far more secure “Main Mode” can be applied. Although
with Main Mode more unencrypted messages can be exchanged during the IKE handshake, the method is overall
more secure than Aggressive Mode.

An ISDN line is not necessary for establishing this type of connection. The dynamic end communicates its IP
address encrypted via the Internet protocol ICMP (or alternatively via UDP).

Static — dynamic

If, on the other hand, computer A in LAN 1 requires a connection to computer B in LAN 2, for example when head-
quarters carries out remote maintenance at the external locations, then gateway 1 receives the request and attempts
to establish a VPN tunnel to gateway 2. Gateway 2 only has a dynamic IP address and cannot be directly contacted
over the Internet.

With LANCOM Dynamic VPN, the VPN tunnel can be set up nevertheless. The connection is established in three steps:
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Gateway 1 with .
static IP address

Computer A Computer B

(1) Gateway 1 calls Gateway 2 via ISDN. It takes advantage of the ISDN functionality of sending its own subscriber
number via the D-channel free of charge. Gateway 2 determines the IP address of Gateway 1 from the precon-
figured VPN remote stations using the received subscriber number.

If Gateway 2 does not receive a subscriber number via the D-channel (if that particular ISDN service feature is
not available, for example) or an unknown number is transferred, the authentication will be performed via the
B-channel. Once the negotiation was successful, Gateway 1 sends its IP address and closes the connection on
the B-channel immediately.

(2 Now its Gateway 2's turn: It first connects to its ISP and is assigned a dynamic IP address.

(3 Gateway 2 authenticates itself at Gateway 1. The static IP address of gateway 1 is known, of course.

=
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(4) Gateway 1 now knows the address of Gateway 2 and sets up the VPN tunnel to Gateway 2.

The advantage of LANCOM devices, for example when connecting from the headquarters to branch offices: The func-
tions in LANCOM Dynamic VPN also allows access to networks without a flatrate, i.e. networks that are not always
online. The ISDN connection and an associated MSN act to substitute the another address, such as a static IP address
or the dynamic address translation via dynamic DNS services, a solution often used with flatrate connections.
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Q‘ The described connection set up requires an ISDN connection for both VPN gateways. But usually no charges
will arise for this procedure.
Dynamic — dynamic

With LANCOM Dynamic VPN, VPN tunnels can also be set up between two gateways that both only have dynamic
IP addresses. Let's modify the previous example so that in this case Gateway 1 also has a dynamic IP address. Once
again, Computer A would like to connect to Computer B:
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Gateway 1
with dynamic IP

..'h -
@ @ T Gl via IsDN
@ @ Computer B @

Computer A

Gateway 2
with dynamic

(1) Gateway 1 connects to its ISP and is assigned a public, dynamic IP address.
(@ It then calls Gateway 2 via ISDN to send this dynamic address. Three procedures are used to send the address:

> As information in the LLC element of the D-channel. In the D-channel protocol of Euro-ISDN (DSS-1),
the so-called LLC (Lower Layer Compatibility) element can be used to send additional information to the
remote station. This transfer takes place before the B-channel connection is established. Once the address
has been sent successfully, the remote station rejects the call. Charges are thus not incurred for a B-channel
connection. The IP address is sent nevertheless for free in this case.

@ The LLC element is generally available as a standard feature in Euro-ISDN that does not require registration

“oractivation. It may be disabled by telephone companies or individual exchanges, however. The LLC element
is not available in 1TR6, the German national ISDN. The procedure described above thus will not work with
1TR6.

> As a subaddress via the D-channel. If it is not possible to send the address via the LLC element, Gateway
1 will attempt to send the address as a so-called subaddress. Like the LLC element, the subaddress is an
information element of the D-channel protocol that permits short items of information to be sent free of
charge. In this case, the telephone company must enable the 'subaddressing' feature first; this is generally
subject to a charge. As with the LLC element, the call is rejected by the remote station once the IP address
has been transferred successfully. The connection thus remains free of charge.

I> Via the B-channel. If both attempts to send the IP address via the D-channel fail, then a conventional con-
nection via the B-channel must be established to send the IP address. The connection is dropped immedia-
tely after the IP address has been sent. This connection is subject to the usual charges.

(3 Gateway 2 connects to the ISP and receives a dynamic IP address.
(4) Gateway 2 authenticates itself at Gateway 1. The static IP address of gateway 1 is known, of course.

(5) Gateway 1 now knowss the address of Gateway 2 and sets up the VPN tunnel to Gateway 2.
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(‘ Dynamic VPN works only between LANCOM that each feature at least one ISDN port that can be used for
" the ISDN connection.

Dynamic IP addresses and DynDNS

It is also possible to establish a connection between two stations using dynamic IP addresses by using so-called
dynamic DNS services (DynDNS). The address of the tunnel end-point is not defined as an IP number (which is, of
course, dynamic and subject to frequent change) but as a static name instead (e.g. MyLANCOM@DynDNS.org).

Two things are needed for translating a name to its current IP address: A dynamic DNS server and a dynamic DNS
client:

» The first, available from numerous providers in the Internet, is a server that is in communication with Internet
DNS servers.

> The dynamic DNS client is integrated in the device. It can make contact to any one of a number of dynamic-DNS
service providers and, assuming that a user account has been set up, automatically update its current IP address
for the DNS name translation. This can be set up very conveniently with a Wizard under LANconfig (also see
‘Dynamic DNS' on page 284):

Setup Wizard for 1621AnnexB x| (%)
Setup Wizard for 1621AnnesxB 3 =
Configue Dynarmic DNS g
=
This wizard supports you o configure the automatic refresh of a DNS account [85)
The refresh is perfermsd every time pour devics sstablishs & connsction snd can be = =
configured for each remote ste separatel. o Q-
=
For this you should alteady havs configured an Internet account. In addition you need IS =
;gl\flt;;'esd domin and an azcount ith ane of e olowing d e P y— = N
=
Dipnmic: DN provider TrDNsag 3| Setup Wizard for 1621AnnexB ot a
h Configuie Dynamic DNS —
HelP o i ©
DiM.ee ) =
HN.org Enter the fully qualiied domain name FIDN) for which the DNS update should be =
DIDNS Pertormen =
ChangslP cam =~
Dyrllp.net DHS resolwabls rame: mylancom. dyndins.org
i gyl o -
DHS.org 3 Plisss sntet pour DNS account dats hers
Clle - These data should have bsen given to you by your DNS provider when your dynamic
< Back
| L DN account was sel up:
User name: lancom
Passward [

< Back I Newt > I Cancel
L

(‘ For reasons of security and availability, LANCOM Systems recommends the use of Dynamic VPN in preference
= to dynamic DNS-based VPN solutions. Dynamic VPN is based on direct connections via the ISDN network
and ensures a higher degree of availability than dynamic DNS services in the Internet.
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10.5 Configuration of VPN connections

Three questions are answered in the configuration of VPN connections:

> Between which VPN gateways (remote stations) is the connection established?

> What security parameters are used to secure the VPN tunnel between the two gateways?
» Which networks or computers can intercommunicate via these tunnels?

Q‘ This section introduces the basic considerations for configuring VPN connections. Considered first of all is
the simple connection of two local networks. Special cases such as dialling in to LANs with individual com-
puters (RAS) or the connection of structured networks will be covered subsequently.

10.5.1 VPN tunnel: Connections between VPN gateways
Virtual Private Networks (VPNs) are used to interconnect local networks over the Internet. This involves the routing
of the private LAN IP addresses via an Internet connection between two gateways with public IP addresses.

For the secure routing of private IP addresses over the Internet, a VPN connection, also known as a VPN tunnel, is
established between the two LANS.

The VPN tunnel has two important tasks:
» To shield the transported data from unauthorized access

> Toroute private IP addresses via an Internet connection that can normally only be used to route public IP addres-
ses.

The VPN connection between the two gateways is defined by the following parameters:

» The end-points of the tunnel, the VPN gateways, each of which are accessible via public IP addresses (static or
dynamic)

> The IP connection between the two gateways

> The private IP address range that are to be routed between the VPN gateways

> Setting relevant to security, such as passwords, IPSec keys etc. to shield the VPN tunnel

This information is contained in the so-called VPN rules.



LANCOM Reference Manual LCOS 3.52 P Chapter 10: Virtual Private Networks—VPN

> Configuration of VPN connections

IP network: 10.1.0.0 IP network: 10.2.0.0
@ Net mask: 255.255.0.0 Net mask: 255.255.0.0

=
IP address: %@

217.213.77.120

¥

y@_ IP address:

< |30.146.81.251
N

VPN tunnel with IPSec
encryption

IP connection

\

10.5.2 Set up VPN connections with the Setup Wizard

If possible, make use of the Setup Wizard within LANconfig to set up VPN connections between local networks. The
Wizard guides you through the configuration and makes all the necessary settings for you. Carry out the configura-
tion on both routers, one after the other.

(1 Choose your device from the selection window in LANconfig and select the Setup Wizard button or use the
menu bar Tools » Setup Wizard.

% LANconfig L (=] 4|
Fle Edt Device View Tools Heps

B i il W sl 77 Setup Wizard for LANCOM 1811 Wireless DSL x|
oyl il mlE| Bl

I3 LANCanFig

Setup Wizard for LANCOM 1811 =0

{21 Branch_officss Wireless DSL
{2 Clienkil e . .
(£ Clientoz This wizard lets you configure pour device for specific
e applications quickly and easily =
nternal
“wihat do you wart b do? £

Hame
) 3j17/2004  4:18:3... LANCC ,
T %, 5t up Intemet access

93, Provide remote access [AAS, lso VP!

(%)
S

=
D
=
2
=

=
Q
~

T
2
=
S

5% Check securty settings

]

4 cal area netioiks (also VP 0|
LAMCCM 1811 Wireless DSL 5, Configure firswal 7

4%, Configure Dynamic DNS

(2 Follow the Wizard's instructions and enter the necessary data. The Wizard will inform you when the required
information is complete. You can then close the Wizard with Finish.

(3 Once you have completed the set-up of both routers, you can start testing the network connection. Try to com-
municate with a computer in the remote LAN (e.g. with ping). The device should automatically connect to the
remote station and make contact to the requested computer.

This Wizard automatically sets up the VPN connections essential for typical LAN-LAN coupling. In the following situ-
ations, the VPN connections will have to be configured manually:
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> Where no Windows computer with LANconfig is available. In this case, the necessary parameters are set with
WEBconfig or via the Telnet console.

» Where only selected portions of the LAN (intranet) are to communicate with other computers via the VPN con-
nection. This is the case where, for example, the intranet is connected to further subnets with routers, or when
only selected portions of the intranet should have access to the VPN connection. In such cases, additional para-
meters are defined supplementary to those entered in the Setup Wizard.

» Configuring VPN connections to third-party devices.

10.5.3 Inspect VPN rules

VPN rules represent a combination of various pieces of information and they are not directly defined in a LANCOM
device; instead, they are compiled from a variety of sources. This is why it is not possible to inspect the VPN rules
with LANconfig or any other configuration tool.

Information about the current VPN rules in the device can be retrieved with the Telnet console. Start a Telnet con-
nection to the VPN gateway and enter the command show vpn in the console:

8 Telnet 192.168.2.100

it
! LANCOM 1811 Wireless DSL

t Uer. 3.32.0815 ~/ 02.83.2004
! SN.  B15300688046

! Copyright (c) LANCOM Systems

UPN_NHAMEL, Connection No.: 882 (LAN>
Pas.

UPN_NHAMEL:/
> show vpn

=
SN

UPN PM SPD and Ike configuration:
# of connections = 1
Connection #1 ipsec 192.168.2.8-255.255.255.0.8(->10.8.8.8-255.8.8.8.8 any

Name = UPN-GH-2

Unigque Id: ipsec—1-UPN-GU-2-prB-10-r8

Flags: pfs main-mode

Local HNetwork [@1: IPU4_ADDR_SUBNET{any:@, 192.168.2.08,255.255.255.8>
Local Gateway: IPU4 ADDR{any:@,. 8@.146.81.251)

Remote Gateway: IPU4 ADDR{any:@, 217.213.77.128)

Remote Network [@1: IPU4_ADDR_SUBNET{any:0,. 10.0.0.0-255.0.0.0>

!
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The output informs you of the network relationships that are relevant to VPN connections to other networks.

In this example, the local network at a branch office (network 192.168.2.0, netmask 255.255.255.0) is connected
to the network at the headquarters (network 10.0.0.0, netmask 255.255.255.0). The public IP address of the local
gateway is 80.146.81.251, and that of the remote VPN gateway is 217.213.77.120.

'\ Entering “any:0” displays the protocols and ports that can be used over the connection.

Further output is displayed by the command “show vpn long”. The information displayed here covers net-
work relationships and also the parameters that are relevant to security, such as IKE and IPSec proposals.

10.5.4 Manually setting up VPN connections

Manually setting up VPN connections involves the tasks described previously:
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» Definition of the tunnel endpoints

Definition of the security-related parameters (IKE and IPSec)

> Definition of the VPN network relationships, i.e. the IP address ranges to be connected. Should the IP ranges
overlap at both ends of the connection, please refer to the section ‘N:N mapping’ on page 74.

> When coupling Windows networks (NetBIOS/IP): Without WINS servers at both ends of the VPN connection (such
as when linking a home office), the LANCOM can take over the necessary NetBIOS proxy functions. To this end,
the NetBIOS module in the LANCOM must be activated, and the corresponding VPN remote site must be entered
into the NetBIOS module as the remote site. Should WINS servers be present in both of the coupled networks,
then the NetBIOS module should be deactivated so that the LANCOM does not perform NetBIOS proxy functions.

v

<‘ To use the LANCOM NetBIOX proxy either LANCOM Dynamic VPN must be applied, because it transmitts the
required addresses, or the IP address of the remote station as a primary NBNS must be entered in the IP para-
meter list (LANconfig. Communication / Protocols).

» When using LANCOM Dynamic VPN: Entry for the corresponding remote site in the PPP list with a suitable pass-
word for the Dynamic VPN handshake. The username entered here must correspond with the name entered in
the remote device that describes the VPN connection to this local device. Activate "IP routing”. If Windows net-
works are also to be coupled, then the NetBIOS entry should be activated here.

The tunnel endpoints, i.e. the local VPN gateway and each of the VPN remote stations, are entered into the VPN
connection list.

=
SN

Manually configuring the VPN connection involves the following steps:
(1) Create an entry for the remote VPN gateway in the connection list and enter its public IP address.

(2 The security parameters for the VPN connection are normally taken from the prepared list, and all that is required
here is to define an IKE key.
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(3 For a Dynamic VPN connection, create a new entry in the PPP list with the name of the remote VPN gateway as
the remote station, with the name of the local VPN gateway as the User Name, and set a suitable password. Be
sure to activate the IP routing for this PPP connection and, if required, the routing of “NetBIOS over IP" as well.
The remaining PPP parameters, such as the procedure for checking the remote station, can be defined in the
same way as for other PPP connections.

(4 The main task in setting up VPN connections is in defining the network relationships. Which IP address ranges
at each end of the VPN tunnel should be included in the secured connection?
10.5.5 Prepare VPN network relationships

The firewall integrated into LANCOM routers is a powerful instrument for defining source and target address ranges
between which data transfer (and limitations to it) can be enabled or prohibited. These functions are also used for
setting up the network relationships for the VPN rules.

In the simplest case, the firewall can generate the VPN rules automatically.
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> Thelocal intranet serves as the source network, i.e. the same private IP address range that the local VPN gateway
itself belongs to.

> For automatically generated VPN rules, the target networks are those network ranges that have a remote VPN
gateway set as their router.

To activate the automated rule generation, simply switch on the corresponding option in the firewall!. When coup-

ling two simple local networks, the automatic VPN can interpret the necessary network relationships from the IP

address range in its own LAN and from the entry for the remote LAN in the IP routing table.

IP network: 10.1.0.0 IP network: 10.2.0.0
Net mask: 255.255.0.0 Net mask: 255.255.0.0

VPN-GW 1
80.146.81.251

VPN-GW 2 -GW 2
217.213.77.120 .213.77.120

i

4

IP routing table: IP routing table:
10.2.0.0/16 > VPN-GW-2 10.1.0.0/16 > VPN-GW-1

=k
ys

The description of the network relationships is more complicated if the source and target networks are not only rep-

resented by the intranet address ranges of the connected LANS:

> When only a portion of the local intranet is to be available to the remote network, then the automatic method
is unsuited as the IP address range that is open to the VPN connection is too large.

IP: 10.1.0.1 to 10.1.0.50 1P:10.2.0.2 t0 10.2.0.99
Net mask: 255.255.0.0 Net mask: 255.255.0.0

=
=
=

1. automatic when using the VPN installation Wizard under LANconfig



LANCOM Reference Manual LCOS 3.52 P Chapter 10: Virtual Private Networks—VPN

> Configuration of VPN connections

> In many network structures, the local network is connected by further routers to sections of other networks with
their own IP address ranges. Additional settings are required to include these address ranges in the network rela-
tionship.

IP network: 10.2.0.0
Net mask: 255.255.0.0

IP network: éy@_

10.1.0.0
Net mask: ’@_
255.255.0.0 <&

: @
IP network: 10.1.0.0

Net mask: 255.255.0.0

In these cases, the network relationships that describe the source and target networks must be entered manually.
Depending on the situation, the scope of the automatically generated VPN rules may be extended, although some-
times it is better to deactivate the automatic VPN system to prevent unwanted network relationships.

The necessary network relationships are defined by the appropriate firewall rules under the following circumstances:
> In the firewall rules, the option “Consider this rule when generating VPN rules” must be activated.

=
SN

. The firewall rules for generating VPN rules are active even when the actual firewall function in the LANCOM
device is not required and is switched off!
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> Make sure that the firewall action is set to “Transfer”.
> Sources and targets for the connection can be entered as individual stations, certain IP address ranges, or whole
[P networks.

(“‘ It is vital that target networks are defined in the IP routing table so that the router in the LANCOM devices

= can forward the appropriate data packets to the other network. You can make use of the entries that already

exist there and simply enter a higher-level network as the target. The intersecting portion of the target net-

work defined by the firewall and the subordinate entries in the IP routing table is integrated into the network
relationships for the VPN rules.

Example: The target networks 10.2.1.0/24, 10.2.2.0/24 and 10.2.3.0/24 are entered into the IP routing
table and can be accessed via the router VPN-GW 2. An entry for the target network 10.2.0.0/16 is sufficient
for these three subnets to be included in the VPN rules.
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ﬁ The definition of source and target networks must agree at both ends of the VPN connection. It is not pos-
sible, for example, to map a larger target address range to a smaller source address range at the opposite
end. Decisive here are the IP address ranges allowed by the VPN rules and not the networks defined in the
firewall rules. These can be very different from the network relationships in the VPN rules because of the
intersecting ranges.

> VPN connections can also be limited to certain services or protocols according to your requirements. This means
that the VPN connection can be limited to use only with a Windows network, for example.

(' These limitation should be defined by a separate set of rules that applies only to the firewall and that will
not be used in generating VPN rules. Combined firewall/VPN rules can very quickly become highly complex
and difficult to comprehend.

10.5.6 Configuration with LANconfig

The section demonstrates how LANconfig can be used to configure a LAN-LAN coupling with additional subnets. In
this section, VPN gateway 1 will be configured and then the configuration of gateway 2 with the help of WEBconfig
will be demonstrated.

10.2.0.0/16 10.5.0.0/16

LAN router 5: 10.4.0.5 e
— AN

10.4.0.0/16

Gateway 1: Gateway 2: —
gw1.dyndns.org gw2.dyndns.org %

10.3.0.0/16

(1) When configuring VPN, access the “IKE param.” tab and create a new IKE key for the connection:

Identification: [IKE-KEY-1 oK RI

Preshared secret: b cancel |
Loeal identity type: [ho identity 4|

Local identity:
Remote identity bype:  [No identity -

—
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(2 Under the “General” tab, create a new entry in the list of Connection parameters. Select the IKE key created ear-
lier for this. PFS and IKE groups can also be selected in the same way as IKE and IPSec proposals from the options
prepared earlier.

Identification: [vPr-Para-1 ok
PFS aroup: 5 - r—
IKE group: | 5 =

IKE proposals: [ePresixey =]

IKE key: [wexers =]

IPSer proposals: [eseamn =]

TPSec key (Out): =

IPSec key (In): | |

(3@ You should then generate a new entry in the Connection list with the name of the remote gateway as “name for
the connection”. For LANCOM Dynamic VPN connections the entry “Remote gateway” must remain empty.
Otherwise enter the public address of the remote station: either the fixed IP address or the name for translation

Connection list - New Entry 2lx|
Mame of connection; | YPN-GATEWAY-2 Ok
Shart hold time: [ seconds — |
Dead Peer Detection; |0 seconds

Extranet address: [onon
Remote gateway: [qwzdyndns.org
Connestionparameter: | WPR-PARA-L x|
Rule Creation: fae ]

Dynaric VPN connection (only with compatible remate stations):
' No dynamic YPN
" Dynamic YPN (a connection is created to transmit IP addresses)

" Dynamic YPN (IF addresses ars transmitted without establishing a
connection if possible)
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" Dynamic VPN (an ICMP packet will be sent to transmit IP addresses)
" Dynamic VPN (an UDP packst wil be sent to transmit IP addresses)

IKE exchangs {only in conjunction with "o dynamic YPN):
' Main mode

' Aggressive mode

(4) When using LANCOM Dynamic VPN: Change to the “Communication” configuration area. Using the “Protocols”
tab, make a new entry in the PPP list. Select the remote VPN gateway as the remote site, enter the User Name
as the name of the VPN connection that the remote VPN gateway uses to address the local device, and enter a
suitable password that is identical at both locations, but for safety reasons should not be identical to the pre-
shared key.
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PPP list - New Entry 21x|
Remote site: [vencatewarz =] [ ok
User name: | veH-GATEWAY-1
Cancel

— [

¥ Activate IP routing

IV Activate NetBIOS over IP

™ Activate TPX routing
Authentication of the remate site:

& No active authentication. However, the remote site (your Internet
Service Provider For example) can da his own authentication.

" Authenticate the remoate site via PAP.
© authenticate the remote site via CHAP,

Be sure to activate "IP routing" and, if required, "NetBIOS over IP" (—Seite 187).

(5 Change to the “IP Router” configuration area. On the “Routing” tab, make a new entry in the routing table for
those parts of networks that are to be accessible in the remote and in the local LAN. In each case, define the
router as the remote VPN gateway and switch the IP masquerading off.

Routing Eable - New Entry 2] x|
1P address: [10.4.00 ok
Hetmask: 255.255.0.0 e
¥ Entry active
Roter: WPN-GATEWAY-2 -

Distancs: 0
1P masquerading:
TP Masquerading switched off

For the “VPN gateway 1, the following entries are necessary so that the remote network sections can be rea-
ched.

=
S

[%2)
S
=
I
=
i
S
<
K
=
§ 10.4.0.0 255.255.0.0 VPN gateway 2 No

10.5.0.0 255.255.0.0 VPN gateway 2 No

For those subnetworks connected to your own LAN, define the router as the IP address for the appropriate LAN
router.

10.2.0.0 255.255.0.0 10.1.0.2 No

10.3.0.0 255.255.0.0 10.1.0.3 No

These entries enable VPN gateway 1 to forward packets arriving from the remote network to the correct sections
of the local network.
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(& Change to the “Firewall/QoS” configuration area. On the “Rules” tab, add a new firewall rule with the name
“VPN GATEWAY 1 OUT" and activate the option “This rule is used to create VPN rules”. This ensures that IP net-
works described in this rule will be used in establishing VPN network relationships.

General | Actions | 005 | Stations | Sevice |

Filter rules can be used to ransfer of diop data packets
=

sccording to specified crteria

Mame of this rule:
[VPHGATEWAY-1-0UT

I~ This rule is active for the fiswal
IV This e s used to create YPN rules

— o trandl e

@ It is recommended to keep the rules used for making network relationships separate from those firewall rules
" that affect the services used in communications, for example.

(7) On the "Actions” tab for these firewall rules, set the “Packet Action” to “Transmit”.

Filter rule YPNGATEWAY-1-0UT, 2 x|
General Actons | 0o5 | Stations | Service |

Action:

The actions table describes an arbitrary amount of
G actions that vl be eveculed, | special e matching
smounts of dats of packages will bs excesded.

=
SN

On the “Stations” tab for these firewall rules, define the source of the data transfers as the subnets at the local
site, and set the destination as all of the subnets at the remote site.
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=
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Filter rule YPNGATEWAY-1-0UT, 2 x|

General | Actions | 05 Stations | Service |

i~ Connection sourc
E\=  This ruls applies to packets on
SO  connections irom all stalions

& _connections fram the follwing stations:

IP retwork 101.00 £ 255 255,00
|F network 10.2.0.0 / 255.256.0.0
: 10

Add, Edt.. Delete |

i~ Cotmection destination

=k [ This iule applies to packets on
" connections to all stations

(+_connections to the following stations:

Add... Edf.. Delete
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(9 Now for the incoming data transmissions, generate a firewall rule named “VPN GATEWAY 1 IN” with the same
parameters as the rule just described. The only difference is that the source and the destination networks are
swapped.

Filter rule YPNGATEWAY-1-IN ¥ 2l

General | Actions | 05 Statians | Service |

- Connection sours
El=  This iule applies to packets on

" connections from al stations

(¥ _cannections from the following stations:

|F network. 10.4.0.0 / 255.256.0.0
IP network 105,00 /255 255,00

Add Edt [Elete

i~ Connection destination
=+ B} This ruls applies to packets on
S0 connections to all stations
1+ connections to the following stations:
IP network. 10.1.0.0/ 255 266,00
P 10

IP network 10.3.0.0 / 255.256.0.0

Add Edt. || Dol |

10.5.7 Configuration with WEBconfig
(D Under Configuration » VPN » IKE-Param. » IKE key set a new IKE key for the connection:

(%)
E

=
IS
=
T
2

=
Q_
—

©
=
=
S

=
% £ panagement IKE key
& Do & Time
S Log& Trace - Add
Idantification FE
Preshared secret =
Floaso retype the Tollawing entry
Preshared secrat =
Local idartity hype [Maideresy =1
o e Loxcal idertity
o “MI_ -4 yeg | FHOTICON Ickartity typ [Faidarey =]
3 BE ey Riemata identity
S had et |
.

(2 Under Configuration » VPN » General » Connection parameters define a new “VPN layer” for the con-
nection parameters. Select the IKE key created earlier for this.

Connection parameter
- Add

Identification pEEa

FFS group F a3

IKE growp FE

WEproposale  [WEFPESHIEY =
.| IKE ke [wEsEe =0

e PSecproposats [EseAam =

Poeckey(Owy [ =

Peckeyinl  [emee 8]
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(3 Under Configuration » VPN » Connection list generate a new entry with the name of the remote gateway

set to “Name”. For the “Remote gateway”, enter the public address of the remote station: either the fixed IP
address or the name for translation by DNS.

C tion list

Marne of cornpction Pt G TE A0
Shirt hold tme B seconds
Dwad Poer Datection [0 seconds
Etracst sddress [oee
Riencte gatovay [wigmamog
Connection paramtic W
Ruls Creation e = .
Dynamic VPN connechon [onkywith compatibls remate stations)
= Mo dynamic VPN
© Dynamic VFM [a connection is created to ransmit P addresses)

 Enmarmic VPN (IP s
corrmetion if pessibly)

© Dynamic VFR {an IZMP packet will be sent to transmit ¥ addresses)

© Dynamic VEM [an LD packet wil be sent bo ransmit IF addresses)
IKE exchange {only in congnchion with To dynamic VFRT)

& Main moda

are ransitlod witheut establshing &

 Agoressive mode

(] ()

(@) When using LANCOM Dynamic VPN: Under Configuration » Setup » WAN module » PPP list make a new
entry.
Select the remote VPN gateway as the remote site, enter the User Name as the name of the VPN connection that
the remote VPN gateway uses to address the local device, and enter a suitable password that is identical at both

[%2)
5

=
D
=
=
2

L
Q-
~
<
=
NS
S

locations.
PPP list
- Add
| Remots sie T —
Usarnama (S
Fassword =

Flease retype the tobowing

x|
£
chvate X roung o1 OE

Franticasan o tha ramaka st

[
A
A
A
n

Be sure to activate "IP routing" and, if required, "NetBIOS over IP" (—Seite 187).

(5 Under Configuration » Setup » IP router module » IP routing table generate a new entry for each network
portion that should be accessible in the remote and in the local LAN. In each case, define the router as the remote
VPN gateway and switch the IP masquerading off.
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Routing table
Add

P address  [l10g

Mommask  [EREE0DD
Entry acrve [es 2]
Routar aon

: Cestance [0
2 Time controltatle o oo e
& Masg )

&) NN Maooing & P Masquerading switched off

For the “VPN gateway 2", the following entries are necessary so that the remote network sections can be rea-
ched.

10.1.0.0 255.255.0.0 VPN gateway 1 No
10.2.0.0 255.255.0.0 VPN gateway 1 No
10.3.0.0 255.255.0.0 VPN gateway 1 No

For those subnetworks connected to your own LAN, define the router as the IP address for the appropriate LAN
router.

10.5.0.0

255.255.0.0 10.4.0.5 No

=
S

These entries enable VPN gateway 2 to forward packets arriving from the remote network to the correct sections
of the local network.

(® Under Configuration » Firewall/QoS » Object table make an entry for each part of the network that should
be used as a source or destination for the VPN connection via “VPN GATEWAY 1" ("VPN-GW1-LOCAL" and "VPN-
GW1-REMOTE"). Enter each subnet in the form “%A10.1.0.0 %M255.255.0.0".

(%2
B

=
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=
2
2

L
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~

<
=
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S

{ LANCOM 1811 Wireiess DSL 3420021/ 24.06.2004)

Espelt Configuration
& Seng

& [Purguter-moduls

A Eirevell
Object-table
{ LANCOM 1811 Wirslass DL 342 0021 £ 24 06 2004)
Mame F‘N-(‘.ATE‘MM.‘
Descnption  [%AIDY0I%2S525500 a
[Begy] ] S P
2 Firewal

@ St Date and Time
SPevousFags O EnrPage G LANCOMS Object-table

Nams [ rEmoTE

Description  [FAT020 0%0055 255 010 %10 3 0.0%MZ56 755 D 05410 40 0%WE25

(@ Under Configuration » Firewall/QoS » Rules table define a new firewall rule named “VPN-GW1-0UT". Set
the objects to “CPN-GW1-LOCAL" and “VPN-GW1-REMOTE", the protocol to "ANY" and the action to “ACCEPT".
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Activate the option “"VPN rule” so that the IP networks described in this rule will be used in establishing VPN
network relationships.

{LANCOM 1811 Wiretess DSL 342 0021 / 24 06 2004)

Rule-table

Name oo
Prat
Sourcy VPRHEATLOCAL

Destnanon  fPmeGgwnsemote

Action e

lﬂ

Linked |
Fio —
Active [
vPtbnle [ sl
==

tatehid

As a rule, it is recommended that you keep the rules used for making network relationships separate from
those firewall rules that affect the services used in communications, for example.

Now for the incoming data transmissions, generate a firewall rule named “VPN-GWY1-IN" with the same para-
meters as the rule just described. The only difference is that the source and the destination networks are swap-

=
S
ped. =
[85)
=< =
2 &
S
=
Rule-table o_
—
Newe  fEREmE ©
Prat kil g
Seurce [oEreGo-REMGTE =
Action JaccEr
T

10.5.8 Diagnosis of VPN connections

If the VPN connections fail to work after the configuration of the parameters, the following diagnostic methods can
be applied:

» The command show vpn spd on the Telnet console calls the “Security Policy Definitions”.

> Use the command show vpn sadb to access information about the negotiated “Security Associations” (SAs).

» The command trace + vpn [status, packet] calls up the status and error messages for the current VPN negotia-
tions.

> The error message “No proposal chosen” indicates a fault in the configuration at the remote site.

> The error message “No rule matched”, on the other hand, indicates a fault in the configuration of the local
gateway.

197



P Chapter 10: Virtual Private Networks—VPN LANCOM Reference Manual LCOS 3.52

[> Specific examples of connections

10.6 Specific examples of connections

This section covers the 4 possible types of VPN connections with concrete examples. These 4 different connection
types are categorized by the type of IP address of the two VPN gateways:

> static/dynamic

> dynamic/static (the dynamic peer initiates the connection)
> static/dynamic (the static peer initiates the connection)

» dynamic/dynamic

There is a section for each of these types, together with a description of all required configuration information in the
familiar table form.

10.6.1 Static/static

Headquarters
> >
A o~
=) S
=) S
= =
<C <C
— =
) . ™ .
atic P address . PP address
Public IP 193.10.10.1 T RUNS - Public IP 193.10.10.2
Private IP 10.10.1.1 Private IP 10.10.2.1

=
S

A VPN tunnel via the Internet serves as the connection between the LANCOM Headquarters and branch office.
Both gateways have static IP addresses. Thus, both can initiate the connection.

(%)
B

=
IS
=
T
2

Py
Q_
—

©
=
RS
S

Type of local IP address static static

Type of remote IP address static ><: static

Name of the local device Headquarters Branch_office
Name of the remote device Branch_office ><: Headquarters
Shared Secret for encryption secret | <4—p | secret

IP address of the remote device 193.10.10.2 193.10.10.1
IP-network address of the remote 10.10.2.0 10.10.1.0
network

Netmask of the remote network 255.255.255.0 255.255.255.0
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10.6.2 Dynamic/static

Headquarters

LAN 10.10.1.x

-

Private IP 10.10.1.1

~'~ ' A\, .
ictP-address RTINS @ PP e
Public IP 193.10.10.1 TR

Branch_office

LAN 10.10.2.x

[> Specific examples of connections

[Private IP | 10.10.2.

The VPN gateway Branch office initiates a VPN connection to the gateway Headquarters. Branch office has a
dynamic IP address that was chosen and assigned by the Internet service provider upon dialling in, whereas Head-
quarters has a fixed, static address. When the connection is set up, Branch office transmits its actual IP address
to Headquarters. This is accomplished by a special ICMP packet (alternatively UDP, port 87).

Type of local IP address static dynamic i’|<’
Type of remote IP address dynamic ><: static g,
Name of the local device Headquarters Branch_office >
Name of the remote device Branch_office ><: Headquarters E
Password for the secure transmission of the IP address confidential | 4 | confidential g
Shared Secret for encryption secret | <—p | secret n\c;
IP address of the remote device - 193.10.10.1 S
IP-network address of the remote network 10.10.2.0 10.10.1.0

Netmask of the remote network

255.255.255.0

10.6.3 Static/dynamic (with LANCOM Dynamic VPN)

In this case (other than the example above), the peer with the static IP address initiates the VPN connection.

255.255.255.0
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Branch_office

> >
= ~
°‘ [J < :
S S
— 0 K —
= . =
< K —
- * -
h. 4 ‘Q' .

Static IP address DAL 5 et Dynamic IP address

Private IP 10.10.1.1 Bl - - Private IP 10.10.2.1

Public IP 193.10.10.1 ISDN no. (069) 54321

ISDN no. (030) 12345 ISDN identifier | 06954321

ISDN identifier | 03012345

The VPN gateway Headquarters initiates a VPN connection to Branch office. Headquarters has a static IP
address, Branch office a dynamic one.

The entries for the ISDN connection are needed for the transmission of the actual dynamic IP address solely.
The Internet access wizard configures the connection to the Internet.

@ Alternatively, this application can be solved with the help of dynamic DNS. In this constellation, the head-
quarters with its static IP address connects to the branch office with the help of a dynamic DNS name which
is assigned to the current dynamic IP address. More information is available under ‘Dynamic IP addresses

and DynDNS" —page 183.

Type of local IP address static

=
S

dynamic

(%2
B

=
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=
2
2

L
Q_
~

<
=
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Type of remote IP address dynamic static

Name of the local device Headquarters : Branch_office

Name of the remote device Branch_office Headquarters
ISDN-calling number of the remote device 06954321 03012345
ISDN-caller ID of the remote device 06954321 03012345
Password for the secure transmission of the IP address confidential | 4— | confidential
Shared Secret for encryption secret | <4—p | secret

IP address of the remote device 193.10.10.1
IP-network address of the remote network 10.10.2.0 10.10.1.0
Netmask of the remote network 255.255.255.0 255.255.255.0
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10.6.4 Dynamic/dynamic (with LANCOM Dynamic VPN)

Headquarters Branch_office
= =
- o~
O. - LR O
S S
= =
< <
e . * e
“~ / N "0 .
Dynamic P address Seal ] Lot Dynamic | ess
Private IP 10.10.1.1 === by --- Private IP 10.10.2.1
ISDN no. (030) 12345 ISDN no. (069) 54321
ISDN identifier |03012345 ISDN identifier | 06954321

A VPN tunnel via the Internet serves as the connection between the LANCOM Headquarters and branch office.
Both sites have dynamic IP addresses. Thus, both can initiate the connection.

Q‘ The entries for the ISDN connection are needed for the transmission of the actual dynamic IP address solely.
The Internet access wizard configures the connection to the Internet.

ﬂ Alternatively, this application can be solved with the help of dynamic DNS. Instead of a static IP address, a
dynamic DNS name helps to find the dynamic IP address that is currently in use. More information is avai-

Virtual Private Networks—

lable under ‘Dynamic IP addresses and DynDNS’ —page 183. =

Q
~

Type of local IP address dynamic dynamic

Type of remote IP address dynamic ><: dynamic

Name of the local device Headquarters Branch_office

Name of the remote device Branch_office ><: Headquarters

ISDN-calling number of the remote 06954321 03012345

device

ISDN-caller ID of the remote device 06954321 03012345

Password for the secure confidential | 4— | confidential

transmission of the IP address

Shared Secret for encryption secret | 4—p | secret

IP-network address of the remote 10.10.2.0 10.10.1.0

network

Netmask of the remote network 255.255.255.0 255.255.255.0
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10.7 How does VPN work?

In practice, a VPN must fulfill a number of requirements:

» Unauthorized third parties must not be able to read the data (encryption)
It should not be possible to manipulate the data (data integrity)
Unambiguous identification of the sender of data (authentication)
Simple key management

Compatibility to VPN devices from a variety of manufacturers

vvyyvyy

LANCOM VPN achieves these five major goals by applying the widely used IPSec standard.

10.7.1IPSec—The basis for LANCOM VPN

The original IP protocol does not contain any provisions for security. Security problems are compounded by the fact
that IP packets do not go directly to a specific recipient, but are sent scattershot to all computers on a given network
segment. Anyone can help themselves and read the packets. This leaves the door open to the misuse of data.

IP has been developed further for this reason. A secure version is now available: IPSec. LANCOM VPN is based on
[PSec.

IPSec stands for “IP Security Protocol” and was originally the name used by a working group of the IETF, the Internet
Engineering Task Force. Over the years, this group has developed a framework for a secure IP protocol that is gene-
rally referred to as IPSec today.

It is important to note that IPSec itself is not a protocol, but merely the stan-dard for a protocol framework. IPSec
actually consists of a variety of protocols and algorithms for encryption, authentication and key management. These
standards will be introduced in the following sections.

Security in an IP environment

IPSec has been implemented almost completely within level 3 of the OSI model, i.e. in the network layer. The transfer
of data packets using the IP protocol is realized on level 3 of IP networks.

IPSec thus replaces the IP protocol. Under IPSec, the packets have a different internal structure than IP packets. Their
external structure remains fully compatible to IP, however. IPSec packets can therefore be transported without pro-
blems by existing IP networks. The devices in the network responsible for the transport of the packets cannot distin-
guish IPSec packets from IP packets on the basis of their exterior structure.

The exceptions in this case are certain firewalls and proxy servers that access the contents of the packets. Problems

can arise from the (often function dependent) incompatibilities of these devices to the existing IP standard. These
devices must therefore be adapted to IPSec.

IPSec will be firmly implemented in the next generation of the IP standard (IPv6). For this reason, we can assume
that IPSec will remain the most important standard for virtual private networks in the future.
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10.7.2 Alternatives to IPSec

IPSec is an open standard. It is not dependent on individual manufacturers and is being developed by the [ETF with
input from the interested public. The IETF is a nonprofit organization that is open to everyone. The broad acceptance
of IPSec is the result of this open structure which unites a variety of technical approaches.

Nevertheless, there are other approaches for the realization of VPNs. We will only mention the two most important
of these here. They are not realized at the network level like IPSec, but at the connection and application levels.

Security at the connection level — PPTP, L2F, L2TP

Tunnels can already be set up at the connection level (level 2 of the OSI model). Microsoft and Ascend developed the
Point-to-Point Tunneling Protocol (PPTP) early on. Cisco presented a similar protocol with Layer 2 Forwarding (L2F).
Both manufacturers agreed on a joint effort and the IETF produced the Layer 2 Tunnel Protocol (L2TP).

Their main advantage over IPSec is that any network protocol can be used with such a network connection, especially
NetBEUI and IPX.

A major disadvantage of the described protocols is the lack of security at the packet level. What's more, these pro-
tocols were designed specifically for dial-up connections.

Security at higher levels — SSL, S/MIME, PGP

Communications can also be secured with encryption at higher levels of the OSI model. Well known examples of this
type of protocol are SSL (Secure Socket Layer) mainly used for web browser connections, SIMIME (Secure
Multipurpose Internet Mail Extensions) for e-mails and PGP (Pretty Good Privacy) for e-mails and files.

In all of the above protocols, an application handles the encryption of the data, for example the Web browser on
one end and the HTTP server on the other.

A disadvantage of these protocols in the limitation to specific applications. In addition, a variety of keys is generally
required for the different applications. The configuration must be managed on the individual computers and can not
be administered conveniently on the gateways only, as is the case with IPSec. Security protocols at the application
level tend to be more intelligent as they know the significance of the data being transferred. They are usually much
more complex, however.
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All of these layer-2 protocols only support end-to-end connections; they are therefore not suitable for coupling entire
networks.

On the other hand, these mechanisms do not require the slightest changes to the network devices or access software.
And unlike protocols in lower network levels, they are still effective when the data content is already in the computer.

Combinations are possible

All of the alternatives listed above are compatible to IPSec and can therefore be used parallel to it. This permits a
further increase of the security level. It would be possible, for example, to dial into the Internet using an L2TP con-
nection, set up an IPSec tunnel to a Web server and exchange HTTP data between the Web server and the browser
in secure SSL mode.
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Each additional encryption would reduce the data throughput, however. Users can decide on a case-by-case basis
whether the security offered by IPSec alone is sufficient. Only in rare cases is a higher level of security really necessary.
Particularly as the degree of security can be adjusted within [PSec.

10.8 The standards behind IPSec

IPSec is based on a variety of protocols for the individual functions. These protocols are based on, and complement
one another. The modularity achieved with this concept is an important advantage of IPSec over other standards.
IPSec is not restricted to specific protocols but can be supplemented at any time by future developments. The pro-
tocols integrated to date also offer such a high degree of flexibility that IPSec can be perfectly adapted to virtually
any requirements.

10.8.1 IPSec modules and their tasks

IPSec has to perform a number of tasks. One or more protocols have been defined for each of these tasks.
> Authentication of packets

> Encryption of packets

» Transfer and management of keys

10.8.2 Security Associations — numbered tunnels
Alogical connection (tunnel) between two IPSec devices is known as an SA (Security Association). SAs are managed
independently by the IPSec device. An SA consists of three values:
> Security Parameter Index (SPI)
ID to distinguish multiple logical connections to the same target device with the same protocols

» Target IP address

> Security protocol used
Designates the security protocol used for the connection: AH or ESP (further information will be provided on
these protocols in the following sections).

An SA applies only to one communication direction of the connection (simplex). A complete send and receive con-
nection requires two SAs. In addition, an SA only applies for one used protocol. Two separate SAs are also required
if AH and ESP are used, i.e. two for each communication direction.

The SAs are managed in an internal database of the IPSec device that also contains the advanced connection para-
meters. These parameters include the algorithms and keys used, for example.

10.8.3 Encryption of the packets — the ESP protocol

The ESP protocol (Encapsulating Security Payload) encrypts the packets as protection against unauthorized access.
This was once the only function of ESP, but in the course of the further development of the protocol it was expanded
with options for the protection of integrity and verification of authenticity. In addition, ESP also features effective
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protection against replayed packets. ESP thus offers all of the functions of AH —in some cases, however, the use of
AH parallel to ESP is advisable.

How ESP works

The structure of ESP is more complex than that of AH. ESP also inserts a header behind the IP header as well its own
trailer and a block of ESP authentication data.

ESP ESP-Auth.

IP header | ESP header Data Tl Data

Transport and tunnel mode
Like AH, ESP can be used in two modes: transport and tunnel mode.

In transport mode, the IP header of the original packet is left unchanged and the ESP header, encrypted data and
both trailers are inserted.

The IP header contains the unchanged IP address. Transport mode can therefore only be used between two end
points, for the remote configuration of a router, for example. It cannot be used for the coupling of networks via the
Internet — this would require a new IP header with the public IP address of the recipient. In such cases, ESP can be
used in tunnel mode.

In tunnel mode, the entire packet including the original IP header is encrypted and authenticated and the ESP header
and trailers are added at the entrance of the tunnel. A new IP header is added to this new packet, this time with the
public IP address of the recipient at the end of the tunnel.
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Encryption algorithms
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As a higher-level protocol, IPSec does not require specific encryption algorithms. The manufacturers of IPSec pro-
ducts are thus free in their choice of the processes used. The following standards are common:

» AES — Advanced Encryption Standard
AES is the official encryption standard for use by US authorities, and therefore one of the most important stan-
dards worldwide. Following a worldwide competition in the year 2000 to find the best of the numerous encryp-
tion algorithms, the National Institute of Standards and Technology (NIST) selected the Rijndael algorithm
(pronounced: “Rinedoll”) and declared it as the AES in 2001.
AES is a symmetric key algorithm with variable block and encryption lengths. It has been developed by the Bel-
gian scientists Joan Daemen and Vincent Rijmen, and features outstanding security, flexibility and efficiency.

» DES — Data Encryption Standard
DES was developed by IBM for the NSA (National Security Agency) in the early 1970s and was the worldwide
security standard for years. The key length of this symmetrical process is 56 bits. Today, it is considered to be
insecure due to its short key length and in the year 2000 the NIST replaced it with the AES (Rijndael algorithm).
It is no longer suitable for use.
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» Triple DES (a.k.a. 3-DES)
A further development of DES. The conventional DES algorithm is applied three times consecutively. Two or three
different keys, each with a length of 56 bits are used. The key for the first run is reused for the third DES run. The
result is a nominal key length of 168 bit, with an effective key length of 112 bits.

Triple-DES combines the sophisticated DES technology with a suffi- ciently long key and is therefore considered
to be highly secure. Triple-DES is slower than other processes, however.

> Blowfish
This development by the renowned cryptographer Bruce Schneier is a symmetrical encryption process. Blowfish
achieves outstanding data throughput on multifunction processors. The process is reputed to be extremely effi-
cient and secure.

> CAST (from the authors Carlisle Adams und Stafford Tavares)

is a symmetrical process with a key length of 128 bits. CAST permits the modification of parts of the algorithm
at runtime.

(“ The encryption settings can be modified in the expert configuration within LANconfig. Modifications of this
sort are generally only required when setting up VPN connections between devices from different manufac-
turers. LANCOM gateways offer the encryption as standard either after AES (128 bit), Blowfish (128 bit) or
Triple-DES (168 bit).

10.8.4 Authentication — the AH protocol

The AH protocol (Authentification Header) guarantees the integrity and authenticity of the data. Integrity is fre-
quently regarded as a component of authenticity. In the following, we will consider integrity to be a separate problem
that is resolved by AH. In addition to integrity and authenticity, AH also provides effective protection against the
replay of received packets (Replay Protection).

AH adds its own header to IP packets immediately after the original IP header. The most important part of this AH
header is a field containing authentication data, often referred to as the Integrity Check Value (ICV).

IP header Data

35FBA5248DFCAADS!
A&?ﬁgﬁ%mg g
BDFCA4D8€YA55CA52
BDFCA4D5CA5248DF

The AH process in the sender
In the sender, the authentication data is generated in 3 steps.

(1 A checksum is calculated for the complete package using a hash algorithm.
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(2 This checksum is once again sent through a hash algorithm together with a key known to both the sender and
the recipient.

(3 This results in the required authentication data which is inserted in the AH header.
Oy

IP header | AH heade( Data

35FB A4D5C
IA524 A524
BDF! A524

8DFCA4DSCA5248DFC

@%—u@

721C98A% 14EF141F
D16E90AD14E8575D6(
[721D14AC50B5A1EC31

[®

Checking of integrity and authenticity by the recipient

=
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The AH protocol works in a very similar manner at the recipient's end. The recipient also uses his key to calculate the
authentication data for the received packet. The comparison with the sent ICV of the packet determines the integrity
and authenticity of the packet.
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IP header | AH header Data

35FBAB2ABDFCA4D50]
IA524 SWPBA524
8DF codek 524
3 8DFCA4D5CA5248DF(

1 304%%% E.E&a%?c 304}33
P16E90AD%YES575D6( D16E90A E8575D6C

721D14AC50B5A1EC3 721D14AC50B5A1EC31

+9

Identical?

Determining the checksum for the integrity check

AH adds a checksum to each packet before it is sent to guarantee the integrity of the transferred packets. At the
recipients end, AH checks whether the checksum and the contents of the package match. If this is not the case, the
packet was either incorrectly transferred or deliberately manipulated. Such packets are discarded immediately and
are not forwarded to higher protocol levels.

A variety of so-called hash algorithms are available to determine the checksum. Hash algorithms are distinguished
by the fact that their results (the hash code) are a unique fingerprint of the original data. Conversely, the original
data cannot be determined on the basis of the hash code. In addition, minimum changes of the input value entail a
completely different hash code with a high-grade hash algorithm. Systematic analyses of several hash codes thus
are made more difficult.

LANCOM VPN supports the two most common hash algorithms: MD5 and SHA-1. Both methods work without keys,
i.e. on the basis of fixed algorithms. Keys do not play a role until a later step of AH: the final generation of the
authentication data. The integrity checksum is only a necessary intermediate result on the way there.

Generation of the authentication data

In the second step, AH generates a new hash code using the checksum and a key, the final authentication data. A
variety of standards are available under IPSec for this process as well. LANCOM VPN supports HMAC (Hash-based
Message Authentication Code). The hash functions MD5 and SHA-1 are available as hash algorithms. The HMAC
versions are accordingly known as HMAC-MD5-96 and HMAC-SHA-1-96.

This clarifies why AH leaves the packet itself unencrypted. Only the checksum of the packet and the local key are
added to the packet together with the ICV, the authentication data, in encrypted form as a verification criterion.
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Replay protection — protection against replayed packets

In addition to the ICV, AH assigns a unique sequence number to each packet. The recipient can thus recognize which
packets were intercepted by a third party and resent. Attacks of this type are known as “packet replay”.

) AH does not cater for the masking of IPSec tunnels unless additional measures, such as NAT-Traversal or an
outer Layer-2-Tunneling (e.g. PPPT/L2TP), are used that offer “changeable” IP headers.

10.8.5 Key management — IKE

The Internet Key Exchange Protocol (IKE) permits the integration of subprotocols for managing the SAs and for key
administration.

Within IKE, two subprotocols are used in LANCOM VPN: Oakley for the authentication of partners and key adminis-
tration, and ISAKMP for managing the SAs.

Setting up the SAs with ISAKMP/Oakley

Establishing an SA involves a sequence of steps (with dynamic Internet connections, these steps follow the exchange
of the public IP addresses):

(1) The initiator sends a plain-text message to the remote station via ISAKMP with the request to set up an SA and
with proposals for the security parameters of the SA.

(2) The remote station replies with the acceptance of a proposal.

=
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(3 Both devices now generate key pairs, each consisting of a public and private key, for Diffie-Hellman encryption.

@) In two further messages, the devices exchange their public keys for Diffie-Hellman. The further communication
is encrypted with Diffie-Hellman.
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(5) Both ends use numbers that have been transferred (with the Diffie-Hellman method) and the Shared Secret to
generate a common secret key that is used to encrypt the subsequent communication. Both sides additionally
authenticate their Shared Secrets by using hash codes. Phase 1 of the SA setup is thus completed.

(&) Phase 2 is based on the encrypted and authenticated connection established in Phase 1. In Phase 2, the session
keys for the authentication and symmetrical encryption of the actual data transfer are generated at random and
transferred.

(“ Symmetrical processes are used for the encryption of the actual data transfer. Asymmetrical processes (also
known as public-key encryption) are more secure as they do not require the exchange of secret keys. Howe-
ver, they require considerable processing resources and are thus significantly slower than symmetrical pro-
cesses. In practice, public-key encryption is generally only used for the exchange of key material. The actual
data encryption is then performed using the fast symmetrical process.
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The regular exchange of new keys

ISAKMP ensures that new key material is regularly exchanged between the two devices during the SA. This takes
place automatically and can be checked using the ‘Lifetime’ setting in the advanced configuration of LANconfig.
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11 Virtual LANs (VLANSs)

11.1 What is a Virtual LAN?

The increasing availability of inexpensive layer 2 switches enables the setup of LANs much larger than in the past.
Until now, smaller parts of a network had been combined with hubs. These individual segments (collision domains)
had been united via routers to larger sections. Since a router represents always a border between two LANSs, several
LANs with own IP address ranges arose by this structure.

By using switches, it is possible to combine much more stations to one large LAN. By the specific control of data on

the individual ports, the available bandwidth can be utilized much better than by using hubs, and the configuration

and maintenance of routers within the network can omitted.

But also a network structure based on switches has disadvantages:

> Broadcasts are sent like hubs over the entire LAN, even if the respective data packets are only important for a
certain segment of the LAN. A sufficient number of network stations can thus lead to a clear reduction of the
available bandwidth in the LAN.

> The entire data traffic on the physical LAN is “public”. Even if single segments are using different IP address ran-
ges, each station of the LAN is theoretically able to tap data traffic from all logical networks on the Ethernet
segment. The protection of individual LAN segments with Firewalls or routers increases again the requirements
to network administration.

One possibility to resolve these problems are virtual LANs (VLANS), as described in IEEE 802.1p/qg. By this concept,

several virtual LANs are defined on a physical LAN, which do not obstruct each other, and which also do not receive

or tap data traffic of the respective other VLANs on the physical Ethernet segment.

11.2 This is how a VLAN works
By defining VLANSs on a LAN the following goals should be achieved:
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> Data traffic of certain logical units should be shielded against other network users.
> Broadcast traffic should also be reduced to logical units, not bearing a burden on the entire LAN.

> Data traffic of certain logical units should be transmitted with a specific priority compared to other network
users.

An example to clarify: A switch is connected to a hub within a LAN, which connects four stations from the marketing
department to the network. One server and two stations of the accounting department are directly connected to the
switch. The last section is the base station of a wireless network, where four WLAN clients reside from the sales
department.

The stations from marketing and sales should be able to communicate with each other. Additionally, they should be
able to access the server. The accounting department needs also access to the server, but should otherwise be shiel-
ded against the other stations.
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LAN segment
marketing

Server Accounting stations

base station

Switch

11.2.1 Frame tagging

In order to shield or, if necessary, to prioritise data traffic of a virtual LAN against the other network users, data

packets must have an additional feature (a “tag”). That's why the respective process is also called “frame tagging”.

Frame tagging must be realized such that the following requirements are fulfilled:

> Data packets with and without frame tagging must be able to exist in parallel on a physical LAN.

> Stations and switches in a LAN, which do not support VLAN technology, must ignore the data packets with frame
tagging and/or treat them as “normal” data packets.

The tagging is realized by an additional field within the MAC frame. This field contains two important information

for the virtual LAN:

> VLAN ID: A unique number describes the virtual LAN. This ID defines the belonging of data packets a logical
(virtual) LAN. With this 12 bit value it is possible to define up to 4094 different VLANSs (VLAN IDs “0" and “4095"
are reserved resp. inadmissible).

(.3 VLAN ID “1" is used by many devices as the Default VLAN ID. Concerning unconfigured devices, all ports
" belong to this Default VLAN. However, this assignment can also be changed by configuration. (‘The port
table’" —page 216).

» Priority: The priority of a VLAN-tagged data packet is indicated by a 3 bit value. “0" represents the lowest pri-
ority, “7" the highest one. Data packets without VLAN tag are treated with priority 0"

This additional field makes the MAC frames longer than actually allowed. These “overlong” packets can only be
recognized and evaluated by VLAN-capable stations and switches. Frame tagging incidentally leads to the desired
behaviour for network users without VLAN support:
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> Switches without VLAN support simply pass on these data packets and ignore the additional fields within the
MAC frame.

> Stations without VLAN support are not able to recognize the protocol type due to the inserted VLAN tag and
discard the packets silently.

Older switches in the LAN are perhaps not able to pass on correctly the overlong frames between the indi-
vidual ports and will reject the tagged packets.

11.2.2 Conversion within the LAN interconnection
Certain stations shall be grouped to logical units by virtual LANs. But the stations themselves are usually neither able
to generate the required VLAN tags, nor able to handle them.

Data traffic between network users always runs over different interfaces of the distributors in the LAN. These distri-
butors (switches, base stations) have got the task to insert VLAN tags according to the desired application into the
data packets, to evaluate them and, if necessary, to remove them again. Because logical units are each connected
to different interfaces of the distributors, the rules for generating and processing of the VLAN tags are assigned to
the single interfaces.

Coming back again to the first example:

/ Data packet without VLAN tag
@ V‘@ LAN segment WLAN
ﬁ E marketing sales
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A workstation from the marketing sends a data packet to a workstation of the sales department. The marketing hub
passes the packet simply on to the switch. The switch receives the packet at its port no. 1, and recognizes that this
port belongs to a VLAN with the VLAN ID “3”. It inserts an additional field into the MAC frame with the appropriate
VLAN tag, and issues the packet only on ports (2 and 5), which also belong to VLAN 3. The base station of the sales
department will receive the packet on its LAN interface. By its settings, the base station can recognize that the WLAN
interface belongs also to VLAN 3. It will remove the VLAN tag from the MAC frame, and issues the packet again on
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the wireless interface. The WLAN client can handle the packet then, which has a “usual” length again, like each other
data packet without VLAN tagging.

11.2.3 Application examples

Main application of virtual LANs is to install different logical networks on a physical Ethernet segment, whose data
traffic is protected against the other logical networks.

The following sections present examples for the operation of virtual LANs on behalf of this background.

Management and user traffic on a LAN

Several hot spots are installed on an university campus, so that students equipped with notebooks and WLAN cards
have access to the Internet and to the server of the library. The hot spots are connected to the university LAN. Via
this LAN the administrators also access the base stations to carry out several management tasks via SNMP.

= B 4 &
s B H =

2

I\ Data traffic without/I
VLAN tag

I A

e [ R —

By setting up a virtual LAN between the base stations and the administrator’s switch, management data is shielded
against all “public” traffic on the LAN.

Different organisations on one LAN

The flexibility of the modern world of work raises new challenges for administrators concerning planning and main-
tenance of network structures. The occupation of the rooms by leaseholders changes permanently in public office
buildings, and also inside of a company, teams are often newly assembled. In both cases, the individual units must
have an independent, protected LAN. But this task is very burdensome to realize by hardware changes, or even not
at all, because e.g. only one single central cabling exists in the office building.
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Company

A, sales
» (@
&m @

VLAN ID=3 VLAN ID=5

Company A,
accounts dep.

VLAN ID=11

Comp. A, administrat. Comp. B

central network cabling

>

VLAN ID=3, 5, 11

Virtual LANs enable to perform this task in a very smart way. Also when departments or companies change at a later
time inside of the building, the network structure can be easily adjusted.

All network users in this example use the central Ethernet, which is, like the connected devices, supervised by a ser-
vice provider. Company A has three departments on two floors. The sales department can communicate with the
administration department via VLAN ID 3, the accounts department with the administration via VLAN ID 5. The net-
works of accounts department and sales do not see each other. Company B is also shielded by VLAN ID 11 against
all other networks, only the service provider can access all devices for maintenance purposes.

11.3 Configuration of VLANSs

@ VLAN technology functions are presently only supported by LANCOM Wireless devices.

Ther configuration of LANCOM Wireless devices within the VLAN realm has to perform two important tasks:
> Defining virtual LANs and assigning them a name, a VLAN ID and the affected interfaces.
> Defining for the interfaces how to proceed with data packets with or without VLAN tags.
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11.3.1 The network table

In the network table are those virtual LANs defined, in which the LANCOM should participate. The table contains 32
entries at maximum with the following information:

>
>
>

Name: The VLAN name serves only as a description during configuration. This name is used at no other place.
VLAN ID: This number marks the VLAN unambiguously. Possible values range from 1 to 4094.

Port list: All LANCOM interfaces belonging to the VLAN are entered into this list. As ports can be entered:

> "LAN-n" for all Ethernet ports of the device.

> “WLAN-n" for point-to-station WLAN ports.

> "“P2P-n" for point-to-point WLAN ports.

Given a device with a LAN interface and a WLAN port, e.g. ports “LAN-1" and "WLAN-1" can be entered. In case
of port ranges, the individual ports must be separated by a tilde: “P2P-1~P2P-4".

(‘iy The available ports can be found in the port table (—Seite 216).

Example for a network table:

Default 1 LAN-1, WLAN-1, WLAN-2
Sales 2 LAN-1, WLAN-1
Marketing 3 LAN-1, WLAN-2

11.3.2 The port table

The port table configures the individual ports of the device for use by the VLAN. The table has got an entry for each
port of the device with the following values:

>
>

>

Port: Name of the port, not editable.

Use tagging: This option indicates, whether data packets should be tagged on this port. The tagging refers only
to data packets sent over this port.

Allow untagged frames: This option indicates, whether untagged data packets are passed on, which have
been received on this port.

Allow all VLANS: This option indicates, if tagged data packets with any VLAN IDs should be accepted even if
the port itself is not belonging to the same VLAN ID.

Default ID: This VLAN ID has two functions:
> Untagged packets received on this port are provided with this VLAN ID.

> If tagging for sent packets is switched on, this VLAN ID will not be assigned to the packets. If a packet with
this VLAN ID is received, it will be passed on without this ID, although tagging has been switched on.
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Example for a port table:

LAN-1 On On On 1
WLAN-1 off On Off 1
WLAN-2 off On off 1
P2P-1 off On off 1
pP2p-2 off On off 1
P2P-3 off On off 1
P2pP-4 off On off 1
P2P-5 off On off 1
P2P-6 off On off 1

11.3.3 Configuration with LANconfig

Parameters for virtual networks can be set with LANconfig under ‘Management' on the register card 'VLAN'. The
definition of the used virtual networks can be accessed via the button VLAN table:

New Configuration for LANCOM 1811 Wireless DSE 2 x|
Configure: |Management ‘l

Generall Interfacesl Wireless LANI Secuiityl Costs  WLAN |

—WLAM setting
This table holds the definition of all VL&Ns used.

Metwork table ... %I

This table holds YLAN-related configuration items for every part
the device has.
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Port table - |

Dece AN 0: TS 2]

Remate site | Source IP | Tetmask, | Mapped IP | OF |
ZEMTRALE 10.0.0.0  255.255.255.0 192.168.1.0
Cancel |

2|

N:M table - New Entry i 2 x|
Destination remote site: | ZENTRALE LI | QK

| Original source address: IID.D.D.D cancel |

Metmask: 255,255,255.0
7:;::NEDM ok | Cance I
Mapped source address: | 192.168.1.0]
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Network table N _‘?Ill
WLAN narme | YLAN ID | Port list | OF
1 LAMN-1,'WLAN-1,PZP-1~PZP-6
Cancel
il
Network table - New Entry 1} 2 x|
YLAN name: | INTERNAL oK
Add ... Edit ... | _ WLANID: |3 ) |
Port list: I LAMN-1,WLAN-1

The button Port table opens a drop down list where a VLAN port can be selected for editing:

Port table - Local area network 1} 2 x|
[~ Frames emitted on this port will have a YLAN tag

¥ allow the forwarding of untagged frames being 5

received on this port Cancel |
¥ Accept Frames on this port that belong to ather

WLAMNS

Part YLAN ID: I 1

%)
=
S 11.3.4 Configuration with WEBconfig or Telnet
N
g Under WEBconfig or Telnet the tables for configuring the VLANs can be found via the following paths:
<
~
g
= WEBconfig Expert Configuration > Setup P> LAN Management module »
S VLAN Configuration
Terminal/Telnet cd /Setup/LAN Management module/VLAN Configura-
tion

The VLAN configuration shows up under WEBconfig as follows
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Expert Confiquration
5 Setup

5 LAN-mananement-module

VLAN-Configuration

B Metwork-Table 32 % [Name VLAN-ID Port-List]

EA Port-Table g% [PortUse-Tagaing Allow-Untagaed-Frames Allowe-All-WLANS, . ]
Er Device-VLAN-ID 1

@ Help (Reference Manual (5 2/4/2004 13:26

o Previous Page €3 Entry Pade @ LAMCOM Systems Homepade
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12 Wireless LAN — WLAN

12.1 What is a Wireless LAN?

. The following sections are a general description of the LCOS operating system functions in wireless networks.
The precise functions supported by your device are described in its manual.

In this chapter we will show you briefly the technology of wireless networks. In addition, we give you an overview
of the various applications, functions and abilities of your LANCOM Access Points and WLAN Router.

A Wireless LAN connects single terminals (e.g. PCs or notebooks) to a local network (also LAN — Local Area Network).
In contrast to a conventional LAN, communication takes place via radio links rather than via network cables. This is
the reason why a Wireless LAN is also called a Wireless Local Area Network (WLAN).

All functions of a cable-bound network are also available in a Wireless LAN: access to files, servers, printers etc. is
as possible as the connection of individual stations to an internal mail system or to the Internet access.

The advantages of Wireless LANs are obvious: notebooks and PCs can be set up just where they are needed. Due to
Wireless LANs, problems with missing connections or structural alterations belong to the past.

12.1.1 Standardized radio transmission by IEEE

LANCOM network products comply with the IEEE 802.11 standards. These standard'’s family represents an extension
to the already existing IEEE standards for LANs, of which IEEE 802.3 for Ethernet is the most popular one. Within
the IEEE 802.11 family, different standards exist for the radio transmission in different frequency ranges and with
different speeds. LANCOM base stations and AirLancer client adapters support according to their respective type dif-
ferent standards:

> IEEE 802.11a with up to 54 Mbps transfer rate in the 5 GHz band, up to 108 Mbps in turbo mode. (complement
to standard)

> [EEE 802.11b with up to 11 Mbps transfer rate in the 2,4 GHz band

> |EEE 802.11g with up to 54 Mbps transfer rate in the 2,4 GHz band, up to 108 Mbps in turbo mode. (comple-
ment to standard)

>

IEEE 802.11a: 54 Mbps

IEEE 802.11a describes the operation of Wireless LANs in the 5 GHz frequency band (5,15 GHz to 5,75 GHz), with
up to 54 Mbps maximum transfer rate. The real throughput depends however on the distance and/or on the quality
of the connection. With increasing distance and diminishing connecting quality, the transmission rate lowers to 48
Mbps, afterwards to 36 Mbps etc., up to a minimum of 6 Mbps. The distance of transmission ranges from up to 125
m in open expanses, in buildings typically up to 25 m. The IEEE 802.11a standard uses OFDM (Orthogonal Frequency
Division Multiplexing) as modulation scheme.
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In the 5 GHz frequency band, the OFDM modulation scheme is used for IEEE 802.11a. OFDM is a modulation scheme,
which utilizes multiple independent carrier frequencies for the signal transmission, and which modulates these mul-
tiple carriers each with a reduced data transfer rate. Thus the OFDM modulation scheme is very insensitive in parti-
cular to echoes and other impairments and enables high data transfer rates.

In "turbo mode’, LANCOM Wireless base stations are able to use simultaneously two radio channels and can so incre-
ase the transfer rate up to maximum 108 Mbps. The turbo mode can be used in conjunction with the IEEE 802.11a
standard between LANCOM base stations and AirLancer wireless network cards. The increase of the transfer rate
must be switched on in the base station, but can also reduce the transmitting power and the range of the radio con-
nection.

IEEE 802.11b: 11 Mbps

[IEEE 802.11b describes the operation of local Wireless LANs in the ISM frequency band (Industrial, Scientific,
Medical: 2.4 up to 2.483 GHz). The maximum transfer rate is up to 11 Mbps. The real through-put depends however
on the distance and/or on the quality of the connection. With increasing distance and diminishing connecting quality
the transmission rate lowers to 5,5 Mbps, afterwards to 2 and finally to 1 Mbps. The range of the transmission dis-
tances is between up to 150 m in open expanses and in buildings typically up to 30 m. Due to different frequency
bands in use, IEEE 802.11b is not compatible to IEEE 802.11a.

For shielding against interferences by other transmitters, which have possibly the same frequency band, the DSSS
procedure (Direct Sequence Spread Spectrum) is used for IEEE 802.11b in the 2,4 GHz frequency band. A transmitter
normally uses only a very narrow range of the available frequency band for transmission. If exactly this range is used
by another transmitter, interferences in transmission would be the result. With the DSSS procedure the transmitter
uses a broader spread of the possible frequencies and becomes more insensitive to narrow-band disturbances then.
This procedure is also used in military range for increasing tap- proof security.

IEEE 802.11g: 54 Mbps

The IEEE 802.119 standard works likewise with up to 54 Mbps data transmission rate in the 2,4 GHz ISM-frequency
band. Contrary to IEEE 802.11b, the OFDM modulation is used for IEEE 802.11g, like already introduced for IEEE
802.11a. IEEE 802.119 contains a special compatibility mode that ensures a downward compatibility to the popular
IEEE 802.11b standard . However, in this compatibility mode you encounter reduced transmission speeds. Due to the
different frequency bands, IEEE 802.11g can not be compatible to IEEE 802.11a. The transmission distances of IEEE
802.11g products are comparable with those of IEEE 802.11b products.

With the 802.11g standard in ‘turbo mode' the transfer rate can be increased to a maximum of 108 Mbps, by using
two radio channels. But as a 2.4 GHz band uses less channels than the 5 GHz band, the turbo mode limits in this
case the options of channels.

Transfer rates

The indicated transfer rates are always to be interpreted as gross data rates, i.e. the entire protocol overhead - as
for example the complex protocols to secure the radio transmission - is included in the indicated transfer rates. The
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net data transfer rate can be thus lower than the indicated gross data rates, typically over up to the half for all IEEE
802.11 standards mentioned above.

Ranges

The actually obtained distances for radio transfers depend strongly on the individual environment. In particular influ-
ences of noise and obstacles have an effect on the range. Decisive is an optimal placement of the radio stations (both
network adapters and base stations). For further increase of the transfer distance, we recommend the operation with
additional antennas (e.g. AirLancer Extender).

IEEE standards

In order to guarantee a maximum of compatibility, LANCOM Systems Systems fully complies with the industry stan-
dards of the IEEE" described in the preceding paragraph. For this reason, your LANCOM base station operates wit-
hout problems and with reliably also with devices of other manufacturers.

Your LANCOM base station supports - according to the model type - the standards IEEE 802.11g (downward-com-
patible to IEEE 802.11b), and/or IEEE 802.11a.

The operation of the integrated wireless card of your base station is only possible in one single frequency band, that
is, either 2,4 GHz or 5 GHz. Thus a simultaneous operation of IEEE 802.11g and IEEE 802.11a is not possible. Since
IEEE 802.11g is downward-compatible to IEEE 802.11b, an simultaneous operating of these two standards is pos-
sible, but with certain speed constraints.

Transfer rates in compatibility mode

=

3 Please notice that the reached data transfer rates depend on the used 2,4 GHz mode. You will achieve the high-

= est transfer rates with a base station operating in the 802.11g mode. The transfer rate will go down when star-

2' ting the compatibility mode, even, if only inactivated 802.11b

< stations are near to your base station. When these 802.11b stations HSsESSESEEmEtEmEsrr .

@ start to be activated in a wireless network with operating compati- \’;E:ratior! WEP;:rf;all |P°";';°d'iz°'”‘| | —

% bility mode, the actual transfer rate will fall again.

. , . S requency band: lﬁ

§ That's why you should only activate the compatibility mode, when ;u:bandib : I—_ITWH ey =
you have really operating 802.11b and 802.11g stations in your . iumber [Cranrel 10 2457 Gz =]
wireless network. 5 4 GHa mode: [R02 119/b (compatile) 7]

Q: Please notice that not all frequencies are permitted in each country! You will find a table with the allotted
\ frequencies and the permission regulations in the appendix.

12.1.2 Operation modes of Wireless LANs and base stations

Wireless LAN technology and base stations in Wireless LANs are used in the following operation modes:

1. Institute of Electrical and Electronic Engineers — International association, which established i.a. numerous technology standards.
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Only in IEEE
802.11b or
IEEE 802.11g
standard

> What is a Wireless LAN?

Simple direct connections between terminals without base station (ad-hoc mode, only with 2.4 GHz)
Larger Wireless LANs, connection to LANs with one or more base stations (infrastructure network)
Connecting two LANSs via a direct radio link (point-to-point mode, point-to-multipoint)

Connecting of devices with Ethernet interface via base stations (client mode)

Extending an existing Ethernet network with WLAN (bridge mode)

Multiple radia cells with one access point (Multi-SSID)

vVvyVvyvVvyyvyy

The ad-hoc mode

When two terminals are equipped with compatible wireless interfaces, they both can communicate directly via radio.
This simplest use is the so-called ad-hoc mode.

In ad-hoc networks you connect two or more PCs with own wireless interfaces directly together for building a Wire-
less LAN.

This operation mode is generally called peer-to-peer network (spontaneous network). PCs can immediately get in
touch and exchange data.

The infrastructure network

By use of one or more base stations (also called access point), a Wireless LAN becomes more comfortable and more
efficient. A Wireless LAN with one or more base stations is referred to as an infrastructure network in Wireless LAN
terminology.

@ [In some devices the access point is built in, so called WLAN router.

Inté%esting applications arise for the Wireless LAN from the LAN connection of base stations:
> Connecting the Wireless LAN to an existing LAN

> Extending the coverage of a Wireless LAN

Additionally, the use of a base station enables a central administration of the Wireless LAN.
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> What is a Wireless LAN?

Connectionto  An infrastructure network is ideally suitable as an extension to existing wired LANs. For extension of a LAN in areas,

izﬁxisting where a wiring is not possible or uneconomical, the infrastructure network represents an ideal alternative.

LAN base station

Largerexten-  The area, in which mobile stations can get in touch with a base station, is called radio cell.
sion by roa-

ming function If the range of a radio cell is not sufficient any longer to serve all mobile stations of a wireless network, several base

stations can be brought in action. It is possible to change from a radio cell into another one without interruption of
the network connection. The transmission of roaming information and data between the base stations is enabled by
the wired LAN connection.

Mobile station leaves ... changes
radio cellAand ... into radio cell

—————
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connection via
LAN

In the example above, the roaming function of the mobile station enables the access to the workstation in radio cell
A also after changing into radio cell B. After the radio cell change, the base station in radio cell B passes on the data
of the mobile station via LAN to the base station in radio cell A. From there, they arrive via radio at the workstation
in radio cell A. In this way, the connection between both devices remains existing at any time.

A Wireless LAN can consist of as many as desired radio cells. Thus the extension of a Wireless LAN is unlimited.
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> What is a Wireless LAN?

Base station as router

The LANCOM Wireless base station possesses a WAN connector for all current broadband modems with cable-bound
Ethernet connection (DSL or cable modem). In this operation mode, the base station offers all functions of a complete
IP and IPX router as well. The base station serves in this connection variant as gateway to the Internet. The router
checks for all received data packets whether they need to be transferred to another network or workstation. The rou-
ter itself establishes the connections as required.

The integrated Stateful Inspection Firewall prevents effectively the penetration of undesired data traffic into the own
network by permitting incoming data only as reaction to outgoing data traffic. For accessing the Internet, the IP mas-
querading function of the router hides all workstations of the LAN behind a single public IP address. The real iden-
tities (IP addresses) of the individual workstations remain concealed. Firewall filters of the router permit specific IP
addresses, protocols and ports to be blocked. With MAC address filters it is also possible to specifically control the
access of workstations in the LAN to the IP routing function of the device.

base station DSL modem or any broad-
band connection

VPN pass-through

VPN technology (VPN=Virtual Private Network) is more and more frequently in use to protect sensitive data. The
LANCOM 70117 VPN base station is able to route and mask simultaneously the encrypted data between a VPN client
of the WLAN and another workstation of the cable-bound LAN. This “passing-through” of VPN encrypted data is
called in technical jargon “VPN pass-through”. Following are provided:

> PPTP pass through

> IPsec pass through
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> What is a Wireless LAN?

Point-to-mul-
tipoint opera-
tion
Point-to-sta-
tion operation
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VPN client

» e E
VPN remote station

The LANCOM 7071 VPN base stations support VPN pass-through function for multiple stations within a
wireless network.

Wireless bridge between two Ethernet segments

With two base stations, two LANs can be connected via a radio link (point-to-point mode). In this so-called bridge
mode, all data is transferred automatically to the remote network.

By the use of narrow beam antennas (e.g. AirLancer Extender), also larger distances can be bridged securely. An
additional increase of reach can be achieved by use of further base stations, which operate in relay mode between
two LAN segments.

BT
gasass man

It is possible to couple up to seven remote network segments to an united network by wireless bridges in the so-
called P2MP operation (point-to-multipoint) mode.

The so-called P2Station operation (point-to-station) connects a single station is to a remote LAN.
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> What is a Wireless LAN?

Base station in client mode

For binding single devices with Ethernet interfaces to a Wireless LAN, LANCOM Wireless base stations can be put
into the so-called client mode, in which they behave like a conventional Wireless LAN adapter and not like a base
station. Due to the client mode, it is also possible to integrate devices like PCs or printers having only one Ethernet
interface into a Wireless LAN.

base stations in
client mode

base stations in
standard mode
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@ An Access Point in normal mode further clients can log on, but not in client mode.

Multiple radio cells with Multi-SSID
Conventionally, a wireless network card supports exactly one radio cell.

These radio cells are given a network name, known as the ‘SSID’ (Service Set Identifier), that is entered into the
access points and network cards during configuration. Certain settings that apply to the radio cell can be defined
under the SSID during the configuration of the access point. The settings include, for example, the data transfer
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speed and the first WEP key, which is also used as passphrase for encryption with 802.11i and WPA. Those clients
that are programmed with the SSID can make use of the radio cell and work with the parameters as defined. The
access point treats all clients on an equal basis

In some applications, however, it may be desirable to divide the clients the radio cell into different groups, each of
which is treated in a certain way by the access point. It may be necessary, for example, to operate a public wireless
network without any encryption simultaneous to a protected, 802.11i-, WPA- or WEP-encrypted wireless network
that excludes unauthorised parties.

The Multi-SSID function of the LANCOM access points is ideally suited to scenarios like this. This function enables a
physical WLAN interface of an access point to be assigned with more than one SSID. Up to eight different logical
radio cells—each with its own SSID—can be supported by a single WLAN interface.

SSID='PUBLIC" '
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12.2 Development of WLAN security

The WLAN standards WPA and 802.11i are currently redeeming the reputation of WLAN security, an issue which has
recently been under attack. The processes incorporated into the original standard proved insufficient in practice. This
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lack led on the one hand to a series of proprietary extensions of the standard, like "CKIP" from Cisco, or "KeyGuard"
from Symbol Technologies, and on the other hand to solutions which offered the required security on higher protocol
layers with tools like PPTP or IPSec. All these processes are quite functional, but they introduce limitations, for
instance those relative to interoperability or data transmission rates.

In the standard 802.11i released in Summer, 2004, the IEEE Committee has redefined the topic "WLAN and security"
from the ground up. The result is a set of standardized methods that enable the construction of secure and
manufacturer-independent WLANSs in line with current standards.

On the way from the original WEP of the 802.11 standard to 802.11i, a whole series of concepts have arisen that
have tended to increase confusion and insecurity among the users. This chapter should help to explain the concepts
and the processes used, in chronological order of their development.

12.2.1 Some basic concepts

Even though one constantly hears the blanket term 'Security' when talking about computer networks, it is still
important for the coming exposition to differentiate a little more closely between the requirements it actually entails.
Authentication

The first point in security is access security:

> Here, a protective mechanism is involved which allows access to the network only to authorized users.

> On the other hand, however, it must also be ensured that the client is connected to the precise desired access
point, and not with some other access point with the same name which has been smuggled in by some nefarious
third party. Such an authentication can be provided, for example, using certificates or passwords.

Authenticity

Authentcity: Proof of the authorship of the data and the originality of the data content; the process of establishing

this proof is known as authentication.

Integrity
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Once access is provided, one would like to ensure that data packets reach the receiver without any falsification, that
is, that no-one can change the packets or insert other data into the communication path. The manipulation of data
packets themselves cannot be prevented, but changed packets can indeed be identified using suitable checksum
processes, and then discarded.

Confidentiality

Quite separate from access security is confidentiality, that is, unauthorized third parties must not be able to read the
data traffic. To this end, the data are encrypted. This sort of encryption process is exemplified by DES, AES, RC4, or
Blowfish. Along with encryption, of course, there must also be a corresponding decryption on the receiving end,
generally with the same key (a so-called symmetric encryption process). The problem naturally then arises, how the
sender can give the key to the receiver for the first time—a simple transmission could very easily be read by a third
party, who could then easily decrypt the data traffic.
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In the simplest case, this problem is left to the user, that is, one simply assumes that the user can make the key known
at both ends of the connection. In this case, one speaks of pre-shared keys, or 'PSK".

More sophisticated processes come into play when the use of pre-shared keys is impractical, for instance in an HTTP
connection built over SSL—in this case, the user can't retrieve a key from a remote web server quite so easily. In this
case, so-called assymetric encryption methods such as RSA can be used, that is, to decrypt the data, a different key
is used than the one used to encrypt it, meaning that key pairs are used. Such methods are, however, much slower
than symmetric encryption methods, which leads to a two-phase solution:

> The sender possesses an asymmetric key pair. It transmits the public part of the key pair, i.e. the key for
encryption, to the receiver as a certificate, for example. Since this part of the key pair cannot be used for
decryption, there are no misgivings with regard to security.

> The receiver selects any symmetrical key. This symmetrical key that is used both for encryption and for
decryption, must now be securely transmitted to the sender. It is encrypted with the sender's public key and
returned to the sender. The only way that the symmetrical key can be decrypted again is with the sender's private
key. Potential eavesdroppers observing the key exchange cannot decrypt this information, and consequently the
transmission of the symmetrical key is secure.

This method can be used for the safe transmission of symmetrical keys via the Internet. In the following sections, we
will see these methods again, sometimes in modified form.

12.2.2 WEP

WEP is an abbreviation for Wired Equivalent Privacy. The primary goal of WEP is the confidentiality of data. In
contrast to signals which are transmitted over cables, radio waves spread out in all directions—even into the street
in front of the house and other places where they really aren't desired. The problem of undesired interception is
particularly obvious in wireless data transmission, even though it can also arise in larger installations with wired
networks—however, access to cables is far more easily restricted than is the case with radio waves.

During the development of the WLAN security standard, the IEEE Committee did not intend to develop a "perfect”
encryption method. Such high-security encryption methods are, for instance, required and also used in electronic
banking—in this case, however, the applications themselves use high-quality encryption methods, and it would be
unnecessary to repeat this effort at the radio transmission level. With the new security standards, only those
applications which normally work without encryption in wired LANs should be provided with sufficient security
against eavesdropping by unauthorized third parties.

WEP is a symmetrical method of encryption and uses RC4 algorithm as its basic encryption technology, a process
already well-known in other areas and considered highly secure. RC4 uses a key between 8 and 2048 bits in length,
which is used to generate a pseudo-random series of bytes using a predetermined process. The data packet for
encryption is then XOR'd byte by byte with this byte stream. The receiver simply repeats this procedure with the same
key and in the same order to produce the original data packet again.

However, RC4 has one serious disadvantage: one may only use a particular RC4 key once for a single packet, as two
different packets that have been coded with the same RC4 key potentially provide the basis to reproduce the original
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data. As it would be impracticable for the user to enter a new code key for every data packet, WEP combines this
key with an additional internal key, the initial vector (IV). This is automatically changed from packet to packet.

The IEEE standard originally foresaw a relatively short key length of 40 bits, which was probably oriented towards
the then-existing US export restrictions on strong cryptography; this variant in combination with the 24 bits of the
IV is usually referred to as WEP64. Most WLAN cards today support a variant in which the user can configure a 104-
bit key, which results in a 128 bit long RC4 key—correspondingly, this is often called WEP128. More seldom are key
lengths of 128 bits (WEP152) or 232 bits (WEP 256). In principle RC4 can work with key lengths of up to 2048 bits
(WEP keys of up to 2024 bits), although in practice key lengths reach a simple limit at which the user can manage
to enter the columns of digits without making a mistake.

The IEEE standard specifies that up to four different WEP keys can exist in one WLAN. The sender encodes the
number of the WEP key used in the encrypted packet along with the initial vector, so that the receiver can use the
appropriate key. The idea behind this was that old keys in @ WLAN could gradually be exchanged for new keys, in
that stations which had not yet received the new key could still use an old key during a transition period.

One of the chief weakness of WEP is the length of the initial vector, which is far too short. As mentioned previously,
the repetition of a key with RC4 presents a significant security loophole which, with a length of just 24 bits, can occur
within just a few hours depending on the data rate. Since particular portions of the encrypted data packets can
quickly offer conclusive information about the key, an eavesdropper only needs to process a small amount of the
data traffic with specialized sniffer tools in order to crack the key. These weaknesses unfortunately degraded WEP to
an encryption scheme which at best could be used to protect a home network against ‘accidental eavesdroppers.'

12.2.3 WEPplus

As explained in the previous section, the use of 'weak' IV values was the problem which weakened the WEP process
most. A first 'quick shot' to secure WLANS against this kind of program was the simple notion that the weak IV values
are known, and that they could simply be skipped during encryption—since the IV used is after all transmitted in
the packet, this procedure would be completely compatible with WLAN cards which didn't understand this
extension, dubbed WEPplus. A true improvement in security would naturally only result once all partners in the
WLAN were using this method.

In a network equipped with WEPplus, a potential attacker again has the chore of listening to the entire data traffic,
waiting for IV repetitions—simply waiting for the few packets with weak Vs is no longer an option. This raises the
bar for an attacker once again. Objectively speaking, WEPplus is a slight improvement--it is suitable for home use,
provided that the key of reconfigured often enough. For use in a professional environment, however, this is not
sufficient.
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12.2.4EAP and 802.1x

Obviously, an ‘add-on' like WEPplus can't eliminate the basic problem of too-short IVs, without changing the format
of packets on the WLAN, thus rendering all existing WLAN cards incompatible. There is, however, a possibility of
solving several of our problems with one central change: no longer use the formerly fixed WEP key, but to negotiate
them dynamically instead. As the process to be used for this purpose, the Extensible Authentication Protocol has
emerged. As the name suggests, the original purpose of EAP is authentication, that is, the regulated access to a
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WLAN—the possibility of installing a valid WEP key for the next session is more or less a byproduct. Figure 2 shows
the basic process of a session secured by EAP.

Client Access point RADIUS server
@

WLAN registration
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sharing of Master Secret
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Figure 2: Schematic process of a WLAN session with EAP/802.1x

In the first phase, the client registers with the access point as usual, and enters the state in which it can now send
and receive over the access point in normal WEP or WEPplus—but not with EAP, because in this state the client still
doesn't have a key to secure its data traffic from eavesdropping. Instead, the client is in an ‘intermediate state' from
the point of view of the access point, in which only particular packets from the client are forwarded, and these are
only directed to an authentication server. These packets are the EAU/802.1x mentioned previously. The access point
packs these packets in RADIUS queries and sends them on to the authentication server. The access point converts
the replies coming from the RADIUS server back into EAP packets, and sends them back to the client.

The access point is thus a sort of middle man between client and server. it doesn't have to check the contents of
these packets, it just has to check that no other data traffic to or from the client can occur. Over this "tunnel" through
the access point, the client and server authenticate one another, that is, the server checks the client's access privilege
to the network, and the client checks that it is talking to the right network. "Wild" access points set up by hackers
can be recognized in this way.
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A whole series of authentication processes exist which can be used in this tunnel. A current process (and one
supported by Windows XP) is for instance TLS, in which server and client exchange certificates; another is TTLS, in
which only the server supplies a certificate—the client is authenticated using only a username and password.

After the authentication phase, a secure tunnel even without WEP encryption has been set up, in which the access
point is connected in the next step. For this, the RADIUS server sends the so-called 'Master Secret’, a session key
calculated during the negotiation, to the access point. The LAN behind the access point is considered secure in this
scenario, so that this transmission can be performed in clear text.

With this session key, the access point now takes over the tunnel and can use it to provide the actual WEP key to the
client. Depending on the capabilities of the access point hardware, this can be a true session key (that is, a WEP key
which will only be used for data packets between the access point and precisely this client), or a so-called group key,
which the access point will use for communication with multiple clients. Classical WEP hardware can usually handle
only group keys, these being the four mentioned in the chapter on WEP.

The particular advantage of this procedure is that the access point can regularly change the WEP key over the EAP
tunnel, that is, it can perform a so-called rekeying. In this way, WEP keys can be replaced by new ones long before
they run the risk of being cracked due to IV collisions. A common ‘use time" for such WEP keys might be 5 minutes.

The disadvantage of the procedure is its complexity. The maintenance of the central RADIUS server and the
certificates stored there is generally only possible in large installations with a separate IT department—it is less
suitable for use in the home or in smaller companies. These practical hurdles have thus limited EAP/802.1x to
professional use so far—the home user must simply make do with WEPplus, or address security problems on the
applications level.

12.2.5TKIP and WPA

As clarified in the last section, the WEP algorithm is flawed and insecure in principle; the measures taken so far were
largely either 'quick fixes' with limited improvement, or so complicated that they were basically impractical for home
use or smaller installations.

After the problems with WEP became public knowledge, the IEEE began with the development of the standard IEEE
802.11i. As an interim solution, the WiFi Alliance defined the Wifi Protected Access (WPA) 'standard’. WPA uses the
following changes:

» TKIP and Michael as replacement for WEP

> A standardized handshake procedure between client and access point for determination/transmission of the
session key.

> A simplified procedure for deriving the Master Secret mentioned in the last section, which can be performed
without a RADIUS server.

> Negotiation of encryption procedure between access point and client.
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TKIP

TKIP stands for Temporal Key Integrity Protocol. As the name suggests, it involves an intermediate solution for
temporary use until a truly strong encryption procedure is introduced, but which deals with the problems of WEP,
never the less. A requirement of this method was compatibility with existing WEP/RC4 hardware.

Encryption makes use of components familiar from WEP but benefits from decisive improvements with the "Michael
hash" from improved encryption and the TKIP method for calculation of the RC4 key. Furthermore, the internally
incremented IV transmitted in clear text in the packet is 48 bits long instead of 24--thus the problem with the
repeating IV value is practically excluded.

As a further detail, TKIP also mixes the MAC address of the sender into the calculation of the key. This ensures that
the use of identical IVs by different senders cannot lead to identical RC4 keys and thus again to attack possibilities.

The Michael hash does not, however, represent a particularly tough cryptographic hurdle: if the attacker can break
the TKIP key or get encrypted packets past the CRC check via modifications similar to those for WEP, then not many
barriers remain. For this reason, WPA defines countermeasures if a WLAN card detects more than two Michael errors
per minute: both the client and the access point break data transfer off for one minute, afterwards renegotiating
TKIP and Michael keys.

The key handshake

In the discussion of 802.1x it was already noted that EAP/802.1x provides a possibility to inform the client at the
outset of a session of the key valid for it. WPA now places that on a standardized basis, and considers the session-
key option offered by modern access points that, in addition to the four 'global’ keys, assigns each registered client
with a session key that is used exclusively with data packets to or from that client. The key handshake under WPA
involves first of all the exchange of the pairwise keys and then the group keys.

After a successful group key handshake, the access point can release the client for normal data transfer. The access
point is free to perform a rekeying again during the session using the same type of packets. In principle, the client
may also request rekeying from the access point.

WPA also takes the case of older WLAN hardware into account, in which the access point does not support pairwise
keys, but only group keys. The first phase of the handshake in this case proceeds exactly as before, but doesn't result
in the installation of a pairwise key—the group key handshake simply proceeds in clear text, but an encryption in
the EAP packets themselves prevents an attacker from simply reading the keys.

WPA with passphrase

The handshake described in the previous section runs strictly under WPA, i.e. the user will never have to define any
TKIP or Michael keys. In environments in which no RADIUS server is available to provide master secrets (for instance
in smaller companies or home networks), WPA therefore provides the PSK method besides authentication using a
RADIUS server; here, the user must enter a passphrase of 8 to 32 characters on the access point and on all stations,
from which the master secret is calculated along with the SSID used using a hash procedure. The master secret is
therefore constant in such a PSK network, although different TKIP keys still result.
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In a PSK network—similar to classical WEP—both access security and confidentiality depend on the passphrase not
being divulged to unauthorized people. As long as this is the case, WPA-PSK provides significantly improved security
against break-ins and eavesdropping over any WEP variant. For larger installations in which such a passphrase
would have to be made known to too large a user community for it to be kept secret, EAP/802.11i is used in
combination with the key handshake described here.

Negotiating the encryption method

Since the original WEP definition specified a fixed key length of 40 bits, the registration of a client at an access point
only had to communicate whether encryption should be used or not. Key lengths exceeding 40 bits require that the
key length is announced. WPA provides a mechanism with which client and access point can agree on the encryption
and authentication procedures to be used. The following information is made available:

> The encryption method to be used for broadcasts in this network (also the type of group key). Each client wanting
to register in a WPA-WLAN must support this procedure. Here, besides TKIP, WEP is also still allowed, in order
to support mixed WEP/WPA networks—in a pure WPA network, TKIP will be selected.

> A list of encryption methods which the access point provides for the pairwise key—here, WEP is explicitly
disallowed.

> Alist of authentication methods a client may use to show itself to the WLAN as authorized for access—possible
methods are currently EAP/802.1x or PSK.

As mentioned, the original WPA standard specifies only TKIP/Michael as an improved encryption method. With the
further development of the 802.11i standard, the AES/CCM method described below was added. In a WPA network
it is now possible for some clients to communicate with the access point using TKIP, while other clients use AES.

12.2.6 AES and 802.11i

In mid-2004 the IEEE approved the long-awaited 802.11i standard that places the entire security concept of WLAN
on a new basis. As mentioned in the last section, WPA has already implemented a whole series of concepts from
802.11i—so in this section we will only describe the components which are new compared to WPA.
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AES

The most obvious extension is the introduction of a new encryption process, namely AES-CCM. As the name already
hints, this encryption scheme is based on DES's successor AES, in contrast to WEP and TKIP, which are both based
on RC4. Since only the newest generation of WLAN chips contain AES hardware, 802.11i continues to define TKIP,
but with the opposite prerequisites: any 802.11i-compliant hardware must support AES, while TKIP is optional—in
WPA that was exactly the other way around.

The suffix CCM denotes the way in which AES is used in WLAN packets. The process is actually quite complicated,
for which reason CCM is only sensibly implemented in hardware—software-based implementations are possible,
but would result in significant speed penalties due to the processors commonly used in access points.

In contrast to TKIP, AES only requires a 128-bit key, with which both the encryption and protection against
undetected changes to packets is achieved. Furthermore, CCM is fully symmetric, i.e. the same key is used in both
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communications directions—a standards compliant TKIP implementation, on the other hand, requires the use of
different Michael keys in the send and receive directions, so that CCM is significantly simpler in use than TKIP.

Similar to TKIP, CCM uses a 48-bit Initial Vector in each packet—an IV repetition is impossible in practice. As in TKIP,
the receiver notes the last IV used and discards packets with an IV which is equal to or less than the comparison
value.

Pre-authentication and PMK caching

802.11i is intended to help with the use of WLAN for speech connections (VoIP) in enterprise networks. Especially
in connection with WLAN-based wireless telephony, quick roaming (switching from one access point to another
without lengthy interruptions) is of special significance. In telephone conversations, interruptions of 100
milliseconds are irritating, but the full authentication process over 802.1x, including the subsequent key negotiation
with the access point, can take significantly longer.

For this reason, the so-called PMK caching was introduced as a first measure. The PMK serves as the basis for key
negotiation in an 802.1x authentication between client and access point. In VolP environments it is possible that a
user moves back and forth among a relatively small number of access points. Thus it may happen that a client
switches back to an access point in which it was already registered earlier. In this case it wouldn't be sensible to
repeat the entire 802.1x authentication again. For this reason, the access point can provide the PMK with a code,
the so-called PMKID, which it transmits to the client. Upon a new registration, the client uses the PMKID to ask
whether this PMK is still stored. If yes, the 802.1x phase can be skipped and the connection is quickly restored. This
optimization is unnecessary if the PMK in a WLAN is calculated from a passphrase as this applies everywhere and is
known.

A second measure allows for some acceleration even in the case of first-time registration, but it requires a little care
on the part of the client. The client must already detect a degrading connection to the access point during operation
and select a new access point while it is still in communication with the old access point. In this case it has the
opportunity to perform the 802, 1x negotiation with the new access point over the old one, which again reduces the
"dead time" by the time required for the 802.1x negotiation.

12.2.7 Summary

After the security loopholes in WEP encryption became public knowledge, the presentation of short-term solutions
such as WEPplus and the intermediate steps like WPA, the IEEE committee has now presented the new WLAN
security standard 802.11i. The TKIP procedure used by WPA is based on the older RC4 algorithm, the foundation of
WEP. AES is the first important and conclusive step towards a truly secure encryption system. 802.11i/AES have
confined the practical and theoretical security loopholes in previous methods to history.

The AES procedure provides security on a level that satisfies the Federal Information Standards (FIPS) 140-2
specifications that are required by many public authorities.

LANCOM Systems equips its 54Mbps products with the Atheros chip set featuring a hardware AES accelerator. This
guarantees the highest possible level of encryption without performance loss.
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The user-friendly pre-shared key procedure (entry of a passphrase of 8-63 characters in length) makes 802.11i quick
and easy for anybody to set up. Professional infrastructures with a larger number of users can make use of 802.1x
and RADIUS servers.

In combination with further options such as Multi-SSID and VLAN tagging, it is possible to provide highly secure
networks for multiple user groups and with different levels of security.

> VLAN tagging is available as of LCOS version 3.32.

> Multi-SSID is available as of LCOS 3.42.

» LANCOM Systems provides the PSK procedure as of the LCOS version 3.50.

> 802.1x will be supported as of LCOS version 3.52.

12.3 Protecting the wireless network

A wireless LAN does not, like conventional LAN, use cable as the transmitting medium for data transfer, but the air
instead. As this medium is openly available to any eavesdropper, the screening of the data in a WLAN is an important
topic.

Depending on how critical WLAN security is for your data, you can take the following steps to protect your wireless
network:

(D Activate the "Closed network function”. This excludes all WLAN clients using "Any" as the SSID, and those that
do not know your network SSID. ('Network settings" —page 254)

(2 Do not use your access point's default SSID. Only take a name for your SSID that cannot be guessed easily. The
name of your company, for example, is not a particularly secure SSID. ('Network settings’ —page 254)

(3 If you know exactly which wireless network cards are permitted to access your WLAN, you can enter the MAC
addresses of these cards into the access control list, thus excluding all other cards from communications with
the access point. This reduces access to the WLAN only to those clients with listed MAC addresses. ('Access Con-
trol List" —page 239)

(#) Use encryption on the data transferred in the WLAN. Activate the strongest possible encryption available to you
((802.11i with AES, WPA or WEP) and enter the appropriate keys or passphrases into the access point and the
WLAN clients (‘Encryption settings’ —page 242 and "WEP group keys' —page 245).
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(5 Regularly change the WEP key. Also change the standard key ('Encryption settings’ —page 242) in the configu-
ration. Alternatively, you can use a cron job to automatically change the key every day, for example ('Zeitauto-
matik fiir LCOS-Befehle’ —page 46). The passphrases for 802.11i or WPA do not have to be changed regularly
as new keys are generated for each connection anyway. This is not the only reason that the encryption with
802.11i/AES or WPA/TKIP is so much more secure that the now aged WEP method.

(& Ifthe data is of a high security nature, you can further improve the WEP encryption by additionally authenticating
the client with the 802.1x method ('IEEE 802.1x/EAP" —page 257) or activate an additional encryption of the
WLAN connection as used for VPN tunnels ('IPSec over WLAN" —page 258). In special cases, a combination of
these two mechanisms is possible.
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(t_‘\‘ Further information is available from our web site www.lancom-systems.com under Support » FAQ.

12.4 Configuration of WLAN parameters

Changes to the wireless network settings can be made at various points in the configuration:

>

Some parameters concern the physical WLAN interface. Some LANCOM models have one WLAN interface, others
have the option of using a second WLAN card as well. The settings for the physical WLAN interface apply to all
of the logical wireless networks supported by this card. These parameters include, for example, the transmitting
power of the antenna and the operating mode of the WLAN card (access point or client).

Other parameters are related solely to the logical wireless network that is supported by a physical interface.
These include, for example, the SSID or the activation of encryption, either 802.11i with AES or WPA with TKIP
or WEP.

A third group of parameters affect the wireless network operation, but are not significant only to WLANs. These
include, for example, the protocol filter in the LAN bridge.

12.4.1 WLAN security

In this part of the configuration, you can place limitations on the communications available to the users in the wire-
less network. This is done by limiting the data transfer between user groups according to individual stations or the
protocol being used. Further, the key for the WLAN encryption is set here.

General settings

Depending on the application, it may be required that the WLAN clients connected to an access point can—or
expressly cannot—communicate with other clients. You can centrally define the permissible communication for all
physical and logical networks, and consider the three following cases in doing so:

>

>

>

Allow data traffic: This setting allows all WLAN clients to communicate with other stations in their own and in
other available wireless networks.

Do not allow data traffic between stations that are logged on to this access point: In this case, WLAN clients can
only communicate with mobile stations located in other available wireless networks, but not with the stations in
their own WLAN.

Do not allow data traffic: This last variant prevents all communications between the WLAN clients.

In addition to controlling the communication between the clients, you can define whether the mobile stations in the
wireless network can change to a neighbouring access point (roaming).

In particular for public WLAN access points (public spots), the charging of usage fees requires the recognition of sta-
tions that are no longer active. Monitoring involves the access point regularly sending packets to logged-in stations.
If the stations do not answer these packets, then the charging systems recognises the station as no longer active.
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For configuration with LANconfig you will find the general WLAN access settings under the configuration area
"WLAN Security' on the 'General' tab.

<2 YPN_NHAMEL Configuration i 2]

Configure:

General | Stations | Pratocols | WEP | IEEE 8021

— General setting:
D ata traffic: between the individual stations:

& Allow data traffic between the individual stations

7 Do not allow data braffic between those stations that are
azzociated to thiz access point

" Do not allow data braffic between the individual stations

[~ Moritar stations to recogrize inactive ones

IV Muhile stations can roam between the access points in the
local network,

Under WEBconfig or Telnet you will find the general WLAN access settings under the following paths:

WEBconfig Expert configuration B> Setup » WLAN module P Inter-stations
traffic, monitor stations or IAAP protocol (for roaming)

Terminal/Telnet cd /Setup/WLAN module/Inter-station traffic,
Monitor stations or IAAP protocol (for roaming)
Access Control List

With the Access Control List (ACL) you can permit or prevent the access to your wireless LAN by individual clients.
The decision is based on the MAC address that is permanently programmed into wireless LAN adapters.

For configuration with LANconfig you will find the general WLAN access settings under the configuration area
"WLAN Security' on the 'Stations' tab.

Check that the setting ‘filter out data from the listed stations, transfer all other" is activated. New stations that are
to participate in your wireless network are added with the button 'Stations'.
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<2 YPN_NHAMEL Configuration 21x|
Configure: |W'LAN Security 'l

General Stations | Pratocols | WEP | IEEE 8021

i~ Filter station:

[rata traffic between the wireless LAN and vour local network,
can be restricted as required by excluding individual stations, or
only enabling specified stations.

Filter function:

7 filber out data from the listed stations, transfer all other

% ransher data from the listed stations, autherticate all other
ivia RADIUS o filker them out

Stations .. |

|—Authenticat|'0n via RADIUS |

Under WEBconfig or Telnet you will find the Access Control List under the following paths:

WEBconfig Expert configuration P> Setup P WLAN module P> Access list

Terminal/Telnet cd /Setup/WLAN-Module/Access-List

Protocol filter

With the protocol filter you can influence the handling of certain protocols during transfer from the WLAN to the
LAN.

ﬂ Packets from the WLAN for certain protocols/ports can be redirected to special IP addresses in the LAN by
= the protocol filter. This function known as "Redirect” is described in detail in the section ‘Redirect function’
—page 256.

For configuration with LANconfig you will find the protocol filter under the configuration area "WLAN Security' on
the *Protocols’ tab.
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<2 YPN_NHAMEL Configuration 21x|
Configure: |W'LAN Security 'l

General | Stations  Protocols | weP | IEEE 8021

Filter protocal

The pratocol filkers can be uzed to control the transfer, drop or
redirect of specific protocols between LAN, wireless LAM and
Paint-to-Pairt links.

| Pratocols ... |
| 1
RECEOEDE Protocols - New Entry i 2l x|
tame | Protocol [ subtype [ First port [ Last port [ Interface st [ & . [ x|
FTE. ooon,.. 6 & & Wanie. . bt
Pratocal; 0800 concel |
Subbype: B3
First port: a0
Last port; a0
Edit | Intefacelist wilan-1-2
Action:
' Drop packsts
" Pass packets
™ Redirect packets to the Following 1P address

Make an entry in the protocol list for each protocol that requires special handling. Enter the following values:
> Aname of your choice for the filter entry
» Protocol number, e.g. '0800' for IP. If no protocol is entered, the filter will be applied to all packets.

> Subprotocol, e.g. '6" for TCP. If no subprotocol is entered, the filter will be applied to all packets of the entered
protocol.

> Port start and port end, e.g. each ‘80" for HTTP. If no ports are entered, then this filter will be applied to all ports
of the appropriate protocol/subprotocol.
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(\ Lists of the official protocol and port numbers are available in the Internet under www.iana.org.

> Action for the data packets:
> Let through
> Reject
I> Redirect (and state the target address)
> List of interfaces that the filters apply to
> Redirect address when the 'Redirect’ action is selected
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Example:

ARP 0806 0 0 0 WLAN-1-2 Let through | 0.0.0.0
DHCP | 0800 17 67 68 WLAN-1-2 Let through | 0.0.0.0
TELNET | 0800 6 23 23 WLAN-1-2 Redirect 192.168.11.5
ICMP | 0800 1 0 0 WLAN-1-2 Let through | 0.0.0.0

HTTP | 0800 6 80 80 WLAN-1-2 Redirect 192.168.11.5

ARP, DHCP, ICMP will be let through, Telnet and HTTP will be redirected to 192.168.11.5, all other packets will be
rejected.

As soon as an entry is made in the protocol filter, all packets not matching the filter will be automatically
rejected!

Under WEBconfig or Telnet you will find the protocol filter under the following paths:

WEBconfig Expert configuration P> Setup » LAN management module b
Protocol table

Terminal/Telnet cd /Setup/LAN-Management-Module/Protocol-Table

Encryption settings

Access points of the LANCOM range support the most up-to-date methods of encryption and security for data that
is transferred via WLAN.

> The IEEE standard 802.11i/WPA stands for the highest degree of security that is currently available for WLAN
connections. This standards uses a new encryption procedure (AES-CCM) which, in combination with other
methods, achieves levels of security equalled only by VPN connections until now. When using AES-capable hard-
ware (such as the 54-Mbit AirLancer clients and the 54-Mbit LANCOM access points) the transmissions are much
faster than with comparable VPN security.

> WEP is also supported to ensure compatibility with older hardware. WEP (Wired Equivalent Privacy) is the
encryption method originally incorporated in the 802.11 standard for the encryption of data in wireless trans-
mission. This method uses keys of 40 (WEP64), 104 (WEP128) or 128 bits (WEP152) in length. A number of secu-
rity loopholes in WEP have come to light over time, and so the latest 802.11i/WPA methods should be used
wherever possible.
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1‘ Further information about the 802.11i and WPA standards are available under 'Development of WLAN secu-
rity" —page 228.

The tab '802.11i/WEP" in the configuration area "WLAN Security' is used for setting the encryption parameters for
each logical WLAN. Open the list with the button for WPA or Private WEP settings.

First of all, select the type of encryption for the individual logical WLAN interfaces:

> Yes—Access only for stations with encryption (recommended): In this mode, only the WLAN clients with activa-
ted WEP and the correct key can register with the access point.

> Yes—Access also for stations without encryption allowed: In this mode, WLAN clients with activated WEP and
AirLancer MC 11 clients (without WEP) can register with this access point.

» No—No encryption

Set the encryption method to be used here.

» 802.11i (WPA)-PSK — Encryption according to the 802.11i standard offers the highest security. The 128-bit AES
encryption used here offers security equivalent to that of a VPN connection.

> WEP 152, WEP 128, WEP 64 — encryption according to the WEP standard with key lengths of 128, 104 or 40
bits respectively. This setting is only to be recommended when the hardware used by the WLAN client does not
support the modern method.

» WEP 152-802.1x, WEP 128-802.1x, WEP 64-802.1x — encryption according to the WEP standard with key
lengths of 128, 104 or 40 bits respectively, and with additional authentication via 802.1x/EAP. This setting is also
only to be recommended when the hardware used by the WLAN client does not support the 802.11i standard.

The 802.1x/EAP authentication offers a higher level of security than WEP encryption alone, although the neces-
sity for a RADIUS server makes very high demands of the IT infrastructure.

In line with the encryption method activated, you can enter a special WEP key for the respective logical WLAN inter-
face or a passphrase when using WPA-PSK:

> The passphrase, or the 'password' for the WPA-PSK method, is entered as a string of at least 8 and up to 63
ASCII characters.

(‘ Please be aware that the security of this encryption method depends on the confidential treatment of this
passphrase. Passphrases should not be made public to larger circles of users.

> The WEP key 1, that applies only to its respective logical WLAN interface, can be entered in different ways depen-
ding on the key length. Rules of the entry of the keys can be found in the description of the WEP group key 'Rules
for entering WEP keys' —page 246.

If '802.11i (WPA)-PSK" has been entered as the encryption method, the procedure for generating a session or group
key can be selected here:

» AES — the AES method will be used.
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» TKIP — the TKIP method will be used.

> AES/TKIP — the AES method will be used. If the client hardware does not support the AES method, TKIP will be
used.

If the encryption method was set as WEP encryption, two different methods for the authentication of the WLAN client

are available:

> The 'Open system' method does not use any authentication. The data packets must be properly encrypted from
the start to be accepted by the access point.

> With the 'Shared key' method, the first data packet is transmitted unencrypted and must be sent back by the
client correctly encrypted. This method presents potential attackers with at least one data packet that is unen-
crypted.

If WEP encryption is selected, the access point can select from four different WEP keys for each logical WLAN inter-
face:

> Three WEP keys for the physical interface

» An additional WEP key particular to each logical WLAN interface

The private WEP settings are used to set the additional key for each logical WLAN interface (see ‘Key 1/passphrase’).
You should also select which of the four keys is currently to be used for the encryption of the data (default key). This
setting can be used to change the key frequently, so increasing security.

Rules of the entry of the keys can be found in the description of the WEP group key ‘Rules for entering WEP keys'
—page 246.

For configuration with LANconfig you will find the private WEP settings under the configuration area "WLAN Security'
on the '802.11i/WEP" tab.
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Configure: IW’LAN Security "l
Generall Stationsl Protocols  802.111AWEP | IEEE 802.1><|

802171 (WPAAES) / wired Equivalent Privacy

@ “r'ou should gelect 802,111 Enhanced Security with
Advanced Encryption Standard [wWRAMES] or at least
‘whred Equivalent Privacy PEP), so that all information
will be tranzmitted encrypted.

Thiz iz where you can make encryption settings for each [P ar Private WEP settings - it Entry
: ; WPA or Private WEP settings - Edit Entry 7%
wireless LAN network [MuliSSI10). A
—  Interface: WLAN-L Wireless
Select 802 11i Enhanced Security with Advanced —
: : Encryption Standard (WPAJAES) or Standard Wired =
WPA or Private WEP settings e 2l x|
Erervoton Bt ated " Yes - Access only for stations with encryption
(recommended)
Yes and required a0 ™ Yes - Access alsa for stations without encryption Cancel

WLAN-1-3: Wireless Metwork 3 Ves and required 802,111 (WPA)-PSK allowed

WLAN-1-4: Wireless Network ¢ Ves and required  B02.11i (WPA}PSK | (= Hio < Hid Shervphion:

WLAN-1-5: Wireless Network 5 Ves and required 802111 (WPA)-PSK ;

WLAN-1-6: Wireless Network 6 Ves andrequired  WEP128 (104 bit)  Method { Key 1 length:  |wEPe4 (40 bit) -

WLAN-L1-7: Wireless Network 7 o WEPE4 (40 bit) 4|
Key 1jpassphrase: 0x0000000000
WP Session Key Type:  [11e 7 J

A
Authentication: Open system (recomme >
Default key: -
LANCOM ok | AT o 1
Systens

Configuration  Under WEBconfig or Telnet you will find the individual key settings for logical WLAN networks under the following

with paths:
WEBconfig or

Telnet

WEBconfig Expert configuration P> Setup P> Interfaces P> WLAN-Inter-
facesP Encryption-Settings

Terminal/Telnet cd /Setup/Interfaces/WLAN-Interfaces/
Encryption-Settings
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WEP group keys
Wired Equivalent Privacy (WEP) is an effective method for the encryption of data for wireless transmission. The WEP
method uses keys of 40 (WEP64), 104 (WEP128) or 128 bits (WEP152) in length. Each WLAN interface has four WEP

keys: a special key for each logical WLAN interface and three common group WEP keys for each physical WLAN inter-
face.

@ If 802.1x/EAP is in use and the ‘dynamic key generation and transmission' is activated, the group keys from
" 802.1x/EAP will be used and are consequently no longer available for WEP encryption.

Rules of the entry of the keys can be found in the description of the WEP group key ‘Rules for entering WEP keys'
—page 246.
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Configuration  The tab '802.11i/WEP" in the configuration area "WLAN Security" is used for setting the three WEP keys 2 to 4. Open

with . the list with the button for WEP Group Keys. These WEP keys apply to the physical WLAN interface and thus globally
LANconfig to all of the associated logical WLAN interfaces.
<= ¥PN_NHAMEL Configuration kT b

Configure: IW’LAN Security > l

Generall Stationsl Frotocol; WEP |IEEE 802.1><|

—wired Equivalent Privacy |

@ *'ou should activate 'Wired Equivalent Privacy (v Eld Group Keys - Wireless LAN 2=l
enciypt all data transmizssions in your wireless LAl
Key 2 length:
This iz where you can make WEP settings for each log S
wireless LAN network [MuliSS10). Key 2: I 00000000000
Cancel |
Private WEP seftings  Key 3 length: |4D bit (WEPE4) j

This is where pou car specify for sach physical wisle: ey 3 I 00000000000
interface those WEP group keps 2 to 4, that are used -
the lngical wirsless LAN networks in comman, Key 4 length: |4U bit (WEPE4) 'l

I WEF Group Keys Key 4: I 00000000000

BRI

Configuration  Under WEBconfig or Telnet you will find the group keys for the physical WLAN interface under the following paths:
with
WEBconfig or
Telnet

WEBconfig Expert configuration P> Setup P> Interfaces P> WLAN-Inter-
facesP Group-Keys

Terminal/Telnet cd /Setup/Interfaces/WLAN-Interfaces/

Group-Keys
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Rules for entering WEP keys

WEP keys can be entered as ASCII characters or in hexadecimal form. The hexadecimal form begins with the charac-
ters '0x'. The keys have a length depending on the WEP method:

WEP 64 5 characters 10 characters

Example: 'aR45Z' Example: '0x0A5C1B6DSE'
WEP 128 13 characters 26 characters
WEP 152 16 characters 32 characters
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The ASCII character set includes the characters '0' t0'9", 'a' to 'z', A" to 'Z" and the following special characters:
P"#S%& 0*+,-/ ;<=>2@[\]A_"{|}~

The HEX form uses the numbers "0 to ‘9" and the letters ‘A" to 'F' to display each character as a character pair, which
is why twice the number of characters is required to display a HEX key.

Select the length and the format (ASCII or HEX) of the key depending on the best option available in the wireless
network cards that register with your WLAN. If the encryption in an access point is set to WEP 152, some clients may
not be able to log into the WLAN as their hardware does not support the key length.

12.4.2 General WLAN settings

Regulations for the operation of WLAN cards differ from country to country. The use of some radio channels is pro-
hibited in certain countries. To limit the operation of the LANCOM access points to the parameters that are allowed
in various countries, all physical WLAN interfaces can be set up for the country where they are operated.

For the configuration with LANconfig, the country settings can be found in the configuration area ‘Management' on
the tab 'Wireless LAN" in the group 'General":

<2 YPN_NHAMEL Configuration 1 21x|
Configure: | M anagement x l

Generall Interfaces  Wireless LAN |Security| Costs I WLAN I

Q |
General

Thiz iz where you can make settings for all wirsless LAN
interface in comman.

Country: | Germany x l

¥ ARP handing rang 2
™ Broken link detection EIEECE .
Lt

This group includes two other parameters in addition to the country setting:

> Mobile stations in the wireless network that are on standby do not answer the ARP requests from other network
stations reliably. If 'ARP handling' is activated, the access point takes over this task and answers the ARP
requests on behalf of stations that are on standby.

» The 'Broken link detection' deactivates the WLAN card if the access point loses contact to the LAN.

Under WEBconfig or Telnet you will find the general WLAN parameters under the following paths:

WEBconfig Expert-Configuration P Setup » WLAN-Module

Terminal/Telnet ‘ cd /Setup/WLAN
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12.4.3 WLAN routing (isolated mode)

When set by default the data between LAN and WLAN is transmitted transparently. Thereby the data transmission
between cabled and radio network does not pass over the IP Router. This means, that the features firewall and Qua-
lity of Service integrated in the IP router are not provided for transfering data between WLAN and LAN. To use these
options nevertheless, the WLAN interface can be set to “isolated mode”, so the data is transfered deliberatly over
the IP router.

ﬁ‘ So the IP router can transfer data between LAN and WLAN correctly, both areas must have different IP
~ address sections and the local routing must be activated in the IP router settings.

Configuration  When configuring with LANconfig you can find the WLAN routing in the configuration area ‘Management' on the

with tab 'Interfaces' in the section 'Network adapter":
LANconfig

<2 ¥PN_NHAMEL Konfiguration 2

Konfiguriere: | M anagement T l

Allgemein  Interfaces |W’ire|ess LAM I Securityl Kostenl WLAN I

i~ Metzwerkanschiu
Physikalizche Adresze;  0DADSFOFBSBF

Hier konnen Sie fur jedes LAN-Interface lhres Gerats weitere
Einstellungen vormehmen.

LA Forts =

‘Whlen Sie die Art der Verbindung zwizchen dem LAM- und
dem Wirsless-LAN-| nterface:

' Verhindung Liber eine Bridge herstellen [Standard)
" Werbindung iiber den Router herstellen (lzolisrter Modus)

Configuration  Under WEBconfig or Telnet you can find the WLAN routing as follows:
with

WEBconfig or
Telnet
WEBconfig Expert Configuration P> Setup P> LAN-module P> Isolated Mode

Terminal/Telnet ‘ cd /Setup/LAN-module/Isolated Mode
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12.4.4The physical WLAN interfaces

Setting up the WLAN card

Apart from the parameters common to all WLAN cards, there is a series of settings to be made that are particular to
each WLAN card of the access point.
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Configuration  For configuration with LANconfig you will find the settings for the WLAN card under the configuration area
with " ‘Management' on the 'Wireless LAN' tab. Open the list of physical WLAN interfaces by clicking on the button Phy-
LANconfig sical WLAN settings.

<5 YPN_NHAMEL Configuration 20 x|
Configue: | Management =

General | Intertaces Wieless LAN | Secury | Costs | vLAN |

This is where you can make settings for all wirgless LAN
intertace in common

Country: Germany =

IV ARP handing
I™ Broken link detection

rInterfac

This s where you can make futher settings for your physical
wircless LAN interface,

Physical WLAN sattings =

> WLAN interface (On)

This is where you can make >
wircless LAN netwark (MuliSSID).

Logical WLAN seftings

WLAN card operation
Operation LANCOM Wireless devices can be operated in two basic operation modes:

d o . .
moce > Asan access point, it forms the link between the WLAN clients and the cabled LAN.

» In Client mode the device seeks another access point and attempts to register with a wireless network. In this
case the device serves to link a cabled network device to another access point over a wireless connection.

Select the operation mode from the tab 'Operation'. If the WLAN interface is not required, it can be completely deac-
tivated.

Physical WLAN settings - WLAN interface 2=l

Operatian | Radio I Super &/G I Point-to-PointI Client model
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¥ WLAN interface enabled

WLAN operation mode: IAccess Paint 'l

: ik
Station [Client mode k‘

Configuration ~ Under WEBconfig or Telnet you can set the operation mode for the physical WLAN interface under the following

with paths:
WEBconfig or

Telnet

WEBconfig Expert configuration P> Setup P> Interfaces B> WLAN-Inter-
facesP> Operation-Settings

Terminal/Telnet cd /Setup/Interfaces/WLAN-Interfaces/
Operation-Settings
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Frequency
band, Sub-
band

Channel num-

ber

Compatibility
mode

Turbo mode
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Radio settings

When selecting the frequency band on the ‘Radio’ tab under the physical interface settings, you decide whether the
WLAN card operates in the 2.4 GHz or in the 5 GHz band (also see 'Standardized radio transmission by IEEE’
—page 220), and thus the available radio channels.

In the 5 GHz band, a subband can also be selected which is linked to certain radio channels and maximum trans-
mission powers.

In some countries, the use of the DFS method for automatic channel selection is a legal requirement. Selec-
ting the subband also defines the radio channels that can be used for the automatic channel selection.

The radio channel selects a portion of the conceivable frequency band for data transfer.

(‘i In the 2.4-GHz band, two separate wireless networks must be at least three channels apart to avoid inter-
ference.

Two different wireless standards are based on the 2.4-GHz band: the IEEE 802.11b standard with a transfer rate of
up to 11 Mbps and the IEEE 802.11g standard with up to 54 Mbps. When 2.4 GHz is selected as the frequency band,
the data transfer speed can be set as well.

(‘\ Please observe that clients supporting only the slower standards may not be able to register with the WLAN
if the speeds set here are higher.

The 802.11g/b compatibility mode offers the highest possible speeds and yet also offers the 802.11b standard so
that slower clients are not excluded. In this mode, the WLAN card in the access point principally works with the faster
standard and falls back on the slower mode should a client of this type log into the WLAN. In the ‘2Mbit compatible'
mode, the access point supports older 802.11b cards with a maximum transmission speed of 2 Mbps.

Using two neighbouring, vacant channels for wireless transmissions can increase the transfer speeds up to 108
Mbps. Set this option for the 2.4-GHz band by selecting the drop down list ‘2.4 GHz mode", for the 5-GHz band in
the appropriate list '5 GHz mode' below.

Physical WLAN settings - WLAN interface 21 x|

Operation  Radio |Super A.-"GI Point-to-PointI Client model

Frequency band: W
Subbands: lﬁ
Chanriel nurnber: IW
2.4 GHz mode; m
5 GHz mode: W

hormal mode
108kMBit!s turbo mode
& Only transmit on primary antenha

Select the desired diversity
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Antenna gain
Transmission
power reduc-
tion

Access point
density

Maximum dis-

tance

Configuration
with
WEBCconfig or
Telnet

> Configuration of WLAN parameters

Where the transmission power of an antennae exceeds the levels permitted in the country of operation, the power
must be attenuated accordingly.

> The field 'Antenna gain' is for the gain of the antenna minus the actual cable loss. For an AirLancer Extender O-
18a antenna with a gain of 18dBi and a 4m cable with a loss of 1dB/m, the 'Antenna gain' would be entered as
18 - 4 =14. This value for true antenna gain is dynamically used to calculate and emit the maximum permissible
power with regards to other parameters such as country, data rate and frequency band.

> In contrast to this, the entry in the field ‘Tx power reduction’ causes a static reduction in the power by the value
entered, and ignores the other parameters. Also see "Establishing outdoor wireless networks” —page 258.

Antenna gain: |3 dBi
T power reduction: IU dB

. The transmission power reduction simply reduces the emitted power. The reception sensitivity (reception
antenna gain) remains unaffected. This option is useful, for example, where large distances have to be
bridged by radio when using shorter cables. The reception antenna gain can be increased without exceeding
the legal limits on transmission power. This leads to an improvement in the maximum possible range and,
in particular, the highest possible data transfer rates.

The more access points there are in a given area, the more the reception areas of the antennae intersect. The setting
‘Access point density' can be used to reduce the reception sensitivity of the antenna.

T power reduction: IU dB

Access point density: Low -

Large distances between transmitter and receiver give rise to increasing delays for the data packets. If a certain limit
is exceeded, the responses to transmitted packets no longer arrive within an acceptable time limit. The entry for
maximum distance increases the wait time for the responses. This distance is converted into a delay which is accep-
table for wireless communications.

Under WEBconfig or Telnet you will find the radio parameters under the following paths:

WEBconfig Expert configuration P> Setup P> Interfaces P> WLAN-Inter-
facesP> Radio-Settings

Terminal/Telnet cd /Setup/Interfaces/WLAN-Interfaces/
Radio settings
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Configuration
with
WEBconfig or
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Point-to- point connections

Access points are not limited to communications with mobile clients; they can also transfer data from one access
point to another. On the 'Point-to-Point' tab for the physical interface settings, you can allow the additional
exchange of data with other access points. You can select from:

Physical WLAN settings - WLAN interface

21|

Dperationl Radio I Super 4/G  Point-to-Point | Clignt model

Paint-to-Paint operation mode;

" 0ff - This access paint cah only communicate with mobile
stations.

' [On - This access point can alzo communicate with other
access points to connect several local wireless networks.

" Exclusiv - Thiz access point can only communicate with other
access points; mobile stations can not connect to this access
paint [pure 'WLAMN bridge].

[™ Do not forward among P2P links on the same interface

Channel 5election Scheme [JERE

Access point 1: IDDDDDDDDDDDD

drrace noink |nnnnnnnnnnnn
> Point-to-point 'Off': The access point only communicates with mobile clients

> Point-to-point 'On": The access point can communicate with other access points and with mobile clients
> Point-to-point 'Exclusive’: The access point only communicates with other access points
The input fields are for the MAC addresses of the WLAN cards for the point-to-point connections (up to 7).

i’j Please observe that only the MAC addresses of the WLAN cards at the other end of the connections are to
be entered here! Not the access point's own MAC address, and not the MAC addresses from any other inter-
faces that may be present in the access points.

Under WEBconfig or Telnet you can set the settings for the point-to-point connections under the following paths:

WEBconfig Expert configuration P> Setup P> Interfaces B> WLAN-Inter-
facesP> Interpoint-Settings

Terminal/Telnet cd /Setup/Interfaces/WLAN-Interfaces/
Interpoint-Settings
Client mode

If the LANCOM Wireless device is operating as a client, the tab 'Client mode' can be used for further settings that
affect the behaviour as a client.
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Network types

Create IBBS

Keep client
connection
alive

Scan bands

Configuration
with
WEBCconfig or
Telnet

Configuration
with
LANconfig

> Configuration of WLAN parameters

Physical WLAN settings - WLAN interface

Dperationl Fadio I Super 4G | Pointto-Point  Client mode |

Metwork types: Infrazstucture
[ Create IBSS

IV Keep client connection alive

Scan bands |2.4 GHz only 'l

‘Network types' controls whether the station can register only with infrastructure networks, or also with adhoc net-
works. Further information about these network types can be found under ‘The ad-hoc mode” —page 223 and ‘The
infrastructure network” —page 223.

If the station can establish an IBBS (Independent Basic Service Set), meaning an adhoc network, then the station can
connect to other WLAN clients. For the connection of devices with a client station, this is mostly unwanted or not
required.

This option ensures that the client station keeps the connection to the access point alive even when the connected
devices do not send any data packets. If this option is switched off, the client station will automatically log off from
the wireless network if no packets are transferred over the WLAN connection within a given time.

This defines whether the client station scans just the 2.4 GHz, just the 5 GHz, or all of the available bands for access
points.

Under WEBconfig or Telnet you will find the settings for the client mode under the following paths:

WEBconfig Expert configuration P> Setup P> Interfaces P> WLAN-InterfacesP> Client-Settings

Terminal/Telnet cd /Setup/Interfaces/WLAN-Interfaces/
Client-Settings

12.4.5The logical WLAN interfaces

Every physical WLAN interface can support up to eight different logical wireless networks (Multi-SSID). Parameters
can be defined specifically for each of these networks, without the need of additional access points.

For configuration with LANconfig you will find the settings for the logical WLAN interface under the configuration
area ‘Management' on the 'Wireless LAN' tab. Open the list of logical WLAN interfaces by clicking on the button
Logical WLAN settings and select the required logical interface.
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&= ¥PN_NHAMEL Configuration i 2
Corfigure; Management =

General | Interfaces Wirsless LAN | Secuity | Costs | WLAN |

This is where you can make ssttings for all wirsless LAN
interface in commen.

Country: Germany E

¥ ARP handing
I~ Broken link detection

This is where you can make further settings for pour physical

wireless LAN interface:
Physical WLAN settings

This is where yau can make futher seftings for each logical
wireless LAN retwark (MuliSSID)

Logical WLAN seftings

33} WLAN network 1 (On)

3 WLAN network 3 (OFF) k

Network settings

tion. In this operation mode, mobile stations that do not know the network name (SSID) are excluded from taking
part in the wireless LAN.

Activate the closed network mode if you wish to prevent WLAN clients using the SSID ‘ANY* from registering with
your network.

Set the SSID Define an unambiguous SSID (network name) for each of the logical wireless networks on the 'Network' tab for the
logical interfaces. Only network cards that have the same SSID can register with this wireless network.
Hetwark | Transmissionl

2 ¥ WLAN network enabled
S‘ Metwark name [S510]: IW’LAN_EIDMF'ANY
§ ¥ This radio netwark carnot be accessed with the network name

| UANY" [clozed network)
= - , I . . . . .
< Closed net- You can operate your wireless LAN either in public or private mode. A wireless LAN in public mode can be contacted
2 work mode by any mobile station in the area. Your wireless LAN is put into private mode by activating the closed network func-
S

Switch logical The switch "WLAN network enabled' enables the logical WLAN to be switched on or off separately.
WLAN on and

off
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transmit rate

Broadcast rate

RTS threshold

> Configuration of WLAN parameters

Under WEBconfig or Telnet you can set the network settings for the logical WLAN interface under the following
paths:

WEBconfig Expert configuration P> Setup P> Interfaces »> WLAN-Interfaces® Network-Settings

Terminal/Telnet cd /Setup/Interfaces/WLAN-Interfaces/
Network settings
Transmission settings

Details for the data transfer over the logical interface are set on the ‘Transmission" tab.

Logical WLAN settings - WLAN network 1 2=l

MNetwark  Transmission |

Packet size: 1,550 byte
Minimum transmit rate: IAuto 'l
I awimurn transmit rate: IAuto Bt l

Broadcast rate: |2 megabit 'l
RTS threshold: |2.34? byte

™ Use long preamble for 802,110

Ok | Abbrechen |

Smaller data packets cause fewer transmission errors than larger packets, although the proportion of header infor-
mation in the traffic increases, leading to a drop in the effective network load. Increase the factory value only if your
wireless network is largely free from interference and very few transmission errors occur. Reduce the value to reduce
the occurrence of transmission errors.

The access point normally negotiates the data transmission speeds with the connected WLAN clients continuously
and dynamically. In doing this, the access point adjusts the transmission speeds to the reception conditions. As an
alternative, you can set fixed values for the minimum and maximum transmission speeds if you wish to prevent the
dynamic speed adjustment.

The defined broadcast rate should allow the slowest clients to connect to the WLAN even under poor reception con-
ditions. A higher value should only be set here if all clients are able to connect "faster”.

The RTS threshold prevents the occurrence of the "hidden station” phenomenon.
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Longpreamble
for 802.11b

256

Network coverage access point ) Network coverage access point €)

(1] (2]

Here, the three access points @), @, and @) are positioned such that no direct wireless connection between the two
outer devices is possible. If @ sends a packet to @, @ is not aware of this as it is outside of @'s coverage area.
© may also try, during the transmission from @, to send a packet to @ as well, because @) has no knowledge of
the medium (in this case the wireless connection) being blocked. A collision results and neither of the transmissions
from @ nor @ to @ will be successful. The RTS/CTS protocol is used to prevent collisions.

CTS signal from @), can also be

RTS signal from @) to @) received by @
wﬂp RE=S====== -ﬂ? 3 “’P »
(1) (2 (3

To this end, @ precedes the actual transmission by sending an RTS packet to @, that @ answers with a CTS. The
(TS sent by @ is now within "listening distance" of @), so that @ can wait with its packet for @. The RTS and CTS
signals each contain information about the time required for the transmission that follows.

A collision between the very short RTS packets is improbable, although the use of RTS/CTS leads to an increase in
overhead. The use of this procedure is only worthwhile where long data packets are being used and the risk of col-
lision is higher. The RTS threshold is used to define the minimum packet length for the use of RTS/CTS. The best value
can be found using trial and error tests on location.

Normally, the clients in 802.11b mode negotiate the length of the preamble with the access point. "Long preamble”
should only be set when the clients require this setting to be fixed.

12.4.6 Additional WLAN functions

Apart from the different encryption methods 802.11i/AES, WPA/TKIP or WEP and the closed network, a variety of
other functions exist for securing the operation of a wireless network. The Redirect function provides the convenient
control over the connection of WLAN clients in changing environments. As this function has significance to other
modules of the LANCOM LCOS, the configuration parameters are to be found outside of the WLAN settings.

Redirect function

Clients within wireless networks often have one main aspect in common: a high degree of mobility. The clients are
thus not always connected to the same access point, but frequently change between access points and the related
LANS.
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The redirect function assist the applications being used by the WLAN clients to find the correct target computer in
the LAN automatically. If a WLAN client's HTTP request from a certain logical wireless network should always be
directed to a certain server in the LAN, then a filter setting for the appropriate protocol with the action "redirect”
will be set up for the desired logical WLAN interface.

lﬁ) .
Logical wireless network =
9 - S

= on interface WLAN-1-2 -
7 HTTP request to

' 192.168.2.25

ﬁ FW
L e e =
(rﬁ

Redirect: HTTP from
WLAN 1-2 to 10.0.0.99

All requests with this protocol from this logical wireless network will automatically be redirected to the target server
in the LAN. The returning data packets are sent to the senders' addresses and ports according to the entries in the
connection statistics, which ensures the trouble-free operation in both directions. Further information to the confi-
guration of the protocol filter can be found 'Protocol filter" —page 240

IEEE 802.1x/EAP

The international industry standard IEEE 802.1x and the Extensible Authentication Protocol (EAP) enable access
points to carry out reliable and secure access checks. The access data can be managed centrally on a RADIUS server
and can be called up by the access point on demand.

This technology also enables the secure transmission and the reqular automatic changing of WEP keys. In this way,
IEEE 802.1x improves the security of WEP.

The IEEE-802.1x technology is already fully integrated in Windows XP. Client software exists for other operating sys-
tems.

For the configuration with LANconfig you will find the IEEE-802.1x settings in the configuration area "WLAN Secu-
rity". This is where you decide if you want to activate |[EEE-802.1x. If IEEE-802.1x is activated, a RADIUS server must
be defined for the IEEE-802.1x authentication.
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Configuration
with
WEBconfig or
Telnet

Only with the
LANCOM VPN
Option. Not
available with
all LANCOM
devices.
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<2 YPN_NHAMEL Configuration 21x|
Configure: |W'LAN Security 'l

Generall Stationsl Protocolsl WEP  |EEE B0Z.1x |

— Authentication for network acce:

IV Activate IEEE 802.1% (EAF)]

-~ Interface setting:

Specify login settings for each local area network interface.

Interfaces - |

— Authentication via RADIUS
Server [P address: W
Server port: I1812—
Shared secret: ||—

Under WEBconfig or Telnet you will find the settings for IEEE-802.1x under the following paths:

WEBconfig Expert configuration P> Setup P> User authentication module »>
EAP config

Terminal/Telnet cd /Setup/User-Authentication-Module/EAP-Config

IPSec over WLAN

With the help of the IPSec-over-WLAN technology in addition to the security measures described already, a wireless
network for the exchange of especially sensitive data can be optimally secured. To this end, the LANCOM Wireless
access point is upgraded to a VPN gateway with the LANCOM VPN Option. In addition to the encryption per 802.11i,
WPA or WEP, the LANCOM Wireless now offers the possibility of encrypting wireless connections with an IPSec-based
VPN.

12.5 Establishing outdoor wireless networks

LANCOM access points in combination with appropriate external antennae are ideally suited to establishing point-
to-point wireless connections to other access points.

There are two main questions to be answered when setting up the wireless connection:
> How should the antennae be positioned to ensure a problem-free connection?
> What performance characteristics do the antennae need to ensure sufficient data rates within legal limitations?
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12.5.1 Geometrical layout of the transmission path

Antennae do not emit their signals linearly, but within an angle that depends on the model in question. The spherical
expansion of the signal waves is characterised by constructive and destructive interference between these waves at
certain distances perpendicular to the line of sight between transmitter and receiver. The areas where the waves
amplify or cancel themselves out are known as Fresnel zones.

Fresnel zone 3

Fresnel zone 2

Fresnel zone 1

To ensure an optimal signal reception between transmitter and receiver, the Fresnel zone 1 should remain free from
any obstruction. Any disturbances from elements protruding into this zone will significantly reduce the effective sig-
nal power. The object not only screens off a portion of the Fresnel zone, but the resulting reflections also lead to a
significant reduction in the signal reception.

The radius (R) of Fresnel zone 1 is calculated with the following formula assuming that the signal wavelength (A)
and the distance between transmitter and receiver (d) are known.

R=05* V(A *d)
The wavelength in the 2.4-GHz band is approx. 0.125m, in the 5-GHz band approx. 0.05 m.
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Example: With a separating distance of 4 km between the two antennae, the radius of Fresnel zone 1 in the 2.4-
GHz band is 11 m, in the 5-GHz band 7 m.

To ensure that the Fresnel zone 1 remains unobstructed, the height of the antennae must exceed that of the highest
obstruction by this radius. The full height of the antenna mast (M) should be as depicted:
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Safety margin:

Obstruction height H

arth's curvature E

M =R+ 1m + H + E (Earth's curvature)

The height of the Earth's curvature (E) is calculated from the distance (d) E=d2 * 0,0147 — even at a distance of 8
km that results in almost 1m!

Example: With a distance of 8 km between the antennae, the result in the 2.4-GHz band is a mast height above the
level of the highest obstruction of approx. 13 m, in the 5-GHz band 9 m.

12.5.2 Antenna power

The power of the antenna must be high enough to ensure acceptable data transfer rates. On the other hand, the
country's legal limitations on transmission power should not be exceeded.

The calculation of effective power considers everything from the radio module in the transmitting access point to the
radio module in the receiving access point. In between there are attenuating elements such as the cable, plug con-
nections, and even the air, and amplifying elements such as the external antennae.

Amplification with Free-space loss Amplification with
antenna gain antenna gain

Loss through
cable, plugs and
lightning protec-

Loss through
cable, plugs and
lightning protec-

Output power of the Input signal at the
radio module radio module



LANCOM Reference Manual LCOS 3.52 P Chapter 12: Wireless LAN — WLAN

[> Establishing outdoor wireless networks

(1D The calculation of the power over the path begins at the transmitters's radio module. The radio module in the
LANCOM access points in 802.11a mode emits the following power levels depending on the channel used and
the data transmission rate:

6 17 17 17 17
9 17 17 17 17
12 17 17 17 17
18 17 17 17 17
24 17 17 17 17
36 14 14 14 14
48 13 13 13 13
54 12 12 12 12
72 (Turbo) 14 14 14 14
96 (Turbo) 13 13 13 13
108 (Turbo) 12 12 12 12

To achieve a data transmission rate of 24 Mbps the radio module emits a power of 17 dBm.

The data transmission rate is set according to the reception power. A WLAN module has an input sensitivity
equivalent to a power level of, for example, -80dBm. If the received power falls below this level, then a lower
data rate can be switched in that corresponds with an improved sensitivity with a lower level of power.

(2) Outdoor wireless connections are usually realised with external antennae and extension cables together with
lightning protection for safety. The power loss from the cable is approx. 1 dB per metre. A cable 4 m long thus
reduces power by 4 dB, the lightning protection and the various plug connections also lead to the loss of a
further 1 dB. Thus the power of the external antenna is:
17dBm -4 dB- 1db=12 dBm.
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(3@ The power received by the antenna is then amplified. An AirLancer Extender 0-18a (with an emitting angle of
18°) supplies an antenna gain of 18 dBm. The total power output from the antenna is thus:

12 dBm + 18 dBm =30 dBm.

@ This power emission must be within the legal limits of the country where the antenna is in operation!
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(4 Radio transmission through air is subject to power attenuation from the so-called "free-space loss" x, which is
logarhythmically related to the distance d (in km) between transmitter and receiver.

x =100 + 20 * log (d) [dB] in the 2.4-GHz band
x =105+ 20 * log (d) [dB] in the 5-GHz band
A 802.11a transmission over a distance of 4 km results in a free-space loss x of:
x=105dB +20 *log (4) dB=105dB + 12 dB =117 dB.
(5 A10dB safety margin is added to this attenuation so that the total loss for this example can be taken as 127 dB.

(& This loss between the transmitting and receiving antenna is subtracted from the output power of the transmitting
antenna:

30 dBm - 127 dBm = - 97 dBm.
This determines the reception power at the receiving antenna.

() The receiving end also has amplifying and attenuating elements. If the same antenna is used as at the transmit-
ter, the antenna gain is 18 dB and the loss from cable (again 4m), lightning protection and plug connectors is 5
dB. The radio signal thus arrives at the receiver's radio module with the following power:

- 97 dBm + 18 dBi - 5 dB =-84 dBm.

From the table for reception sensitivity of the radio module, the attainable data rate can be read off, in this case
24 Mbps:

6 -90 -85
9 -89 -84
12 -88 -83
18 -87 -82
24 -85 -80
36 -81 -76
48 -76 -1
54 -73 -68
72 (Turbo) -78 -73
96 (Turbo) -73 -68
108 (Turbo) -70 -65
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This values are the result of a calculation that includes a 'safety margin' of 10dB. As every radio path is uni-
que, these values can only serve as a rough guide.

12.5.3 Emitted power and maximum distance
For a simplified calculation of attainable distances and data rates for AirLancer Extender antennae, please refer to
the following table. All tables include a 10 dB safety reserve and can be considered to be realistic.

For each antenna, the table has a column for point-to-point mode (P2P, connection between two access points) and
for point-to-multipoint mode (P2mP, connection from an access point to the registered clients, e.g. notebooks).

The last column in the table shows the transmission power reduction to be set so that the upper limits of 30 dBm
(802.11a) or 20 dBm (802.11b/g) cannot be exceeded.

The specifications for 802.11a apply only for Germany, the Netherlands, Luxembourg and Great Britain. In
Belgium, Austria and Switzerland, only the 802.11b/g standard is approved for outdoor use.

AirLancer Extender 0-18a (802.11a)

> Antenna gain: 18 dBi
» Assumed cable loss: 4 dB

6 7,94 1,78
9 7.08 1,58
12 6,31 1,41
18 5,62 1,26
2 4,47 1,00
36 2,00 0,45
48 1,00 0,22
54 0,63 0,14
72 (Turbo) 1,41 032
96 (Turbo) 0,71 0,16
108 (Turbo) 0,45 0,10

AirLancer Extender 0-30 (802.11b/g)
> Antenna gain: 15 dBi
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» Assumed cable loss: 9 dB

1,0 2,82 1,58
2,0 2,51 1,41
55 2,24 1,26
6,0 2,24 1,26
9,0 2,24 1,26
11,0 2,00 1,12
12,0 1,78 1,00
18,0 1,41 0,79
24,0 1,00 0,56
36,0 0,71 0,40
48,0 035 0,20
54,0 0,18 0,10

= AirLancer Extender 0-70 (802.11b/g)

< . .

§‘ > Antenna gain: 8.5 dBi

| » Assumed cable loss: 6 dB

=

<

~

[%5)

v

2

=

= 1,0 1,26 1,06
2,0 1,12 0,94
55 1,00 0,84
6,0 1,00 0,84
9,0 1,00 0,84
11,0 0,89 0,75
12,0 0,79 0,67
18,0 0,63 0,53
24,0 0,45 0,38

264



LANCOM Reference Manual LCOS 3.52

P Chapter 12: Wireless LAN — WLAN

36,0 0,32 0,27
48,0 0,16 0,13
54,0 0,08 0,07

12.5.4 Transmission power reduction

[> Establishing outdoor wireless networks

Every country has regulations concerning the permissible output power from WLAN antennae, often with differences
according to the WLAN standard or divided according to indoor or outdoor use. The output power from external
antennae may not exceed these maximum power levels. The relevant power level is the result of adding the radio
module power and the antenna gain, and subtracting the loss from cable, connectors and lightning protection.

Setting the transmission power reduction is described in the section ‘Radio settings’ —page 250.
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13 Office communications with LANCAPI

C‘\ This section only applies to devices with ISDN interface.

LANCAPI from LANCOM Systems is a special version of the popular CAPI interface. CAPI (Common ISDN Application
Programming Interface) establishes the connection between ISDN adapters and communications programs. For their
part, these programs provide the computers with office communications functions such as a fax machine or answe-
ring machine.

13.1 What are the advantages of LANCAPI?

The main advantages of using LANCAPI are economic. LANCAPI provides all Windows workstations integrated in the
LAN (local-area network) with unlimited access to office communications functions such as fax machines, answering
machines, online banking and eurofile transfer. All functions are supplied via the network without the necessity of
additional hardware at each individual workstation, thus eliminating the costs of equipping the workstations with
ISDN adapters or modems. All you need do is install the office communications software on the individual worksta-
tions.

For example, faxes are sent by simulating a fax machine at the workstation. With LANCAPI, the PC forwards the fax
via the network to the router which establishes the connection to the recipient.

Please note: All LANCAPI-based applications access the ISDN directly and do not run across the router of the
device. The connect-charge monitoring and firewall functions are thus disabled! The LANCAPI is also inde-
pendent from all routing or VPN functions.

13.2 The client and server principle

The LANCAPI is made up of two components, a server (in the LANCOM) and a client (on the PCs). The LANCAPI client
must be installed on all computers in the LAN that will be using the LANCAPI functions.

PCs with LANCAPI client
and ISDN answering

machine software g g g

SDN

LANCOM wmithL AN ARPISsamer
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13.2.1 Configuring the LANCAPI server

Two basic issues are important when configuring the LANCAPI server:
> What call numbers from the telephone network should LANCAPI respond to?
> Which of the computers in the local network should be able to access the telephone network via LANCAPI?

The configuration of the router takes place in the configuration tables of LANconfig or WEBconfig. In the following
two sections you can find the instructions for both of these configuration programs.

Configuration with LANconfig

(1) Open the configuration of the router by double-clicking on the device name in the list and enter your password
if requested.

ol

File Edit Device Wiew Tools Help

|l | | wE il ERlE BlEEwl 2

LaMconfig Mame I Description | Address | Device Status | Progress | :I

{11 Cliento1 EAILC_PPP 10.1.1,31 13
=10 Clientoz &P le-vrls-e201 10.1.10.183 ok
{'_‘| Office0l Eplc-wrls-e316 10.1.10.154 Ok
(0 officenz Elc-wrls-e201-54m 10.1.10.186 Ok
{1 Internal Eple-ez14-L54ag 10.1.10.187 Ok
Elc-e308-L54ag 10.1.10.188 ok

L L= AN AN 1o Al

(@ In the configuration area 'LANCAPI' klick on the tab ‘General’ and select at the LANCAPI interfaces the ISDN
port you want to set.

7% NHAMEL_HOME Configuration 1 2=l

Configure: | LAMCAF x l

General | Options I

Interface setting:

Select the interfaces that you wizh to make available to the
LANCAP! clients.

LANCAP! interfaces -

Y ISDM (S0 bus) (Outgoing and incaming calls)
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(3 Activate the LANCAPI server for the outgoing and incoming calls, or allow only outgoing calls.
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LANCAPI interfaces - ISDN (S0 bus) 21x|

General | Availabilty |

Interface: ISDM [S0 bus)

MNumber [MSH]: |123458

Acocess to this interface:
" Deactivated

" For outgoing calls anly
" For incoming calls only

' For outgoing and incoming calls

Max. # of connections: IUnIimited 'I

[~ Always set the subscriber number of this interface as own

number for outgoing calls.
()3 |:l Cancel |

If the LANCAPI server is supposed to respond to incoming calls, enter the call numbers to which the LANCAPI
should respond in the 'Number (MSN)' field. You can enter several call numbers separated by semicolons. If you
do not enter a call number here, all incoming calls are reported to LANCAPI.

Configuration of WEBconfig

(D Select in the main menu the Expert Configuration.

(@ Select in the following menus Setup » LANCAPI-module > Interface-list.

(3 Select in the Interface-list the (only) entry SO-1.

(4) Activate the LANCAPI server for outgoing and incoming calls (*On’), or only allow outgoing calls (‘Dail-only').

Expert Configuration
3 Setup

3 LANCAPLmodule

Interface-list

S0-
1

Operating On -
EAZ-MEM(s) |089123458?

Force-out-MSN Im 'l
Resetl

Ifc
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If the LANCAPI server is supposed to respond to incoming calls, enter the call numbers to which the LANCAPI
should respond in the 'Number (MSN)' field. You can enter several call numbers separated by semicolons. If you
do not enter a call number here, all incoming calls are reported to LANCAPI.

13.2.2 Installing the LANCAPI client

<‘~ For the installation of the LANCAPI client on a system with Windows XP or Windows 2000 administrator
rights are required.

(1) Place the LANCOM CD in your CD-ROM drive. If the setup program does not automatically start when you insert
the CD, simply click ‘autorun.exe' in the main directory of the LANCOM CD in the Windows Explorer.

(2 Select the Install LANCOM software entry.
(3 Highlight the LANCAPI option. Click Next and follow the instructions for the installation routine.

If necessary, the system is restarted and LANCAPI is then ready to accept all jobs from the office communications
software. After successful installation, an icon for LANCAPI will be available in the toolbar. A double-click on this
icon opens a status window that permits current information on the LANCAPI to be displayed at any time.

The LANCAPI client starts automatically and shows the status in the windows task bar.

L4 = active | b = Error | i@ = inactive

TAPI

13.2.3 Configuration of the LANCAPI clients

The configuration of the LANCAPI clients is used to determine which LANCAPI servers will be used and how these
will be checked. All parameters can remain at their default settings if you are using only one LANCOM in your LAN
as an LANCAPI server.

(1 Start the LANCAPI client in the 'LANCOM' program group. Information regarding the drivers for the available
service can be found on the 'General' tab.
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(2 In the LANCAPI client, change to the Network tab. First, select whether the PC should find its own LANCAPI
server, or specify the use of a particular server.

I>  For the former, determine the interval at which the client should search for a server. It will continue searching
until it has found the number of servers specified in the next field. Once the required number of servers has
been found, it will stop searching.

> In the event that the client should not automatically search for servers, list the IP addresses of the servers to
be used by the client. This can be useful if you are operating several LANCOM in your LAN as LANCAPI servers
and you would like to specify a server for a group of PCs, for example.
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> Itis also possible to set the interval at which the client checks whether the found or listed servers are still
active.

LANCOM LANCAPI Properties i |
General Metwork | Dptionsl Advancedl

~ CAPI devices in the local area netwark.

' Find CAPI devices automatically
LI

The local area network will be scanned frequently
for devices providing CAF| services.

" Use only specific CAPI devices

Only the CAP| devices whose addresses you have
entered in the list will be uzed.

Fepeat search every BD_:I zeconds

Stop searching, when I ‘I_I; device(z] found

Check availability of a device every I 10_% zeconds

0k, Cancel | Apply

13.3 How to use the LANCAPI

Two options are available for the use of the LANCAPI:

> You may use software which interacts directly with a CAPI (in this case, the LANCAPI) port. This type of software
searches for the CAPI during its installation and uses it automatically.

» Other programs such as LapLink can establish a variety of connection types, for example, using Windows Dial-
Up Networking. You may select the installed communications device that you would like to use when creating a
new dial-up connection. For the LANCAPI, select the entry 'ISDN WAN Line 1'.

13.4 The LANCOM Systems CAPI Faxmodem

The CAPI Faxmodem provides a Windows fax driver (Fax Class 1) as an interface between the LANCAPI and applica-
tions, permitting the use of standard fax programs with an LANCOM. The LANCOM CAPI Faxmodem emulates the
modem functions, as well as the fax protocols in the software on the PC. For this purpose an adequate performance
(500 MHz Pentiumand more) is required.
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Installation

The CAPI Faxmodem can be installed from the CD setup. Always install the CAPI Faxmodem together with the current
version of LANCAPI. After restarting, the CAPI Faxmodem will be available for you, e.g. in Windows 98 under Start
> Settings » Control Panel » Modems.

Faxing with the CAPI Faxmodem

Most major fax programs recognize the CAPI Faxmodem automatically during installation and identify it as a 'Class
1" fax modem. Fax transmissions can thus be realized at speeds of up to 14,400 bps. If your fax program offers you
a choice (such as WinFax and Talkworks Pro), select the option 'CLASS 1 (Software Flow Control)' when setting up
the modem.

Faxing under Windows XP and Windows 2000

Windows XP or Windows 2000 provide with the CAPI Faxmodem full functionality for faxing. An additional fax
program is not required.

Thereto start in the Control Panel under “Add or Remove Programs”, “Add/Remove Windows Components” and
select “Fax Services”.

After the installation the fax can be found under “Printers and Faxes”, and can be chosen in any Windows pro-
gram instead of a printer.

(‘i\ The CAPI Faxmodemis only able to transmit fax messages, if the LANCAPI ist active.

13.5 LANCOM Faxmodem option

Additionaly to the CAPI Faxmodem some LANCOM models (LANCOM 800, 4000, 4100) have a faxmodem option.
With this solution the fax and modem services are implemented in the LANCOM itself, the PCs are released from the
load of the modem emulation.

13.6 Provided B channel protocols
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Following CAPI-Protoc:ols are provided

B1 protocol
0 64 Kbps with HDLC framing
1 64 Kbps transparent with byte framing of the network
2 V.110 asynchron with start-stop-byte framing
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4* T.30-Modem for fax group 3

7* Modem with full negotiations (B2 muss 7 sein)
B2-Protocol

0 IS0 7776 (X.75 SLP)

1 Transparent

4* T.30 for fax group 3

7* Modem with full negotiations (z.B. V.42 bis, MNP 5)

9 V.120 asynchron
B3-Protocol

0 Transparent

1 T.90NL, compatibel with T.70NL in accordance with T.90, Appendix Il

2 1SO 8208 (X.25 DTE-DTE)

4* T.30 for fax group 3

5* T.30 fir fax group 3 extended

7 Modem

* = valid only for LANCOM faxmodem option
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14 More services

An LANCOM offers a number of services for the PCs in the LAN. These are central functions that can be used by work-
station computers. They are in particular:

vVvVvyVvyyvwvyy

Automatic address administration with DHCP

Name management of computers and networks with DNS
Logging of network traffic with SYSLOG

Recording of charges

Office communications functions with LANCAPI

Time server

14.1 Automatic IP address administration with DHCP

In order to operate smoothly in a TCP/IP network, all the devices in a local network must have unique IP addresses.

They also need the addresses of DNS-servers and NBNS-servers as well as that of a default gateway through which
the data packets are to be routed from addresses that are not available locally.

In a smaller network, it is still conceivable that these addresses could be entered manually in all the computers in
the network. In a larger network with many workstation computers, however, this would simply be too enormous of
a task.

In such situations, the DHCP (Dynamic Host Configuration Protocol) is the ideal solution. Using this protocol, a DHCP
server in a TCP/IP-based LAN can dynamically assign the necessary addresses to the individual stations.

The LANCOM devices have a build in DHCP server, which assigns the IP addresses in the LAN. If a DHCP server
already exists in the local network, the device in DHCP client mode can alternatively get the required address infor-
mation from the other DHCP server.

14.1.1 The DHCP server

As a DHCP server, the LANCOM can administer the IP addresses in its TCP/IP network. In doing so, it passes the fol-
lowing parameters to the workstation computers:

>

vVvVvyvVvyyvwyy

(%)
D
8
=
D
(%9
=
=

IP-address

network mask

broadcast address

standard gateway

DNS server

NBNS server

period of validity for the parameters assigned

The DHCP server takes the IP addresses either from a freely defined address pool or determines the addresses auto-
matically from its own IP address (or intranet address).
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In DHCP mode, a completely unconfigured device can even automatically assign IP addresses to itself and the com-
puters in the network.

In the simplest case, all that is required is to connect the new device to a network without other DHCP servers and
switch it on. The DHCP server then interacts with LANconfig using a wizard and handles all of the address assign-
ments in the local network itself.

14.1.2 DHCP—'on’, 'off', ‘auto’, ‘client’ or ‘forwarding'?

The DHCP server can be set to five different states:

> ‘on': The DHCP server is permanently active. The configuration of the server (validity of the address pool) is che-
cked when this value is entered.
> When correctly configured, the device will be available to the network as a DHCP server.

> In the event of an incorrect configuration (e.g. invalid pool limits), the DHCP server is disabled and switches
to the 'off' state.

(‘\ Only use this setting if assured, that no further DHCP server is active in the LAN.

» ‘off': The DHCP server is permanently disabled.
> ‘auto: In this mode, after switching it on, the device automatically looks for other DHCP servers within the local
network. This search can be recognized by the LAN-Rx/Tx LED flashing.
> If at least on other DHCP server is found, the device switches it's own DHCP server off, changes to the DHCP
client mode, and obtains the IP adress from the DHCP server in the LAN. This prevents the unconfigured
device from assigning addresses not in the local network when switched on.
> The device then enables its own DHCP server if no other DHCP servers are found. If at a later point of time
a further DHCP server is switched on in the LAN, the device automatically changes back into the DHCP client
mode.
> 'client": The DHCP server is switched off, the device acts like a DHCP client and obtains the address information
from a different DHCP server in the LAN.

(.‘ Only use this setting if assured, that a further DHCP server is active in the LAN and takes over the assigned
~ IP address information.

» ‘forwarding': The DHCP server is active and the device accepts the requests from the DHCP clients in the local
network. The device does not respond to these requests itself, but forwards them to a central DHCP server.

Whether the DHCP server is active or not can be seen in the DHCP statistics.
The default setting for this condition is ‘auto’.
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14.1.3 How are the addresses assigned?

IP address assignment
Before the DHCP server can assign IP addresses to the computers in the network, it first needs to know which addres-
ses are available for assignment. Three options exist for determining the available selection of addresses:

> The IP address can be taken from the address pool selected (start address pool to end address pool). Any valid
addresses in the local network can be entered here.

Configure: | TCRARP ¥ l

General | Addiesses DHCP | BOOTP | DNS | ONS Fiter |

DHCP server enabled: IAuto 'l

—Addresses for DHCP client

First address: |1 92.168.2.50
Last address: |1 92.168.2.90

Metmask: |255.255.255.D
Broadcast: ID.D.D.D

Drefault gateway: |1 92.168.2.100
r— Forwarding of DHCF querie

Server address: |EI 0.0.0

[T &dapt server replies to the loeal network

I™ Flace server ieplies i intermediate storage

LANCOM ok, [ I Cancel |
Systens

> 1f'0.0.0.0" is entered instead, the DHCP server automatically determines the particular addresses (start or end)
from the IP or intranet address settings in the 'TCP-1P-module' using the following procedure:

> If only the Intranet address or only the DMZ address is entered, the start or end of the pool is determined by
means of the associated network mask.

> If both addresses have been specified, the Intranet address has priority for determining the pool.

From the address used (Intranet or DMZ address) and the associated network mask, the DHCP server determines
the first and last possible IP address in the local network as a start or end address for the address pool.

> If the router has neither an Intranet address nor an DMZ address, the device has gone into a special operating
mode. It then uses the IP address '172.23.56.254' for itself and the address pool '172.23.56.x" for the assign-
ment of IP addresses in the network.
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If only one computer in the network is started up that is requesting an IP address via DHCP with its network settings,
a device with an activated DHCP module will offer this computer an address assignment. A valid address is taken
from the pool as an IP address. If the computer was assigned an IP address at some point in the past, it requests this
same address and the DHCP server attempts to reassign it this address if it has not already been assigned to another
computer.

The DHCP server also checks whether the address selected is still available in the local network. As soon as the uni-
queness of an address has been established, the requesting computer is assigned the address found.

Netmask assignment

The network mask is assigned in the same way as the address. If a network mask is entered in the DHCP module,
this mask is used for the assignment. Otherwise, the network mask from the TCP/IP module is used. The order is the
same as during the assignment of the addresses.

Broadcast address assignment

Normally, an address yielded from the valid IP addresses and the network mask is used for broadcast packets in the
local network. In special cases, however (e.g. when using subnetworks for some of the workstation computers), it
may be necessary to use a different broadcast address. In this case, the broadcast address to be used is entered in
the DHCP module.

<“‘ The default setting for the broadcast address should be changed by experienced network specialists only.
Incorrect configuration of this section can result in the undesired establishment of connections subject to
connect charges!

Standard gateway assignment
The device always assigns the requesting computer its own IP address as a gateway address.
If necessary, this assignment can be overwritten with the settings on the workstation computer.

DNS and NBNS assignment
This assignment is based on the associated entries in the 'TCP/IP-module’.

If no server is specified in the relevant fields, the router passes its own IP address as a DNS address. This address is
determined as described under 'IP address assignment'. The router then uses DNS-forwarding (also see 'DNS-for-
warding'), to resolve DNS or NBNS requests from the host.

Period of validity for an assignment

The addresses assigned to the computer are valid only for a limited period of time. Once this period of validity has
expired, the computer can no longer use these addresses. In order for the computer to keep from constantly losing
its addresses (above all its IP address), it applies for an extension ahead of time that it is generally sure to be granted.
The computer loses its address only if it is switched off when the period of validity expires.
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For each request, a host can ask for a specific period of validity. However, a DHCP server can also assign the host a
period of validity that differs from what it requested. The DHCP module provides two settings for influencing the
period of validity:
> Maximum lease time in minutes
Here you can enter the maximum period of validity that the DHCP server assigns a host.
If a host requests a validity that exceeds the maximum length, this will nevertheless be the maximum available
validity!
The default setting is 6000 minutes (approx. 4 days).

» Default lease time in minutes

Here you can enter the period of validity that is assigned if the host makes no request. The default setting is 500
minutes (approx. 8 hours).

Precedence for the DHCP server—request assignment

In the default configuration, almost all the settings in the Windows network environment are selected in such a way
that the necessary parameters are requested via DHCP. Check the settings by clicking Start » Settings » Control
Panel » Network. Select the TCP/IP entry for your network adapter and open Properties.

Check the various tabs for special entries, such as for the IP address or the standard gateway. If you would like all
of the values to be assigned by the DHCP server, simply delete the corresponding entries.

On the '"WINS configuration' tab, the 'Use DHCP for WINS Resolution' option must also be selected if you want to
use Windows networks over IP with name resolution using NBNS servers. In this case, the DHCP server must also
have an NBNS entry.

Priority for computer—overwriting an assignment

If a computer uses parameters other than those assigned to it (e.qg. a different default gateway), these parameters
must be set directly on the workstation computer. The computer then ignores the corresponding parameters assigned
to it by the DHCP server.

Under Windows 98, this is accomplished through the properties of the Network Neighbourhood.
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Click Start / Settings / Control Panel / Network. Select the 'TCP/IP* entry for your network adapter and open Pro-
perties.

You can now enter the desired values by selecting the various tabs.
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Checking of IP addresses in the LAN

WEBconfig Expert Configuration Setup / DHCP-module
Table-DHCP
Terminal/Telnet setup/DHCP-module/table-DHCP

The DHCP table provides a list of the IP addresses in the LAN. This table contains the assigned or used IP address,
the MAC address, the validity, the name of the computer (if available) and the type of address assignment.
The ‘Type' field specifies how the address was assigned. This field can assume the following values:
> ‘new'
The computer has made its initial request. The DHCP server verifies the uniqueness of the address that is to be
assigned to the computer.
> ‘unknown’
While verifying uniqueness, it was determined that the address has already been assigned to another computer.
Unfortunately, the DHCP server has no means of obtaining additional information on this computer.
> static’
A computer has informed the DHCP server that it has a fixed IP address. This address can no longer be used.
> ‘dynamic'
The DHCP server assigned the computer an address.

14.2 DNS

The domain name service (DNS) is responsible in TCP/IP networks for associating computer names and/or network
(domains) and IP addresses. This service is required for Internet communications, to return the correct IP address for
a request such as ‘www.lancom.de' for example. However, it's also useful to be able to clearly associate IP addresses
to computer names within a local network or in a LAN interconnection.

14.2.1 What does a DNS server do?

The names used in DNS server requests are made up of several parts: one part consists of the actual name of the
host or service to be addressed; another part specifies the domain. Specifying the domain is optional within a local
network. These names could thus be ‘www.domain.com' or ‘ftp.domain.com’, for example.

If there is no DNS server in the local network, all locally unknown names will be searched for using the default route.
By using a DNS server, it's possible to immediately go to the correct remote station for all of the names with known
IP addresses. In principle, the DNS server can be a separate computer in the network. However, the following reasons
speak for locating the DNS server directly in the LANCOM:

» LANCOM can automatically distribute IP addresses for the computers in the local network when in DHCP server
mode. In other words, the DHCP server already knows the names and IP addresses of all of the computers in its



LANCOM Reference Manual LCOS 3.52 » Chapter 14: More services

> DNS

own network that were assigned IP addresses via DHCP. With the dynamic address assignments of a DHCP server,
an external DNS server might have difficulties in keeping the associations between the names and IP addresses
current.

When routing Microsoft Networks via NetBIOS, the LANCOM also knows the computer names and IP addresses
in the other connected NetBIOS networks. In addition, computers with fixed IP addresses can also enter them-
selves in the NetBIOS table and thus be known by their names and addresses.

The DNS server in the LANCOM can also be used as an extremely convenient filter mechanism. Requests for
domains can be prohibited throughout the LAN, for subnetworks, or even for individual computers—simply by
specifying the domain name.

How does the DNS server react to the request?

When processing requests for specific names, the DNS server takes advantage of all of the information available to it:

>

>
>

>

>

First, the DNS server checks whether access to the name is not prohibited by the filter list. If that is the case, an
error message is returned to the requesting computer stating that access to the address has been denied.
Next, it searches in its own static DNS table for suitable entries.

If the address cannot be found in the DNS table, it searches the dynamic DHCP table. The use of DHCP informa-
tion can be disabled if required.

If no information on the name can be located in the previous tables, the DNS server then searches the lists of
the NetBIOS module. The use of the NetBIOS information can also be disabled if necessary.

Finally, the DNS server checks whether the request to another DNS server is to be forwarded to another DNS
server via a WAN interface (special DNS forwarding via the DNS destination table).

If the requested name cannot be found in any of the information sources available to it, the DNS server sends the
request to another server—that of the Internet provider, for example—using the general DNS forwarding mecha-
nism, or returns an error message to the requesting computer.

14.2.2 DNS forwarding

If it cannot serve the request from its own DNS tables, the DNS server forwards the request to other DNS servers.
This process is called DNS forwarding.

Here a distinction is made between

>

>

special DNS forwarding

Requests for certain name areas are forwarded to certain DNS servers.
general DNS forwarding

All other names not specified in detail are forwarded to the "higher-
level” DNS server.

Special DNS forwarding

With “special DNS forwarding” name areas can be defined for the resolution of which specified DNS server are
addressed.
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Atypical application for special DNS forwarding results for a home workstation: The user wants to be able to connect
to the company intranet and directly to the Internet at the same time. The requests sent into the intranet must be
routed to the company DNS server, and all other requests to the DNS server of the provider.

General DNS forwarding

All DNS requests that cannot be resolved in another way are forwarded to a DNS server. This DNS server is determi-
ned according to the following rules:

> Initially the router checks whether a DNS server has been entered in its own settings. If it is successful there, it
obtains the desired information from this server. Up to two higher-level DNS servers can be specified.

LANconfig TCP/IP B> Addresses P> Primary DNS / Secondary DNS

WEBconfig Expert Configuration P> Setup > TCP-IP-module B> DNS-default
» DNS-backup

Terminal/Telnet /setup/TCP-IP-module/DNS-default
/setup/TCP-IP-module/DNS-backup

> If no DNS server is entered in the router, it will attempt to reach a DNS server over a PPP connection (e.g. from
the Internet provider) to get the IP address assigned to the name from there. This can only succeed if the address
of a DNS server is sent to the router during PPP negotiation.

> The default route is established and the DNS server searched for there if no connection exists.

This procedure does not require you to have any knowledge of the DNS server address. Entering the Intranet address

of your router as the DNS server for the workstation computers is sufficient to enable you obtain the name assign-

ment. This procedure also automatically updates the address of the DNS server. Your local network always receives

the most current information even if, for example, the provider sending the address changes the name of his DNS

server or you change to another provider.

14.2.3 Setting up the DNS server

The settings for the DNS server are contained in the following menu or list:

LANconfig TCP/IP B> DNS
WEBconfig Expert Configuration P> Setup P> DNS-module
Terminal/Telnet cd /setup/DNS-module

Proceed as follows to set the DNS server:
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(1D Switch the DNS server on.

WEBconfig ‘ ... > Operating

Terminal/Telnet ‘set operating on

(2 Enter the domain in which the DNS server is located. The DNS server uses this domain to determine whether the
requested name is located in the LAN. Entering the domain is optional.

WEBconfig ‘ ... > Domain

Terminal/Telnet ‘set domain yourdomain.com

(3 Specify whether information from the DHCP server and the NetBIOS module should be used.

WEBconfig ... > DHCP-usage
... > NetBIOS-usage

Terminal/Telnet set DHCP-usage yes

set NetBIOS-usage yes

New Configuration for LANCOM 821 ADSL/ISDN 2xl

Confi 5 - .
anfgue:  [TC/P | Activated DNS server
General | Addresses | DHCP | BODTP DNS | DS Fiter | in the TCP IP configuration

¥ DNS server enabled
i~ General setling:

Owin domair: Iintamal. cor
Walidity: I2,UUU mirutes

i~ Host name resclving

¥ Resolve addresses of DHCP clients

¥ Resolve names of NetBIOS stations

Enter the host hames and the coresponding IP addiesses
here.

Host names ... |
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“You can fonvard requests for certain domains explicity to
ceftain remote sites.

Fonwarding |
LANSOM Corcel |
Systens

(#) The main task of the DNS server is to distinguish requests for names in the Internet from those for other remote
stations. Therefore, enter all computers in the Host names table,

> for which you know the name and IP address,
I> that are not located in your own LAN,
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> that are not on the Internet and
> that are accessible via the router.
With the following commands you add stations to the Host names table:

LANconfig TCP/IP B> DNS P> Host names »> Add
WEBconfig ... > DNS-table > Add
Terminal/Telnet cd setup/DNS-module/DNS-
table set mail.yourdomain.com 10.0.0.99

For example, if would like to access the mail server at your headquarters (name: mail.yourdomain.com, IP:
10.0.0.99) via the router from a branch office, enter:

Host names - New Entry i 2=l
Host name: I mail.mylancom, com QK
IP address: IID.D.D.99 cancel |

Stating the domain is optional but recommended.

When you now start your mail program, it will probably automatically look for the server 'mail.yourdomain.com’.
The DNS server thereupon returns the IP address '10.0.0.99'. The mail program will then look for that IP address.
With the proper entries in the IP routing table and name list, a connection is automatically established to the
network in the headquarters, and finally to the mail server.

(5) To resolve entire name areas of another DNS server, add a forwarding entry consisting of a name area and remote

station:
% LANconfig TCP/IP »> DNS »> Forwarding P> Add
)
§ WEBconfig ... > DNS destination table » Add
93 Terminal/Telnet cd setup/DNS-module/
® DNS-destination- table set *.intern COMPANY
=

When entering the name areas, the wildcards '?' (for individual characters) and *** (for multiple characters) may
be used.

To reroute all domains with the ending ".intern to a DNS server in the LAN of the remote station 'COMPANY’,
create the following entry:

Forwarding - New Entry _ g ﬂll

Damain: I *.internal QK

Remate site: I CEMTRAL_OFFICE| 'l Cancel |
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1'.\‘ The DNS server may either be specified by the remote site name (for automatic setting via PPP), or by an
explicit IP address of the according name server.
14.2.4 URL blocking
(D Finally, one can restrict access to certain names or domains with the filter list.

To block the domain (in this case the web server) ‘www.offlimits.com’ for all computers in the LAN, the following
commands and entries are required:

LANconfig TCP/IP D> DNS Filter B> DNS filter... » Add
WEBconfig ... P> Filter-list > Add
Terminal/Telnet cd setup/DNS-module/filter-list

set 001 www.blocked.com 0.0.0.0 0.0.0.0

DNS filter - New Entry I 2
Daomain: I ww, blocked-domain, cor \—OKR{—I
IP address: I 0.0.0.0] Cancel |
Metmask: I 0.0.0.0

The index '001" in the console command can be selected as desired and is used only for clarity.

When entering the domains, the wildcards '?* (represents exactly one character) and "*' (for any number of
characters) are permitted.

To only block the access of a certain computer (e.g. with IP 10.0.0.123) to COM domains, enter the following

values:
DNS filter - New Entry N 2=l
Damain: I *.com o
IP address: IID.D.D.ZS cancel |
Metmask: I 255.255.255,255

In the console mode the command is:
set 002 *.com 10.0.0.123 255.255.255.255
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(‘ The hit list in the DNS statistics contains the 64 most frequently requested names and provides a good basis
=~ for setting up the filter list.

If your LAN uses subnetting, you can also apply filters to individual departments by carefully selecting the IP
addresses and subnet masks. The IP address '0.0.0.0' stands for all computers in the network, and the subnet
mask '0.0.0.0' for all networks.

14.2.5 Dynamic DNS

Systems with dynamic IP addresses become accessible over the WAN - for example over the Internet - via so-called
Dynamic DNS service providers, e.g. www.dynDNS.org.

Thereby a LANCOM becomes available under a certain DNS-resolvable name (FQDN -'fully qualified Domain Name',
for example "http://MyLANCOM.dynDNS.org").

The advantage is obvious: If you want to accomplish e.g. remote maintenance for a remote site without ISDN avai-
lable (e.g. over WEBconfig/HTTPS), or to connect with the LANCOM VPN Client to a branch office with dynamic IP
address, then you just need to know the appropriate Dynamic DNS name.

How to deposit the current IP address at the Dynamic DNS server?

All Dynamic DNS provider support a set of client programs, which can determine the current assigned WAN [P
address of a LANCOM via different methods (1), and transfer this address - in case of a change - to their respective
Dynamic DNS server (2).

server at DynDNS provi- PC with DynDNS

der client program
LANCOM

The current WAN IP address of a LANCOM can be picked under the following address:
http://<address of LANCOM>/config/1/6/8/3/
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IP detection settings x|
Check IP every |3DU 3: ser.
‘wWarning: Remote IP detection won't accur less than every 10 minutes Cancel
[¥ Enable detection or local machine

URL [http:#/

[http://directupdate free.fi/check_ip.php3
[ Thitp:/¢checkip. dyndns.orgd

[ Thttp /v binorge ol P2y ourl P cgi ¥ Enatle

[Ihttpe#/upsps de/dyndns/check_ip php3 [~ Can be moved to presarve bandwidth
[ Thttp: /v dnsart. com/myip.php
[ Ihttp://dyrupdate. no-ip. comdip. php X 5
[Thttp:/fupdate. dynu.com/basicipcheck. asp ¥ Requirss aulherticalion

[ http: /v dsart com: 7777 /myip. php I—
[ Ihttp: /¢checkip. dyndns.org: 8245/ Usermiame :

I | Use prosp senver

Idove down | tfove up

Alternatively the LANCOM can directly transmit the present WAN IP to the DynDNS provider.

server at DynDNS provi-
der

LANCOM

The required settings can be changed comfortably with the Setup Wizard:
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Setup Wizard for 1621 AnnexB x|
Setup Wizard for 1621AnnexB +3
Configure Dynamic DNS
This wizatd suppotts you to configure the automatic refresh of a DNS acoount
The tefiesh is pertormed svery time your device establishs a connection and can be
configured for each remole site separately
Fo i you chould aleady have confiqured a ERSmS— PSP Tyw——" x|
registered damain and an account with one ol
pioviders Setup Wizard for 1621AnnexB +4
Dynamic DNS provider: DyrDNS.org Configure Dynamic DNS
NodP.com ; ; ]
Do Enter the fully quallied damain name (FADN) for which the DNS update should be
AN perfomed
P DN resolvable name mylancem dyndns.crg
a’;g}’j@i il Please enter your DNS account dats here
- |DHS.om These data should have besn given ta you by your DRS pravider when your dynamic
[DyhSen DNS account was set up.
5 User name lancom
Password: [

< Back Newt > Cancel
h;I

14.3 Call charge management

The capability of the router to automatically establish connections to all desired remote sites and to close them again
when no longer required provides users with extremely convenient access, e.g. to the Internet. However, quite sub-
stantial costs may be incurred by data transfer over paid lines if the router is not configured properly (e.g. in the filter
configuration) or by excessive use of the communications opportunities (e.qg. extended surfing in the Internet).

To reduce these costs, the software provides various options:
> The available online minutes can be restricted to a specific period.
> For ISDN connections, a limit on time or charges can be set for a particular period.

14.3.1 Connection limits for DSL and cable modem

Even though a DSL or cable modem connection behaves like a leased line, which is always online, depending on the
provider connection charges can be accounted by the time.
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@ lIn this section all connections over a ethernet WAN port of the LANCOM, e. g. cable modem connection,
= will be referred as DSL connection.

To limit the costs, the maximal connection duration can be controlled with time, by arranging a time limit for DSL
connections for a period of time. By default the DSL connections can only be used for a maximum of 600 minutes
in six days.
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% If the limit is reached, all DSL connections are automatically terminated. As soon as the current period has
~ passed the time count is reset and the connection enabled. The administrator can of course reset the time
count and enable the connection beforehand.

@ If the connection has a charge limit and a short hold of '0' or '9999" seconds, the charge control is switched
off and the connection is kept even if the limit is exceeded.

If in an exceptional case you would like to extend the online budget, e.g. to download a large file from the internet,
you do not necessarily have to change the time limit. In this case you can manually reset the limit.

Klick with the right mouse button on the error in LANmonitor and select in the menu the entry ‘Reset Charge And

Time Limit'
ﬁf LANmonitor ;Iglll
File Device View Tools Help
<ol ol kalsal o] o||w® = x| =

Refresh
Delete

Wigw WPN Connections
i Wiews Accounting Information
ﬁ Wireles ‘Wiew Firewall Event Log
@ Firowal  Miew Device Activities jected
Eo System Device Activities Logging ...
RS Reset Charge And Time Limits ...
% W Options. .,
?f: W, ,
g Total charge: O units

(\3 If you cannot see the system information in LANmonitor, activate the view with View » Show Details »
~  System Information.

In WEBconfig and Telnet the commands to activate the additional time limit are as follows:
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WEBconfig Experte Configuration P> Setup P> Charges-module P> Activate-additional-budget

Terminal/Telnet cd /Setup/Charges-module
do activate-additional-budget

The additional time limit is activated for the current period, in the following period normal time limit is set.
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14.3.2 Charge-based ISDN connection limits

If charge information is sent to an ISDN connection, the resulting connection charges can be limited quite easily. For
example, in its default state, a maximum of 830 charge units may be used in six days. The router will not permit the
establishment of any further connections once this limit has been reached.

@ The best way to use the router's call charge monitoring function is if you have “call charge information enab-

=~ led during the connection” to the ISDN network (i.e. AOCD). If necessary, subscribe to this facility from your
telecommunications carrier. Charge monitoring with the “Charge information after connection” feature is
also possible in principle, but in this case continuous connections may not be detected!

@ If you have enabled least-cost routing on the router modules, connections may be established to providers
who do not transmit any charge information!

14.3.3 Time dependent ISDN connection limit

However, this mechanism of ISDN connection monitoring will not work if the ISDN connection does not provide
charge information. That may be the case, for example, if the provision of charge information was not requested for
the connection, or if the telecommunications provider generally does not supply this information.

To reduce the costs of ISDN connections even if no call charge information is available, maximum connection lengths
based on time can be requlated. This requires setting up a time budget for a specified period. In the router's default
state, for example, connections may only be established for a maximum of 210 minutes within six days.

% When the limit of a budget is reached, all open connections that were initiated by the router itself will be
shut down automatically.The budgets will not be reset to permit the establishment of connections until the
current period has elapsed. Needless to say, the administrator can reset the budgets at any time if required!

The charge and time monitoring of the router functions can be disabled by entering a budget of 0 units or 0 minutes.

( Only the router functions are protected by the charge and time monitoring functions! Connections via
LANCAPI are not affected.
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14.3.4 Settings in the charge module

LANconfig Management »> Costs
WEBconfig Expert Configuration P> Setup »> Charges-module
Terminal/Telnet cd /setup/charges-module

In the charges module, the online time can be monitored and used to control call establishment.

» Day(s)/Period
The duration of the monitoring period in days can be specified here.

> Budget units, Online minutes budget
The maximum number of ISDN units or online minutes in a monitoring period

The current charge and connect-time information is retained when rebooting (e.g. when installing new firm-
ware) is not lost until the unit is switched off. All the time references here are in minutes.

14.4 The SYSLOG module

The SYSLOG module gives the option of recording accesses to the LANCOM. This function is of particular interest to
system administrators, because it allows a full history of all activities to be kept.

To be able to receive the SYSLOG messages, you will need an appropriate SYSLOG client or daemon. In UNIX/Linux
the SYSLOG daemon, which is installed by default, generally does the recording. It reports either directly through the
console or writes the protocol to a SYSLOG file.

In Linux the file /etc/syslog.conf directs which facilities (this expression will be explained later) should be written
to which log file. Check in the configuration of the daemon whether network connections are explicitly monitored.
Windows does not have any corresponding system functions. You will need special software that fulfills the function
of a SYSLOG daemon.
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14.4.1 Setting up the SYSLOG module

LANconfig

Management P> Log & Trace

WEBconfig

Expert Configuration > Setup P> SYSLOG-module

Terminal/Telnet

cd /setup/SYSLOG-module

14.4.2 Example configuration with LANconfig

Create SYSLOG client
(1 Start LANconfig. Under ‘Management', select the 'Log & Trace' tab.

(2 Turn the module on and click SYSLOG clients.
(@ In the next window click Add....
(4) First enter the IP address of the SYSLOG client, and then set the sources and priorities.

SYSLOG clients - New Entry ed e

IP address:

Source:

v System

v System kime
¥ Connections
[ admiristration
Priority:

v alert

v ‘\Warning

" Debug

|10.1.0.160 oK

v Login
™ Console login

r Accounting
[ Router

Iv Error
¥ Information

SYSLOG comes from the UNIX world, in which specified sources are predefined. LANCOM assigns its own internal
sources to these predefined SYSLOG sources, the so-called “facilities”.
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The following table provides an overview of the significance of all news sources that can be set in the LANCOM.
The last column of the table also shows the alignment between the internal sources of the LANCOM and the
SYSLOG facilities.

System system messages (boot processes, timer system etc.) KERNEL

Login messages regarding login and logout of a user during the PPP negotiation and errors occurring | AUTH
during this process

System time messages regarding changes to the system time CRON

Console login messages regarding console logins (Telnet, outband, etc.), logouts and errors occurring during AUTHPRIV
this process

Connections messages regarding establishing and releasing connections and errors occurring during this pro- | LOCALO
cess (display trace)

Accounting accounting information after release of a connection (user, online time, transfer volume) LOCAL1

Administration messages regarding configuration changes, remotely executed commands etc. LOCAL2

Router regular statistics on the most frequently used services (sorted by port numbers) and messages LOCAL3
regarding filtered packets, routing errors etc.

The eight priority stages defined initially in the SYSLOG are reduced to five stages in the LANCOM. The following
table shows the relationship of alarm level, significance and SYSLOG priorities.

Alert All messages requiring the attention of the administrator are collected under this heading. PANIC, ALERT, CRIT

Error All error messages that can occur during normal operation without requiring administrative ERROR
intervention are sent to this level (e.g. connection errors).

Warning Error messages that do not affect normal operation of the device are sent to this level. WARNING

Information All tr‘nes)sages that are purely informative in character are sent to this level (e.g. accounting infor- | NOTICE, INFORM
mation).

Debug Transfer of all debug messages. Debug messages generate a high data volume and interfere DEBUG

with the normal operation of the device. They should therefore be disabled during normal ope-
ration and should only be activated for troubleshooting.

(5) After you have set all the parameters, confirm the entries with OK. The SYSLOG client is then entered with its
parameters into the SYSLOG table.

Facilities

All messages from LANCOM can be assigned to a facility with the Facility mapping button and then are written to
a special log file by the SYSLOG client with no additional input.

All facilities are set to ‘local7'. Under Linux in the file /etc/syslog.conf the entry
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local7.* /var/log/lancom.log

writes all outputs of the LANCOM to the file /var/log/lancom.log.

14.5 Time server for the local net

LANCOM routers can apply exact information of time either over ISDN or over public time servers on the internet
(NTP-Server with "Open Access’ policy). The LANCOM can then provide the detected time for all stations in the local
network.

14.5.1 Configuration of the time server under LANconfig

To provide the current time in the local network your LANCOM has to regularly apply the time from a time server. For
this so called real time clock klick in the configuration area ‘Date & time' on the tab 'Synchroniziation'. Under 'NTP
settings' open the list of time servers by clicking on the button Time Server ... With the button Add... you can
extend the list.

NHAMEL_HOME Configuration 2=l
Configure: |Date & Time: 'l

General Synchrorization | Time Serverl Public Holidaysl

Select the adjustment method for the implemented realtime clock:
" Noregular adiustment of the device time

" Adjustment whenever a connection is made to ISDN

' Synchronize to a time server using NTP at regular intervals

= r»%F' zetting:

Time Server ... | ‘
oo E 20
—Powe | Domain Mame or IP Address | Ok |
PTETIMEL.PTE.DE
If yau Cancel |
tirne
humk
2]
Fhon
Dialir z |
Add ... Edit ... | Remove |
Time Server - New Enktry ] 7| %
LANCOM _I_I
Systens
Mame or Address: I ﬂ K I
ptbtime2.pth.de Cancel |
nkps1-0.cs.tu-berlin.de

With these settings only the LANCOM applies the time from public time servers. To provide the real time for the
remaining device enable the local time server under the tab "Time Server'. Furthermore activate the broadcast mode
and enter the broadcast interval.
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NHAMEL_HOME Configuration 2=l
Configure: |Date & Time: 'l

Generall Synchronization  Time Server | Public Holidaysl

— Local time server

“rour device can serve as a local time server to which other
devices or stations can synchronize, Additionally it can send
the time in constant intervallz to all stations of your local
hetwork.

¥ Time server enabled

¥ Broadcast Mods

Broddcast Interval: |B4 seconds

14.5.2 Configuration of the time server with WEBconfig or Telnet

When configuring with WEBconfig or Telnet you can find the required parameters in the following areas:

WEBconfig Expert Configuration P> Setup P> NTP-module

Terminal/Telnet cd /Setup/NTP-Modul

14.5.3 Configuring the NTP clients

The NTP clients must be configured so that they use the time information from the LANCOM. Not all operating sys-
tems provide an integrated NTP client: Windows XP does so, for other Windows operating systems a separate NTP
client is required, Linux distributions have to be installed with NTP.

The settings of date and time in a XP system can be opened with a double click on the time at the bottum left, where
you can select the server for synchronization.
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Date and Time Properties 1 i |

Date & Time I Time Zone  Internet Time |
¥ automatically synchronize with an Internet time server

Server: ILC_VPN_internaI| j Update Mow |

The time has been successfully synchronized with time, windows,com on
1/28/2004 at 6:15 AM,

Mext synchronization: 2/4/2004 at 6:14 AM

Synchronization can occur only when your computer is connected to the
Internet, Learn more about time synchronization in Help and Support
Center,

OF Cancel Apply

14.6 Scheduled Events

Regular Execution of Commands

This feature is intended to allow the device to execute predefined commands in a telnet-like environment, at times
defined by the user. The functionality is equivalent to the UNIX cron service. Subject of execution can be any
LANCOM command line command. Therefore, the full feature set of all LANCOM devices can be controlled by this
facility.

Application examples:

» scheduled connection
Many leased lines disconnect automatically after 24 hours of continuous operation. This enforced disconnection
can have some unwanted side-effects for example if it happens to an unsuitable time during the day, because
e.g. the VPN tunnel is disconnected and the IP address of the LANCOM is changed. To control the disconnecting
time a manual disconnection can be set e.g. at midnight, so it can not happen at an unsuitable time.

As a second example devices with a distributed network with only dynamic IP addresses can build up a connec-
tion at a certain time to a VPN gateway, so that data can be transferred safely. This way a protected access is
even possible without an ISDN connection.

> time-dependant firewall or QoS rules

The firewall and QoS rules are at first temporally constant. But it can be useful to make variable settings for dif-
ferent daytimes or weekdays. At e. g. off-hours or weekends different priorities for garanteed bandwidths can
be set than at business hours.

» regular firmware or configuration updates
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Time-controlled rules do not only provide the settings of particular values, it is even possible to switch to a whole
different configuration. This possibility allows you to pool a whole string of settings and change them all at once
with one command. Therefore changing the configuration of the device with completely different values at the
weekend and switching back on monday mornings can be done with just one command.

Additionally the regular update of the newest firmware from one single source is adjustable.

> Email messages

With the time- controlled rules you have the option that the LANCOM informs the administrator by email not only
about specific firewall events, but even to set times. The email can e.g. inform about building up an internet
connection successfully after an enforced disconnection or after booting the device because of a restart.

> time-dependant interfaces

The time dependant use of interfaces for a set duration is also provided by the time-controlled rules. Therewith
e.g. a WLAN interface can permit the wireless access to the network only at certain times.

> Deleting certain tables

It can be useful to delete the content of some tables in LCOS regularly. If your internet access for example has a
monthly limited transfer volume, you can delete your accounting table monthly to have a servey of the present
transferred data volume.

14.6.1 The cron table

The parameters for the time-controlled rules are stored in the cron table with the following layout:

Index Unambiguously identifies this entry in the table

Base The Base field rules whether the time check is done against the device's operation time or the real time. Rules based on
real time are only executed if the device has acquired the current time, e.g. via NTP. For real-time based rules, all four columns
have a meaning, while operation-time based rules only take the minute/hour fields into account.

Minute The entries Minute to Month form a mask that lets the user define at which times a command will be executed. Entries
Hour in the mask field may be blank to mark that the respective component shall not be part of the compare operation; otherwise,
DayOfWeek | a field may contain a list of comma-separated items that may either be a single number or a number range, given as mini-
Day mum and maximum concatenated with a hyphen.

Month For the DayOfWeek field, the usual cron interpretation applies:

Sunday

Monday

Tuesday

Wednesday

Thursday

Friday

Saturday

U WN —=O

Command | The command itself may be a list of command line commands, separated by semicolons.
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(’ Realtime-controlled rules can only be executed if the device has a valid time reference e.g. via NTP ('Time
” server for the local net’ —page 292).

Examples:
Timebase Min. Std. W-Tage M-Tage Monate Befehl
Realtime 0 4 0-6 1-31 1-12 do /oth/man/disconnect internet
Realtime 59 3 0-6 1-31 1-12 mailto:admin@mylancom.de?subject=Enforced disconnec-
tion?body=Manual disconnecting the interface
Realtime 0 0 1 do /setup/accounting/Delete- Accounting-list
Realtime 0 18 1,2,34,5 do /so/man/connect HEADQUARTERS

> The first entry will enforce a disconnection to the internet provider every morning at 4 AM.

» The second entry will inform the admin every morning at 3:59 AM by email, shortly before the enforced discon-
nection.

> The third entry will delete on the first of every month the accounting table.
> The fifth entry will connect the device every weekday at 6 PM to the headquarters.

(‘ Time-controlled rules will not necessarily be executed at precisely zero seconds of real time.
Please note that the language of the commands must be identical to the set language of the console, oth-
erwise they will not be executed. The display language of your LANCOM is set to english by default. The lan-
guage can be changed if desired ('Change the language of the display.” —page 22).

14.6.2 Configuring the time-controlled rules

Under LANconfig you can find the Cron table in the configuration area ‘Date & Time' on the tab 'General':
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NHAMEL_HOME Configuration | ﬂll
Configure: |Date & Time: ‘l

General | Synchronizatl'onl Time Serverl Fublic Holidaysl

— Drate and time -
Timezone:
™ Daylight Saving”

r— Cran table

Define actions that a

Cron table

Time base | Minutes | Hours | Weekdays | Days | Months | Commands
Realtime D 4 06 131 1-12  do fobjmanjdisconnect internst

Realtme 0 i 1 do Jsetiaccountingfdelste

Cron table - New Entry 4 2 x|
4 Which time base should be used For the trigger:
&+ Real time k
Cancel |
" Operation time

Minutes: I i
Hours: I 4

Days of week: 0-6
Days: 1-31
Months: 1-12

LANCOM

Under WEBconfig

| Commands: I do fotfmandisconnect int

K ra

or Telnet you can find the Cron table as follows:

WEBconfig

Expert-Configuration P> Config-module P> Cron-table

Terminal/Telnet

setup/config-module/cron-table

Realtime 59 3 -6 1-31 1-12 mailta:admin@mylancam, de/subject=Disconnect hody=manual disconnect of inkernet line Cancel

[> Scheduled Events
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15 Appendix

15.1 Error messages in LANmonitor

[> Error messages in LANmonitor

It is possible to read out VPN error messages over the LANmonitor.

15.1.1 General error messages

Connection establishment failed (D-channel layer 1)

Bus activation failed

Connection establishment failed (D-channel layer 2)

no UA on SABME

Connection establishment failed (Layer 1)

a/b ports

Connection establishment failed (Layer 2)

alb ports

ISDN line error (Layer 1)

Cable not connected

Connection aborted (layer 2)

X.757V.110

Local error

Required resource not available -> ISDN problem; boot
telecommunications system

PP login at remote site - PAP rejected

Remote device can only handle PAP, but CHAP is required

PPP login from remote site - timeout (PPP-PAP RX)

Remote did not send PAP request

PPP login at remote site - timeout (PPP-PAP TX)

Remote did not respond to PAP request

PPP login from remote site - CHAP rejected

a CHAP reject was received after a CHAP challenge

PPP login from remote site - timeout (PPP-CHAP RX)

Remote did not send CHAP response

PPP login at remote site - timeout (PPP-CHAP TX)

Remote did not respond to CHAP response

Time limit exceeded

exactly like fee limit... .

Connection establishment failed (Layer 1)

no HDLC flags found

Connection establishment failed (Layer 2)

X.75/V.110 not working

DSL line error (Layer 1)

15.1.2 VPN error messages

Appendix

Cable not connected

(‘ For correct evaluation of error messages for VPN connections, at least LCOS version 3.22 must be installed

on both LANCOM devices.

A VPN connection is always either an outgoing or an incoming connection. To make searching for the error faster
and more efficient, the error messages are different for the initiator and the responder. The initiator is the remote
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device which initiates the connection. The responder is the device which receives the connection. After the error
message is read out, look in the appropriate menu item on the corresponding remote.

Example:

For the error message 'IKE or IPSec establishment timeout (Initiator)', no direct error can be determined. The
responder, however, has determined an error like ‘No proposal matched (Responder, IPSec)', which it send to an
SNMP client (LANmonitor) using an SNMP trap. Using this error message, the corresponding parameter in the
configuration can be checked and changed if necessary. Thus is it always necessary to verify the error messages on

both sides.

License exceeded - no more VPN tunnels
available (Responder, IKE)

The maximum number of possible VPN channels has been
reached.

No route to remote gateway

The router to the remote gateway could not be found. Please
check the the public IP address or the DynDNS name of the
remote device.

Dynamic VPN - no PPP table entry matched

In dynamic VPN, the outgoing call could not be authenticated
with the PPP data sent. Please check the PPP username and
PPP password on both sides under "Configure -->
Communication --> Protocols --> PPP list --> Remote site".

Dynamic VPN - no PPP table entry matched

The incoming call cannot be authenticated with the PPP data
received. Please check the PPP username and PPP password on
both sides under “Configure --> Communication --> Protocols
--> PPP list --> Remote site".

IKE or IPSec establishment timeout

A time limit was reached. The router on the remote side is no
longer responding. Please check the VPN error message in the
LANmonitor on the remote device.

Line polling to remote gateway failed

The LCP polling failed. Please check on the remote device
whether ping blocking is enabled in the firewall menu under
"Configure --> Firewall --> General --> Ping blocking"

No entry in polling table and keep alive in
configured

The holding time of the VPN tunnel under "Configure --> VPN
--> Connection list --> Names" is set to Short hold (9999 sec).
However, the required ICMP polling is missing. Please add
them under "Configure --> Communication --> Remote Sites -
-> Polling Table". As remote site, enter the VPN remote device,
for the IP address enter an IP address from the LAN at the
remote site.

Dynamic VPN - predefined charge limit
exceeded

The fee limit under "Configure --> Costs --> Fees - Limit
(ISDN)" was reached. Please reboot the device.

Dynamic VPN - preset time limit exceeded

The time limit under "Configure --> Costs --> Time limit
(ISDN)" was reached. Please reboot the device.

Dynamic VPN - no ISDN call number for
negotiator channel

The ISDN call number for the remote device for dynamic VPN is
missing. Please enter the call number under "Configure -->
Communication --> Remote sites --> Name list (ISDN) -->
Name".
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Dynamic VPN - Multiple connections on
ISDN interface for negotiator channel not

While establishing multiple ISDN connections, a limit was
reached. Please check under "Configure --> Management -->

Appendix

allowed Interfaces --> Interface Settings --> ISDN --> Max. outgoing
calls".

Predefined charging limit exceeded X The fee limit under "Configure --> Management --> Costs -->
Charge limit (ISDN)" was reached. Indicated by a synchronized
blinking of the Power LED.

Predefined time limit exceeded X The time limit under "Configure --> Management --> Costs --
> Time Limit (ISDN)" was reached. Indicated by a synchronized
blinking of the Power LED.

No IP address for PPTP server X The IP address of the PPTP selected has not been entered.
Enter the IP address under "Configure --> Communication -->
Protocols --> PPTP list". Also see .

Exchange type mismatch (Main or x (IKE) The exchange type does not match that of the remote device.

Aggressive mode) Please check the value under "Configure --> VPN -->
Connection list --> Edit VPN remote site entry --> IKE
Exchange”

No proposal matched X (IKE) The IKE proposals do not match. -- > Check VPN rules

No proposal matched x (IKE) The IKE proposals do not match. -- > Check VPN rules

IKE group mismatch x (IKE) Please check the IKE groups on both sides under "Configure --
> VPN --> Connection parameters --> VPN remote site
identification --> IKE Group"

Life type unsupported (other than Kbytes or X (IKE) The value for the lifetime is not supported. Please use a life

seconds?) type in “sec = seconds" or "kb = kilobytes". Check this entry
under "Configure --> VPN --> Parameters --> Lifetime"

Lifetime mismatched X (IKE) The lifetime specified does not match that of the remote
device. Check this entry under "Configure --> VPN -->
Parameters --> Lifetime"

ID type value unsupported (other than IP X (IKE) False entry of identity. Please correct your entry under

network, domain, or email) "Configure --> VPN --> IKE --> IKE key"

ID type mismatch (e.g. IP network, domain, x (IKE) The two sites are using different identities. Compare the

or email) identification at both sites under "Configure --> VPN --> IKE -
-> IKE key"

No rule matched ID - unknown connection x (IKE) The incoming VPN connection could not be assigned to a

or wrong ID (e.g. remote gateway remote device.

definition)

IKE key mismatch x (IKE) Please compare the preshared keys under “Configure --> VPN
--> IKE --> IKE key"

IKE key mismatch X (IKE) Please compare the preshared keys under “Configure --> VPN
--> KE --> IKE key"

Out of memory X (IKE) The number of VPN connections has overloaded the device's

memory. To maintain the stability of the device, no further VPN
connections should be established.
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Out of memory x (IKE) The number of VPN connections has overloaded the device's
memory. To maintain the stability of the device, no further VPN
connections should be established.

No rule matched IDs - unknown connection x (IKE) The incoming VPN connection could not be assigned to a

or wrong ID (e.g. IP network definition) remote device. Please check the following parameters: ID type
does not match (see this document), incorrect network
definition, VPN rules do not match (see VPN RULES).

No proposal matched X (IPsec) X (IPsec) The devices cannot agree on a matching proposal. Please
check the settings under "Configure --> VPN --> IKE --> IKE
Proposals" and under "Configure --> VPN --> IPSec
parameters --> IPSec proposal lists".

IPSec PFS group mismatch Please check the PFS (Perfect Forward Sequence) under
"Configure --> VPN --> Connection parameters --> VPN
remote identification --> PFS Group"
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[> SNMP Traps

coldstart

Device was restarted by switching power off and on.

warmstart

LCOS was restarted, for instance by a software reboot

authentication failed
(= console login failed)

Login failed during access to the configuration

Firmware upload started

Firmware upload was started

Configuration upload started

The reading of the firmware or configuration was started

Upload succeeded

The reading of the firmware or configuration was successful

Upload failed (timeout)

The reading of the firmware or configuration failed: maximum time was exceeded

Upload failed (incomplete)

The reading of the firmware or configuration failed: incomplete configuration

Upload failed (bad device)

The reading of the firmware or configuration failed: wrong device

Configuration download started

Output of the configuration was started

Download succeeded

Output of the configuration was successful

Console login

Login to configuration successful

Console logout

Logout from configuration was successful

Firewall trap

Information about a firewall event

Connection status

WAN connection status

VPN Connection status

Status of VPN connection

WAN-Ethernet UP/DOWN

WAN interface available or not available

WLAN Scan started

Access point or client | The WLAN station has started a scan for free radio channels

Started WLAN BSS ID

Access point The WLAN station has created a new radio cell

Joined WLAN BSS ID

Client The WLAN station has found a radio cell

Authenticated WLAN station

Access point The authentication of a client WLAN station was successful

Deauthenticated WLAN station

Access point The client WLAN station has signed off

Associated WLAN station

Access point Client WLAN station connected

Reassociated WLAN station

Access point Client WLAN station has reconnected, was previously signed in to another

access point

303

Appendix




» Chapter 15: Appendix LANCOM Reference Manual LCOS 3.52

> SNMP Traps

RADIUS access check for WLAN | Access point Checking of RADIUS access to the WLAN station was successful
station succeeded

RADIUS access check for WLAN | Access point Checking of RADIUS access to the WLAN station was unsuccessful
station failed

Disassociated WLAN station due | Access point WLAN station was signed off due to a request from the station

to station request

Rejected association from WLAN | Access point The sign on of the WLAN station was rejected

station

WLAN card hung, resetting Access point or client | WLAN card stopped, reset
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15.3 RFCs supported

1058 Routing Information Protocol

1331 The Point-to-Point Protocol (PPP) for the Transmission of Multi-protocol Datagrams over Point-to-Point Links

1334 PPP Authentication Protocols

1389 RIP Version 2 MIB Extensions

1483 Multiprotocol Encapsulation over ATM Adaptation Layer 5

1542 Clarifications and Extensions for the Bootstrap Protocol

1552 The PPP Internetworking Packet Exchange Control Protocol (IPXCP)

1577 Classical IP and ARP over ATM

1631 The IP Network Address Translator (NAT)

1877 PPP Internet Protocol Control Protocol Extensions for Name Server Addresses

1974 PPP Stack LZS Compression Protocol

2284 Extensible Authentication Protocol

2104 HMAC: Keyed-Hashing for Message Authentication

2131 Dynamic Host Configuration Protocol

2132 DHCP Options and BOOTP Vendor Extensions

2225 Classical IP and ARP over ATM

2364 PPP Over AALS

2401 Security Architecture for the Internet Protocol

2402 IP Authentication Header -
2403 The Use of HMAC-MD5-96 within ESP and AH *§
2404 The Use of HMAC-SHA-1-96 within ESP and AH §
2405 The ESP DES-CBC Cipher Algorithm With Explicit IV ~
2406 IP Encapsulating Security Payload (ESP)

2407 The Internet IP Security Domain of Interpretation for ISAKMP

2408 Internet Security Association and Key Management Protocol (ISAKMP)

2409 The Internet Key Exchange (IKE)

2410 The NULL Encryption Algorithm and Its Use With IPsec

2412 The OAKLEY Key Determination Protocol
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2451 The ESP CBC-Mode Cipher Algorithms
2516 A Method for Transmitting PPP Over Ethernet (PPPoE)
2684 Multiprotocol Encapsulation over ATM Adaptation Layer 5
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> Glossary

802.11

Wireless LAN specification of the IEEE; data rate up to 2 Mbps; in 2.4 GHz ISM band; FHSS and DSSS; infrared
spectrum communications also planned

802.11a

Extension to 802.11; data rate up to 54 Mbit/s; in 5 GHz band; OFDM

802.11b

Extension to 802.11; data rate up to 11 Mbit/s; in 2.4 GHz band; high market penetration; DSSS/CCK

802.11g

Extension to 802.11; data rate up to 54 Mbit/s; in 2.4 GHz band; OFDM and DSSS

802.11h

802.11a customization, data rate up to 54 Mbit/s; in 5 GHz band; in area of transmission power and frequency
management; for use in Europe; OFDM

802.11i

Future 802.11 extension with additional security features

802.1x

Specification of a port-based authentication mechanism from the IEEE

AES

Advanced Encryption Standard

Access point

Base station in a wireless LAN; independent LAN-WLAN bridge; connects stations of a LAN (local network) with a
WLAN (wireless network) in a point-to-multipoint mode; connects two networks over a wireless network in point-to-
point mode

Access router

Active network component for connection of a local network to the Internet or a company network

ADSL

Asymmetrical Digital Subscriber Line - transmission process for high-speed data transmission over normal telephone
lines. With ADSL, transmissions (downstream) of up to 6 Mbps can be implemented over normal telephone lines; for
bidirectional transmission there is a second frequency band with transmission speeds of up to 640 kbps (upstream) -
hence the name "asymmetric".

Bandwidth

Data rate with which a user can surf the Internet; the higher the bandwidth, the faster the connection

Broadband

Service which provides high bandwidth; e.g.: DSL or WLAN

Bridge

Transport protocol-independent, transparent network component; transmits all packets which are identified as "not
local" and only understands the difference between "local" and "remote”. Works on Layer 2 of the OSI model

Broadcast

Broadcasts are packets to all stations of a local network; bridges transmit broadcasts; routers do not transmit
broadcasts

BSS

Basic Service Set

CAPI

Appendix

Common ISDN Application Programming Interface - CAPI is a standard for control of ISDN adapters

K

Code Complementary Keying; type of modulation used by DSSS

Client

Any computer equipped with a wireless LAN adapter (wireless LAN card), which uses services provided by other
participants in the wireless network

CSMA/CA

Carrier Sense Multiple Access with Collision Avoidance; access procedure to the radio channel used under 802.11

CRC

Cyclic Redundancy Check; process for detecting bit errors

Data throughput

Speed at which you can surf on the Internet; depends on the bandwidth and the number of users

DHCP

Dynamic Host Configuration Protocol
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DNS Domain Name Service - computers communicate with computers in remote networks using IP addresses; DNS
servers translate names into IP addresses; without DNS servers, you would have to remember all [P addresses and
couldn't work with names (e.g. www.lancom.de)

Domain area of network closed to outside; => Intranet
Download / Download / downstream denotes the direction of dataflow in a WAN. Downstream is the direction from the head end
Downstream or Internet to the participant connected to the network.
DS Distribution System
DSL Digital Subscriber Line - DSL procedures include all procedures for digital-broadband use of telephone lines, such as
ADSL, HDSL, SDSL, VDSL and so on, which are also called xDSL.
DSSS Direct Sequence Spread Spectrum; code multiplex -- band spreading process
Dynamic DNS IPsec-VPN implementation which allows the transparent connection of local networks into a VPN solution, even
when their routers work with dynamic addresses (dial-up)
EAP Extensible Authentication Protocol
EAP-MD5 EAP variant which uses password for one-sided authentication
EAP-TLS EAP Transport Layer Security; EAP variant which uses certificates for mutual authentication
EAP-TTLS EAP Tunneled Transport Layer Security; EAP variant which uses certificates for mutual authentication
EIRP Effective Isotropic Radiated Power
ESS Extended Service Set
ESSID Extended Service Set Identity; “network name" of the wireless LAN
Ethernet Strand or star-formed physical transport medium; all stations can send simultaneously; collisions are detected and
corrected through the network protocol
FHSS Frequency Hopping Spread Spectrum; frequency skipping band spread procedure
Firewall Protective mechanism for an Intranet against attacks from outside
X Frequency Number of oscillations per second (given in Hertz; 1 Hz = 1 oscillation per second; GHz = Gigahertz = 1 billion Hertz
g or oscillations per second)
qé FTP File Transfer Protocol enables data transfer between different systems and simple file manipulation; FTP is based on
< the TCP transmission protocol
Frequency band Contiguous frequency range which has the same transmission properties
Radio frequency Every radio application uses globally regulated radio frequencies
Gateway Network component which provides access to other network components on a layer of the => OSI model. Packets
which do not go to a local partner are sent to the gateway. The gateway takes care of communication with remote
networks.
Hub Network component; distributor; collector; also used to translate from one connection type to another
HotSpot Locally limited wireless network with a base station with Internet access; public wireless Internet access
IAPP roaming Roaming between the cells of a wireless network using IAPP (Inter Access Point Protocol)
IBSS Independent Basic Service Set
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IDS Intrusion Detection System -- earliest possible detection of attacks on the network
IEEE Institute of Electrical and Electronics Engineers, New York - www.ieee.org
IP Internet Protocol

IP masquerading

Combination of PAT (Port Address Translation) and NAT (Network Address Translation) from LANCOM Systems
process used for connection of an intranet (multiple workstations) to the Internet over a single IP address;
simultaneously, the internal computers are protected from attacks from outside

IPSec

Internet Protocol Security

IP Quality of Service

These functions give precedence to enterprise-critical applications, particular services, or user groups

ISDN

Integrated Services Digital Network -- fast connection; two independent channels; higher transmission rates than
analog (up to 128 Kbit/s); uses the old analog lines; comfort features (call forwarding, callback on busy, etc.);
supports both analog and digital services

Appendix

ISM frequency band | Industrial-Scientific-Medical, license-free frequency bands which can be used for industrial, scientific, and medical
purposes.

ISP Internet Service Provider -- service provider with a connection to the Internet (backbone) who provides connection
points for end customers

Lcos LANCOM Operating System - uniform operating system for LANCOM products

LAN Local Area Network - local network limited to one site

LANcapi Virtual CAPI which is provided over the network; with LANcapi, which is implemented in all LANCOM routers with
ISDN interfaces, a PC connected to the LAN can use ISDN telematic services

LANconfig Software for configuration of LANCOM devices under Windows

LANtools Diverse, user-friendly set of tools for the management and monitoring of LANCOM products and systems

MAC Media Access Control; radio access protocol on 1SO Layer 2 data link; it defines packet format, packet addressing,
and error detection

MAC address Serial number of a network component which is assigned by the manufacturer

Mbit Megabit: standard unit for the specification of data quantities in the context of bandwidths

MIC Message Integrity Check, cryptographic integrity protection mechanism

NetBios Network Basic Input/Ouput System. Non-routable network protocol for local networks developed by IBM and later
taken over by Microsoft.

NTBA Network Termination Basic Adaptor . The NTBA (network termination adapter) is responsible in an ISDN base
connection for the translation of the connection created by the telephone company to the SO bus.

OFDM Orthogonal Frequency Divison Multiplex

PEAP Protected EAP, EAP variant for mutual authentication

PKI Public Key Infrastructure

PPP Point to Point Protocol: network protocol for connections between two computers. PPP is based on TCP/IP.

PPTP Point to Point Tunneling Protocol: Network protocol for the construction of virtual private networks over the Internet.
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Point-to-Multipoint
(WLAN)

Multiple WLAN stations log into a base station and constitute a common network with the wired stations

Point-to- Point

Two base stations connect two wired networks over WLAN; point-to-point operation enables coupling of networks

(WLAN) even across streets without cables

QoS Quality of Service (see also IP Quality of Service)

RADIUS Remote Authentication Dial-In User Service; authentication and monitoring protocol on the application level for
authentication, integrity protection, and accounting for network access

RC4 Streaming cipher process by Ron Rivest, “Ron's Code"

RFC Request for Comments

Router Intelligent network components; comparable with a post office, which can determine from the logical destination
address of a packet which next network component should transmit the packet; knows the overall topology of the
network

SDSL Single Line Digital Subscriber Line - downstream and upstream with 2.048 Mbit/s (two-strand wire)

Server Computer which provides services over the network (e.g. files, news, email, WWW pages)

SINA Secure Inter-Network Architecture

SMTP Simple Mail Transfer Protocol - SMTP protocol is the Internet standard for distribution of electronic mail; the protocol
is based on the TCP protocol

SNMPv3 Simple Network Management Protocol Version 3

SSID Service Set Identity; “network name" of the wireless LAN

SSL Secure Socket Layer

Splitter The splitter is comparable with an audio frequency filter; in an ADSL connection, the splitter separates the ISDN
signals from the DSL signals; the ISDN signals go to the NTBA and the DSL signals go to the DSL modem

Switch A central distributor in a star-shaped network; each station has the entire bandwidth available; if a station fails, the
rest of the network is not affected; is used for collision prevention; increases the overall throughput of the network;
switches are cascadable

TAE Telephone connection unit used in Germany. Plug for the connection of analog devices like a telephone or modem
into the telephone network.

TCP/IP Transmission Control Protocol/Internet Protocol; family of protocols (ARP, ICMP, IP, UDP, TCP, HTTP, FTP, TFTP) used
mainly in the Internet, although it is making headway in intranets as well

TKIP Temporal Key Integrity

TLS Transport Layer Security

TPC Transmission Power Control

Upload/Upstream Upload / upstream denotes the direction of dataflow in a WAN; upstream is the direction from the node connected to
the network to the head end/Internet

Chaining Concatenation of bit sequences

VPN Virtual Private Network - a VPN is a network consisting of virtual connections over which non-public or company

internal data can be transmitted securely, even if public network infrastructures are used
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WAN

Wide Area Network - network connection over long distances (e.g. over ISDN with a LANCOM router)

WECA

Wireless Ethernet Compatibility Alliance; alliance of manufacturers of wireless LAN components based on |EEE
802.11; renamed the WiFi Alliance

WEBCconfig

Web-based configuration interface for LANCOM devices.

WEP

Wired Equivalent Privacy

WiFi

Wireless Fidelity; marketing concept generated by the WECA

WiFi-Alliance

Alliance of manufacturers of wireless LAN components based on IEEE 802.11; formerly the WECA

WLAN

Wireless Local Area Network - local radio network

WPA

WiFi Protected Access; name for security mechanisms beyond IEEE 802.11; generated by the WiFi Alliance

WISP

Wireless Internet Service Provider

XDSL

xDSL stands for the family of Digital Subscriber Line technologies

XOR

Logical operation "exclusive OR"

Appendix
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15.5 Overview of functions for LANCOM models and LCOS* versions

Stateful Inspection 2.80 2.80 2.80 J J/ 2.80 2.80 J J/ J/ 2.80 2.80 2.80 2.80 J/ 2.80 2.80 2.80 2.80 2.80 2.80
DoS 2.80 2.80 2.80 V4 V4 2.80 2.80 V4 V4 V4 2.80 2.80 2.80 2.80 V4 2.80 2.80 2.80 2.80 2.80 2.80
IDS 2.80 2.80 2.80 J J/ 2.80 2.80 J J/ J 2.80 2.80 2.80 2.80 J/ 2.80 2.80 2.80 2.80 2.80 2.80
Extended IP QoS 3.30 3.30 3.30 3.30 V4 3.30 3.30 V4 V4 V4 3.30 3.30 3.30 3.30 V4 3.30 3.30 3.30 3.30 3.30 3.30
N:N Mapping 3.30 3.30 V4 330 V4 3.30 3.30 3.30 3.30 V4
VLAN 3.30 J/ 3.30 J/ 3.30 3.30 3.30 3.30 3.30
DMZ port ) 1) 1) 1 ) ) 1) V4 )
AES, 3-DES, DES, Blow- 332 3.32 332 2) 2)
fish, CAST v v v v v v v
VPN-5 Option integriert | integriert integriert integriert ab integriert
ab 3.32 ab 3.32

VPN-25 Option V4 V4 V4 V4 V4
VPN Hardware in Verbindung | in Verbindung | in Verbindung J/
Acceleration mit VPN-25 mit VPN-25 mit VPN-25
VPN-100 J/
VPN-200 4

< Ve v

2 ADSL Mod

> odem v/ /9 v/ v

QL

% 4 Port Switch V4 V4 V4 / V4 / V4 /
ISDN Leased Line Option V4 V4 V4 V4 V4 V4 / V4 V4 V4 integriert integriert integriert integriert V4 V4
Faxmodem Option J/ - - - - - - - - - - integriert J/ - - - V4 J/ - -
Dynamic DNS 3.10 3.10 3.10 V4 V4 3.10 3.10 V4 V4 V4 3.10 3.10 3.10 3.10 V4 3.10 3.10 3.10 3.10
DSLoL 3.10 J/ 3.10 J/ 3.10 3.10 3.10 3.10
CRON 3.10 3.10 3.10 V4 V4 3.10 3.10 V4 V4 V4 3.10 3.10 3.10 3.10 V4 3.10 3.10 3.10 3.10 3.10 3.10
802.11b v/ 4 v/ 4 v v/ 4 4 v/ v/ 4
802.11g v/ v/ v v/ v v/ v/
802.11a (inkl. 108 Mbit/s
Turbo Mode) v v v v
Multi-SSID 3.42 3.42 3.42 3.42 3.423) 3.42 3.42 3.42 3.42 3.42 3.42
IP-Redirect 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42
Super A/G (108 Mbit/s 3.42 3.42 3.42 3.42 3.429 3.42 3.42
802.11a/g Turbo-Mode &
Bursting)
DHCP Auto Client Modus 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42
802.11i with HW-AES 3.50 3.50 3.50 3.50 -13.50 3.50 3.50

* Numbers in the table show the LCOS version, with which the feature was implemented.
1

2

) Port Seperation (Private Mode)

) onl it VPN option is activated in both devices

3) not with in conjunction with 802.11b WLAN cards
4 optional VPN 500 and VPN 1000

5 compatible to ADSL and ADSL2
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Numerics
1:1 mapping
3 DES
3-DES
4-Port Switch
802.11
802.11a
802.11b
802.11g
802.11h
802.11i
PMK caching
VolP
802.11x
Rekeying

A

AAL-5

Access Control List

Access point

Access protection
by name or number
by number
for the configuration
via TCP/IP

Access router

Address administration
IP address administration

Address pool

ADSL

ADSL-Modem

AES

AES-CCM

Aggressive mode

AH

Antenna gain

AOCD

ATM

ATM adaptation layer

176,

228,

44,

176, 205, 229, 307,

176, 204,

77
206
312
312
307
307
307
307
307
307
236
236
307
233

84
239
307

55

55

55

54

50
307

273
275
307
312
312
235
176
206
251
288

44

84

Authentication
Authentication process
TLS
TTLS
auto reconnect

B
Bandwidth
B-channel
protocol
B-Kanal-Protokolle
Blowfish
Bonk
Bridge
Broadband
Broadcast
Brute force
BSS

C
Call charge
information
limit
management
Callback
according to RFC 1570
Fast callback
for Microsoft CBCP
Callback procedure
fast callback
Caller ID
Calling Line Identifier Protocol
Capab.
CAPI
CAPI Faxmodem
CAPI interface
CAPI Protocols
CAST
CCK
Chaining

88, 91, 229, 231

233
233
90

307

56

271

176, 206, 229
147

307

307

307

50

307

288

286

266, 286
55, 56
92

56

90

91
55
56
278
307
270
266
271
176, 206
307
310

313
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Channel bundling
dynamic
static
Charge limiting
Charges
information
units
Client
Client mode
CLIp
Collision domain
Command line interface
Command line reference
Common ISDN Application
Programming Interface (CAPI)
Computer names
Configuration
procedure
SNMP
Configuration files
Configuration interface
Connection limit
Cost reduction
CRC
CRON
cron service
cron table
CSMA/CA

D

D channel

Data compression procedure
LZS

Data throughput

Data transfer

Denial of Service attacks
Bonk
Ping of Death
Teardrop

Denial-of-Service- Angriffe
Fragrouter

314

93
93
93
288

93

93, 288
307

227, 252
56

211

22

22

266
278
88
15
24
28
15
288
286
307
312
294
295
307

44, 56

93
307
93

147
147
147
145
147

LAND
Smurf
SYN Flooding
DES
Device-name
DHCP
broadcast address
DHCP server
mode 274
DNS and NBNS server
for WINS resolution
mode
network mask
period of validity
standard gateway
Dial-Up Network
Dial-Up Networking
Differentiated Services —
see DiffServ

Differentiated Services Code Point —

see DSCP
Diffie- Hellman method
DiffServ
Assured Forwarding
Best Effort
Class Selector
Expedited Forwarding
IPSec
Distance of a route
DMZ
IP address assignment
DMZ-Port
DNS
available information
DNS forwarding
DNS server
DNS-table
Dynamic DNS
filter mechanism
Domain

146

146

146

176, 205, 229
88

44, 83, 273, 307
276

273, 278

276
2717
274
276
276
276

24

55

209

151, 153

152, 153

153

153

151, 153, 155
152

63

73

275

312

44, 278, 308
279

279

273, 276, 278
282, 283

284

279

278, 283, 308
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deny access
Domain name service (DNS)
DNS
DoS
Download
Downstream
Downstream rate
DS
DSCP
DSL
DSLoL
DSSS
Dynamic channel bundling
Dynamic DNS
Dynamic Host Configuration
Protocol (DHCP)
Dynamic routing
Dynamic VPN
dynamic — dynamic
Dynamic — static
dynamic — static
Examples
How it works
ICMP
Introduction
PPP list
static — dynamic
upp

E
EAP

Process of a session secured by EAP

RADIUS server
EAP/802.1x

Master Secret
EAP-MD5
EAP-TLS
EAP-TTLS
EIRP
E-mail virus
Encapsulation

221,

284, 308,

181,

180,

231,

283

278
312
308
308
157
308
153
308
312
308

93
312

273
62

201
199
179
199
179
199
178
187
199
199

308
232
232
233
233
308
308
308
308
124

83

Encryption
asymmetric
symmetric

Encryption methods
AES-CCM

End address

Enterprise specific Traps

ESP

ESS

ESSID

ETH-10

Ethernet

Exclusion routes

exposed host

Extensible Authentication Protocol

F
Fail
Fast callback
Fax
Fax Class 1
Fax driver
Fax transmission
Faxmodem Option
faxmodem option
FHSS
Firewall
Quell- und Zielobjekte
Firmware-upload
with LANconfig
with terminal program
with TFTP
with WEBconfig
Flash ROM memory
Flat rate
Fragrouter
Frame tagging
Frequency
Frequency band
FTP
active FTP

174, 205, 209, 229
230
229

235

275

303
176, 204
308

308

84

308

63
72,173
231, 257

88
56
270
270
270
271
312
272
308
225, 266, 308
132
30
31
31
31
31
29
89
147
212
308
308
308
162

315
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passive FTP
TCP-secured transfer
FTP data transfer
FTP download

G

Gateway

Gross data rate
gross data rate

H

Hash algorithms
HDLC

Hidden station

High telephone costs
Host

Host name table
HotSpot

HTTPS

Hub

|

IAPP roaming

IBBS

IBSS

ICMP

Identification control

Identifying the caller

IDS

IEEE

IEEE 802.11a

IEEE 802.11b

IEEE 802.11g

IEEE 802.1p/q

IEEE 802.1x/EAP

IEEE 802.3

IKE

Inband

inband
Configuration via Inband
with Telnet

Install software

316

162
158
157
151

273, 308
156
156

176

84
255
286
278
281
308

19
308

308

253

308
126, 199
54, 55
55

309, 312
309

220

221

221

211

257

84

176, 209
15

15
21
29

Internet
Internet access
Intranet
IP address assignment
Intrusion Detection
Intrusion-Detection
IP-Spoofing
Inverse masquerading
IP
IP addresses
Dynamic
Static
IP broadcast
IP header
IP masquerading
simple masquerading
IP multicast
IP parameter
IP Quality of Service
IP routing
standard router
IP routing table
IP telephony
IP4 address
IP-address
IPSec
IPSec over WLAN
IP-Spoofing
IPv6
ISAKMP
ISDN
B channel
D channel
Euro-ISDN (DSS-1)
LLC
ISDN Festverbindungs-Option
ISM frequency band
ISP

K
Keep-Alive

67
87

275
144

144
70, 74
309

179

179

66

152

44, 67, 74, 225, 309
70

66

187

309

63

62

157

74

41, 86

176, 202, 229, 309
258

144

202

176, 209
309

182

56, 181, 182
182

182

312

309

309

89
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Key lengths 176 M
L MAC 309
MAC address 309
L2F 203 MAC address filter 225
L2TP 203
MAC frame 213
LAN 309 .
. I Mail server 282
Different organisations on one LAN 214 .
logisch 2 Main mode 176
giseh Maximum bandwidth 153, 154
physikalisch 212 .

. Mbit 309
LANcapi 309 MIB2 303
LANCOM FirmSafe 29 MIC 309
LANconfig 15, 17, 24, 30, 33, 309 .

Management of multiple devices 18 Microsoft Network 211
Minimum bandwidth 152, 153, 155
LAND 146 Reception 154
LANmonitor 36, 40 P
. . Sending 154
Accounting information 38
L Modem 84
Activity log 39 o
display options 40 Monitoring 40
. . MS-CHAP 84, 85
Firewall actions log 39 .
monitor Internet connection 40 Multi SS1D 253
. . Multilink PPP (MLPPP) 85, 93
system information 40 .
. Multi-SSID 227
VPN connections 37 Multithreadin 35
LANtools 309 9
Layer-2 84 N
Layer-2-switch 211 N
Layer-3 83 N-Mapping 312
LCOS 10, 309 N:N mapping 74
LCP echo reply 86 Central mapping 77
LCP echo request 86 Configuration 77
LCR 288 Decentralized mapping 77
Least-cost routing 288 DNS forwarding 78
LLC-MUX 83 Firewall 78
Logging table 137 Loopback address 78
Logical LAN 212 NAT table 77
Logical sending direction 162 Network coupling via VPN 75
Logical wireless networks 238 Routing table 78
Login 29, 50 VPN rule 78
Login barring 50 NAT 74
Loopback address 77 NBNS server 273, 277
LZS data compression 93 Net data rate 156
net data rate 156
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Net data transfer rate
NetBIOS

NBNS
NetBios
NetBIOS networks
NetBIOS proxy
NetBIOS/IP
Network Address Translation
Network coupling
Network management
Network names
No charge information
NTBA
NTP clients
NTP server

0
OFDM
Online minutes
Outband
configuration via Outband
Overhead

P

Packet dump

passwd

Password

PEAP

Period

Period of validity

Physical LAN

Physical sending direction
Physical WLAN interface
Ping

Ping blocking

Ping of Death
Ping-Blocking

PKI

PMTU reduction
Point-to-Multipoint (WLAN)
Point-to-Point (WLAN)
Point-to-Point Tunneling

318

222

44, 279
187
309

279
124, 187
187

74

74

33

278
288

309

293

292

220, 309
286
15
15
151

44
49

25, 26, 41, 48, 54, 55, 88

309
286
273, 276
212
162
238
126
110
147
110
309
158
310
310

Protocol (PPTP)
Port
Port Address Translation
Port-Separierung
PPP
callback functions
checking the line with LCP
handshake
IP address assignment
LCP Extensions
PPP client
PPP connection
PPPoE
PPTP
Precedence
Pre-Shared Key
Preshared key
Private Mode
Private WEP settings
Project management
Protection
for the configuration
Protocol filter
PSK
Public key

Q
QoS
Direction of data transfer
QoS -
— Quality of Service
Quality of Service
Queue
Queues
Secured queue
Standard queue
Urgent queue |
Urgent queue |l

R
Radio cell
Radio frequency

41, 55, 83, 93,
89, 203, 229,
158, 310,

89
70
74
312
309
90
86
27
86
92
24
26
84
309
153
230
176
312
243
33

48
240
230
209

312
162

151
155
155
155
155
155
155

224
308
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RADIUS

RADIUS server

Range

RAS

RC4

Redirect

Remote access

Remote configuration

Remote connection

Remote control

Remote maintenance
with N:N mapping

Remote-ID

Repetitions

RFC

RFCs

Rijndael

RIP

Router

Router-interface-list

Router-name

RSA

RTS threshold

RTS/CTS protocol

S

Scheduled Events

SDSL

Security
Association
checklist
Parameter Index
settings

Security procedures

Security settings

Serial port

Server

SINA

SMTP

Smurf

SNMP

232, 310
257
222, 224
171,172
229, 310
240, 256
24, 87
15

25

74

75
88
88
310
305
205
43
225, 310
94
63
230
255
256

294
310
48
204
57
204
11
56
49
15
310
310
310
146
24

SNMP Trap

SNMP trap

SNMPv3

Splitter

SSID

SSL

Stac data compression
Standard fax programs
Start address

Stateful Inspection
Static channel bundling
Static routing

Switch

SYN Flooding
SYN/ACK speedup
SYSLOG

T

TAE

TCP

TCP control packets
TCP Stealth mode
TCP/IP

TCP/IP networks
TCP-Stealth-Modus
Teardrop

Telnet

Temporal Key Integrity Protocol
Term

Terminal program
TFTP

Throughput

Time

Time budget

Time dependent connection-
limit

Time server
Time-out

TKIP

TLS

ToS

303
76
310
310
310
310
93
270
275
225, 312
93
62
310
146
67
289

310
151
155
111
61,310
278
111
147
24
234
88
30
23
93
88
288

288

292

93, 94
310

310
151, 153

319




» Index LANCOM Reference Manual LCOS 3.52

High Reliability 151 Network table 216
IPSec 152 Port 216
Low Delay 151, 155 Port list 216
Priority 153 Port table 216
TPC 310 Priority 212
Trace Shielding of SNMP traffic 214
examples 46 Use of a central cabling 214
keys and parameters 43 Use tagging 216
outputs 42 VLAN D 216
starting 43 VLAN ID 212
Transfer rates 221 Voice-over-1P 151, 153
Transmission rates 41 VolP 72
Transport mode 176, 205 VoIP —
Triple DES 176, 206 see Voice-over-IP
Trojans 124 VPN 171, 310, 312
Troubleshooting 40 Client 126
Tunnel mode 176, 205 Configuration 184
Type-of-Service — Configuration with LANconfig 190
see ToS Configuration with WEBconfig 194
dynamic — dynamic 201
U dynamic — static 199
uDP 151,199 Examples 198
Upload 29, 310
Upstream 310 Gateway . . . 125
Upstream rate 156 Network coyplmg Wlth'N.N. mapping 75
User name 27, 55, 88 Rempte malntgnance via N:N mapping 75
static — dynamic 199
v static - static 198
V.110 84 VPN client 178
VC-MUX 83 VPN connections
Virtual LAN 211 Diagnosis 197
Virtual Private Network 171 Manual set-up 186
VLAN 211, 312 Setup Wizard 185
Allow all VLANs 216 VPN example application 174
Allow untagged frames 216 VPN network relationships 187
Configuration 215 VPN rules 186
Connection of WLAN stations 214
Conversion in the interfaces 213 W
WAN 311
Default ID 216 WAN-layer 83
Default-VLAN ID 212 WEBconfig 15,19, 30, 311
D 212 HTTPS 19
Management of LAN traffic 214
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WECA 311 IBBS 253
Well known groups 176 infrastructure network 223
WEP 242, 245, 311 IPSec over WLAN 258
Explanation of the process 230 Keep client connection alive 253
Private WEP settings 242 Maximum distance 251
RC4 230 Multi-SSID 223
Sniffer tools 231 Network settings 254
WEP group keys 246 Network types 253
WEP key Operation mode 249
dynamic 231 Point-to-point connections 252
WEPplus 231 point-to-point mode 223
Limits 231 Protocol filter 240
WiFi 311 Radio settings 250
WiFi Alliance 311 Redirect 256
Wifi Protected Access 233 Scan bands 253
Wildcards 283 SSID 254
Windows networks 187 Subband 250
WINS Address 2717 Transmission power reduction 251
WINS server 187 Turbo mode 250
Wired Equivalent Privacy 230 WEP group keys 245
Wireless LAN WLAN interface
Ad-hoc 223 logical 253
operation modes 222 physical 248
Wireless bridge 226 WLAN security 229
Wireless LANs 802.11i 235
Infrastructure network 223 802.1x 231
WISP 311 AES 235
WLAN 311 EAP 231
Access point density 251 Sniffer tools 231
ACL 239 TKIP 233
ad-hoc mode 223 WEP 230
ARP handling 247 WEPplus 231
bridge mode 223 WPA 233
Broken link detection 247 WPA 228, 233, 311
Channel number 250 Group Key 234
client mode 223, 252 Handshake procedure 233
Closed network mode 254 Key handshake 234
Compatibility mode 250 Master Secret 233
Country setting 247 Michael 233
DFS method 250 Pairwise Key 234
Frequency band 250 Passphrase 234
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Rekeying 234 XOR 311
TKIP 233, 234 v
X Y connection 94
xDSL 311
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» Addendum for LCOS version 4.0

> Encrypted configuration with SSH access

A-1

A Addendum for LCOS version 4.0

The addendum describes the new functions and changes from LCOS version 3.52 and the latest version 4.0.
» 'Encrypted configuration with SSH access’ —page A-1
» VPN connections: High availability with "load balancing"* —page A-3
» 'Managing rights for different administrators’ —page A-5
» 'Changes to the LANtools" —page A-11
» 'Manual definition of the MTU" —page A-15
» 'LEPS—LANCOM Enhanced Passphrase Security’ —page A-16
» ‘Standard WEP encryption” —page A-18
» 'Port mapping’ —page A-19

» 'Multiple loopback addresses” —page A-20

» 'IEEE 802.11i for point-to-point connections in the WLAN" —page A-21
» 'Multi-PPPoE" —page A-24

» 'IKE config mode” —page A-25

> 'SYSLOG storage in the device’ —page A-27

@ Due to the restricted hardware capacities not all of the former models can be updated to the current LCOS

~ version and the features described in this document. Please refer to the function overview to check the fea-

tures supported by your LANCOM device (‘Overview of functions for LANCOM models and LCOS* versions’
—page A-30).

A.1  Encrypted configuration with SSH access

In addition to the option to configure a LANCOM with Telnet or a terminal program, LCOS version 4.0 and later
provides an additional option of access via SSH. With a suitable SSH client such as PuTTy, you can set up an encrypted
connection to the device and thus prevent the data being transferred during configuration from being intercepted
within the network.

Start PuTTy (for example) and enter the LANCOM device's IP address as the host name. Use the command prompt
that follows to log in by entering your user data.
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% PUTTY Configuration x| |

Category:
- Session | Basic options for your PuTTY seszion
: e Logging B : ; —
H X Specify pour connection by host name or IP address
=1~ Teminal
o Host Mame [or IP addressz) Fort
- Keyboard
Bl [192.168.2.100) 22
- Features Frotocal:
window " Raw " Telnet © Rlogn & SSH

- Appearance | =
- Behaviour Load, save or delete a stored sezzion
- Translation Saved Sessions
Selection p 2 (LAN)
Eolo.urs Default Settings Load
- Connection _—
- Prosy Save ]
- Telnet —_—

Alternatively, you can use LANconfig under Tools » Options » Extras to enter your SSH client as an "external
program”; then start the SSH access with a right-mouseclick on the device and open WEBconfig/Console session
» Open SSH session.

I (x|

Generall Startupl Windows  Exlras |

—Set up new devices

& ¥ Launch Setup ‘Wizard when a new

unconfigured device iz found #%35 LANconfig

File Edit Device Wiew Tools Help

ol alo| ml@lE| =lel wlmls w=lslalsl wlelel 22

— External program:

' Telnet clisnt: Itelnet.exe

Mame Descripkion Address Device Status Progress
S5H client: ID:\Programme\LANEDM\putty. [ = 197 148,2,100 k.
Configure Enter
Setup Wizard Chrl+i
Check Chrl4+FS
Configuration Managenent 3

Firmware Management 3

Open \Web Browser

Open secure Web-Browser  Chrl+E

Open Telnet Session Chrl+T

Open 55H o Chrl+5Shift+5

Monitor Device Chrl+M
Set DatefTime ...
Activate Software Option

The configuration is carried out with the same commands as used under Telnet or other terminal program (Reference
Manual ‘Command line reference’” —page 22).
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» Addendum for LCOS version 4.0

> VPN connections: High availability with "load balancing”

A-3

A.2 VPN connections: High availability with "load balancing"

A.2.1  Multiple VPN gateway addresses

In decentralized company structures that rely on VPN for networking the various locations, the availability of the
central VPN gateway is of particular significance. The company-wide communications only remain reliable as long
as these central dial-in nodes are working properly.

Branch office || | 1]
1]
Headquarters @ JIH lﬁ
>
|
Home office J

Branch office

With the option of configuring several "remote gateway" addresses for a VPN connection, LANCOM VPN gateways
offer a high level of availability by using redundant devices. This involves multiple gateways at the headquarters
being set up with identical VPN configurations. On location at the satellite sites, all of these available gateways are
entered as possible remote stations for the VPN connection. If one of the gateways is unavailable, the remote router
automatically redirects the request to one of the other routers.

To ensure that the computers in the LAN at the headquarters know which VPN gateway it to be used to reach a
particular satellite station, the outband router currently connected to the remote site is propagated via RIPv2 to the
network at the headquarters. This task is typically assumed by a central firewall which, in such scenarios, is located
in the DMZ.

@ A powerful mechanism for load balancing between the VPN gateways at the headquarters is attained with
~ the configuration of the satellite stations to select the remote site for VPN connection on a random basis.

A.2.2  Configuration

During configuration, additional destinations for a VPN connection should be entered in the list of "Remote
gateways". The list consists of the following entries:

» Name: Name of the remote site from the VPN connection list, the "target" of the VPN connection.
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LANconfig

> VPN connections: High availability with "load balancing"

» Gateway 2 to Gateway 9: Address of the alternative gateways, as an IP address or DNS-translatable address.
» Begin with: In which order should the entries are to be tried. You can select from:

> Last used: Selects the entry for the VPN connection which was successfully used most recently.

I>  First: Selects the first of the configured remote stations.

I> Random: Selects one of the configured remote stations at random. This setting provides an effective measure
for load balancing between the gateways at the headquarters.

@ The entry for the gateway in the VPN connection list can be left blank if all of the possible gateways are
~ entered into the list of "Remote gateways".

When using LANconfig for the configuration, you will find the list of gateway addresses in the configuration area
VPN' on the ‘General' tab under the button Remote gateway.

<2 YPN_NHAMEL Configuration [ 2]

Configure:

General | Parameterl IKE param.l IPSec prop. I IPSec param.l

irtual Private Metwork: IActivated -1 —
Remote Gateway

PN connection

I thiz table, vou define the YPN connections tha

este_nblish_ed by yaur devic_:e. Spec_:ify a;lditional net AR AR, VR e sl =kt
zettings in the configuration zection 'Firewall/QoS Remote Gateway S NEUERT ﬂll
Ceheslonh (3) For connection establishment of redundanten
WPN routes yvou can assign further destination k
— Remate Gateway gateway IP addresses or URLs, Those addresses |

5 o : are used For the referenced connection Cancel |
In this table you can specify 2 list of possible redu additional to the one specified in the YPH
gateways for each remate site. connections list, All gateways must be configured J Remove

same according ko the referenced VPN

Mare of connection: | WPN_HEADQIARTER vl
~ Connection b
P Remote gateway 2; | Gw_1.dyndns.org

Drefine other parameters for the individual VPN connections

here. Remote gateway 3 I G _2.dyndns.org

-Q Femote Gatewayr T |

Connection parameter ... | Remote gateway 4! G _3.dyndns.org
Remote gateway 5: |
LANCOM DK | bbrechen | Remote gateway 6 | —

Remote gateway 7! I

<
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» Addendum for LCOS version 4.0

> Managing rights for different administrators

WEBconfig,
Telnet or
terminal
program

A-5

Under WEBconfig, Telnet or terminal program, you will find the settings for the remote gateway addresses under the
following paths:

WEBconfig Expert configuration P> Setup P> Config-module P> Remote-gateway-list

Terminal/Telnet Setup/VPN-module/Remote-gateways

The following options are available for defining the strategy for the utilization of the configured remote-gateway
addresses:

» last used

> first

» random

Example:

The following command sets three gateways as target at the headquarters, one of which is to be selected at random:
set VPN_ZENTRALE GW_1.dyndns.org GW_2.dyndns.org GW_3.dyndns.org * * * * * random

A.3  Managing rights for different administrators

Multiple administrators can be set up in the configuration of the LANCOM, each with differing access rights. For a
LANCOM, up to 16 different administrators can be set up.

@ Besides these administrators set up in the configuration, there is also the "root" administrator with the main
~ password for the device. This administrator always has full rights and cannot be deleted or renamed. To log
in as root administrator, enter the user name "“root" in the login window or leave this field empty.

As soon as a password is set for the "root" administrator in the device's configuration, then WEBconfig will display
the button Login that starts the login window. After entering the correct user name and password, the WEBconfig
main menu will appear. This menu only displays the options that are available to the administrator who is currently
logged in.

If more than one administrator is set up in the admin table, the main menu features an additional button Change
Administrator which allows other users to log in (with different rights, if applicable).

A.3.1 Rights for the administrators

Two different groups are differentiated regarding administrators' rights.
» Each administrator belongs to a certain group that has globally defined rights assigned to it.

» Each administrator also has "function rights" that determine the personal access to certain functions such as the
Setup Wizards.
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Administrator groups

Supervisor All Supervisor — member of all groups
Admin-RW Limited Local administrator with read and write access
Admin-RO Read only Local administrator with read access but no write access
None None No access to the configuration

» Supervisor: Has full access to the configuration

>

Local administrator with read and write access: Also has full access to the configuration, although the following
options are prohibited:

> Upload firmware onto the device
> Upload configuration onto the device
> Configuration with LANconfig

@ Local administrators with write access can also edit the admin table. However, a local administrator can only

change or create entries for users with the same or less rights than himself. It follows that a local
administrator cannot create a supervisor access and assign himself those rights.

Local administrator with read access: Can read the configuration with Telnet or a terminal program, but cannot
change any values. The administrators can be assigned certain configuration options via their function rights.
None: Cannot read the configuration. The administrators can be assigned certain configuration options via their
function rights.

Function rights

Function rights can be used to grant the following options to users:

VVvVVvVvVVvVvVvVYVYyYVYYy

Basic Settings Wizard

Security Settings Wizard

Internet Connection Wizard
Selection of Internet Provider Wizard
RAS Account Wizard

LAN-LAN Connection Wizard
Change time and date

Search for further devices
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» WLAN link test
» alb Wizard

A.3.2 Administrators' access via TFTP and SNMP

The additional access possibilities for administrators are generally used for configuring the device with Telnet,
terminal programs or SSH access. However, the other administrators can also access the device via TFTP or SNMP.

Access with LANconfig

A user with supervisor rights can login to LANconfig by entering his user data into the Password field of the login
window in the combination "user:password".

Access with TFTP

In TFTP, the user name and password are coded in the source (TFTP read request) or target file names (TFTP write
request). The file name is either made up of the master password and the command to be executed, or of the
combined user name and password separated by a colon, plus with the command as a suffix. Thus a command sent
by TFTP resembles the following:

» <Master password><Command> or
» <User name>:<Password><Command>

Examples (the LANCOM has the address mylancom.intern, the master password is 'RootPwd' and a user has been
set up named 'LocalAdmin' with the password 'Admin’):

» Read the configuration from the device (supervisor only)

tftp mylancom.intern GET RootPwdreadconfig mylancom.lcf
» Write the configuration to the device (supervisor only)

tftp mylancom.intern PUT mylancom.lcf RootPwdwriteconfig
» Read out the device MIB (for the local administrator)

tftp mylancom.intern GET localadmin:Adminreadmib

mylancom.lcf mylancom.mib

For the menus and available commands, the same limitations on rights apply as with Telnet.

Access with SNMP management systems

For the administration of networks with the help of SNMP tools such as HP OpenView, the various levels of
administrator access can be used for the precise control of rights.

Under SNMP, user name and password are coded in the "community”. Here, the 'public' community can be selected
or one of either the master password or a combination of user name and password divided by a colon can be
selected.
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ﬁ,; The community 'public’ corresponds with the rights of a local administrator with read-only access, as long
as the SNMP read access without password is enabled (‘Password protection for SNMP read-only access.’
—page A-12). If this access is not allowed, then the ‘public' community will have access to no menus at all.

Otherwise, the same limitations on rights apply for the menus as with Telnet.

A.3.3 Configuration of user rights

LANconfig When using LANconfig for the configuration, you will find the list of administrators in the configuration area
‘Management' on the 'Admin’ tab under the button Further administrators.

<2 YPN_NHAMEL Configuration i 21x|
Configure: | M anagement x l

Generall Interfacesl Wireless LAM  Adrmin |Eosts I WLAN I

i~ Device Configuration
Further Administrators
Main Device Pazsword; |w

Administrator | Active | Access rights | Basic Wiz, | Security Wiz, | Internet Wiz, | RAS Wizard | LAN-LAN ‘Wiz,
Mumber [MSM]: | e ”
Administrator  Yes Restricke
Further Administratars .. -
—[}\gi Further Administrators - New Entry 2=l
[~ Password required for SNMP read permission —
Administratar: I Administrator QK I
r— Configuration login lock
. g Password: | e el |
Lock configuration after: |5 login Failun

™ Entry active

Lock configuration for: |5 minutes =
Access rights: IAII 'l

r— Configuration access ways

—Function Rights For HTTP{=E =]

Here you can specify the access rights for each network and e Read only k
each supported configuration protocol separately. In addition [ Basic Wizard Mone
you can limit access ta the unit to certain stations, ¥ Security Wizard ¥ Internet Wizard

¥ Ras wizard ¥ LAN-LAN wWizard
¥ Provider Selection
[V WLAN Linkkest

:_tA NEOM 0K I Abbrechen | V' adjustment of Date and Time
i ¥ Search of Further Devices in LAN

Access rights - | Access stations ... |
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Enter the following values:

» Name for the new administrator with password.
> Access rights

» Function rights

Ql You can temporarily deactivate the entries without having to delete them completely with the button 'Entry
~ active'.
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Under WEBconfig, Telnet or a terminal program, you will find the settings for the serial interface under the following
paths:

WEBCconfig Expert configuration P> Setup B> Config-module » Admin.-table

Terminal/Telnet ‘ Setup/Config-module/Admin.-table

The different user groups are represented by the following values:

Supervisor Supervisor — member of all groups

Admin-RW Local administrator with read and write access
Admin-RO Local administrator with read access but no write access
None No access to the configuration

The different function rights are represented by the following hexadecimal values:

0x00000001 The user can run the Basic Configuration Wizard

0x00000002 The user can run the Security Wizard

0x00000004 The user can run the Internet Wizard

0x00000008 The user can run the Wizard for selecting Internet providers
0x00000010 The user can run the RAS Wizard

0x00000020 The user can run the LAN-LAN Coupling Wizard

0x00000040 The user can set the date and time (also applies for Telnet and TFTP)
0x00000080 The user can search for additional devices

0x00000100 The user can run the WLAN Link test (also applies for Telnet)
0x00000200 The user can run the a/b Wizard

The entry results from the sum of the first, second and third columns from the right. If, for example, the user is to
receive rights to use the "Security Wizard", "Selection of Internet provider”, "RAS Wizard", "Change time" and
“WLAN Link Test", then the resulting values are as follows:

» First column from the right: 2 (Security Wizard) + 8 (Selection of Internet Provider) = "a" (hexadecimal)

» Second column from the right: 1 (RAS Wizard) + 4 (Change Time) = "5" (hexadecimal)

» Third column from the right: 1 (WLAN-Linktest) = "1" (hexadecimal)
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For this example, the function rights are entered with the value "0000015a".
Said differently it is a disjunction of the hexadecimal values:

Security Wizard 0x00000002
Selection of Internet provider 0x00000008
RAS Wizard 0x00000010
Change time 0x00000040
WLAN Link Test 0x00000100
Disjunction 0x0000015a
Examples:

The following command sets up a new user in the table who, as local administrator "Smith" with the password
"BW462G29", can select the Internet provider. The user will be activated immediately:

set Smith BW46zG29 yes Supervisor 00000008

The following command extends the function rights such that user "Smith" can also run the WLAN link test (the
asterisks stand for the values which are not to be changed):

set Smith * * * 00000108

A3.4 Limitation of the configuration commands

The availability of commands when configuring the devices with Telnet or a terminal program depends on the user's
rights:

activateimage

cfgreset

The 'linktest' command can also be executed if the user
possesses the function right to carry out a WLAN link test

linktest

readconfig

writeconfig

SIS IS S8R

writeflash

setenv

RN NN N NN S

testmail
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time v The ‘time’ command can also be executed if the user
possesses the function right to set the system time

unsetenv v

delete/rm v

readmib v

WLA v

set 4

All other commands (such as 'cd’, 'ls', 'trace’, etc...) can be used by all users. The user must possess at least write
access to be able to operate commands that cause changes to the system (e.g. 'do’ or 'time’).

@ The commands listed above are not available in all LCOS versions or LANCOM models.
A.4  Changes to the LANtools

A.4.1  Optimized connection establishment with VPN connections

The Wizard for LAN-LAN coupling suggests two variants for VPN connection establishment:
» Optimized connection establishment (IKE and PFS group 2)
» Slow connection establishment (IKE and PFS group 5)
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%73 Setup Wizard for YPN_NHAMEL x|
Connect two local area networks [also YPN) ¢:__?
Settings for the connection

The IKE and PFS groups of the ¥PN connection parameters affect the connection
establizhment. They must be configured equally for thiz and the remate site ta
accomplish a connection.

‘whould you like a faster connection establishment with appropriate securnity or a slower
one with higher security:

' Optimized connection establishment (IKE and PFS group 2]
" Slower connection establishment (IKE and PFS group 5)
The 2. selection [IKE and PFS group 5] iz required, if the YPH account on the

remote zite was [or will be] configured with the wizard of a LAMconfig with a
wersioh number less than 3.521

< Zuriick I W'eite_t> I Abbrechenl

A.4.2  Password protection for SNMP read-only access.

The read-only access to a LANCOM device via SNMP—for example with LANmonitor--can be password protected.
This uses the same user data as with access to LANconfig. Password protection of SNMP access means that the user
data must be entered before information about the device status, etc. can be accessed over SNMP.

=y

2

2

N

LANmonitor User information can be entered in LANmonitor separately for each device. To do this, click with the right-hand A
mouse key on the required device, select the Options point from the context menu and enter your user data. 8
~

2x] S
General |Advanced| E
S

~ Information g

I i) Device: LANCOM 1817 Wireless DSL %

Wendor: LAMCOM Systems GmbH ;.E

IP address: 1921682100

— Authentication

@? Enter pour configuration access data for the
|

device here.
Adrninizstratar: localadmin|
Password: Ir

Mote: The adminiztrator may only be specified if
an administrator account haz been configured in
T

Access rights in LANmonitor depend on the rights possessed by the user:
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» A supervisor has full access to the information in LANmonitor and can execute actions such as closing a
connection, among others.

» A local administrator also has full access to the information in LANmonitor and can execute actions such as
closing a connection, among others.

» A user with read-only rights can view the information in LANmonitor but cannot take any actions such as closing
a connection.

» A user without rights has no SNMP access to the device's information.
For configuration with LANconfig, you will find the switch for SNMP access in the configuration area ‘Management'
on the 'General' tab.

<2 YPN_NHAMEL Configuration 21x|
Configure: | M anagement x l

Generall Interfacesl Wireless LAM  Adrmin |Eosts I WLAN I

Device Configuration

Mumber [MSM]: I

Further Administratars ... |

phPassword required for SMMP read permission

|— Eorr;?iguration login lock |

Under WEBconfig, Telnet or a terminal program, you will find the settings for the SNMP read access under the
following paths:

WEBconfig Expert configuration P> Setup P Config-module P> Password-required-for-SNMP-read-access

Terminal/Telnet ‘ Setup/Config-module/Password-required-for-SNMP-read-access

A.4.3 Manual and automatic searches for firmware updates

To make the update of LANCOM devices with new firmware as convenient as possible, the firmware files for the
various LANCOM models and LCOS versions are, ideally, saved to a central archive directory. The search for new
versions of the firmware in this directory can either be initiated manually or automatically after starting LANconfig.

Automatic search for firmware updates

The directory where LANconfig is to search for the updates is set under Tools » Options » Extras. It is also possible
to set up LANconfig to search the firmware archive and to check if any of the devices found require an update. With
this option activated, starting LANconfig automatically displays all of the devices for which new updates are
available.
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O 21

v Search for new devices at startup i Firmware updates for your devices have been found during the
X Q’ automatic update scan in the Following direckory:
¥ i the local network,
[:\ProgrammelL ANCOMILANConfighFirmware
|3 _IZ seconds

. . Do you like to select the devices ko be updated now?
[ in the following remate netwarks 0 B

13 =| seconds Yes Mo |

Ad

| |

Edit...
—Il x
Femove

Select the devices to be updated:

v Scan fimware archive at startup

Update Mo k
Cancel |

Archive:  [D:\ProgrammetLANCOM\LANcanfighFim |

WI\Eheck devices for pozzible firmware updates

Manual search for firmware updates

To search manually for firmware updates, click with the right-hand mouse key on a device marked in the list and
select the following point from the context menu: Firmware management »Check for firmware update. If you
wish to update several devices simultaneously, the entry Check for firmware updates is displayed directly in the
context menu.

Buaoniy -Ioix

File Edit Device Wiew Tools Help

|yl mlwE e wlxls wslaal wlslw 2@ Fesead

Mame Descripkion Address Device Status Progress |
% e L) Ok
ERLANCOM T Conflgl..lre Enter B ok
Setup Wizard Chel+y
Check Chrl4+FS
Configuration Managenent L3
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Firrnware Management Check for Firmware Update

WEBConfig f Consale session 3 Upload Mews k TWare Chrl+0
Monitor Device Chrl+mM 1 Yersion 4,00 of 26,11,2004
Set DatefTime ... ® 2 Version 3,52 of 21.09,2004

Activate Software Option I

View a full list of all firmware versions

If your search in the archive did not reveal a new firmware version, you can alternatively view a full list of all of the
firmware files that have been found. You can, for example, switch back to an older version. LANconfig displays all
versions found for the marked devices, including the version currently active in each device. For each device, you can
select precisely one firmware version that will then be uploaded onto the device.
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Firmware update x|

Mo newer firmware was Found in the selected archive direckor

D:{Programme|LANCOMILANConfig\Firmware Firmware update x|

For the Following devices firmwares were Found;

‘Would you like ko view the Found firmwares anyway?

[ & WPH_MHAMEL: .00 (26.11.2004) -> 3.52 (21.09,2004) Update N
[ & WPM_MHAMEL: 4,00 (26.11.2004) -> 4,00 (25.11.2004)
‘7 8 VPN NHAMEL: 4,00 (26,11,2004) -> 4,00 (26,11,2004) Cancel |
& LANCOM DSLT-1611 Office: 4,00 (26,11,2004) -» 3,52 (21.09,2004)
[ & LANCOM DSLJI-1611 OFfice: 4,00 (26,11.2004) -> 4.00 (26.11.2004)

es

s

A.5 Manual definition of the MTU

Many Internet providers operate their own backbone; however, their customers dial in to the network over the access
nodes provided by third-party telecommunications providers. The two-stage dial-in procedure can lead to problems
with the realized data rate:

» When dialing into the nodes of Deutsche Telekom, for example, a LANCOM negotiates a permissible maximum
transmission unit (MTU), which defines the greatest possible size of unfragmented data packet. This MTU is then
observed by the LANCOM.

» When the data packets are forwarded to the actual provider, an additional header is added which increases the
size of the data packets again. For the data packets to meet with the permitted size, they must now be
fragmented into smaller units. This additional fragmentation can cause losses in the data-transfer speeds.

This problem can be avoided by entering a fixed MTU for each remote site.

A.5.1  Configuration

WEBconfig, Under WEBconfig, Telnet or a terminal program, you will find the MTU list for a maximum of 16 entries under the
Telnet or following paths:

terminal

program
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WEBconfig Expert configuration P> Setup » WAN module » MTU list

Terminal/Telnet Setup/WAN-module/MTU-1ist

The table contains the following entries:
» Device name: Name of the remote device. It can be a physical or a virtual (PPTP/VPN) remote station
» MTU: MTU to be used for the connection
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A.5.2  Statistics

Under Status » WAN-statistics you will find the MTU statistics recorded for all current connections. The table is
partially dynamic and begins with 16 entries. Like the MTU list under Setup » WAN-module it contains two
columns with the remote name and the MTU.

INET 1200 The INET remote site is the Internet connection and a forced MTU of 1200 bytes.
MuLTI 1492 MULTI is a PPPoE connection, for which the MTU was negotiated (and is consequently 1492 bytes).
TESTVPN 1100 TESTVPN is a VPN connection established via the Internet. An assumed overhead of 100 bytes is taken for

VPN connections, and consequently the MTU here is 1100 bytes.

TESTVPN-PPTP 1060 TESTVPN-PPTP is a PPTP connection established over the VPN connection TESTVPN. The overhead for
PPTP connections is 40 bytes, and consequently the MTU here is 1060 bytes.

@ MTU lists and MTU statistics are only available for devices with a DSL or ADSL interface
A.6 LEPS—LANCOM Enhanced Passphrase Security

A.6.1  LEPS remedies the security issues presented by global passphrases.

The modern encryption methods WPA and IEEE 802.11i provide data traffic in the WLAN with far improved security
from eavesdroppers than the older WEP can. It is very easy to handle a passphrase as a central key; a RADIUS server
such as that for 802.1x installations is not required.

However, the use of WPA and IEEE 802.11i still has some weak spots:

» A passphrase applies globally for all WLAN clients

» The passphrase may fall into unauthorized hands if treated carelessly

» The "leaked" passphrase then offers any attacker free access to the wireless network

This means in practice that: Should the passphrase "go missing" or an employee with knowledge of the passphrase
leaves the company, then the passphrase in the access point really needs to be changed—in every WLAN client, too.
As this is not always possible, an improvement would be to have an individual passphrase for each user in the WLAN
instead of a global passphrase for all WLAN clients. In the case mentioned above, the situation of an employee
leaving the company requires merely his "personal” passphrase to be deleted; all others remain valid and
confidential.

With LEPS (LANCOM Enhanced Passphrase Security), LANCOM Systems has developed an efficient method that
makes use of the simple configuration of IEEE 802.11i with passphrase, but that avoids the potential security
loopholes that come with global passphrases.
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A-17

LEPS uses an additional column in the ACL (access control list) to assign an individual passphrase consisting of any
8 to 63 ASCII characters to each MAC address. The connection to the access point and the subsequent encryption
with IEEE 802.11i or WPA is only possible with the right combination of passphrase and MAC address.

This combination makes the spoofing of the MAC addresses futile—and LEPS thus shuts out a potential attack on
the ACL. If WPA or IEEE 802.11iis used for encryption, the MAC address can indeed be intercepted—nbut this method
never transmits the passphrase over wireless. This greatly increases the difficulty of attacking the WLAN as the
combination of MAC address and passphrase requires both to be known before an encryption can be negotiated.

LEPS can be used both locally in the device and centrally managed with a RADIUS server. LEPS works with all WLAN
client adapters available on the market without any modification. Full compatibility to third-party products is assured
as LEPS only involves configuration in the access point.

@ An additional security aspect: LEPS can also be used to secure single point-to-point (P2P) connections with
~anindividual passphrase. Even if an access point in a P2P installation is stolen and the passphrase and MAC
address become known, all other WLAN connections secured by LEPS remain secure, particularly when the

ACL is stored on a RADIUS server.

A.6.2 Configuration

The configuration of LEPS merely involves the assignment of an individual passphrase to the MAC address of each
client that is approved for the WLAN. To this end, the MAC filter is set to positive, i.e. the data from clients entered
here will be transmitted.

@ The passphrases should consist of a random string at least 22 characters long, corresponding to a
~ cryptographic strength of 128 bits.

When using LANconfig for the configuration, you will find the list of stations approved for the WLAN in the
configuration area 'WLAN Security' on the 'Stations' tab under the button Stations.
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<2 YPN_NHAMEL Configuration 1 21x|
Configure: |W'LAN Security 'l

General Stations | Pratocols | 802 11iAWER | IEEE 80214 |

i CUTEE—— 21
[rata traffic between the wireless LAN and pour local r
can be res_tric:ted a_s_require_d by excluding individual st Physical address I Mame I Passphtase I Comment | (o]
only enabling specified stations. 0010c6252a3F  Musller  sdfmu74SfnopWIF  MC-S4g
Filter function: Mewmann it 7atjfpwer Powerbook Cancel

7 filter out data from the listed stations, transfer all ot

% trangfer data from the listed stations, autherticate :
via RADIUS or filter thern out

Tl

Stations ..
Add ... | Edit ... | Copy .. | Remaove |
~ Authentication via RADIUS - =

Server [P address: ID.D.D.D
Physical add, i 00904b6as51b O

Server port: |1.812 ySIGSHAcCrEss I \_kl

£ IS kb

Shared secret: | biolte 0 Cancel |
Passphrase {optional): I aw-reHUIRetkgh
Comment: I Dell

Ladifeiohy) DK£ | anbrechen |

Under WEBconfig, Telnet or a terminal program, you will find the access list for the wireless network under the
following paths:

WEBconfig Expert configuration B> Setup » WLAN-module P> Access-list

Terminal/Telnet ‘ Setup/WLAN-module/Access-list

A.7  Standard WEP encryption

As of LCOS version 4.0, WEP128 encryption is activated for every unconfigured device as standard.

If your device has one or more WLAN interfaces, you can also carry out the "wireless" configuration from a computer
with a WLAN card. To use a WLAN client to connect to a new LANCOM access point for wireless configuration, the
WLAN client must be programmed with the 13-character standard WEP key.

The standard WEP key consists of the first letter “L" followed by the LAN MAC address of the access point in ASCII
characters. The LAN MAC addresses of the LANCOM devices always begin with the character string “00A057". You
will find the LAN MAC address on a sticker on the base of the device. Only use the character string labeled as “MAC
address” that starts with “00A057". The other addresses that may be found are not the LAN MAC address.
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| ANEUNIRIARIAN

MAC ID  DOOBABIOEASY

v

A device with the LAN MAC address “00A0570FB9IBF” thus has a standard WEP key of “LOOA0570FBIBF". This key
is entered into the 'Private WEP settings’ of the device for each logical WLAN network as ‘Key 1'.

@ To use a WLAN client to connect to a new (unconfigured) LANCOM access point, the WEP128 encryption
~ must be activated in the WLAN client and the 13-character standard WEP key must be programmed in as
described above.

A.8  Port mapping

A.8.1 Free translation of TCP/IP ports on masked connections

If IP masquerading is used over a connection, the IP address of the computer in the local network is hidden behind
the IP address of the router. So that individual computers in a LAN can still be contacted, inverse masquerading is
used whereby an incoming port range in the service table is assigned to a particular IP address in the LAN.

On occasion it is desirable for the "exposed" host not to be contacted over this standard port, e.g. when security
reasons demand the use of another port. In this case it is not only necessary to map the ports to an IP address, but
to translate between ports as well. Another example of port mapping is the translation of multiple WAN ports to one
common port in the LAN, but to different IP addresses (N-IP mapping).

A.8.2 Configuration

The configuration of port mapping involves the assignment of a port or port range (start port to end port) to an IP
address from the LAN as the target and the port (map port) to be used in the LAN.

@ If "0" is entered for the map port, the ports used in the LAN will be the same as those used in the WAN. If a
~ portrange is to be mapped, then the map port identifies the first LAN port to be used. For example, mapping
the port range '1200' to '1205' to the internal map port '1000' means that the ports 1000 to 1005 will be

used for data transfer in the LAN.

(‘i It is not possible to map two differing ports or port ranges to just one map port in the LAN.

When using LANconfig for the configuration, you will find the service list in the configuration area 'IP Router' on the
‘Masq." tab under the button Service list.
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4= ¥PN_NHAMEL Configuration 1 ﬂll
Configure: |IP Flouter 'l

Generall Routing  Masq. |N:N Mappingl

[ I 21
TCF aging: Im zeconds
Firsk pork | Last pork | Address | Map port | Ackive | Comment | 84
UDF aging: |2D seconds | 3,389 3,389 192.168.2.11 12,345  ‘Yes %
. Cancel |
ICHMP aging: |1 1] zeconds
IPSec aging: |2.DDD zeconds ar |
Fragment aging: |5 zeconds a |
—|nverse mazquerading add s | Edit ... I B | Hae |
*r'ou can make individual services [a WebServer, for ir B A
available to people outzide your network, by specifving Each Service list - Edit Entry ﬂll
service in this list. -
Service list ... [: | R I 3,385 \_OKwI
Last port: 3.389 Canicel |
Intranet address: I 192,168,211
Map port: | 12345]
™ Enkry active
LANCOM 0K | Abbrechen | e —

Under WEBconfig, Telnet or a terminal program, you will find the service list for the wireless network under the
following paths:

WEBconfig Expert configuration P> Setup P> IP-router-module B> Masquerading P> Service-table

Terminal/Telnet ‘ Setup/IP-router-module/Masquerading/Service-table

A.9  Multiple loopback addresses

In a local network, a LANCOM can be contacted with its intranet IP address or with its DMZ IP address. In large
network structures that are managed centrally, it can occur that multiple devices have the same intranet IP number.
Devices in this scenario can still be unambiguously addressed by using additional, freely definable IP addresses.

Up to 16 of these additional "loopback" addresses can be set up in a LANCOM router. Loopback addresses serve as
additional IP addresses for the device and can be selected freely from the pool of private IP addresses. These
loopback addresses do not have to belong to the same range of IP addresses as those used in the intranet or DMZ.
Thus, for the management of multiple or rigorously structured networks, all of the LANCOM routers can be identified
with loopback addresses of consecutive IP addresses selected from a certain range of IP numbers. Each device is then
uniquely identifiable by its loopback address and SNMP traps can be assigned to the corresponding source based
on the loopback address.
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Under WEBconfig, Telnet or a terminal program, you will find the loopback list under the following paths:

WEBCconfig Expert configuration P> Setup P> TCP-1P-module P> Loopback-list

Terminal/Telnet ‘ Setup/TCP-IP-module/Loopback-list

A.10 IEEE 802.11i for point-to-point connections in the WLAN

A.10.1 More security in P2P mode

IEEE 802.11i can be used to attain a significant increase in the security of point-to-point connections in the WLAN.
All of the advantages of 802.11i such as the simple configuration and the powerful encryption with AES are thus
available for P2P mode, as are the improved security of the passphrase from the LANCOM Enhance Passphrase
Security (LEPS).

A.10.2 Configuration

To make use of the advantages of 802.11i encryption on P2P connections, the point-to-point mode must first of all
be activated in the participating devices. Further, each connection requires one device to be configured as 'master’
and one device as ‘slave’. Finally, the MAC address of the opposite WLAN client must be entered at both ends of the
connection.

Slave

Slave

Under WEBconfig, Telnet or a terminal program, you will find the MAC addresses for the WLAN cards in the devices
under the following paths:

WEBCconfig Expert configuration P> Status P> WLAN-statistics P> Interface-statistics

Terminal/Telnet ‘ Status/WLAN-statistics/Interface-statistics
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LANconfig

[> IEEE 802.11i for point- to- point connections in the WLAN

As an alternative, you will find the WLAN MAC address on a sticker on the base of the device. Only use the string
that is marked as the "WLAN MAC" or "MAC-ID". The other addresses that may be found are not the WLAN MAC
address but the LAN MAC address.

LREI RO

MAC ID  DOOBABIOEASY

D

For configuration with LANconfig you will find the settings for P2P connections under the configuration area
‘Management' on the 'Wireless LAN' tab. Click on the button Physical WLAN settings to open the corresponding
WLAN interface and select the tab for 'Point-to-Point'. Activate the point-to-point mode here and set the ‘Channel
selection scheme' to either 'Master' or 'Slave'. Enter the appropriate MAC address for the WLAN card at the remote
station.

Physical WLAN settings - WLAN interface 2=l

Dperationl Radio I Super 4/G  Point-to-Point | Clignt model

Paint-to-Paint operation mode;

 Off - This access point can anly communicate with mobile
stations.

' [On - This access point can alzo communicate with other
access points to connect several local wireless networks.

" Exclusiv - Thiz access point can only communicate with other

access points; mobile stations can not connect to this access
paint [pure 'WLAMN bridge].

[™ Do not forward among P2P links on the same interface

Channel Selection Schem4 M aster = l
— I aster
e T —

Access paint 2: I

Access point 3 I
Acocess point 4: [

To activate the 802.11i encryption for the P2P connection, adjust the settings for the first logical WLAN network in
the WLAN interface that is used (i.e. WLAN-1 if you are using the first WLAN card for the P2P connection, WLAN-2
if you are using the second card, e.g. as with a LANCOM 3550 Wireless).

» Activate the 802.11i encryption.

> Select the method '802.11i (WPA)-PSK).

» Enter the passphrase to be used.

@ The passphrases should consist of a random string at least 22 characters long, corresponding to a
~ cryptographic strength of 128 bits.

When set as P2P Master, the passphrase entered here will be used to check the Slave's authorization to access. When
set as P2P Slave, the access point transfers this information to register with the remote site.

A-22
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[> IEEE 802.11i for point- to- point connections in the WLAN

<= YPN_NHAMEL Configuration ] 21|
Configure: |W'LAN Security 'l
WPA or Private WEP settings

Generall Stationsl Protocols  802.111AKER | IEE

Interface Encryplion | Method [ Key 1 | Key 1/passphrase | WPA Session Key Type | Authent

— 802111 [WPAMES] / Wired Equivalent Privacy — 0 Off Open sy

Q e e i WLAN-1-2: Wireless MNetwork 2 Off WEPR4 (40 bit) 00000000000 TKIPJAES Open sy

i ou should select 802,111 Enhanced Secur - | wi am-1-3: Wireless = - - Open sy

Advanced Encryption Standard [WPAZAES | i an1. Wircloes WPA or Private WEP settings - Edit Entry 2=l R

“wired Equivalent Privacy [WEF] sa that all |y an g 5. wireless Open s

will be transmitted encrypted. WLAN-1-6: Wireless  Interface: WLAN-1: Wireless Open sy

Thiz iz where you can make encryption settings fo WLAN-1-7: Wireless |7 activate 802, 11i Enhanced Security with cancel | Open sy
wireless LAN network (MuliSSI0). Advanced Encryption Standard (WPAAES) or

Standard Wired Equivalent Privacy (WEP)
P4 or Private WEF

Thiz iz where you can specify for each phyzical wireless LAN Method [ Key 1 length: |802. 11§ (WPA)-PSE 'l
interface those "WEF group keys 2 to 4, that are used there by

the logical wireless LAM networks in commar, Kev 1/passphrase: | HotruHUS 786 Jitglkk (5]

WEP Group Keps - | WP Session Key Type: ITKIP.I’AES vI
Authentication: |Open system (recomme 'I

An even higher degree of security can be attained by using LEPS in addition, which involves the matching of MAC
address and passphrase. When using LANconfig for the configuration, you enter the passphrases of the stations
approved for the WLAN in the configuration area 'WLAN Security' on the 'Stations' tab under the button Stations.

%= ¥PN_NHAMEL Configuration | o il

21|
Configure: |W'LAN Security 'l
Physical address I ame | Passphrase | Comment | QK [ I
General  Stations | Protocolsl 802.11i.-"W'EF'| IEE | 0010c6252a3f Sales hfd7tuwegiusaaikmwef] L-54 Wireless
003065268019 Marketing  sdgfmbert76tkjeo7864ij56 1621 Wireless Cancel |
i~ Filter station: b i

[Drata traffic between the wireless LAN and pour lc
can be restricted as required by excluding individ

only enabling specified stations.
= Hi3h Stations - Edit Enktry

£l

Filter function:
= filter out data from the listed stations, transfer . Add . physical address:
% trangher data from the listed stations, authert Mame:

via RADIUS or filter thern out

Passphrase (optional): I sdglfketOp2tudaEsigfop

Comment: | 1811 Wireless

Stations ..
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rAuthentication via RADIUS |

Configuration  Under WEBconfig or Telnet you can set the settings for the point-to-point operation of the physical WLAN interfaces

with under the following paths:
WEBconfig or

Telnet

WEBconfig Expert configuration B> Setup P> Interfaces B WLAN-InterfacesP> Interpoint-Settings

Terminal/Telnet /Setup/Interfaces/WLAN-Interfaces/Interpoint-Settings

A-23
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[> Multi- PPPoE

The encryption settings for the individual logical WLAN networks can be found under:

WEBCconfig Expert configuration P> Setup P> Interfaces P> WLAN-InterfacesP Encryption-Settings

Terminal/Telnet ‘ /Setup/Interfaces/WLAN-Interfaces/Encryption-Settings

The access list for the matching of MAC addresses to the passphrases (LEPS) can be found under:

WEBconfig Expert configuration P> Setup P WLAN-module P> Access-list

Terminal/Telnet Setup/WLAN-module/Access-list

A.11  Multi- PPPoE

In most cases just one connection at a time is established over a DSL or ADSL WAN interface. However, there are
applications where it makes sense to use multiple parallel connections on the WAN interface. LANCOM devices with
a DSL or ADSL interface can establish up to eight different channels in parallel in the WAN using the same physical
interface.

A.11.1 Example application: Home office with private Internet access

One possible application is the home office used by sales personnel who need access to the network at the
headquarters via a VPN connection. The company pays for the VPN connection, the employee in the home office
pays for Internet access privately.

AN
| ||  Fixed IP add
lllll!‘! = e address VPN connection via the

. Internet provider used by the ~ DYnamic IP address
L - rf

Connection via the private
Internet provider Home office

Headquarters
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To ensure a clean separation of the data links, two Internet connections are established, one to each provider. In the
IP routing table, the default route is assigned to the private provider; the network with the headquarters via the VPN
connection is routed over the headquarters' provider.

A.11.2 Configuration

The configuration of this scenario involves the following steps with the home-office router:
» Configuration of the private Internet access, for example with the LANconfig Wizard or with WEBconfig.
» Configuration of the Internet access that is invoiced to the headquarters.

» Selection of the private provider for the default route in the IP routing table (e.g. manually with LANconfig or
with the Wizard for selecting Internet providers in WEBconfig.

» Configuration of the VPN connection to the network at the headquarters.
» Allocation of the VPN connection to the headquarters' provider.

To ensure that the data traffic for the headquarters is routed via the desired Internet provider, one more entry in
the IP routing table is required. Here, the VPN gateway at the headquarters is entered along with its fixed IP
address and appropriate netmask, and is forwarded to the remote site used by the headquarters' provider.

@‘w It is important that the route to the Internet provider used by the headquarters is masked; otherwise the
LANCOM would apply the LAN address and not the WAN address, and the connection would never be
established.

Further information about these steps in the configuration are to be found in the documentation for your LANCOM
device.

ﬁ Administrator rights for the employee in the home office: To avoid the employee making accidental

‘ changes to the settings for the Internet provider or VPN access, he should be assigned with the function
rights for the "Internet connection" and "Selection of Internet provider" Wizards only. Information about the
configuration of special user rights can be found in this addendum under ‘Managing rights for different
administrators’ —page A-5.

@‘w Use the necessary filter rules in the area 'Firewall/QoS' to ensure that the Internet traffic is not accidentally
directed via the network at the headquarters.

A.12 IKE config mode

When configuring VPN dial-in connections, there is as an alternative to fixed IP addresses for the remote stations
that dial in, in that a pool of IP addresses can be made available to them. To this end, the "IKE-CFG" mode is
additionally added to the entries in the connection list. This can assume the following values:
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> IKE config mode

» Server: With this setting, the device functions as the server for this VPN connection. The assignment of an IP
address to the client can take place in two ways:

I> I the remote site is entered in the routing table, the IP address defined here will be assigned to the client.

> If the remote site is not entered in the routing table, an IP address which is available from the IP pool will
be taken for the dial-in connections.

@ The remote site must be configured as IKE-CFG client in this case, and thus has to request an IP address from
~ the server. To dial in with a LANCOM Advanced VPN Client, the option Use IKE Config Mode has to be
activated in the connection profile.

=
IPSec Conliguration - IP addresses LANCOM

Assigring the [P addiess to the client e

Specily which I address the client s going te use. By selecting "Use IKE Config Mode! the
client's IP addiess is dynamically sssigned by the PN gateway.

Furthermore, define where the DNS / WINS servers (if used) can be found.

IP address assignment

|Use local IP address j

Manual IP addiess

» Client: With this setting, the device functions as the client for this VPN connection and requests an IP address
from the remote site (server). The device acts in a similar manner to a VPN client.

» Off: If the IKE-CFG mode is switched off, no IP addresses will be assigned for the connection. Fixed IP addresses
must be defined for both ends of the connection.

LANconfig When using LANconfig for the configuration, you will find the VPN connection list in the configuration area 'VPN'
on the 'General' tab under the button Connection list.
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Connection list - Edit Entry 2]l

Mame of connection: I LCS oK I
Short hold kme: | 30 seconds Cancel |

Dead Peer Detection: | 0 seconds
Extranet address: I 10,99,100.52
Remote gabeway: I 213.217.69.77

Conneckion parameter; LS -
Rule Creation: IAuto 'I

Dynamic ¥PM connection {only with compatible remote stations):
Mo dynamic YFN
" Dynamic ¥PM {a connection is created to transmit IP addresses)

" Dynamic YPM (IF addresses are transmitted without establishing a
connection if possible)

% Dynarmic YPM (an ICMP packet will be sent ko transmit IP addresses)
" Dynamic YPN (an UDP packet will be sent to transmit IP addresses)
IKE exchange {only in conjunction with “No dynamic YPN"):

% [Main mode

€ aggressive mode

IKE-CFiG: IClient i l

Clienk

Under WEBconfig, Telnet or a terminal program, you will find the settings for the IKE-CFG mode under the following
paths:

WEBconfig Expert configuration P> Setup » VPN module »> Name list

Terminal/Telnet ‘ Setup/VPN-module/Name-1list

A.13 SYSLOG storage in the device

SYSLOG protocols the activities of a LANCOM device. To extend the output of the SYSLOG information over an
appropriate SYSLOG client, the 100 most recent SYSLOG messages are stored in the device's RAM. This means that
the SYSLOG messages can be viewed directly on the device to help with diagnosis.

A.13.1 Activate SYSLOG module

The SYSLOG module must first be activated for the protocol to be recorded. Additionally an appropriate SYSLOG client
must be configured ('Configuring the SYSLOG client’ —page A-28).
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LANconfig

WEBconfig,

Telnet or
terminal
program

LANconfig

[> SYSLOG storage in the device

For configuration with LANconfig you will find the SYSLOG module under the configuration area ‘Log & Trace' on the
'SYSLOG' tab.

4= ¥PN_NHAMEL Configuration ﬂll
Configure: |Log & Trace ‘l

SHMP  SYSLOG | SMTP Account | SMTP Options |

System Event Logging

¥ Send information about system evertts to the SYSLOG
[}\flients it the following list

SYSLOG clents... | Faciiy mapping = |

Under WEBconfig, Telnet or a terminal program, you will find the SYSLOG module under the following paths:

WEBconfig Expert-Configuration D> Setup P> SYSLOG-module

Terminal/Telnet /Setup/SYSLOG-module

A.13.2 Configuring the SYSLOG client

The SYSLOG module can write different messages to the memory in the device. If there are messages that you do not
require (e.g. debug and information messages), you can reduce the scope of the messages by entering a local loop-
back address of you LANCOM device (e.g. 127.0.0.1) as the SYSLOG client; for this client, you then activate only cer-
tain sources and/ or priorities.

For configuration with LANconfig you can open the list of SYSLOG clients under the configuration area 'Log & Trace'
on the 'SYSLOG' tab using the SYSLOG clients button.

A-28
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+/2 ¥PN_NHAMEL Configuration ] | 1||
Corfigure: |Log & Trace 'l SYSLOG clients

SMMP STSLOG | SMTP Accountl SMTPI | IP address | Swstem | Login | Swstem time | Console login | Connections | Accounting | Administration | Riouter I Alert I E

i I —— 7| x
System Event Logghg———————————— SYSLOG clients - Edit Entry ] 2]

IV Send information about system events 1P address: I 127.0.0.1 0K
clients in the fallowing list

- = Cancel
SYSLOG clients.. | Fa UIE =i
3 IV System IV Login
[V System time IV Cansale lagin Edit ,
¥ Connections ¥ accounting
v admiristration ¥ Router
~ Priority

IV alert I Errar
¥ ‘arning ™ Information
[ Debug

Under WEBconfig, Telnet or a terminal program, you will find the list of SYSLOG clients under the following paths:

WEBCconfig Expert-Configuration D> Setup P> SYSLOG-module P> Table-SYSLOG

Terminal/Telnet /Setup/SYSLOG-module/Table-SYSLOG

A.13.3 Read-out SYSLOG messages

To read the SYSLOG messages, access the statistics under WEBconfig or Telnet. The SYSLOG output can be accessed
under Status » TCP-1P-statistics > Syslog-statistics:

Expert Configuration
3 Status
A TCP-IP-statistics
4 Syslog-Statistics

Last-Messages

ldx. Time Source Level Message

8  12/3/200417:43:32 LOCALO Error  error for peer 1TUNDA: DSL layer 1

9  12/3/2004 17:43:32 LOCALO Notice none state: DSL-ERR - Ready

10 12/3/2004 17:43:33 LOCALOD Notice none state: DSL-ERR - Dial to 1TUNDA ()

11 12/3/2004 17:43:33 LOCALO Notice Router state: DSL-1 - Establ. PPPoE to 1UNDA ()
12 12/3/200417:43:34 LOCALO Notice Router state: DSL-1 - Protocol

13 12/3/200417:43:35 AUTH  Notice Successfull logged into peer 1TUNDA
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A.14 Overview of functions for LANCOM models and LCOS* versions

Stateful Inspection, DoS, IDS 2.80 2.80 2.80 (4 v 2.80 2.80 v
IP-QosS, Traffic Shaping 3.30 3.30 3.30 3.30 v 3.30 3.30 v
N:N Mapping v 3.30 3.30 v
VLAN 3.30 (4
DMZ-Port 1) 1) ) ) )
AES, 3-DES, DES, Blowfish, CAST 332 332 v
VPN-5 Option integr. with | integr. with integr.
VPN-25 Option v 4 v
VPN Hardware Acceleration in combinatin

with VPN-25
VPN-100
VPN-200
ADSL Modem (%4 v v
Switch Ports 4 4 4 4
ISDN Leased Line Option v v (%4 (%4 v (4 v v
Faxmodem Option v - - - - - - - =
Dynamic DNS, CRON 3.10 3.10 3.10 v v 3.10 3.10 (4 %
DSLoL 3.10 v 3.10 S
WLAN-802.11b v v %)
WLAN-802.11g v v 8
WLAN-802.11a (incl. Turbo Mode) E
Multi SSID, IP Redirect 3.42 3.42 s
Super A/G 3.42 3.42 %
DHCP Auto Client Mode 3.42 3.42 3.42 3.42 3.42 3.42 3.42 3.42 QQJ
802.11i with HW-AES 3.50 3.50 %
SSH Configuration 4.0 4.0 4.0 4.0 4.0 4.0 ~
Redundant VPN Gateways 4.0 4.0 4.0
Rights Management for Admins 4.0 4.0 4.0 4.0 4.0 4.0
LEPS 4.0 4.0
Individual Port Mapping 4.0 4.0 4.0 4.0 4.0 4.0
Multiple Loopback Addresses 4.0 4.0 4.0 4.0 4.0 4.0
Multi PPPoE 4.0 4.0 4.0 4.0 4.0 4.0
Standard WEP Encryption 4.0 4.0
802.11i for P2P in WLAN 4.0 4.0
IKE Config Mode 4.0 4.0 4.0
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Stateful Inspection, DoS, IDS (4 (4 2.80 2.80 2.80 2.80 (4
IP-QoS, Traffic Shaping v v 3.30 3.30 3.30 3.30 v
N:N Mapping 330 v 330 330 3.30 330 v
VLAN 330 v 3.30
DMZ-Port 1) 1) v 1)
AES, 3-DES, DES, Blowfish, CAST 3.32 4 v?2 v?2 v v v
VPN-5 Option integr. with integr. v 4
VPN-25 Option v v v
VPN Hardware Acceleration in combinatin | in combinatin v
with VPN-25 with VPN-25

VPN-100 (4
VPN-200 "4 vy
ADSL Modem v
Switch Ports 4 4 4
ISDN Leased Line Option v v integr. integr. integr. integr.

% Faxmodem Option - - integr. (4 - -

5 Dynamic DNS, CRON v v 3.10 3.10 3.10 3.10 v

N DSLoL v

8 WLAN-802.11b v v v

S WLAN-802.11g v v v

E WLAN-802.11a (incl. Turbo Mode) v 4 v o

§ Multi SSID, IP Redirect 3.42 3.42 3429

S Super A/G 3.42 3.42 3479

% DHCP Auto Client Mode 3.42 3.42 3.42 3.42 3.42 3.42 3.42

~ 802.111 with HW-AES 3.50 3.50 -1350
SSH Configuration 4.0 4.0 4.0 4.0 4.0 4.0 4.0
Redundant VPN Gateways 4.0 4.0 409 4.0 4.0 4.0 4.0
Rights Management for Admins 4.0 4.0 4.0 4.0 4.0 4.0 4.0
LEPS 4.0 4.0 4.0
Individual Port Mapping 4.0 4.0 4.0 4.0 4.0 4.0 4.0
Multiple Loopback Addresses 4.0 4.0 4.0 4.0 4.0 4.0 4.0
Multi PPPoE 4.0 4.0 4.0 4.0 4.0
Standard WEP Encryption 4.0 4.0 4.0

* Numbers in the table show the LCOS version,

4 optional VPN 500 and VPN 1000
with which the feature was implemented.

5 compatible to ADSL and ADSL2
83050 with external MC-54 card only

Y port Seperation (Private Mode)
2) onl it VPN option is activated in both devices

A-31 3 not in conjunction with 802.11b WLAN cards
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Stateful Inspection, DoS, IDS 2.80 2.80 2.80 2.80 2.80 2.80 4 (4 ("4

IP-QoS, Traffic Shaping 3.30 3.30 3.30 3.30 3.30 3.30 v v v

N:N Mapping v

VLAN 3.30 3.30 3.30 3.30

DMZ-Port 1) 1) 1)

AES, 3-DES, DES, Blowfish, CAST v

VPN-5 Option

VPN-25 Option

VPN Hardware Acceleration v

VPN-100 v

VPN-200

ADSL Modem

Switch Ports 4 3 4

ISDN Leased Line Option v v v v integr.

Faxmodem Option - v v - - v 4 v

Dynamic DNS, CRON 3.10 3.10 3.10 3.10 v v v

DSLoL 3.10 3.10 3.10 3.10

WLAN-802.11b v v v v v v S
WLAN-802.11g v (4 QEJ
WLAN-802.11a (incl. Turbo Mode) v 5‘)
Multi SSID, IP Redirect 3.42 3.42 3.42 3.42 3.42 3.42 8
Super A/G 3.42 3.42 ™
DHCP Auto Client Mode 3.42 3.42 3.42 3.42 3.42 3.42 v v v )
802.111 with HW-AES 350 | 350 S
SSH Configuration 4.0 4.0 v v 4 E
Redundant VPN Gateways v %
Rights Management for Admins 4.0 4.0 (4 v v ~
LEPS 4.0 4.0

Individual Port Mapping 4.0 4.0 v v v

Multiple Loopback Addresses 4.0 4.0 (4 (4 (4

Multi PPPoE 4.0 4.0 v v

Standard WEP Encryption 4.0 4.0

802.11i for P2P in WLAN 4.0 4.0

IKE Config Mode 4.0
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